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WARNINGS AND PRECAUTIONS

READ ALL PRODUCT MANUALS AND CONSULT WITH BECKMAN COULTER-TRAINED PERSONNEL BEFORE ATTEMPTING
TO OPERATE INSTRUMENT. DO NOT ATTEMPT TO PERFORM ANY PROCEDURE BEFORE CAREFULLY READING ALL
INSTRUCTIONS. ALWAYS FOLLOW PRODUCT LABELING AND MANUFACTURER’S RECOMMENDATIONS. IF IN DOUBT AS
TO HOW TO PROCEED IN ANY SITUATION, CONTACT YOUR BECKMAN COULTER REPRESENTATIVE.

HAZARDS AND OPERATIONAL PRECAUTIONS AND LIMITATIONS

WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:

WARNING - Can cause injury.
CAUTION - Can cause damage to the instrument.
IMPORTANT - Can cause misleading results.

BECKMAN COULTER, INC. URGES ITS CUSTOMERS TO COMPLY WITH ALL NATIONAL HEALTH AND SAFETY
STANDARDS SUCH AS THE USE OF BARRIER PROTECTION. THIS MAY INCLUDE, BUT IT IS NOT LIMITED TO,
PROTECTIVE EYEWEAR, GLOVES, AND SUITABLE LABORATORY ATTIRE WHEN OPERATING OR MAINTAINING THIS OR
ANY OTHER AUTOMATED LABORATORY ANALYZER.

WARNING Risk of operator injury if:
¢ All doors, covers and panels are not closed and secured in place prior to and during instrument operation.
* The integrity of safety interlocks and sensors is compromised.
« Instrument alarms and error messages are not acknowledged and acted upon.
* You contact moving parts.
¢ You mishandle broken parts.
¢ Doors, covers and panels are not opened, closed, removed and/or replaced with care.
e Improper tools are used for troubleshooting.
To avoid injury:
« Keep doors, covers and panels closed and secured in place while the instrument is in use.
 Take full advantage of the safety features of the instrument. Do not defeat safety interlocks and sensors.
* Acknowledge and act upon instrument alarms and error messages.
e Keep away from moving parts.
« Report any broken parts to your Beckman Coulter Representative.
« Open/remove and close/replace doors, covers and panels with care.
« Use the proper tools when troubleshooting.

CAUTION System integrity might be compromised and operational failures might occur if:
« This equipment is used in a manner other than specified. Operate the instrument as instructed in the Product Manuals.

* You introduce software that is not authorized by Beckman Coulter into your computer. Only operate your system’s
computer with software authorized by Beckman Coulter.

* You install software that is not an original copyrighted version. Only use software that is an original copyrighted
version to prevent virus contamination.

IMPORTANT If you purchased this product from anyone other than Beckman Coulter or an authorized Beckman Coulter
distributor, and, if it is not presently under a Beckman Coulter service maintenance agreement, Beckman Coulter cannot
guarantee that the product is fitted with the most current mandatory engineering revisions or that you will receive the most
current information bulletins concerning the product. If you purchased this product from a third party and would like
further information concerning this topic, call your Beckman Coulter Representative.




REVISION STATUS -

Initial Issue, 9/03
CXP Software Version 1.0. Initial issue for customer distribution.

Issue B, 6/04
CXP Software Version 2.0.

Additions, changes or deletions were made at these locations:
2-3,2-4, 3-8, B-1, B-22, B-24, B-28, B-29, B-38, B-56, B-69, B-80, B-82, B-167 through
B-169, B-181, B-192 through B-194, B-197, and B-199 through B-226.

This document applies to the latest software listed and higher versions. When a subsequent software version
changes the information in this document, a new issue will be released.
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INTRODUCTION -

This introductory section contains the following topics:

e USING YOUR Cytomics FC 500 MANUALS
e ABOUT THIS MANUAL

¢ CONVENTIONS, and

e GRAPHICS.

USING YOUR Cytomics FC 500 MANUALS

The manuals listed below are available as PDF files in the FC 500 CXP software and the
Operator’s Manuals CD-ROM. Printed versions of these manuals are also available by order.

Use the Reference manual for instrument specifications and information on installation and
system options.

Use the Instructions For Use manual for the day-to-day running of your instrument. Go
through the detailed step-by-step procedures of startup, quality control (QC), running
samples, analyzing data, printing reports, reviewing QC data and shutdown. It contains safety
and troubleshooting information, error messages, as well as in-depth information on the
principles of flow cytometry, information about what your instrument does, and the methods
it uses.

Use the Special Procedures manual to clean, replace, or adjust a component of the instrument.
Use the Getting Started manual as a brief introduction to the system.

Use the Master Index to easily locate a topic in any of your manuals.

ABOUT THIS MANUAL

Your Cytomics FC 500 Reference manual provides instrument specifications and information
on installation, safety and software features.

This information is organized as follows:

*  Chapter 1, USE AND FUNCTION
Contains a short description of the major instrument components and options, and the
reagents and quality control materials used.

*  Chapter 2, INSTALLATION
Contains instrument requirements, and diagrams of the interunit cable connections.

»  Chapter 3, SPECIFICATIONS
Details the instrument and performance specifications.

*  Appendices
The appendices provide reference material on the following topics:

* LOG SHEETS
e USING CXP SOFTWARE

=  GLOSSARY
The glossary has definitions for many of the words and terms used in flow cytometry.
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= [NDEX
Use the Index to easily locate specific information in this manual.

CONVENTIONS

This manual uses the following conventions:

* Throughout this manual your FC 500 is also referred to as the system or instrument.
* Bold font indicates a software option, such as Cytometer.

* [Italics font indicates screen text displayed on the instrument, such as
Preparing Samples.

* Courier font indicates text you have to type using the keyboard.

* () indicates a key (such as (Enter]).

¢ (J+] indicates that the two keys listed (such as (At}+(F2)) are linked for a specific
function and must be pressed in this sequence:

a. Press down on the first key listed and while continuing to press it, press down on
the second key listed.

b. Release both keys at the same time.

* (J () indicates to press and release the first key listed then press and release the next
key listed. For example: (Enter).

¢ Icons/buttons to select functions on the software screen are shown within text.

Uk
Example:

d @ indicates to use the mouse to select the screen button labeled

. @ File » Save indicates to use the mouse to select the Save item on the File menu.

. through are special function keys.

* A Note contains information that is important to remember or helpful in performing a
procedure.

e The terms “screen” and “window” are used interchangeably.

*  SHOW ME means there is a video available for the procedure in the online help.
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To Choose A Command With The Keyboard

After you press (At), each menu name has one letter underlined to indicate which letter to use
to pull down the menu. For example, the letter F in the File menu is underlined, press (F] to
pull down the File menu, the letter E in the Edit menu is underlined, press (E] to pull down

the Edit menu.

Command  Function

Accepts your selection.

Stops the operation, discarding your choices.

Tab Moves cursor over different choices if there are multiple options - see

Windows® manuals for Windows operation via keyboard.

Alt}+{Tab When you have more than one application Window open, use (At}+{Tab) to
switch between tasks.

Dialog Box

Dialog boxes receive commands or information; for example, a file name dialog box receives
information about a file name.

Accepts the information you have selected or typed.

Stops the operation, ignoring your choices.
Cancel p p 8 gy

Description of Reporting Units

Unless otherwise stated, all parameter units are shown in the US unit format (cells/uL)
throughout the manuals.

GRAPHICS

All graphics, including screens and printouts, are for illustration purposes only and must not
be used for any other purpose.
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use AND FuncTion i

1.1 SYSTEM COMPONENTS

The system components are shown in Figure 1.1.

Figure 1.1 Cytomics FC 500 Flow Cytometry System

55710268

1] MCL (6] Mouse
2] Cytometer o USB box
3] HeNe laser option 0 Computer
o Keyboard (9] Power Supply
e Monitor
Cytometer

This unit analyzes the sample. It contains the sheath fluid and cleaning agent containers.
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SYSTEM COMPONENTS

Power Supply

This unit provides DC power, pressure, and vacuum to the Cytometer. A 4-L waste bottle sits
in a bracket on the right side of the Power Supply.

Workstation
The Workstation runs the software that enables you to control the instrument. It displays

sample results and other information. It consists of:
* A monitor
* A computer with data storage devices
* A USB box

* A keyboard and a mouse.

Multi-tube Carousel Loader (MCL)

The MCL is an automated sample loader for the instrument. It uses a carousel that holds
thirty-two 12- x 75-mm test tubes. The MCL reads the following bar-code types:

¢ Codabar
e Code 39® bar code
e Code 128

* Interleaved 2-of-5.
For additional information on the bar-code specifications, see Appendix B, BAR-CODE
SPECIFICATIONS.

The MCL mixes each sample before analysis. You can use the MCL to automatically analyze
multiple samples or analyze single tubes manually through the tube access door.

Figure 1.2 shows the location of the carousel number, tube position, and sample tube
bar-code labels on the MCL carousel.

Figure 1.2 MCL Carousel Bar-Code Labels

Sample
bar code
label

Carousel ID
bar code

Tube position
bar code label
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OPTIONS

CXP Software

The CXP software consists of two separate applications:

* CXP Cytometer. This contains the Acquisition and Analysis software and is used when
running the Cytometer.

* CXP Analysis. This contains the Analysis software for offline analysis. You can perform
MultiFile Analysis with this software.

1.2 OPTIONS

Hardware Options

Printer

Provides a printout of sample results and other information. The Printers available for the
system are subject to change, so contact your Beckman Coulter Representative for the current
model selection.

Bar-Code Scanner

A hand-held scanner/reader used to read specimen collection bar-code labels. A fast, accurate
method for inputting specimen and sample tube information and tube ID into the software
database.

* Refer to the bar-code reader
manufacturer’s manual for specific
instructions about using it.

* This illustration shows how to connect
the bar-code reader to your system. One ) )
bar-code connector plugs into the —/ﬁg
keyboard. The other connector @ plugs ’
into the keyboard connection on the
back of the computer. /

Workstation/Network Server

A Beckman Coulter FlowCentre™ Multimedia Workstation can be used as an offline analysis
workstation and network server for data and worklist transfer.

Second Laser

* A 635-638 nm red solid-state laser providing a minimum of 25 mW light regulated laser
power, or

* A 633-635 nm air-cooled red Helium Neon (HeNe) laser providing a minimum of
20 mW light regulated laser power. Additional covers are added to the instrument to
accommodate the HeNe laser.

The second laser has a shutter that allows you to block the laser output.
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REAGENTS AND QUALITY CONTROL MATERIALS

Filter Kit

The optional filter kit includes 5 extra filter holders, an ND 1.0 filter, a full mirror (in a
holder), a 50% mirror in a holder and an additional filter block base.

Single Laser Filter Block

An assembled filter block configured as shown in Figure 5.5 in the Instructions For Use
manual.

Dual Laser Filter Block

An assembled filter block configured as shown in Figure 5.6 in the Instructions For Use
manual.

Single Laser Filter Upgrade
The single laser filter upgrade kit includes two filters: a 620 BP filter and a 645 DSP filter.

Software Options
* Acquisition/Analysis
* Analysis only version
*  Multi user Analysis packs

* Network user Analysis packs

1.3 REAGENTS AND QUALITY CONTROL MATERIALS

Beckman Coulter recommends these reagents or their equivalents. All stated performance
characteristics in this manual are based on the use of the Cytomics FC 500 system with the
following reagents.

Sheath Fluid

In the Cytometer, the sample is guided into a stream of sheath fluid to make the sample cells
flow single file through the laser beam. IsoFlow™ sheath fluid, a nonfluorescent, balanced
electrolyte solution, is made for this purpose.

IsoFlow sheath fluid has the following characteristics:

e Filtered to 0.2 pm
* Transparent and nonfluorescent to 488-nm laser light
* Low background, bacteriostatic, fungistatic

* Compatible with the characteristics of the sample being measured (such as pH,
osmolality, conductivity).

The sheath container has a working capacity of about 1.8 L. The amount of sheath fluid the
container holds beyond the working capacity is for pressurization and level sensing.

Cleaning Agent

When the Cytometer is in the Cleanse mode, COULTER CLENZ® cleaning agent flushes
sample tubing and helps to reduce protein buildup and particles in the instrument. Each
cleanse cycle uses about 15 mL of cleaning agent.
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The cleaning agent container has a working capacity of about 500 mL. That is enough
cleaning agent to use the Cleanse mode once a day for 1 month. The amount of cleaning
agent the container holds beyond the working capacity is for pressurization and level sensing.

Read the container’s label for more information on the cleaning agent.

Quality Control Materials
The quality control materials available from Beckman Coulter are:

Flow-Check™
Fluorospheres

Flow-Set™
Fluorospheres

Flow-Count™
Fluorospheres

Stem-Count™
Fluorospheres

Leuko-Count™
Fluorospheres

CYTO-TROL™
Control Cells

IMMUNO-TROL™
Cells

IMMUNO-TROL
Low Cells

Immuno-Brite™
Fluorospheres

CYTO-COMP™
Cell Kit

Stem-Tro
Cells

QuickGOMP 2 Kit

|TM

QuickCOMP 4 Kit

Control

Fluorospheres used to check the stability of the optical and fluidic systems.

Fluorospheres used to standardize light scatter and fluorescence intensity for human leukocyte
applications.

Fluorospheres with an assayed concentration that are used to determine absolute counts.
Fluorospheres with an assayed concentration that are used to determine absolute counts.
Fluorospheres with an assayed concentration that are used to determine absolute counts.

Lyophilized lymphocytes with assay values for specific surface antigens. Used to assess monoclonal
antibody function and verify proper flow cytometer setup.

Stabilized erythrocytes and leukocytes with a known quantity of surface antigens. Used to verify
monoclonal antibody performance as well as verify the process of sample staining, lysing, and
analysis.

Stabilized erythrocytes and leukocytes with a known quantity of surface antigens. Used to verify
monoclonal antibody performance as well as verify the process of sample staining, lysing, and
analysis.

Uniform size fluorospheres with varying fluorescence intensities that are used to monitor instrument
linearity.

CYTO-COMP Cells stained with a single color, such as CD45, are used to adjust color compensation
settings for multicolor analysis using monoclonal antibodies.

Lyophilized KG-1a cells that have been modified and stabilized to approximate human hematopoietic
progenitor cells (HPC).

Two single-color antibody reagents (FITC and PE) that can be used to adjust color compensation on a
flow cytometer.

Four single-color antibody reagents (FITC, PE, ECD, and PC5) that can be used to adjust color
compensation on a flow cytometer.

The reagents listed below are for “Research Use Only, not for use in diagnostic procedures”.

PC7 (770/488)
Setup Kit

APC (675/633)
Setup Kit

PN 1755708

Argon (488 nm laser) excitable PG7 channel alignment fluorospheres and argon excitable PG7
intensity standard.

Red laser excitable alignment fluorospheres and red laser excitable intensity standard.
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MATERIAL SAFETY DATA SHEETS (MSDS)

1.4  MATERIAL SAFETY DATA SHEETS (MSDS)

To obtain an MSDS for Beckman Coulter reagents used on the Cytomics FC 500 flow
cytometer:

1. On the internet, go to http://www.beckmancoulter.com and select MSDS from the
Customer Support drop down menu.

2. If you do not have internet access:

* In the USA, either call Beckman Coulter Customer Operations (800-526-7694) or
write to:

Beckman Coulter, Inc.
Attention: MSDS Requests
PO. BOX 169015

Miami, FL 33116-9015

* Outside the USA, contact your Beckman Coulter Representative.
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DELIVERY INSPECTION

INSTALLATION

The instrument is tested before shipping. International symbols and special handling
instructions are printed on the shipping cartons to inform the carrier of the precautions and

care applicable to electronic instruments.

CAUTION Possible instrument damage could occur if you uncrate the instrument, install it, or set it up.
Keep the instrument in its packaging until your Beckman Coulter Representative uncrates it for installation

and setup.

When you receive your instrument, carefully inspect all cartons. If you see signs of
mishandling or damage, file a claim with the carrier immediately. If separately insured, file the

claim with the insurance company.

SPECIAL REQUIREMENTS

Before your Beckman Coulter Representative arrives to install the instrument, you must
determine where you want the system placed and the overall layout. Consider the factors

described in the following paragraphs.

Space and Accessibility

Allow room to interconnect the system components. Also, arrange for:

* Comfortable working height

* Space for ventilation, and access for maintenance and service:

Specifications

FC 500 with HeNe Laser

FC 500 w/o HeNe Laser or
with Red Solid-State
Laser.

Height

Additional clearance above for servicing and
lifting the Data Acquisition card cage above the

61.0cm (24in.)

61.0cm (24in.)

sensor 45.7 ¢cm (18 in.) min. 45.7 ¢cm (18 in.) min.
Total clearance needed 106.7 cm (42 in.) 106.7 cm (42 in.)
Width 111.8 cm (44 in.) 90.0 cm (35.51n.)

Additional clearance on right for servicing
Additional clearance on left for servicing
Total clearance needed

30.5cm (12in.)
30.5¢cm (12in.)
172.7 cm (68 in.)

30.5cm (12in.)
30.5¢cm (12in.)
151.0 cm (59.5in.)

Depth

Additional clearance behind instrument for
sufficient cooling and room for servicing

Total clearance needed

88.9cm (35in.)

30.5¢cm (12in.)
119.4 cm (47 in.)

88.9cm (35in.)

30.5¢cm (12in.)
119.4 cm (47 in.)
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2-2

Electrical Input

CAUTION Possible instrument damage could occur if you put the Power Supply plugs on the same
electrical circuit or use an extension cord or a power strip to connect the Power Supply. Use two dedicated
outlets with isolated grounds for the Power Supply plugs.

The Power Supply requires two dedicated outlets with isolated grounds.

Country Dedicated Lines with Isolated Grounds Non-Dedicated Lines
USA Two dedicated lines at 115 Vac, 50/60 Hz | Three non-dedicated lines at 115 Vac,
at 20 A (16 A continuous) 50/60 Hz at 20 A
Europe and Two dedicated lines at 220 Vac, 50/60 Hz | Three non-dedicated lines at 220 Vac,
other applicable | at15 A 50/60 Hz at 10 A
countries or
Two dedicated lines at 240 Vac, 50/60 Hz
at15 A
Japan Two dedicated lines at 100 Vac, 50/60 Hz | Three non-dedicated lines at 100 Vac,

at25A

50/60 Hz at 20 A

The computer requires a separate outlet, but it does not have to be a dedicated line

Ambient Temperature and Humidity

Keep the room temperature between 16°C and 32°C (60°F and 90°F), and do not let it change
more than 5°F per hour. Keep the humidity between 30% and 80%, without condensation.

Heat Dissipation

Heat dissipation is 2,300 W (7,850 Btuw/hour) for a single laser system. Heat dissipation is
2,330 W (7,955 Btwhour) for a two-laser system. Provide sufficient air conditioning (refer to
Ambient Temperature and Humidity).

Drainage

The waste line from the Cytometer is connected to a 4-L waste bottle, which sits in a bracket
on the right side of the Power Supply. Dispose of the waste in accordance with your local
environmental regulations and acceptable laboratory procedures.

WARNING Risk of biohazardous contamination if you have skin contact with the waste container, its
contents, and its associated tubing. The waste container and its associated tubing might contain residual
biological material and must be handled with care. Clean up spills immediately. Dispose of the contents of
the waste container in accordance with your local regulations and acceptable laboratory procedures.

The waste line supplied with the instrument can be connected to an open drain. If you use an
open drain, mechanically secure the waste tube into the drain so the tube cannot accidentally
come out of the drain. This prevents spillage.
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2.3 SYSTEM CONNECTIONS

Power and Signal Cables

Figure 2.1 or Figure 2.2 shows the interunit connections of the power and signal cables,
depending upon your Power Supply configuration. Computer configuration may vary based
on current configuration availability.

Figure 2.1 Power and Signal Cable Connections, with Voltage-specific Power Supply

Cytometer

Workstation

USB box

HeNe laser
option

\

Fiber optic
trans to rec

Fiber optic
rec to xmit| g

5 |
HeNe or
Solid-state — ANALOG oyT1o
laser
LASER
UMBILICAL
: Power Supply
POWER MODULE CONTROL module
L
ac power
5570001B .m
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Figure 2.2 Power and Signal Cable Connections, with Universal Power Supply

Cytometer back cover

Cytometer

Workstation

Fiber optic
trans to rec

Fiber optic
rec to xmit
<2
1
feNe or ——MCL
d-state — |
laser _— CYT12
. ,,/”’/// -
Logic —|
Anal // Power
nalog — —— module
control
D—
D—
ac power Power
line cords Supply Laser
module umbilical
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Waste and Pneumatic Tubing

Figure 2.3 or Figure 2.4 shows the interunit connections for waste and pneumatic tubing,
depending upon your Power Supply configuration.

Note: Ensure the waste tubing does not exceed the height of the MCL head.

Figure 2.3 Waste and Pneumatic Tubing Connections, with Voltage-specific Power Supply
Cytometer

HeNe laser

option Flow restrictor box

FLOW CELL
WASTE

WASTE

PRESSURE

...... 0 ES - VACUUM

Power Supply
module

WASTE
WASTE VENT
WASTE LEVEL

5570003A
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Figure 2.4 Waste and Pneumatic Tubing Connections, with Universal Power Supply
Cytometer back cover

Cytometer

HeNe laser
option

FLOW CELL
WASTE \‘I [ =
= \
WASTE \ PRESSURE
e VACUUM
WASTE Power Supply
LEVEL | module
| .
S
WASTE | gm“l'u_l
I3
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2.4  INSTALLING CXP SOFTWARE

Your CXP Software is a 2 disk set. The contents of the set is,

Disk 1 - Microsoft® .NET Framework and MSDE2000

Disk 2 - CXP Software

Note: You must have Windows Administrator access rights to install the software.

Install Disk 1

If you are reinstalling Disk 1, remove the existing Microsoft .NET Framework and MSDE2000
before proceeding with the installation.

1  Insert Disk 1 into the CD-Rom drive. Instalishield wizard
The CD-Rom should Autorun the Preparing to Install...
Microsoft .NET Framework and MSDE2000 Getup is prepating the InstallShield Wwizard,

which will guide wou through the program setup process.

MSDE2000 installation. Please val.
If the CD_Rom does not Autorun Configuring Micrasoft{R) .MET Framewark.
click here for additional instructions.

2 Follow t.he 1nstruct10n§ on the
installation screens to install the
software.

3 Leave the CD-Rom in the drive and InstallShield Wizard

PN 1755708

@ to restart your

computer and finish installing the
software.

Note: If you are reinstalling Disk 1,
restore your database after restarting
the computer.

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed MSDE 2000,
Before pou can use the pragran, yau must restart pour
computer.

@ Yes, | want o restart my computer now.
£ Mo, | will restart my computer later.

Remave any disks from their drives. and then click Finish to
complete setup.

< Back Finish I: I Cancel
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Install Disk 2
If you are reinstalling Disk 2, remove the existing CXP software before proceeding with the
installation. Uninstalling the CXP software does not remove any of your data files, protocols,
panels or worklists.

1  Insert Disk 2 into the CD-Rom drive. CxP software =
The CD-Rom should Autorun the CXP
Software installation and display the
Welcome screen.

Welcome to the InstallShield Wizard for CXP
Software

The InstalShield® \Wizard will install CXP S oftware on your
computer. To continue, click Mext

If the CD-Rom does not Autorun
click here for additional instructions.

2 Follow the instructions on the
installation screens to install the
software.

< Back Next > I Cancel

CXP Software

InstallShield Wizard Complete

3 @ to install the Romlock

Drivers. These drivers allow CXP
Software to communicate with the
Romlock. The Romlock ensures that
the person using the personal
computer (PC) is a registered user of
the CXP software. CXP Software does
not function fully without the Romlock

Setup has finished instaling C<F Software on your computer.

™ Display the additional Fomlock information bulletin?
I Install Romlack Driver
If pou are instaling & full version of TP software, the

RomLock diver install system will iun when the <finish> button
is clicked

installed.

The installation process is now N I
complete and CXP Software is ready to

run.

4  1f the Romlock drivers are installed, the system prompts you to restart the computer.

Note: The correct display of Tomogram Plots requires graphic card drivers to support
Microsoft® Direct X® technology. Some graphic card drivers may show additional lines within
the Tomogram cube. To remove the additional lines try updating your graphic card driver
using the latest available drivers from the manufacturer’s web site.
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If the problem persists, a registry file (DisableTomogramCube.reg) is provided in the CXP
utilities folder of the Installation disk, which removes all lines from the Tomogram plot.

To remove all Tomogram lines, double click the DisableTomogramCube.reg file.
To re-enable all Tomogram lines, double click the EnableTomogramCube.reg file.

2.5 UNINSTALLING CXP SOFTWARE
Remove .NET Framework and MSDE 2000

IMPORTANT Loss of all QC and Panel Report Data occurs when you remove Microsoft .NET Framework
and MSDE2000. To preserve you QC and Panel Report Data, archive your database before removing

Microsoft .NET Framework and MSDE2000.

8 E.L Settings B3 Control Panel
1 §m5lartl % Settings Efl Control Panel @ ot Metwork and Dial-up ¢
. :§ Frinters

@ Help i Taskbar B Start Menu
Run...

Shut Down...
|§gstart || @ 15 & s & || W pant shos

o =10l
Currently installed programs: Sort by:| ame -
, - § =l
AddiRemove L —— - -
2 Programs | b R -
- .- e
P ——

- - -

3 @ Microsoft .NET Framework.

4 @ Change/Remave

2-9
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9 Repeat steps 1 and 2 for @ MSDE2000.

Remove CXP Software

Note: If you remove CXP Software only and do not remove MSDE2000, your QC and Panel
Report database is not removed.

Metwork and Dial-up ¢

Search L4
(% Prinkers

y Vam B

iﬂ Taskbar & Start Menu

IiaStart “ m e @ (EN] @ Q @ “ “,PalntshopF

& Add/Remove Programs I [l 55
Currently installed programs: Sort by:[Name -

1) Adobe Acrabat ¢ ow e 2

AddjRemove
2 Programs |

£ Eson e Sotteare

i roverisig Premer 2001 g s
T 1 vl wovkshag ]
B LveLpdate o Lene ||
U Mt aaphics Softmare (remove oniy
: MG Sy SER NS £alg e
3 CXP SOftware. P Mcrosoft NET Framewnrh (Enghsh) v1 0 3708
i s o0 =l
Close

4 @ Change/Remove
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Check that the shortcut icons have
been deleted from the Start menu and
the Windows Desktop. If any remain,

a. Right mouse click on the icon.
b.  Select Delete.

If the CD-Rom Does Not Autorun

CHP Cyhomet

®

Open

FC OFF Sean For Viruses. .
5 WinZip 3

Send To 13

FAVA)
Ay

®

FC ON(Warm.

Cut
Copy
Documents Paste

z
;
a
m
B

Create Shortcut

T
Rename

Search

Sork by Name
Properties

Shut bon... —-

o
g
5

'Windows 2000 Professional

AN R

If the CD-Rom does not Autorun,

Mo 2w =

§ ] Shut Dawn, .,
FEdECEED

Use the Look In drop down window to
locate the CXP Software CD-Rom. This
is usually drive D on most systems but
it may be another drive (E, E and so
on).

@ I EiiSetup.exe Open I
@ [ |

Return to step 2 in Installing CXP
Software.

Run 20X

Type the name of a program, folder, document, or
Internet resource, and Windows will open it For you,

Open: I E:iSetup.exe j

[8]4 Cancel | Browse. .. I
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3.1 SAMPLE REQUIREMENTS

See SAMPLE REQUIREMENTS in the RUNNING SAMPLES chapter in the Instructions For
Use manual for details.

3.2 INSTRUMENT SPECIFICATIONS

Dimensions

Component

Computer

Cytometer and MCL
(only for units with Universal
Power Supply)

Cytometer and MCL

Monitor
(typical)
Power Supply
(Universal)

Power Supply
(Voltage-specific)

Height
15.75 cm
(6.2 in.)
61.0 cm
(24 in.)

61.0 cm
(24 in.)
42.7 cm
(16.81 in.)
58.4 cm
(23 in.)
50.8 cm
(20 in.)

Width
53.34 cm
(21 in.)
111.8 cm*
(44 in.)

111.8 cm*
(44 in.)
40.5 cm
(15.94 in.)
45.7 cm
(18 in.)
45.7 cm
(18 in.)

Depth
42.55 cm
(16.75 in.)

105.4 cm
(41.51n.)

88.9 cm
(35 in.)
43.8 cm
(17.25in.)
71.1 cm
(28 in.)
66.0 cm
(26 in.)

SPECIFICATIONS

Weight
18.14 kg
(40 1b)

93.9 kg
(207 1b)

84.8 kg
(187 1b)
22 kg
(48.4 1b)
59.0 kg
(130 1b)
54.4 kg
(120 1b)

* This is the width with the optional HeNe laser. The width of the FC 500 with a single argon
laser or with the optional red solid-state laser is 90.0 cm (35.5 in.)

Installation Category
Category II (per IEC 1010-1 standard).

Cytometer

Flow Cell

Sensing area: BioSense 150 pm x 450 rectangular channel with an integral lens, mounted with
a vertical (upward) flow path.

Flow Rate

Continuous pressure is applied to the sample tube. The amount of pressure depends on the
flow rate you specify:

* Low approximately 10 ul/min
* Medium approximately 30 ul/min

* High approximately 60 ul/min

PN 1755708
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Laser
Air-cooled, software controlled, 20 mW, Argon ion laser operating at 488 nm.

Optional second laser:

* Solid-state, software controlled, 25 mW, diode laser operating at 635 nm, or
* Air-cooled, software controlled, 20 mW, HeNe ion laser operating at 633 nm.

The second laser has a shutter that allows you to block the laser output to the flow cell.

Laser power is monitored 5 times per second. If the laser power deviated more than 1% a
Laser Power Error is displayed on the Status Bar. The system will not run a sample until
corrective measures rectify the fault.

Beam-Shaping Optics

Cross cylindrical lenses 10 mm by 80 mm.

Argon Laser Beam Spot Size
An elliptical spot 10-pm high by 80-um wide.

Solid-State Laser Beam Spot Size
It approximates the beam size for the argon laser.

HeNe Laser Beam Spot Size
An elliptical spot 9.5-um high by 85-pm wide.

Optical Filters

For filters used in the single filter block and the dual laser filter block configurations, see
Figure 5.6 and Figure 5.5 in the Instructions For Use manual.

*  500-nm long pass (LP) filter

* 530-nm short pass (SP) filter

*  488-nm, 550-nm, 600-nm, and 710-nm dichroic, long-pass (DLP) filters
* 645-nm dichroic, short-pass (DSP) filter

* 525-nm, 575-nm, 620-nm, and 675-nm band-pass (BP) filters

* 755-nm long-pass (LP) filter

Sensors
* The FS sensor and the SS sensor are photodiodes.

* The five FL sensors are photo-multiplier tubes (PMTs) that have a 185-nm to 900-nm
spectral range.
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Signal Processing
* High voltage amplification, minimum 250 up to 1,100, in increments of 1, for:

FL1
FL2
FL3
FL4
FL5

* Vernier gain (fine amplification), up to 1,000 (labeled volts), in increments of 1, for the
following. A change of 1 to 750 represents a 1-to-4 change in gain:
FS
SS
AUX

e Linear amplification (gain) by 1.0, 2.0, 5.0, 7.5, 10, 20, 50, 75, 100, 200, 500 or 750 for:

FS
SS
* Linear amplification (gain) by 1.0, 2.0, 5.0, 7.5, 10, 20, 50 or 75 for:
FL1
FL2
FL3

FL4
FL5

* Linear amplification (gain) by 1.0, 2.0, 5.0, 7.5, 10, 20 50 or 75 for:
AUX
* Four-decade digital logarithmic transformation of:

FS

SS

FL1
FL2
FL3
F1L4
FL5

Note: A scale of 0.1 to 1,000 is displayed on the plot axis for logarithmic parameters, but
the default statistics are based on an actual scale of 0.1024 to 1024. The displayed scale
can be changed to 1 to 10,000.

* Fluorescence color compensation is available in 0.1 increments, from 0 to 100%, for:

FL1
FL2
FL3
F1L4
FL5
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3.3

3-4

* A discriminator (maximum value of 1,023) is available for one of the following signals.
Only one discriminator can be specified for any one sample acquisition.

FS
SS
FL1
FL2
FL3
FL4
FL5
AUX

Workstation

The descriptions below are minimum configurations.

Computer
Intel® Pentium® 4 microprocessor and 256 MB of RAM.

Data Storage
e 3.5-in., 1.44-MB diskette drive.

¢ 20-GB nonremovable hard disk.
e  700-MB CD-RW drive
e 250-MB internal ZIP® drive

Interfaces
¢ Windows® 2000

* Bidirectional asynchronous serial interfaces for communication with mainframe and
personal computers.

Input Devices
* PS/2 optical Intellimouse®
e Full size PS/2 keyboard.

Monitor Options
¢ Color LCD with a 17-in. flat screen.

¢ (Color CRT with a 22-in. screen.

SOFTWARE SPECIFICATIONS

Data Qutput and Compatibility

Output and compatibility features include:

* Flow Cytometric Standard (FCS) file format for listmode and histogram files. Listmode
files contain an FCS 2.0 dataset followed by an FCS 3.0 dataset.

* Copy and Paste, or Drag and Drop plots images to third party programs such as MS
Word.
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¢ Full-color printouts with the appropriate optional Printer.

* Printout of sample results and patient reports with FlowPAGE and desktop printing
* PDF format for Acquisition printouts or FlowPAGE reports

* Printout of Worklist for the MCL

* Compatibility with ALTRA™, Elite™, XL™ and XL-MCL™ flow cytometer files (listmode
and histogram files only)

* Export data to MS Excel or similar spreadsheet program

* Save/export data as a text file.

Reporting Units

Reporting units for absolute count calibrators are cells/pL for US units or cells/L for SI units.

Setup Mode

During Setup mode the workspace is a rolling display that is updated up to three times per
second. The maximum number of events can be set on the Cytometer Control Acquisition
Setup Tab. The incoming data is not saved.

Acquisition
During data acquisition, the plots are updated in real time. When one plot is displayed with
statistics underneath, the statistics are also updated in real time.

Unlimited one or two parameter plots are available for any given sample.

One-parameter plots have 1,024-channel resolution.
Two-parameter plots have up to 512- x 512-channel resolution.

Regions
Up to 32 gates and 256 analysis regions are available for gating, analysis, and autogating per
protocol. Up to 8 of those regions can be used to create any one gate.

The following types of regions are available for gating and analysis:

* Linear

* Rectangular
*  Quadrant

* Polygonal

* Elliptical

e Contour.

Listmode Analysis

The instrument can store up to 16 parameters including AUX, TIME, and RATIO as listmode
data. The amount of available random access memory (RAM) in the computer determines the
maximum size of a listmode file.
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3-6

Locked Protocols

Locked protocols are used with the optional tetraCXP application. The following software
screens are disabled when using locked protocols. You cannot make any changes on these
screens.

Dotplot Properties
Region Properties (QC product selection and export region statistics are not locked)
Create / Modify Gates
Color Precedence
Color Blend
Cytometer Control
Plots Toolbar

Plots Menu

Select Results

Edit FlowPAGES

Edit FCS Headers

Overlay

Overlay plot allows gallery, overlay and angled views of any number of single parameter
histograms.

CXP Default File Extensions

CXP has a variety of standard file extensions. Many of these file extensions are not necessary
for CXP itself but are required for compatibility with other programs.

Panel, Protocol and Worklist files are written as pure ASCII text files and can be read and
edited by any ASCII text editor such as Windows Notepad or the MS-DOS Edit command.

The advantage of using ASCII text to describe the set-up information means that protocol
save and restore queries or errors can easily be identified and perhaps even explained or
corrected by fax or telephone support.

Standard (default) files & file extensions

* LMD FCS listmode data file (includes ASCII header information and binary listmode
data).

* HST FCS histogram file, single parameter only per file. (Includes ASCII text file
descriptions and binary histogram channel information).

* PRO Protocol files.
* PNL Panel files.
* WLS Worklist files.

* . CMP Compensation files.
* PPP Listmode compensation panel.
* PDF Files created when “Print to PDF” is selected.

* EWL External Worklist files.
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* WLQ Queue of worklist files.
* ADF Application Definition file.
* ALQ Queue of listmode files saved in AutoMATOR.

The following characters cannot be included in a file name: forward slash (/), backslash (\),
greater than sign (>), less than sign (<), asterisk (*), comma (,), question mark (?), quotation
mark ("), pipe symbol (|), colon (:), or apostrophe (‘). Leading, Trailing and multiple spaces
are not allowed.

Note: When a panel name is read from an external worklist file (*.EWL), the system searches
for the panel in the current user’s panel folder and panel subfolders, and then searches the
common panel folder and panel subfolders.
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Default AutoSetup Protocols and Panels
The following AutoSetup panels and protocols are included with CXP software.

Note: Do not delete any protocol that is associated with an Application Name. All protocols
must be present for an application to run correctly..

Application
Name

Flow-Set™ Protocol

Compensation
Protocols

Verification Protocol

Settings Protocol

Base Protocol

AS 2C1L

AS 2C1L_STAND.PRO

AS 2C1L_FL1.Pro
AS 2C1L_FL2.Pro

AS 2C1L_VERIFY.Pro

AS 2C1L Settings.Pro

AS 2C.Pro

AS 3C1L

AS 3C1L_STAND.PRO

AS 3C1L_FL1.Pro
AS 3C1L_FL2.Pro
AS 3C1L_FL5.Pro

AS 3C1L_VERIFY.Pro

AS 3C1L Settings.Pro

AS 3C1L.Pro

AS 4C1L

AS 4C1L_STAND.Pro

AS 4C1L_FL1 .Pro
AS 4C1L_FL2.Pro
AS 4C1L_FL4.Pro
AS 4C1L_FL5.Pro

AS 4C1L_VERIFY.Pro

AS 4C1L Settings.Pro

AS 4C1L.Pro

AS 4C2L

AS 4C2L_STAND.Pro

AS 4C2L_FL1 .Pro
AS 4C2L_FL2 .Pro
AS 4C2L_FL4 .Pro
AS 4C2L_FL5.Pro

AS 4C2L_VERIFY.Pro

AS 4C2L Settings.Pro

AS 4C2L.Pro

AS 5C1L

AS 5C1L_STAND.Pro

AS 5C1L_FL1
AS 5C1L_FL2
AS 5C1L_FL3
AS 5C1L_FL4
AS 5C1L_FL5

.Pro
.Pro
.Pro
.Pro
.Pro

AS 5C1L_VERIFY.Pro

AS 5C1L Settings.Pro

AS 5C1L.Pro

AS 5C2L

AS 5C2L_STAND.Pro

AS 5C2L_FL1
AS 5C2L_FL2
AS 5C2L_FL3
AS 5C2L_FL4
AS 5C2L_FL5

.Pro
.Pro
.Pro
.Pro
.Pro

AS 5C2L_VERIFY.Pro

AS 5C2L Settings.Pro

AS 5C2L.Pro

3-8

The initial protocol in each application, which you use to adjust or confirm correct PMT High
Voltage and parameter gain settings, utilizes Flow-Set fluorospheres.

If you wish to use a negative control sample use the “AS *_STAND.Pro” protocol in the above
panels. You must modify the protocol for the number of colors you are analyzing.

Each AutoSetup II application requires a user defined base protocol with the desired
parameter names to generate the application. The Application Definition Wizard creates a
unique base protocol with the same name as the application.
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The guidelines below show approximate region widths generated by the Application
Definition Wizard. Flow-Set, Flow-Set 675 and Flow-Set 770 region widths generated by the
Application Definition Wizard may be edited. If different regions widths are desired, open the
appropriate *_Stand protocol onto the workspace and edit the regions. Save the protocol.

Subsequent scheduling of the application uses the edited regions.

¢ Forward Scatter (linear): +20

¢ Side Scatter (linear): +50

* Fluorescence Parameters (logarithmic);

» st decade - beginning or low end: +0.1
» 1st decade - high end: +0.3

» 2nd decade - beginning or low end: 1.0
» 2nd decade - high end: 3.0

» 3rd decade - beginning or low end: £10
» 3rd decade - high end: £30

» 4th decade - beginning or low end: +100
» 4th decade - high end: +300

Default Generic Panels and Protocols

The following generic protocols are included with CXP software.

Panel Name Protocol
Cleanse.PNL Cleanse Bleach.PRO
Cleanse Water.PRO
Application Name Protocol Base Protocol
QC 1L Flow-Check(TM) QC 1L Flow-Check(TM)_ALIGN.PRO QC 1L Flow-Check.PRO
QC 2L Flow-Check(TM) QC 2L Flow-Check(TM)_ALIGN.PRO QC 2L Flow-Check.PRO

QC 4C 1L FITC-PE-ECD-PC5  QC 4C 1L FITC-PE-ECD-PC5

Flow-Check(TM)

Flow-Check(TM)_ALIGN.PRO

QC 4C 1L FITC-PE-ECD-PC5
Flow-Check.PRO

2¢ 5test.PRO (Analysis) N/A
4c 11 2test.PRO (Analysis) N/A
HeNe Alignment.PRO N/A

3-9
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FCS Header - Keyword Reference
The Following FCS keyword information is included in CXP listmode and histogram file

header section.

Those prefixed by a “$” are FCS Standard defined keywords, those prefixed by an “@” or
nothing are CXP defined keywords.

FCS Keyword Key value

$DATATYPE Single character defining base data type of binary data, I=16 bit integer, F=IEEE
32 bit floating point, D=double precision 64 bit floating point, A=ASCII

$PAR Number of parameters

$MODE Single character defining mode of data, L=listmode, C=dual parameter
correlated, U=single parameter uncorrelated.

$PnB Number of bits allocated to store data for parameter n, 8 means 256 channel
data, 16 means up to 64 k channel data

$PnR Channel resolution of parameter n, for example: 256,1024 and so on

$BYTEORD INTEL platform '1,2', Motorola platform '2,1'

$NEXTDATA Byte offset into binary data for next data item, FCS files can be saved as a
pseudo-linked list, most often 0

$DATE DD-MM-YY

$EXP Experiment name (from Workspace Preferences)

$PROJ Project name (from Workspace Preferences)

$op Operator ID, that is, user ID.

$INST Institute name (from Workspace Preferences)

$FIL File name excluding path

$CYT Type of flow cytometer, for example: FC 500, XL, ALTRA, ELITE and so on

$SMNO System defined run number, that is, a number which is incremented each time
the flow cytometer is used to acquire data

$SRC SAMPLEID1

$SYS CXP Intel Windows

$CELLS Cells name (from Workspace Preferences)

$BTIM Start time (HH:MM:SS 24 hour clock ":' delimiters)

$ETIM End time (HH:MM:SS 24 hour clock ":' delimiters)

$TOoT Total number of events acquired

$Pnv Voltage of sensor n

@PnGAIN Amplifier Gain setting of a sensor

$PnN Name of parameter n, for example: Manufacturer assigned name, that is, FS or
FL1 LOG

$PnS User assigned name of parameter

$PnE Lin/Log parameter calibration (0,0) means linear, (decades, offset [for

example: 4.0, 0.1024]) means log

3-10
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FCS Keyword Key value

$DFCiToj % of FLi to subtract from FLj

@Y2KDATE Date in format YYYYMMDD

@SAMPLEID1 User defined string

@SAMPLEID2 User defined string

@SAMPLEID3 User defined string

@SAMPLEID4 User defined string

@Pnz Calibration for parameter n is active when this key value is 'ON'

@PnX Linear calibration values in xx, yy order, for example: xx= channel number, yy =
channel value

@Pnu Units for this parameter n

@PnQ Sensor name for parameter n, from the CCUL.

@PnC Calculation method for parameter n, '"ARITHMETIC' means use arithmetic
method for calculation - may be overridden by analysis engine

@PnADDRESS Mutliplexor address of parameter n

$RUNNUMBER (See $SMNOQ) System defined run number, that is, a number which is
incremented each time the flow cytometer is used to acquire data

@BASELINEOFFSET Default is 'OFF" any other means ON, that is, this sample was acquired using
baseline offset

@FILEGUID Unique 128 bit number identifying this file, changed every time the file is
saved.

@CYTOMETERID The unique ID given to the flow cytometer by the user, for example: the flow
cytometer serial number

@LOCATION The address of the institute who owns the flow cytometer

TESTNAME PROTOCOL NAME

TESTFILE PROTOCOL FILE NAME

@BARCODE Barcode read from MCL

@CAROUSEL Carousel number read from MCL

@TUBENO Tube number read from MCL

@PnDIVIDER Prism channel divider (OXFFFF means OFF)

@COMPENSATIONMODE Displays the method of compensation implemented Advanced or Classic

@Discriminator Displays the discriminator parameter and level

@HENELASER Displays the status of the Red Laser during analysis of the sample.

@TARGETLASERPOWER Displays the Argon Laser power set during acquisition

@RESAVEDFILE Displays Runtime Protocol if the current file is exactly as at the end of

acquisition, if any changes are made post acquisition and the LMD file is
resaved the new file displays New Protocol.

@RATIONUMERATORMUX Internal Mux address of the parameters used for the Ratio Parameter
Numerator.
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FCS Keyword Key value

@RATIODENOMINATORMUX Internal Mux address of the parameters used for the Ratio Parameter

Denominator.

@PANEL

Name of the panel file used for acquisition of the sample.

@ACQUISITIONPROTOCOLOFFSET | Defines where in the LMD file the Runtime Protocol is stored, the value

displayed is number of bytes from start of file to the start of the protocol
section.

@ABSCALFACTOR Defines the calibration factor of the beads used with this sample if Flow-Count

or similar absolute calibration particles are used.

3.4 PERFORMANCE SPECIFICATIONS

Car

Dat

ryover

Scatter and fluorescence carryover is less than 1% from one specimen to another when the
number of gated events is between 100 and 10,000.

a Acquisition Throughput

Acquisition throughput is dependant on many variables, including flow rate, data rate,
number of parameters collected, gated events, data plots, FlowPAGE reports and printouts
generated. As an example, a throughput of approximately 45 tubes per hour is expected when
acquiring four parameters, running at approximately 1,000 gated lymphocytes/second, gated
on 10,000 normal lymphocytes (~2,500 lymphocytes/uL), printing one FlowPAGE. Changing
these variables, such as decreasing the number of events collected, increasing sample
concentration or increasing the flow rate can increase your acquisition throughput; while
increasing the number of events collected or running at a lower data rate can decrease your
acquisition throughput.

Precision for Surface Markers

See reagent package insert for precision specifications of other surface markers.

Resolution

Forward Scatter
The HPCV of the integral signal intensity values using Flow-Check fluorospheres is <2%.

Fluorescence

The HPCV of the integral signal intensity values using Flow-Check fluorospheres is <2% for
FL1-FL4 from the Argon laser. The HPCV of the integral signal intensity values using the
Flow-Check 675 fluorospheres is <2.5% for FL4 from the red laser. The HPCV of the integral
signal intensity values using Flow-Check 770 fluorospheres is <4% for FL5.

Sensitivity

3-12

Scatter
Detects 0.5 pm - 40 pm diameter particles.
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Fluorescence

600 (FITC), 300 (PE) and 600 (APC) molecules of equivalent fluorochrome when measured
with Spherotech™ Rainbow Calibration particles (FITC & PE), Molecular Probes
LinearFlow™ Intensity Calibration particles (APC)and IsoFlow sheath fluid.

Stability

Day-To-Day

The mean channel value of the integral signal intensity of Flow-Check fluorospheres from the
488 nm laser for FS, FL1, FL2, FL3, and FL4 does not vary more than +5% over a period of
7 days, when the temperature does not vary more than +5°F from temperature at alignment.
Refer to the Flow-Check fluorospheres package insert for details.

Stability for FL5 (PC7) mean channel value of the integral signal intensity from the 488 nm
laser using Flow-Check 770 beads does not vary more than +5% from the average of the
integral signal intensity mean channel values obtained over a 7 day period, when room
temperature does not vary more than £5°F from temperature at alignment. Refer to the
Flow-Check 770 fluorospheres package insert for details.

Stability for FL4 (APC) mean channel value of the integral signal intensity from the red laser
using Flow-Check 675 beads does not vary more than +5% from the average of the integral
signal intensity mean channel values obtained over a 7 day period, when room temperature
does not vary more than +5°F from temperature at alignment. Refer to the Flow-Check 675
fluorospheres package insert for details.

Within Day

The mean channel value of the integral signal intensity of Flow-Check fluorospheres from the
488 nm laser for FS, FL1, FL2, FL3, FL4 and FL5 does not vary more than +5% from the
mean integral signal channel number obtained within a period of 24 hours, when the
temperature does not vary more than £5°F from temperature at alignment. Refer to the
Flow-Check fluorospheres package insert for details.

Stability for FL5 (PC7) mean channel value of the integral signal intensity from the 488 nm
laser using Flow-Check 770 beads does not vary more than +5% from the average of the
integral signal intensity mean channel values obtained within a period of 24 hours, when
room temperature does not vary more than +5°F from temperature at alignment. Refer to the
Flow-Check 770 fluorospheres package insert for details.

Stability for FL4 (APC) mean channel value of the integral signal intensity from the red laser
using Flow-Check 675 beads does not vary more than +5% from the average of the integral
signal intensity mean channel values obtained within a period of 24 hours, when room
temperature does not vary more than £5°F from temperature at alignment. Refer to the
Flow-Check 675 fluorospheres package insert for details.
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This appendix contains the following log sheets:

* Reagent Log

e Action Log

* Flow-Set Fluorospheres Charts
» Daily Log for Instrument Standardization
» Establishing HV/Total Gain Ranges

* Flow-Check Fluorospheres Charts
» Daily Log for Instrument Verification of Alignment and Fluidics
» Establishing Peak Position and HPCV Target Ranges

Make photocopies as needed.
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LOG SHEETS A

REAGENT LOG
Concentration
. Date Date I
Reagent Name Units= Received | Opened Lot Number Expiration Date | Tech

(If applicable)

Cytometer Serial No:

Laboratory:

Cytomics FC 500

PN 1755708

@BECKMAN

COULTER
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ACTION LOG

LOG SHEETS A

Date

Condition Noted

Tech

Date

Action Taken

Tech

Cytometer Serial No:

Laboratory:

Cytomics FC 500

PN 1755708

@BECKMAN

COULTER

72720178
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LOG SHEETS

DAILY LOG FOR INSTRUMENT STANDARDIZATION

Application

Flow-Set™ Fluorospheres Lot Number Expiration Date
Flow-Set™ 675 Fluorospheres Lot Number Expiration Date
Flow-Set™ 770 Fluorospheres Lot Number Expiration Date

Instrument HV/Total Gain Target Ranges:

FS LOG FL1 LOG FL3

SS/L0GSS ——— LOGFL2 LOG FL4 LOG FL5

FS SS or LOG SS LOG FL1 LOG FL2 LOG FL3 LOG FL4 LOG FL5

Red Laser [ ]
488 [ ] Tech/

Mode | HV* | Gain [ Mode | HV | Gain |Mode | HV | Mode | HV |Mode| HV | Mode| HV | Mode| HV | Date

=]
=
=

OO |N [ |O1| | (N —

Cytometer Serial No: ‘y BECKMAN

Laboratory: COULTER

Cytomics FC 500 72720138
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LOG SHEETS

ESTABLISHING HV/TOTAL GAIN RANGES

Application

Flow-Set™ Fluorospheres Lot Number Expiration Date

Flow-Set™ 675 Fluorospheres Lot Number Expiration Date

Flow-Set™ 770 Fluorospheres Lot Number Expiration Date

Mode Target Ranges:

FS LOG FL1 LOG FL3

SS/L0GSS —— LOGFL2 LOG FL4 LOG FL5

FS $S or LOG SS LOG FL1 LOG FL2 LOG FL3 LOG FL4 LOG FL5

Red Laser [
488 [] Tech/

Mode | HV | Gain | Mode | HV | Gain [ Mode | HV | Mode | HV |Mode| HV | Mode| HV | Mode| HV | Date

=)
=
=

OO |N|®|O1 ||| N —

20
Average
HV/Gain

Average
+2SD or
+1%

Average
-2SD or
-1%

Cytometer Serial No: ,~i'|

BECKMAN
Laboratory: COULTER
Cytomics FC 500 72720128
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LOG SHEETS A

DAILY LOG FOR INSTRUMENT VERIFICATION OF ALIGNMENT AND FLUIDICS

Flow-Check™ Fluorospheres Lot Number Expiration Date

Flow-Check™ 675 Fluorospheres Lot Number Expiration Date

Flow-Check™ 770 Fluorospheres Lot Number Expiration Date

FS FL1 FL2 FL3 FL4 FL5
Red Laser [
488 [ ]

Run Mode | HPCV Mode | HPCV Mode | HPCV | Mode | HPCV Mode | HPCV | Mode | HPCV | Tech/Date

Target Range

O N[O | (N —

Cytometer Serial No: @
v BECKMAN

Laboratory: CO ULTER
Cytomics FC 500

72720148
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ESTABLISHING PEAK POSITION AND HPCV TARGET RANGES

Flow-Check™ Fluorospheres

Flow-Check™ 675 Fluorospheres

Flow-Check™ 770 Fluorospheres

Lot Number

Lot Number

Lot Number

Expiration Date
Expiration Date

Expiration Date

LOG SHEETS A

Run

FS

FL1

FL2

FL3

Mode

HPCV

Mode

HPCV

Mode

HPCV

Mode

HPCV

FL4

Red Laser [

488

FL5

Mode

HPCV

Mode

HPCV

Tech/Date

OO N[ |01 W (N —

Cytometer Serial No:

Laboratory:

Cytomics FC 500

PN 1755708

@BECKMAN

COULTER

72720158
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USING CXP SOFTWARE E
B.1 WELCOME TO CXP SOFTWARE

This exciting new software, designed in response to customer feedback, is simpler, faster and
more reliable, allowing you to obtain the best from your Cytometer.

CXP Analysis Software can analyze a wide variety of listmode files including those from the
following Beckman Coulter Flow Cytometers:

* COULTER® EPICS® XL
e COULTER EPICS ALTRA
* COULTER EPICS Elite

B.2 MULTI-USER SIGN ON
Page 1

When you start CXP software, the following Startup screen is displayed allowing Password
entry and access to the system.

On the initial Startup after installation, only the Admin User ID is available and the Admin
Password is password. Users must be set up by the Administrator.

Note: It is vital that the default Admin Password is changed as soon as possible by using the
User Profile — User ID option within the User Administration screen.

Displayed are the User IDs of all those who have access rights to CXP software and whether
they are logged in to the system or not.

If you have been previously set up on the system, highlight your User ID and enter your
Password. If you do not have a User ID and Password, see your system Administrator.

Note: If a red X appears next to your User ID ( % [ techcomm)

* Ensure the pathway for your user directory is,
» not a network drive if the network connection is not met.
» nota Zip drive.
» not a CD-ROM drive.

* Ensure all of your user folders are intact. If any of the following folders are missing
from your user directory, use Windows Explorer to create the missing folders.

» AcquisitionProtocol

» AnalysisProtocol

» HST

» HTML
» Images
» LMD

» Panel

» PDF
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MULTI-USER SIGN ON

» Results
»  Worklist
User ID x
Logged In
Password User 1D | Logged In |
. admin Ma
Admin Button SR Diane No

Next Button

R Mick No
= Sharlene Mo
=B No

CxP Software iz supplied for General Use
with FC 500 Cytometers. Copyright
19593, 2002 Applied Cytometry Systems,
Copyright € 2002 Beckman Coulter Inc.

Passward I

Admin | < Back I Mext » I Cancel | Exit | Help |

To sign on and access the administration tools, highlight the admin User ID and enter the
Password. The Admin button is then available. Select this button to access User
Administration for adding, removing, and modifying User profiles, Workgroups, Export Logs,
and User Passwords.

The User ID “admin” and ﬂl are for administrative functions only. You cannot log in
to CXP software with the admin User ID.

User ID

This lists all the Users that are allowed access to the system. User IDs are a minimum of 3
characters and a maximum of 24 characters. If your name is not included, see your system
Administrator.

Logged In

Indicates whether or not the Users are logged in to either Acquisition or Analysis software.

Password

Enter your User Password. Passwords are a minimum of 6 characters and a maximum of 24
characters. Blanks are not allowed.

Admin Button

Allows access to the User Administration Tools, which allow the addition, removal and
modification of User profiles and Workgroups plus the creation of Export Logs.

Next Button
Click this option to accept the current logged-in name and move to Page 2.
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Page 2
Tabbed Protocol Pane x4
Protocol Preview Pane
Finish Button Karen' | Nick' | 'Diane’| 'Sharlene! | Bab' |4 [» Pratacal Preview
BE: BE BE =
E -
2C1LPRO 3CILPRO 4C1LPRO

D
£

5C2LPRO

B

.
[}
ra
2
5
sl
o
n
(]
=
5
sl
o

P
]
P
]

Admir < Back I Finizh I Cancel Exit Help

Other Users within your workgroup are
displayed as tabbed User IDs across the top

of the window. You may read other user
protocols and save them to your directory.
Each user may save files only to their own
directory unless admin has assigned them
rights to Overwrite other data files?. Files
may be read from any of the other Users
within a given Workgroup. To view any
hidden tabs, use the to move between
multiple tabs.

Karen' | Nick' | 'Diane’| 'Sharlene! | Bab' ILI_’I

SRR

2C1LPRO 3CILPRO 4C1ILPRO

The Common tabbed area can be read and
saved into user directories but again, files
should not be saved to this Gommon area.

Tabbed Protocol Pane

Allows you to select a Protocol from your Directory. Also allows Read Only access to the
Protocols belonging to other members of your Workgroup if you have not been assigned
rights to Overwrite other data files?.

Protocol Preview Pane
Displays the details of the currently highlighted protocol.

Finish Button

Starts up CXP software with the selected protocol or with a default protocol if no specific
protocol has been selected.
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B.3

B-4

SIGN-ON ADMINISTRATION

User Administration

This screen allows the Administrator to add, remove and modify User profiles, including
passwords as well as the creation of user Workgroups plus the creation of Export Logs.

Note: In the event of a system lockup, before users log back on to CXP software, the

Administrator can log all users off by @ M on the User Administration screen next to any

User ID displaying logged on for Export Log purposes.

Add User

Modify User

Delete User

Workgroups

Export Billing Information
Remote User Database
Cytometer Serial Number

Note: The Administrator
must set up Cytometer
Serial Number and Add
Users in the CXP Cytometer
software before adding
users in CXP Analysis
software.

Add User

Use this button to add a new user. See User Profile — User ID.

Delete User

User Administration

— User List

OREx
Sharlens
Ol wick

] Karen
Diane
O adwin

Add user...
Delete user,

I adify uzer...

wiorkgroups.. .

Export log...

— Remote User D atabase

I | Cornect b remote datatiase

Create...

— Cytometer Serial Mumber

IAE4DDS4

Cloge

Help

i)

IMPORTANT Deleting a User ID can cause loss of data. If you delete a User ID all the directories and files
including listmode files that are in your Windows desktop under that User ID are deleted. Before deleting a
User ID be sure to move or copy all needed directories and files for that User ID to different directories.

Highlight the User ID you wish to delete from the system and @ Ml.

A confirmation dialog box is displayed. Choose Yes to delete the user or No to revert to the

User Access Control dialog box.

Modify User

Use this button to modify an existing user. See User Profile — User ID.
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Workgroups

USING CXP SOFTWARE
SIGN-ON ADMINISTRATION

Selecting the Workgroup option allows the Administrator to set up various Workgroups of
your choice depending upon your requirements. Choose any names to suit your requirements
and then enable the checkbox next to the names of users you wish to add to the Workgroup.

Workgroup Selection
Users
Edit Button

Within the display, ALL Users
assigned to the system are shown
BUT only those within the
particular Workgroup shown in
the Workgroup Selection box have
the checkbox beside the User ID
enabled.

See also:
User Administration

Workgroup Selection

Displays the current Workgroup. Select the drop down list box to display and select other

Workgroups.

Users

Workgroups

WiorkGroup Selection

=

Users

Frod Devel Edit... |

O admin
Bob
Sharlene
Mick
Karen
Diane

o]

Cancel

Help |

x|

Lists ALL the Users assigned to the system. Those with the checkbox activated by their User
IDs are members of the particular Workgroup shown in the Workgroup Selection box. Users can

be assigned to multiple Workgroups. To add a user to the Workgroup, click to enable the

checkbox. To remove a user from the Workgroup, click to disable the checkbox.

Edit Button

Allows access to the Edit Workgroups screen.

B-5
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B-6

Edit Workgroups

This screen is used to Add or Delete specific Workgroup names.

Add x|

Delete

YwWiorkgroup name | Add
Adrinistration

Prod_Devel

(] Cancel Help

Add

@ 4|&dd to add a new Workgroup to the system. Type the new Workgroup name in

e e et b U0) T

Delete

Highlight the appropriate Workgroup from the list displayed and @ ﬂl to delete a
particular Workgroup from the system. To edit the name of a particular Workgroup, first
delete the Workgroup and then add it as a “new” Workgroup.

See also:
Workgroups
User Administration
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Export Billing Information

Selecting the Export option allows a text file log to be created showing the date and time each
User has spent logged on to CXP software. The information shown records Analysis time and
Cytometer time separately.

1 LOg in as Admin. CXP Cytometer Startup Wizard [Page 1 of 2] x|
a. Highlight Admin. Userl Tloomtin ]
admin Nao
b. Enter the Admin Password. Sl eob o
=M Diare Mo
= | =T Mo
Nick No
. = Shatlene Mo
Adrmiir
C. .
CHP Software is supplied for General Use
with FC 500 Cytometers. Copyright @
1993, 2002 spplied Cytomety Systems,
Capyright © 2002 Beckman Coulter Inc.
Password I ””””””
Admin %J < Back Hest > I Cancel I Exit Help

) Export log... ~User List
’ D admin Add uzer...
OREEab
D Sharlene [relete user
O wick -
D Karen fl ity wser..
D Diane
‘wWorkgraups...
3 Enter the date range for the log and |
‘which dates should the billing infomation cowver?
N ek > From Date ToDate
— | E/1/2003 j | 3/21/2003 j

< Baclk I MNext > I Cancel Help
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4  Select the users to include in the log x
N “Which users should appear in the biling information?
et =
and — Al Users ' Specify Users B3 adhin
iSharlene
< Back I Mext = I Cancel Help
5 Choose to direct the information to the E::-::;:u:urt Billing Informatian - Final step...Where x|
CIIphoard (?r toa Flle If Flle 1S .SeleCted’ ‘where would you like the billing infarmation created?
you can either enter a valid File Name _
" Clipboard & Fig
in the box or use the Browse Button J =]
to select an appropriate file. o
+ Tab
Select between Tab delimited (MS Excel C Comma
default) or a Comma delimited text
format file.
< Back I Firish Cancel Helz

6 @ Finizh

to end.

See also:
User Administration

Remote User Database

Using a remote user database allows multiple users to share a central computer to store and
retrieve data files. This remote computer acts as a server and MUST be able to be read from
and written to by all users. The remote computer contains a database of all users, their
passwords and folder locations on the server and allows users to save and restore files directly

from the server rather than saving files locally.

Note: If you use a network connection for the Remote User Database you must validate the
network connection. Refer to Windows 2000 help for information about the recommended

Windows 2000 network configuration.
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Create Remote User Datahase

USING CXP SOFTWARE

SIGN-ON ADMINISTRATION

From any computer with CXP software
installed, sign in to CXP software as the
Administrator and select Admin.

Admin D | < Bacl I Ment » I

From the User Administration dialog

bOX, @ LCreate... |

Femote User Database

I | Carinest to remote database

I J LCreate. n |

Browse the network for the computer
and home directory to be used as the
location for the Remote User Database

and @ .

All intended users must have read/write
access rights to the chosen location, as
all User files are stored here.

Refer to Windows 2000 help for
instructions about read/write access.

Select location ko create remote database at,

E’@ techcomm =]
- admin
- Cep

{:I CxP Capture

-y

{:I Epson Driver
B FH_Suite
- HTML Help workshaop

B MXP Capture |

oK I Zancel |

B
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Connect To Remote User Database

1 From each user computer you wish to
connect to this database, sign in to CXP Admin Nl sk [ hews> ]

software as Administrator and

@ Adrnin | )

2 From the User Administration dialog Remote User Database

™| Connest to remote database
@ I _Q Lreate... |
box, J

w

3 Locate the folder created in step 2 — 2| x|
The dialog box displays Profiles

Select location of remaote database,
located!.

Prafiles located!

E@ kechcamm ;I
-] admin
- e
& CHP Capture
@ CxP Remate User Database
{:l Documents and Settings
-] Epson Driver
-1 FH_Suite
- HTML Help Warkshop
&1 Matrox
{:l MxP Caphure d

4  Check the Connect to Remote Database Fiemote User Database
checkbox to enable the new location. ¢ Comnect to remate database
I&chevelchEE\techcnmm\MP Remote Uzer Dat B
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9 Close the User Administration dialog box. On the main sign-on screen the hard disk icon

changes to a networked drive icon g'_lj

6  Repeat steps 1 — 5 for each computer you wish to use the remote database.

See also, User Administration

Cytometer Serial Number

Enter the serial number of the Cytometer connected to the Workstation. You must be logged
on as Administrator to enter the serial number.

User Profile — User ID

When a new user is added with the Add user button, or an existing one requires their details
changed under Modify user button, the following screen is displayed.

User ID
Password‘ UserID | pats |

User Privileges

Access other files? ! Userlp  [Karen

Remember last accessed LMD Passward 11234

directory?

Automatically Overwrite acquired data ~Privileges

files? ¥ Access other files?

Overwrite Other data fﬂes7 [~ Remember last accessed LMD directoy?

Add Absolute Calibration Batches ¥ automatically ovensrite acquired data files?

¥ Oeverwiite other data files [Protocals, Panels stc.]?
V¥ Add Absolute Calibration Batches?
¥ Can madify Custam Dyes?

Can Modify Custom Dyes

ak. I Cancel Help

See also:
User Profile — Paths
User Administration
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B-12

User ID

Enter the new User ID if a new user, or Modify the User ID if an existing one. The Admin
name cannot be modified or deleted. User IDs are a minimum of 3 characters and a maximum
of 24 characters.

Password

If you are assigning a Password for the first time, or changing an existing one for a particular
User, type in the appropriate Password. Passwords must be a minimum 6 characters. Note
that the screen is displayed so you can check it for accuracy before selecting the Apply or 0K
buttons. If you are changing the Admin Password, the Admin User ID is grayed out.

User Privileges

The Administrator can assign various privileges, which allow or restrict a user’s ability to
access and overwrite files, and the ability to add Absolute Calibration Batches.

Access other files?

Check this checkbox to enable the User to access other files. Leaving the box Unchecked
allows access only to the User’s own Directories.

Note: If you open protocols from other users folders and you want to save the protocols to
your folder, you must use the Save Protocol As option and navigate to your folder and save
the protocol.

Remember last accessed LMD directory?

If this option is checked, it allows the last accessed LMD (listmode) directory to be selected
by that particular User.

This option is available only if the Access other files? checkbox was enabled.

Automatically Overwrite acquired data files?

Enabling this checkbox, allows the overwriting of your acquired data files (listmode and
histograms). If Access other files is enabled, enabling this checkbox allows overwriting any
other User’s acquired data files.

Overwrite other data files?

If the checkbox is enabled, the User is allowed to overwrite their other files (protocols,
panels, Worklists, and so on). If Access other files is enabled, enabling this checkbox allows
overwriting any other User files.

Add Absolute Calibration Batches

Enabling this checkbox allows the selected user to enter and modify information available in
the Analysis » Absolute Count Calibration dialog box.

Can Modify Custom Dyes

Allow a user access the Custom Dyes Entry dialog to modify the dye entries.

See also, User Administration
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User Profile — Paths

This screen allows the Administrator to assign User directory Paths for different file types, as
well as a Backup Directory.

This Backup directory may be any valid disk or Network area where listmode files may be
automatically archived.

If a Backup directory is present, you are prompted with Archive Now on exiting the program,
followed by an option to delete local files.

Browsing Buttons

Home User|D Paths I

Path Details
Home

Backup ey
LMD [EADP U sers K arent LMD (v |
HST IC:\EXF'\Users'\Karen\HST - |E |
Aquiziion Pratocal IC:\D<F'\Users'\Karen\AcquisitionProto e | |
Analysiz Protocol IC:\D<F'\Users\Karen\AnaIysisF'rotoc:oI @ |
Panel IC:\D<F'\U serstkareniPanel _‘@l
Wwiorklist IC:\D<F'\Users'\Karen\Worklist @ |
E sternal Woarklists IC:\D<F'\Users'\Karen\Worinst e |
Images IC:\WP\Users\Karen\lmages @
Resultz IC:\D<F'\Users'\Karen\Hesults @l
HTML IC:\D<F'\Users'\Karen\HTML @l
Backup I o | |
PDF IC:\%P\Users\Karen\F‘DF @l

] I Cancel I Help |

See also:
User Profile — User 1D
User Administration

Browsing Buttons

The Ellipses ... allow browsing for a target directory. The button opens Windows
Explorer allowing you to browse for a directory name.

Home
Shows the Home Directory Path that applies to that User.

Path Details

Shows the paths to the destination directories for the different File types within CXP
software.

Backup
Shows the path to the Backup or directory for data (listmode) files.
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B.4 FILE OPTIONS TOOLBAR

The following Icon Buttons are shown within the File Options Toolbar.

Open the Open Listmode Data File dialog box.

Open

Save all the FCS listmode data files that are currently open.
Save

Save the Protocol with the current name. If the Protocol has not yet been
Save Protocol  Saved, the Save Protocol As dialog box is displayed.

Open the Print Plot printing dialog box.

5 =] (W 2 O (&

Print
Cut an item previously selected and place it on the Clipboard.
Cut
Copy a previously selected item into Clipboard while retaining it in its original
Copy position.
=) Paste a previously Gut or Copied item from Clipboard into the desired
Paste position.
- Undo the previous command. Use the down arrow symbol to see a list of
== Undo previous actions that can be Undone.
vy Redo the previous Undo command. Use the down arrow symbol to see a list
= Redo of previous actions that can be Redone.

B.5 PLOT OPTIONS TOOLBAR

Note: The Plots toolbar is disabled when running a locked protocol.

Create a Color Dot Plot and specify the plot properties.
® | Color Dot Plot

Create a Histogram Plot and specify the plot properties.
Histogram Plot

Create a Contour Plot and specify the plot properties.
@ Contour Plot

Create a Density Plot and specify the plot properties.
Eﬁ Density Plot

Create an Overlay Plot to compare single parameter histograms (CXP Analysis
L Overlay Plot Software only).

Create a Tomogram Plot and specify the plot properties (CXP Analysis Software
B Tomogram Plot  only).

EI Create a Surface Plot and specify the plot properties (CXP Analysis Software
Surface Plot only).
IEI Create a Prism Plot and specify the plot properties.

Prism Plot

Create a Legend Plot and specify the plot properties.

Legend Plot
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B.6 REGIONS OPTIONS TOOLBAR

& Insert a Polygonal Region into a dual parameter plot. The region is a
] free-form with up to 100 points. It can include horizontal acute angles but
Polygonal Region not vertical re-entrant angles.

] Insert a Rectangular Region into a dual parameter plot.
Rectangular Plot

O Insert a Quadrant Region into a dual parameter plot. All quadrants
Quadrant Region comprise four sets of Rectangular Regions on a dual parameter plot.

Create an Elliptical AutoGate around the selected population on a plot.
Elliptical AutoGate

Create a Contour AutoGate around the selected population on a plot.
Contour AutoGate

==] Edit Both Prism Create or Edit a Dual Parameter plot with a set of Dual Prism Dividers.
== Dividers
Insert a Linear Region.
Single Linear Region
Multiple Linear Insert a Multiple Linear Region.
Region

Edit Single Prism Create or Edit a Single Parameter Prism Divider.
Divider

B.7  GATE, COLOR, STATS AND HELP TOOLBAR

= Access the Create / Modify Gates dialog box.
Create / Modify Gate

17 Modify Color Gate Blend Access the Modify Color Gate Blend Setup dialog box.
Setup

0 Create / Modify Color Gate  Access the Create / Modify Color Gate Precedence Setup dialog box.
Precedence Setup

] ] View/edit a Region's properties, Region points or to delete a Region
View Current Regions that is no longer required.
x Publish Statistics to a Microsoft Excel spreadsheet or a Text file.
= Publish Results
Choose Statistics for display and export.
Select Results
Access the Help System.
(2 Help it
Go to the Beckman Coulter, Inc. web site.
Beckman Coulter
Go to the Applied Cytometry Systems web site.
ACS
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FLOWPAGE TOOLBAR
B.8 FLOWPAGE TOOLBAR
El| New FlowPAGE

B-16
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Insert bitmap

Annotation

Line

Rectangle

Align Top

Align Bottom

Align Left

Align Right

Space Evenly
Across

Space Evenly
Down

Grow to largest

Shrink to smallest

Open a New FlowPAGE — Also see Insert/Blank FlowPAGE.

Insert a Picture into a FlowPAGE.
Add a Text Box to a FlowPAGE.
Draw a Line on a FlowPAGE to enhance the graphical layout of the page.

Insert a Rectangle into a FlowPAGE that can be used as a border for Pictures
or Text Boxes.

Align all the selected items to the top of the selection area.
Align all the selected items to the bottom of the selection area.
Align all the selected items to the left of the selection area.
Align all the selected items to the right of the selection area.

Space selected items within a FlowPAGE evenly across a page.

Space selected items within a FlowPAGE evenly down a page.

Resize the selected items to all be the same size as the reference item.

Resize the selected items to all be the same size as the reference item.

PN 175570B



USING CXP SOFTWARE B
ACQUISITION MANAGER TOOLBAR

B.9 ACQUISITION MANAGER TOOLBAR

: Clear the Acquisition Manager panel to create a new Worklist.
New Worklist
= Open a selected stored Worklist file into Acquisition Manager
& | File Open
= Save the current Worklist with a user definable name.
wi| save Worklist
T Save the current Panel with a user definable name
Save Panel
2 Delete the currently selected test(s).
Delete
T Inserts a blank row at the end of the current panel, which allows for the
Insert Test insertion of extra tests into the selected panels.
i Insert a Panel from file into the current worklist.
% | Insert Panel

Customize Worklist Display the Customize Worklist Columns dialog box, allowing hiding of

Columns unwanted columns and customization of column fitles.
Print the current Worklist.
2| print
E| Run the AutoSetup Scheduler
AutoScheduler
- Import an External Worklist. The acquisition manager is populated with
L& External Worklist the worklist.

Note: The Listmode File Name column displays only a provisional file name prior to
acquisition. If Time or Run Number is included as part of the name the actual value of these
fields can only be determined once acquisition of each sample is complete. Therefore, if you
wish to print a worklist including the final listmode file names, only do so once acquisition of
all samples in the Worklist is complete.

Note: When attempting to save a panel directly from the worklist, the Save Worklist Panel
icon becomes active only when the row number is selected to highlight one line of a worklist.
Selecting the Save Worklist Panel icon then saves the panel of which the highlighted tube is a
member.

Note: Scheduled Applications cannot be saved as Panels or Worklists.
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B.10 AUTOMATOR TOOLBAR

The AutoMATOR Toolbar allows shortcuts to commonly used AutoMATOR functions.

» 1 = | || \Z0000652 Imd RIR =

AutoMATOR Setup  Display the AutoMATOR Setup dialog box.

&

Once all alterations have been made, @ . The toolbar becomes active once all

files have been entered. A list of files for each panel is shown allowing you to choose the
batch required to run first.

|..\Z0000862.Imd 4

The rest of the files follow in order after the selected panel.

Cancel the batch run. This aborts the current panel. When the panel runs again, the test
Stop starts from the beginning.

Start the batch running. The AutoMATOR Status Bar appears showing the status of the
Run tests, that is, if it is currently paused, still running, and so on.

Pause has two states:
* Continuous Pause

Pause the tests for modifications and remain on pause until you decide to continue.
This function allows the test to stop without reverting to the beginning of the panel

again. To resume the test, click the Pause | I button again.
¢ Auto Pause

The run of tests pauses and then carries on with the rest of the panel automatically

after a 15-second wait. The countdown is displayed on the AutoMATOR Status Bar.

When the tests are in the Auto Pause setting, you can hold down and click the

Pause button. overrides the Auto Pause, placing the AutoMATOR into

Continuous Pause. To restart, click the Pause button again and the test resumes
Pause from the point at which it was paused.
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B.11 OVERLAY TOOLBAR

Note: The Overlay Toolbar is only available in CXP Analysis software.

FF
FF

&

i

]

ety

I

IF’

PN 1755708

Gallery View

Overlay View

3-D Overlay

Rotate Clockwise

Rotate Counterclockwise

Legend

Overlay Statistics

Add Plot

Open Histogram

Annotation

Linked Marker

Non-Linked Marker

USING CXP SOFTWARE
OVERLAY TOOLBAR

Arrange the histograms in a Gallery Style. Selecting one of the other

Style buttons can alter this format.

Arrange the histograms so that they are all overlaid on one set of

axis.

Display all the plots in a 3-D format.

Rotate the plot clockwise so that it is easier to view. Gan only be
used when the plots are in the 3-D Overlay Mode.

Rotate the 3-D plot counterclockwise.

Displays a key to the histograms on the Workspace. The Legend can
be utilized in any of the layouts and is removed by clicking again on

the Legend button.

Generate a statistics summary within the overlay plot in any of the
modes. This can be removed by clicking on the Overlay Statistics

button again.

Add a histogram plot created from a stored listmode file to the

Gallery display.

Open a stored histogram file.

Place a free text annotation or FCS Keyword text into a plot.

Set a region on all histograms simultaneously. This shows the
percentage of events inside that region compared to the total

number of events on the plot as a whole.

Add an independent region to a plot. Any number of these can be

added to all/some/one of the plots.
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B.12 CYTOMETER TOOLBAR

E Reset the current acquired events to zero and clear the current
o data in memory. Acquisition restarts at zero events and
Restart Acquisition continues until a stop condition is reached.
N Start acquisition or continue an acquisition if previously
Start/Continue Acquisition ((F2)) Ppaused.
i Pause acquisition of the current sample.
Pause Acquisition ((F11))
) Pause Acquisition and rotate sample to the tube access door.
i Pause / Rotate
- Stop the Acquisition of the current sample and output results.
Stop Acquisition ([E10))
Stop the Acquisition without saving data or outputting reports.
Abort Acquisition ([F12))
Place the Cytometer in Idle mode in order to perform various
Idle Mode cleaning and replacing procedures.
Flush the sample line and flow cell with sheath fluid to declog
Prime or remove bubbles.
Flush the sample line and flow cell with cleaning agent.
Cleanse

Perform the Vacuum Line Cleaning procedure.
AutoCleanse

Run a carousel of samples one tube at a time.
MCL Manual Mode

Run a single tube in fixed position # 10.
Single Tube Mode

Display the Cytometer Control dialog box to adjust the

Cytometer settings. Click the button again to hide the dialog
Cytometer Controls box.

EEEEEEEE
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B.13 LISTMODE PLAYBACK TOOLBAR

The listmode playback tool utilizes two sets of buttons - one for saving and restoring
worklists (panels populated with listmode files) and one for saving and restoring queues (lists
of listmode files).

D Create a new Worklist (clear Worklist)
= Save a Panel
i

Add a Panel to the Worklist

Add a Tube to the Worklist

Delete a tube from the Worklist

Play

Pause

== FEE

Stop

1
Z¥  Sort the Worklist

= Minimize the Listmode Playback window
= Load Playback Worklist

= Save Playback Worklist

= Load Listmode Queue

=

Save Listmode Queue
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B.14 REPORT GENERATOR TOOLBAR

Quality Control
Report

Panel Template
Panel Report
Database Entry

Data Management

Product Editor

Maintenance Log

Service Log

g KR @ |0 B |k |

B.15 FILE MENU

B-22

New Protocol

Display Levey-Jennings plots based on information selected in the QC
Template and data located in the QC tables.

A Panel Template defines the content of the Panel Report that is produced
when the export panel is run.

Display a list of Patient Panel Reports available for display or print.
Enter or view the specimen information in the database.

Backup QC or patient records to an archive database and restore QC or
patient records from an archive database.

Add or edit QC products.

Electronic log of instrument routine maintenance, tracked by user name.

Electronic log of instrument service performed, tracked by user name.

Use this option to create a New Protocol.

1 @ File » New » New Protocol. The Save Existing Protocol? dialog box is displayed.

2 Ifyou @ Yes, the Save Protocol File As... dialog box is displayed. @ the folder in

which you wish to Save the Protocol. Enter a valid File Name in File Name box and @

Save.
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3  If the File Name already exists, a warning box is displayed.

* If you wish to replace the existing Protocol, @ Yes.

* Selecting the No option here allows you to enter a different Protocol File Name.
Clicking No closes the existing Protocol file and clears the workspace.

See also:

Save Protocol As

Creating a Protocol for Analysis
Creating a Multi-File Protocol

Creating a New Acquisition Protocol

1 @ File » New » New Protocol.

2 @ Parameters button on the Cytometer Control Acquisition Setup Tab and choose the
Parameters to be acquired.

3  Create the Plots required for acquisition.

4  1f analysis is to be performed during acquisition, create the required Regions and Gates,
and also select the required statistics from the Analysis » Select Results option.

) @ File » Save Protocol As to save the protocol.
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6  Set the required Listmode File name options from the Workspace Preferences — LMD File

Name tab.

Note: Due to the flexibility of listmode file naming options, listmode filenames can
become very long. When such listmode files are open in the Analysis Only software, the
software assigns a file designator (for example, F1, F2, F3...) and displays that
designator, with the filename in all statistic boxes on a FlowPage. Due to the long file
name, this may result in overlapping statistic boxes, requiring reformatting of the
FlowPage to view all results.

7  Setup the Worklist (sample information, CAL Factor, etc.) and run samples.

8  While running sample, adjust the instrument settings on the Cytometer Control
Detector Tab.

o

when data presentation is satisfactory and @ File » Save Protocol Save... to

update the protocol with the new instrument settings.

Creating a Protocol for Analysis

1 @ File » New » New Protocol to clear the Workspace of all Regions, gates, statistical
definitions, and plots and load the default protocol. You can also Drag and Drop a
listmode file into the Workspace to load the runtime protocol.

2 @ File » Open Listmode File to open a representative listmode data file.
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3  To modify a plot:

Right mouse click on the plot and @ Format Plot.

4  To create a plot:

a. Choose one of the buttons on the Plots Toolbar or use the Plots Menu to select a
plot type.

b. @ the correct parameters for the first plot and @ :

c.  Right mouse click on the plot and @ Format Plot.

9 Modify or create subsequent plots and choose the required File, Parameters, Regions and
any gates to be applied.

6@2

@ statistics output required

[

7 @ Save Protocol As and enter a protocol name.

Creating a Multi-File Protocol

When creating multi-file protocols, ensure that listmode files to be read into the protocol all
contain the same parameters in the same order whenever possible. (CXP Analysis software
only).
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There are many possible ways to create a multi-file protocol. For example:

1 @ File » New »» New Protocol to clear the Workspace of all regions, gates, statistical
definitions, and plots and load the default protocol.

2 @ File » Open Listmode File to open a representative listmode file and its runtime
protocol.

3  Create the desired plots for the additional listmode files.

Individual files can now be replaced by clicking on one of the windows and using (Cti)+Drag
and Drop to add files from the Resource Explorer or by using the Data Source tab in the Dot
Plot Properties dialog box. See Plots - Introduction for more details on Creating Plots.

The different listmode files are designated as F1, F2, F3, and so on in the plot titles.

4@3

@ statistics output required

[

) @ Save Protocol As and enter a File Name for the protocol.

Note: The AutoMATOR has the ability to easily update the different files in a multi-file
protocol in a controlled manner removing the tedium of having to repeatedly select individual
files.
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New Panel

Use the Panel Wizard to create a Panel for use in the Acquisition Manager or in Manual
Acquisition mode. See Creating Panels in the System Overview chapter in the Instructions

For Use manual.

New Worklist

Note: If no Worklist is visible, @ View » Acquisition Manager to display the Worklist pane.
See Creating Worklists in the System Overview chapter in the Instructions For Use manual.

button within

Note: Unless the current Worklist has been saved using the Save Worklist
the ACQUISITION MANAGER TOOLBAR, current worklist settings are lost.

Open Listmode File

PN 1755708

Analysis mode operates with either one FCS file or if using CXP ANALYSIS, several files
simultaneously. Use this option to open a new listmode file into all plots. In CXP Analysis,
this option updates all Plots relevant to one particular tube.

Before any analysis can be done, a listmode file must be read into CXP software. Most buttons
on the Button Bar are disabled until this has been done.

To open a listmode file for the first time:

1 @ File » Open Listmode File.

2 Select the desired listmode file. 20|
Look in I@LMD j - ﬁ‘ Ea-
| 5C 1L 16-56-3-19-45 00000114 102,LMD SC 1L A5 PCT Comp, LMD
a a dlI‘ECtOI‘ 1n the Look in- hSt QSC 1L 5-4-3-19-45 00000113 101.LMD SC 1L A5 Pe Comp.LMD
' y ) [#]5C 1L AS ECD Comp.LMD [#]5C 1L A5 VeriFy 45-56-19-3-8,LMC
bOX. QSC 1L A5 Fitc Comp, LMD . 3-19-45 000000390 O
QSC 1L AS Flow Set.LMD SC ZL §-4-3-19-45 00000091 080,
95C 1L A3 PCS Comp, LMD 5C ZL A5 APC Comp. LMD
b @h f file in the Files of = L
. the type ot 11le 1n the FllesS 0
) yp File name: |5EI 2L 16-56-3-19-45 00000030 079.LMD Open I
type: list box.
Files of type: ILMD Filess [*Irnd = fies) j Cancel |
@ ™ Open Runtime Protocal
. . A
C. the name of the listmode file =

you want to view.
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3 @ ¥ Open Runtime Protocol to replay the LMD into the plots in the runtime protocol. If
the open runtime protocol is not selected, the LMD replays into the plots currently
displayed on the workspace.

Note: Listmode replay uses the runtime protocol Cal Factor unless you select a different
Cal Factor on the Absolute Count Calibration dialog box.

When loading listmode files which have a parameter order different from the current
protocol, you are warned with Parameter Mismatch.

* If you select Continue, the file is loaded and replaces the parameters with those of the
listmode file.

* If you select Abort, the listmode file is not loaded.

Note: Listmode Compensation must be performed using the runtime protocol or a protocol
with equivalent parameters as the runtime protocol.

When loading listmode files from a different instrument This is not an FC 500 file appears.
Select Continue to load the file.

To replace all the plot windows using the same file name with another file:

1 Highlight one of the Plot windows containing the file name you wish to replace.

2 @ File » Open Listmode File.
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3 Select the desired listmode file. 21x|
Laok ir IGLMD j = = EE-
%] 5C 1L 16-56-3-19-45 00000114 102.LMD  |#]5C 1L AS PCT Camp. LMD
a the desired directorv in the #]5C 1L 8-4-3-19-45 00000113 100.LMD [#]5C 1L A5 Pe Comp.LMD
: . y [#]5C 1L AS ECD Camp.LMD [s]5C 1L A Verfy 45-56-19-3-8 LM
Look in: list box. [#]5C 1L A5 Fitc Comp.LMD y
[#]5C 1L AS Flaw Set.LMD -3-1G-
[#]5C 1L A5 PCS Comp.LMD []5¢ 2L s APC Comp.LMD
b @h f file in the Files of N L
. the type ol I1le 1n the Flles 0
. yP File name:  [5C 2L 16-56-3.19-45 00000080 073 LMD Open |
type: list box.
Files of type: ILMD Filess [~ Irnd = f:s) j Cancel |
@ [¥. Open Runtime Protocol
. . 4
c. the name of the listmode file “

you want to view.

All plot windows with the same file name are now replaced with the current file. The
current file name is displayed in the title bar. To add files to individual plots, highlight
the plot and use (Ctl)+Drag and Drop from the Resource Explorer.

Save Listmode File As
If, at any time, you decide to save your file under a different File Name:

1 @ File » Save Listmode File As.

When performing MultiFile Analysis, you must first highlight the plot with the desired
listmode file name.

Note: Due to the flexibility of listmode file naming options, listmode filenames can
become very long. When such listmode files are open in the Analysis Only software, the
software assigns a file designator (for example, F1, F2, F3...) and displays that
designator, with the filename in all statistic boxes on a FlowPage. Due to the long file
name, this may result in overlapping statistic boxes, requiring reformatting of the
FlowPage to view all results.
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2 Specify the name of the file. Karen - Save LMD File HE
Save i |@ LD _'J Ll & E-
] ] ) 2Color CD3 CD19.LMD Marmallo!. LMD
a. the desired d1rectory in the [ 2Color O3 COALMD [ NomalD0z.LMD
N [ 2 Color CD3 COBLMD [ NomalD02 LMD
Save in: list box. [5)2 Color CD& CDSELMD [ Nomald4.LMD
2 Color Control. LMD Mormal005.LMD
FL1 Camp. LMD tetraOMNE FlawCaountl LMD
o [ FL2 Comp LMD tetraOME FlowCount2 LMD
b. the type of file in the Save as =) FL3 Comp.LMD ) verity 4C.LMD
FL4 Camp. LMD

type: list box. In the File name text
box, type the desired File Name.

File: name: I| Save I

CXP software creates a file with the Save as ype: [LHD Fies Cnd s 5 Concel |
name you specified and stores it in the Z

drive and directory you specified in
FCS format.

File Name

A file name can have up to 200 alphanumeric characters, including the path. The following
characters cannot be included: forward slash (/), backslash (\), greater than sign (>), less than
sign (<), asterisk (*), period (.), question mark (?), quotation mark ("), pipe symbol (|),
colon (2), or apostrophe (). Leading, Trailing and multiple spaces are not allowed.

Open Histogram

Use this menu option to add a stored single parameter histogram to a currently displayed
overlay plot.
See also, Adding a Histogram to the Overlay Plot.

Save All FCS Format Files

This option saves the current listmode file to disk and saves any histograms marked for

saving.
1 Hl h].l ht the re uil‘ed ].Ot Histogram Plot Properties: X
x|
Note: The individual Histogram’s Plot DaaSouce | Hitogem | = Sedig |
Labeling Stop and Save Fant

Properties must be set to save.

Acquisition Stop Candition
¥ Usze Stop Condition

Mawimum Everts (3000

¥ Save Histogram Data in FCS Format

ok I Cancel Help
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2 @ Plots » Acquisition Stop & Save menu option.

3 @ Save Histogram Data In FCS Format.

Note: An (S) is added to the plot title if you select this option. Do not confuse this with
an [S] that identifies a gate.

4  Repeat for each plot you wish to be saved.

5 @ File » Save All FCS Format Files.

Save Histogram File As

The Save Histogram File As option allows a single histogram associated with the currently
in-focus plot to be saved directly to an FCS histogram file.

Note: CXP software only saves one Histogram Plot in a single FCS histogram file. CXP
software can only display FCS histogram files as part of an Overlay Plot.
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1 Highlight the Histogram Plot (Current
window).

2 @ File » Save Histogram File As.

Iteration 7.1 - Save HST File

Save in: |@ HST

2|

x|« @ ek E-

|#}2c CD3 CO19 Lymph FL1 LogHST:

2c D3 €019 Lymph FLZ Log.HST
2c D3 CD4 Lymph FL1 Log. HST
2c D3 CD4 Lymph FLZ Log, HST

2t €03 (D56 Lymph FL1 Log.HST
2t €03 (D56 Lymph FLZ Log HST

2c D3 CD& Lymph FL1 Log. HST
2c D3 CD& Lymph FLZ Log, HST
2c Meq Control Lymph FL1 Log, HST
2c Meq Control Lymph FLZ Log, HST

File name:

IDDDDDB28 113 Ungated FL1 Log HST

Save I

Save as type: IHST Filez [* hat]

j Cancel |

Y
3  Specify the desired drives and folders
by selecting them in the list boxes or by
typing the path in the File text box.
4  In the File name text box, type in the desired File Name.
CXP software creates a file with the name specified and stores it in the drive and folder
you specified in FCS histogram format.
Open Protocol
Use this option to open a protocol file from disk.
21 x|

1 File » Open Protocol.

The Open Protocol File dialog box
appears.

2 @ the file you wish to open from the
Folders list box.

Look in: Ia AcquizsitionFrotocol

x| = ®3 e E-

| AS 2C [Settings].PRO
|38 45 2C Flow-5et.PRO

[ 45 2C Meg Contral.PRO
[ 15 2C verify PRO

[ 45 40 1L verify PRO

[ 45 4C 1L Flow-5et.PRO
[ 45 4C 1L [Settings] PRO
|8 45 4C 2L [Settings] PRO
|8 45 4C 2L Flow-Set.PRO

<

A5 4 2L Yerify PRO

A5 5C 1L [Settings].PRO
£5 5C 1L Flow-5et.PRO
£5 5C 1L Verify.PRO

5 5C 2L [Settings].PRO
A5 5C 2L Flow-5et PRO
A5 5C 2L Yerify PRO

A5 FLL Comp.PRO

£5 FLZ Comp.PRO

&5 FL3 Comp PRO
5 FL4 Comp PRO
A5 FLS Comp.FPRO
Cleanse - Bleach PRO
Cleanse - Water PRO

QC 1L Flow-Check PRO

File name:

[0 2L Flow-Check PRO

Files of type: IPmlUcUI Files (*.pra)
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3 @

Note: Double clicking with the mouse on the file name closes the dialog box and opens
the file.

Save Protocol
Selecting this option saves the Protocol in its current form. (Ct))+S] is the shortcut option, as

is the Save Protocol button.

Note: If you open protocols from other Users’ folders and you want to save the protocols to
your folder, you must use the Save Protocol As option and navigate to your folder and save
the protocol.

Save Protocol As
Save a protocol file under a different name or to a different folder.

21x]
1 File » Save Protocol As. Savein: | 3 AcauisiionProtocol o e mckE-

#] A5 2C [Settingsl.PRO )45 4C 1L [Settings].PRO 3] A% 5C 1L Verify PR
=] 45 2€ Flow-Set,PRO [#] A5 4C 2L [Settings].PRO [ 45 5¢ 2L [Settings]
] 45 2C Neg Contral PRO [#] A5 4C 2L Flow-5et,PRO ] A5 5C 2L Flow-Set.k
[ &5 2C Yerify PRO ] 5 4C 2L verify PRO ] 45 5C 2L verify. PR
]85 4C 1L verfy RO |#] A5 5C 1L [SettingslPRO  [#] A4S FL1 Comp.PRO
[#]45 4C 1L Flow-Set.PRO |3 A4S 5C 1L Flow-Sek.PRO ] A4S FL2 Comp.PRO

1] | i

2 In the Save Protocol As dialog box,

File name: iy Save
@ the desired folder from the list or [ o= |
by typing the path in the File name text SaHBAsUReR] Protocol Fies I pro o ceesl | Py

box.

3 In the File name text box, type the desired File Name.

CXP software gives the default file extension *.PRO. The *.PRO extension is only a
suggested extension, any standard DOS characters can be used for the full File Name.
You are urged to keep the extension consistent for easy file searches.

Note: If you are using the CXP Analysis software, protocols are saved in the
Analysis Protocol folder. If you are using the CXP Acquisition software, protocols are
saved in the Acquisition Protocol folder.
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View FCS Header Information

[ﬂ File » View FCS Header

Information to view the FCS
header information on the
current file.

FCS Keywords Used in CXP Software

¥IEW FCS INFORMATION

File . CAC=PAUsers'Sharlene\LMDYAC 2L AS Verify 8-15-3-45-4.LMD

X

[$FTM] F5 Lin
[$P15]F5 Lin
[$P1R] 1024
[$F1B] 10

[$P1] 268
[@P1A0DRESS] 6
[$F1E] Q.0

[@P1] 0.0,0.0
[@P10]

[@P1C] 4RITHMETIC
[@P1Z] O
[@F13]FS Lin

Cloze

3

See FCS Header - Keyword Reference.

Edit FCS Header Attributes

Use this option to edit the FCS header information, including calibration information. You
can change the displayed name of Parameters or change the scaling options. Axis calibration
information can be entered here. This information is embedded in the listmode file. See
Default Log Scaling for setting the default log tick marks.

@ x|
1 File » Edit FCS Attributes to view the -
Edit FCS Header Attributes dialog box. [Fs
N
Note: You cannot make any changes on |FE'Sme
this screen when running a locked
Modes
protocol. (Lo ]
Scale
= Use Default Scale & Use Custom Scale
Channel Yalue Uitz
. 0 0.o0
2 Make the desired changes. ! ! !
QK I Cancel | Help
3 @ or press to accept.
PN 1755708

B-34



USING CXP SOFTWARE B
FILE MENU

4 @ or press to exit the dialog box without saving the changes.

These changes may also be saved permanently within the open protocol by @ File »

Save Protocol or @ File » Save Protocol As.

Note: Modifying the scale options should only be done during offline analysis. Replaying
of the listmode files always uses the calibration set at acquisition.

Import

Settings From CMP File
This option allows compensation settings obtained from the Listmode Playback option to be
imported into the current protocol.

Open LMD compensation settings e ﬂﬂ
1 File » Import » Settings from CMP o T Her o=
Fl Ie 2C QPrepped.cmp 4C QPrepped.cmp

2C Washed.crmp 4C Washed.crmp

3C QPrepped.cmp 5C ZL QPrepped.cmp
3C Washed.crmp 5C 2L Washed.cmp
4C ZL QPrepped.cmp 5C QPrepped.cmp
4C ZIL QPrepped.cmp 5C Washed.cmp

@ File name: | Open I
2 the appropriate file and Files of type:  |LMD Compensation Files [*.cmp) =l Cancel |

U

The compensation settings from the
stored file are then read into the current
CXP software protocol.

4

Print

You can print plots and statistics in a variety of ways.
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Pt S
1 File » Print. The Print dialog b [ |
»>
e int. e Frint dia Og 0X Hame: ICanUn GP300-405 PCL j Properties...
1S dlsplayed. Status: Default printer; Ready
Type: Canon GP300-405 PCL
“where:  \WSBSERVER“CanonGP3
Comment: I Print ta file
— Print Plot: Copi
W' Flats ®a Number of copies: 1 =
. = copies: 3
2 Make the desired changes. £ Curert
Print Statistics @I [~ Collate
’7 [V Statistics v aaaregate Files

Print FlowPAGES

¥ FlowPAGES ok | Cancel |
ol

PAGE 1 &l

CIPaGE 2 " Curent ﬂl

PAGE 3 )
ok % Selection
3 @ Or press Enter| to

commence printing.
See also:Print Plots
Print Statistics
Print FlowPAGEs

4 @ Or press to exit the dialog box without saving the changes.

Print Plots
Select this option if you wish to Print Plots. Choose ALL or CURRENT Plots.

Print Statistics

e Statistics
Select this option if you wish to Print Statistics.

* Aggregate Files
This option groups together statistics from all the regions on a single file. Otherwise
statistics are printed grouped by plot.

Note: If you want to include file information in the statistics printouts, an Info plot,
formatted with desired FCS keywords, must be included in the protocol.

Print FlowPAGEs
Select this option to print FlowPAGEs. Choose ALL, CURRENT or a SELECTION.

To print individual pages, you can enable the page number checkbox.
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Print to PDF

Print plots, statistics or FlowPAGES in PDF format. When printing a multifile analysis to a
PDF file, the PDF filename is derived from the Listmode filename of the last file in each

group.
x
= )l
€ Cument
Print Statiztic
’7 v Statistics v Aggregate Files
— Frint FlowFPAGES
L
! Curent
! Selection
ak. I Cancel I Help |

Note: During installation an ACSPDF printer driver is added to the Windows Printers folder.
This driver is used for the "Print To PDF" options only. If you require additional functionality
to create PDF reports, you need to use a full version of Adobe® Acrobat® software. This
additional software is not included with CXP Software.

If you install Adobe Acrobat 4.0 or 5.0 you should use the Adobe distiller to create PDF files
rather than the ACSPDF - PDF compatible print driver. If you continue to use the "Print to
PDF" options within CXP Software when Adobe Acrobat 4.0 or 5.0 is installed, some
Flowpages are cropped. This issue does not occur when Acrobat Reader® only is installed.

Workspace Preferences - Introduction

Use Workspace Preferences option to set the defaults for the workspace and plot options
according to your own preference. Some of the options are global, so they immediately apply
the specific changes required to all plots. Other options only apply the changes to the plots
created after the option has been selected. Use Plots » Format Plot to modify the Default Plot
options on a per plot basis.

Workspace Preferences - Gating

Workspace Preferences - Publish

Workspace Preferences - Plot Display
Workspace Preferences - LMD File Name
Workspace Preferences - User Info
Workspace Preferences - Acquisition Options
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Workspace Preferences - LMD File Name

B-38

This tab allows you to specify a compound listmode file name, including components such as
the date and the time that the sample was run as well as sample ID fields.

IMPORTANT Risk of erroneous results if you overwrite listmode file names. Either Tag number or Run
Number must always be selected to ensure that unique filenames are created.

The File Name displayed is only a provisional file name. Some available options (for example:
Run Number and Time) can only be defined at the time of acquisition. If a printout of the
Worklist is required with the final assigned file name it is only correct once acquisition of
samples is complete.

A file name can have up to 200 alphanumeric characters, including the path. However, the
following characters cannot be included: forward slash (/), backslash (\), greater than sign
(>), less than sign (<), asterisk (*), comma (,), question mark (?), quotation mark ("), pipe
symbol (), colon (:), or apostrophe (‘). Leading, trailing and multiple spaces are not allowed.

Note: Due to the flexibility of listmode file naming options, listmode filenames can become
very long. When such listmode files are open in the Analysis Only software, the software
assigns a file designator (that is, F1) and displays that designator, with the filename in all
statistics boxes on a FlowPage. Due to the long file name, this may result in overlapping
statistics boxes, requiring reformatting of the FlowPage to view all results.
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First 10 characters.... x
Sample ID 1, 2, 3, 4 Plat Display | Giating | Publish
User 1D LMD File Name | Acquizition Options I User Info
Automatically add unique.... il Meme
Run Number ¥ First 10 characters of pratocal name
[ Sample D 1 ¥ Run Mumber
Y2K Date
Ti [~ Sample D 2 [ 2K Date [vrrr-tbd-D0)
1me
[ Sample 1D 2 I Time [HH:MR]
Tag Number
Fl N E ) [~ Sample ID 4 ¥ TagMumber
e ?me xtension . I~ TubelD " Start each panel at 001
PDF File Name Extension - User D s oo
. . IV Automatically add unique file name extension i file name exists
Note: If more than one Listmode File
Name Option is SeleCted, the priority r Filename Extension POF Filenamne Extension
of the options used for the file name " TagNumber # Append FDF
are & LMD " Replace
K
Mest File Mame...
1. Sample ID 1 s
2. Protocol ID |<F'r0toco|> 00000000 0071.LMD
3. Sample ID 2
4. Sample ID 3 |
0K Cancel Undo Apply Help
5. Sample ID 4
6. Run Number
7. Tag Number
8. Tube ID
9. User ID
10. Date
10. Time

See also: Workspace Preferences - Introduction
Workspace Preferences - Acquisition Options
Workspace Preferences - User Info

Workspace Preferences - Plot Display
Workspace Preferences - Gating

Workspace Preferences - Publish

Note: If the Worklist Column names are changed using the Customize Worklist Columns
option within Acquisition Manager, these changes are reflected in the notation labels on the
above dialog.

First 10 characters....

The first ten characters of the protocol filename is used to generate the listmode filename for
acquisition. If the protocol name is longer, then the name is truncated to 10 characters.

Sample D 1,2, 3, 4

The Sample ID columns allow you to enter information about the particular sample being
run. When this box is checked in Workspace Preferences, the information in any of these
columns is included as part of the listmode file name. If Sample ID 2-4 are not displayed, use
Customize Worklist Columns to add them to the Acquisition Manager. Sample ID 1 is the
same for all tubes within a panel.
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Note: Be sure to verify any manually entered Sample IDs.

User ID
When checked, this includes the User ID as part of the listmode file name.

Automatically add unique....

If a file already exists with the same name and extension, it automatically uses the next
available extension number. This option is only available when a user is not given data file
overwrite capability in the user access rights section of the Admin setup. Depending on User
overwrite privledges, if Tag # is selected and this option is not selected, LMD filenames may
be overwritten.

Run Number

The system automatically generates an incrementing run number every time that a sample is
run. When this option is selected, the run number is included as part of the listmode file
name — the easiest way to ensure unique file names are always generated. If not selected, the
run number is still generated, saved and can be accessed in the FCS Header section of the file.

Y2K Date

When selected, this option includes the date as part of the listmode file name. The format
used is the standard Year 2000 format (YYYY-MM-DD), showing when the sample was
analyzed.

Time
When this option is selected, the time (HH-MM-SS) that the sample was analyzed is included
as part of the listmode file name.

Note: The Listmode File Name column displays only a provisional file name prior to
acquisition. If Time or Run Number is included as part of the name the actual value of these
fields can only be determined once acquisition of each sample is complete. Therefore, if you
wish to print a worklist including the final listmode file names, only do so once acquisition of
all samples in the Worklist is complete.

Tag Number

This allows you to choose whether the Tag number should be included as part of the listmode
file name. If this option is selected, it activates the following items:

* Start each Panel at 001
This starts the Tag Numbering option from 001 for each new panel.

* Start At
This starts the Tag Numbering option from any number that you require, and continues
incrementing until manually reset.

File Name Extension
This sets the file extension to be either Tag Number or LMD:
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e Tag Number
Selecting this option allows you to have the Tag Number as the file name extension. This
is dependent on a Tag Number being previously selected.

e LMD
This option sets the file name extension to be LMD.

PDF File Name Extension
Change the LMD File Name extension to one of the options listed below.

Append .PDF File Name

Append PDF to the listmode file name extension.
Replace

Replace the current listmode file name extension with .PDE This option should only be used
when LMD is being used as the listmode file name extension.
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Workspace Preferences - Acquisition Options

Sets the default Acquisition Options for CXP software during Acquisition, allowing automatic
Saving, Printing and Exporting of Data.

Output Options x
Acquisition Manager Plot Display | Gating | Publish |
Default Log Scahng LMD File Mame Acquisition Dptions | User Info
Cytometer Control Translucency - Ouiput Opton

¥ Save LMD I” Print Plats

™ Save Histograms [~ Frint Statistics

¥ Save Protocol [~ Prirt FlowPAGES

™ Publish [ Prirt FlowPAGES To PDF

™ Edit Sample IDs ™ Prirt Plats To PDF

—Acquizition Manager
™ Auto Duplicate Previous Panel

™| Use Spaces Between Panels

— Default Log Scaling
" Display as 1-10,000
% Display as 0.1024 - 1,024

"Eytometer Contral Translucency

1]

QK I Cancel Undo Apply | Help |

See also: Workspace Preferences - Introduction
Workspace Preferences - LMD File Name
Workspace Preferences - User Info

Workspace Preferences - Plot Display
Workspace Preferences - Gating

Workspace Preferences - Publish

Output Options

The Output actions occur automatically at the completion of the acquisition of each sample
tube. Check the appropriate options for the actions you wish to perform when acquiring data
using the Acquisition Manager. See also, Workspace Preferences - Publish.

Note: Save Protocol applies to any changes made to a protocol, whether acquiring or not. You
cannot alter the Save LMD default, as this is a mandatory setting. If a protocol name begins
with Cleanse, the protocol does not create a listmode file when the protocol is run.

Acquisition Manager
* Auto Duplicate Previous Panel - Adds a copy of the current panel into the Acquisition
Manager at the completion of the current panel, and is useful if you wish to run samples
in Panel Mode but do not wish to define a complete worklist in advance. This setting is
only available in Single Tube Mode.

Default Log Scaling
Sets the default logarithmic scaling (tick marks) to be 0.1024 -1,024 or 1 - 10,000.
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Cytometer Control Translucency
Use this slider to fade the Cytometer Controls dialog so it appears translucent.

[® [Ungated] sS Lin/FSll  MEIEST | | Fcs information

Lymphs
tometer Control
Acg, Setup | Detectars | Compensation |
Bcauistion i = _I0l
Dunaton 1 Discrimnator | [ = [ [Lymphs] FL2 Lo =101x]
E FS = .
1
B OFF
| o ||
o FL2 OFF
5| | Diive SpaceiMBE 16357 | ri oFF
2 FLd OFF
T | -Acquistion mods i L
1| Live Gats o OFF
3 B
) i LIRS
I™ Setup Mods il FL2 Log
L | I QuickcoMp
B | 1 QuickseT Earantos. |
[EE | r Baseine Ofset ~Fied Laser Shutter =lolx]
| Dots € Laser Disabled
1000 % Laser Enabled
1
o
3 1
3
:

T T N T
'q

o’ it
FL Loy FL3 Log

Workspace Preferences - User Info
This option allows defined information and sample/project information to be stored as part of
the FCS header in listmode files. This can be printed out as required via the Legend plot or
with the exported data. All of these are optional and can be filled in according to your

preference.
Institute ]
Institute Street Plot Display | Bating | Publish I
Institute Town LMD FileMame | Acquisiion Dptions User Infa
Sample Source Institute £ Facility
. I
PrOJ ect Institute: Street
Cell Type |
EXpeI‘iment Institute Town
. |
Cytometer Serial Number
Currently logged on user Isam"'eswm
Project
|
Cell Type
|
Experiment
|
Cytometer Serial Mumber Currently logged on user
IAA 1234 ISharIene
QK I Cancel | Undo | Apply | Help |

PN 1755708 B-43



USING CXP SOFTWARE
FILE MENU

See also: Workspace Preferences - Introduction
Workspace Preferences - LMD File Name
Workspace Preferences - Acquisition Options
Workspace Preferences - Plot Display
Workspace Preferences - Gating

Workspace Preferences - Publish

Institute

Enter the Institute name with a minumum of 3 characters . It can be printed out as part of the
statistics output.

Institute Street
Enter the Institute street address. It can be printed out as part of the statistics output.

Institute Town
Enter the Institute town. It can be printed out as part of the statistics output.

Sample Source
This option allows you to enter information regarding where the sample came from.

Project
The name for the project is entered here.

Cell Type
This labels the sample with the specific cell type being analyzed in that sample.

Experiment
The name of the experiment being conducted is entered into this section.

Cytometer Serial Number

The serial number from the specific Cytometer being used is displayed here and recorded in
the listmode file, as more than one Cytometer may be utilized in the same experiment. You
must be logged on as Administrator to enter the serial number.

Currently logged on user

The User ID of the currently logged on user is displayed here and recorded in the listmode
file.
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Workspace Preferences - Plot Display

Show % in Region on New Plots

x
BlaCk PlOt BaCkgroundS LMD File Mame | Acquisition Options I Uzer Info I
Opaque Region Labels st DAty | Gating | Publizh

Print Plot Frames

— General Yiew Options

— Baseline Offset

Print DOtS Black ; ;ho\: :l in:eg;on on:ew Flats & Auto
lack Flat Backgrounds " On
ShOW OVerlaY Legend Pane V¥ Opaque Region Labels 0

Show Overlay Statistics Pane
Log Scale Density Plots

[~ Priet Plat Frames
[~ Prirt Dots Black

USING CXP SOFTWARE
FILE MENU

Smooth Histograms T —  Gallery
Default Overlay Plot Background I Show Dverlay Legend Pane CRuvE
€ Bngled

Color
Default % of Events on Dot Plot

[~ Show Overlay Statistics Pane
V¥ Log Scale Density Plots

— Default Dyerlay Mode

= Default 30 Flat Made

. 5 h Hi
Baseline Offset @l el 7 Gate Precedence hode

Drefault Dverlay Plat

Default Overlay Mode Backgownd Cor. || || Densiybiode
Default 3D Plot Mode ~— Default % of Events on Dot Plat —— — Diefault Plot Size
Default Plot Size 0 50 100 C smal  (1804180)
0ooooo.00000 1+ Medium [225x225)]
—| " Large [300:300)
QK I Cancel | Undo | Apply Help

See also: Workspace Preferences - Introduction
Workspace Preferences - LMD File Name
Workspace Preferences - Acquisition Options
Workspace Preferences - User Info

Workspace Preferences - Gating

Workspace Preferences - Publish

Show % in Region on New Plots

When selected, this automatically displays the percentage of events in a region on newly
created plots. All regions that have been created display this percentage.

Black Plot Backgrounds

This displays the plots with a black background instead of white. This can be useful as it
makes the viewing of smaller populations of cells much easier. When you print, drag or copy
a plot to other software programs, the background remains white.

Opaque Region Labels

This option displays an area around the annotation within black backgrounds, making it
visible.

Print Plot Frames

This option can be used to show or hide frames on plots printed directly from the File Print
menu and exported plot images.

If this is checked, all frames are displayed around plots. If it is clear, frames are not printed or
exported.

B-45

B



USING CXP SOFTWARE

FILE MENU

B-46

Print Dots Black

Select this option to print all dots in black irrespective of their colors. If it is clear, dots are
printed in various shades of gray or, if using a color Printer, the best matched colors available.
This option does not affect the printing of FlowPAGEs.

Show Overlay Legend Pane

When this option is set as the default, any Overlay plot that is created is displayed with the
Legend Pane active. When selected, this option displays the Legend pane on all new overlay
plots as they are created. It does not apply these changes to any previously created plots.

Show Overlay Statistics Pane

When this option is enabled, Overlay plots that are created are displayed with the statistics
pane present. This option is applied to new overlay plots as they are created. It does not apply
these changes to plots created previously.

Log Scale Density Plots

Selecting this option displays any plot with a density mode (that is, density plot, surface plot
and tomogram plot) with log scaling of the density levels. If unchecked, linear scaling of the
density levels is used. These changes are only applied to plots created after this option has
been selected, and not to the ones previously created.

Smooth Histograms

This automatically smooths single histograms by default allowing for easier viewing. When
selected, this option displays smoothed data on all new histograms as they are created. It does
not apply any of the changes to previously created plots.

Default Overlay Plot Background Color

Choose the default background color you require by clicking on the drop down arrow box
and selecting from the color chart displayed. The default color set shows in the box to the left
of the drop down arrow.

Default % of Events on Dot Plot

This allows you to set the default number of dots to be displayed when creating a dot plot.
These changes are only applied to plots created after this option has been selected, and not to
the ones previously created. Reducing the default percentage increases the speed of software
functions when reading large listmode files.

Baseline Offset

IMPORTANT Risk of erroneous results. The Baseline Offset function should only be used after first viewing
data with the baseline offset function turned Off (unchecked). You must be satisfied that the overall results
of an assay are not significantly affected by turning baseline offset on. If the lower marker of a statistics
region is higher than the first decade (of log displayed data) then there should be no effect at all by using
Baseline Offset on Statistics data from that region.

This function allows log data in very low level signals to be moved up from low numbered
channels by adding a randomized Gaussian positive offset. This allows easier comparison of
data from other Cytometers. Baseline Offset includes the following three options:
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¢ Auto
This option displays the listmode data according to a keyword in the FCS file header. If
the Baseline Offset keyword value is ON, then data is automatically displayed with
Baseline Offset switched on. If it is OFF, then data is displayed with no Baseline Offset.
* On
This reads a file and modifies the displayed data only by adding a randomized Gaussian
offset to the low-level signals. Data on disk is not modified and is left as it was when
acquired from the Cytometer.

 Off
Reads a file exactly as it is without modification during display.

Default Overlay Mode

This allows you to select the default mode for the overlay plots. Gallery, Overlay or Angled
view can each be selected as the default. This is only applied to any plots created after this
option has been checked and does not alter any of the previously created plots.

See also, Overlay Plot Mode.

Default 3D Plot Mode

This option sets the default mode for Surface and Tomogram plots. For further details see
Gate Precedence Mode and Density Mode.

This option is only applied to plots created after this has been selected and does not alter any
of the previously created plots.

Default Plot Size
Allows you to select the size of the plot display.
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Workspace Preferences - Gating

Automatic Gate Creation Y
Automauc Gate Malntenance LD File Mame I Acquizition Options I Uzer Info I
Automatic Color Precedence Plot Display Gating | Pubish

Dot Plot Coloring Mode Dot Plat Coloring Mode

¥ Automatic Gate Creation

AutOGating Sen51t1V1tY " Color Blend Mods V¥ Automatic Gate Maintenance
Elllptlcal SenSlthlty ' Color Precedence Mode ¥ Automatic Color Precedsnce
Contour Sen51t1V1ty —AutoGating Sensitivity

Contour Travel Eligicsl  [011T =]

AutoGating Failure Comowr [I =] Tiavel 160

Pause on Error

Abort On Error — AutoGating Failure

& |gnore Emors
" Pauge On Eror
© abart MCL O Error

Ignore Errors

QK I Cancel Undo Apply Help

See also: Workspace Preferences - Introduction
Workspace Preferences - LMD File Name
Workspace Preferences - Acquisition Options
Workspace Preferences - User Info

Workspace Preferences - Plot Display
Workspace Preferences - Publish

Automatic Gate Creation

This option allows you to create a new gate automatically when a new Region is created. If
this option is not selected you must use Analysis » Create Modify Gates to create gating logic.
Regions copied using +Drag and Drop into a plot assign the region as a gate.

Automatic Gate Maintenance

Enabling this option ensures that when the gating of a plot changes, the associated gate of any
region drawn onto this plot also changes to reflect the new gating state.

Regions with an associated gate CANNOT appear on more than one plot when this mode is
enabled (CXP Analysis software only).

Automatic Color Precedence

As a new region is drawn, the color for that gate is placed at the top of the list in the color
precedence dialog box. If this option is disabled, a color is not associated with a gate.
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Dot Plot Coloring Mode
This alternates Color Dot plot mode between Color Blend and Color Precedence modes:
* Color Blend Mode
e (Color Precedence Mode (default)

AutoGating Sensitivity
Select the sensitivity of the AutoGate region drawn.

Elliptical Sensitivity

Settings are 0.11, 0.33 and 1.1 (% of processed peak). Selecting 0.11 creates a larger region,
whereas selecting 1.1 creates a smaller radius region around the target population.

Contour Sensitivity

Settings are 1, 2, 3, 4, and 5. Level 1 = 0.11% processed peak at a resolution of 64x64, levels
2,3 and 4 are 0.11, 0.33 and 1.1% at a resolution of 128x128. Level 5 is 1.1% processed peak
at a resolution of 256x256.

Contour Travel

Input a maximum value the contour AutoGate region travels from the mean. The Minimum
value is 25; Maximum is 250 channels. Use this option to slightly adjust the AutoGate from
tube to tube if slight changes in lysis cause the target population to move slightly. This option
is not available for elliptical AutoGates.

AutoGating Failure

You can select an error option when the AutoGate algorithm fails during acquisition in the
MCL automatic mode.

Pause on Error

The system pauses the current acquisition when an AutoGating error occurs and awaits
further input before proceeding.

Abort On Error

The system automatically aborts the Worklist when an AutoGating error occurs.

Ignore Errors
The system continues processing the Worklist when an AutoGating error occurs.
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Workspace Preferences - Publish

Publish Data to Text File
Export Data Format

File References in Data
Publish Data to MS Excel
Export Bitmap Size

VWorkspace Preferences

LMD File Mame |
Flat Dizplay I

[~ Publish Data to Test File

r— Export Data Format

7 Calurnre
One sheet per file.

& Calurnres
Aggregate files.

" Experiment Table

Acquigition Options | User Info
Gating Publish

[~ Publish Data to M5 Excel

Export Bitmap Size
7 Smal [400x400)
& Medium  [BO0RE00]
 Large  (B00x800)

™ Switch to MS Excel on publish

~ File References in D ata
7 Full Path & Mame
& Mame Only

()8 I Cancel

Undo Apply Help

See also: Workspace Preferences - Introduction
Workspace Preferences - LMD File Name
Workspace Preferences - Acquisition Options

Workspace Preferences - User Info
Workspace Preferences - Plot Display
Workspace Preferences - Gating

Publish Data to Text File

Enable this checkbox to publish data to an ASCI text file with a file extension of .TXT.

Publish Data to MS Excel

This function enables you to publish data to a Microsoft Excel Workbook, used in
conjunction with the Tools » Publish Results Now menu item.

Export Data Format
Select the Export Data Format.

*  Columns - New sheet per file to export the data with each file on a separate worksheet,

* Columns to export the data from all files to a single worksheet

* Experiment Table to export the data in experiment table format for inclusion in a pivot

table.

File References in Data

Choose to reference the file name by Full Path and Name or by Name Only.
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Switch to MS Excel on Publish

MS Excel starts and displays the published data. When enabled, Excel moves to the front of
Windows desktop as the active application with each export. If left unchecked, Excel runs in
the background with each subsequent export.

Export Bitmap Size
Allows you to select the size of the Bitmap used in when exporting.

Log Out

Allows a particular user to Log Out of CXP software so that another person can Sign-On.

Exit

This option closes down the CXP software and returns you to your Windows Desktop.

B.16 EDIT MENU
Undo

Edit > Undo reverses software operations such as Region drawing, Region label editing and
FlowPAGE editing. Each New operation is appended to an Undo list. The valid Undo
operations are then performed in reverse order with each Undo request.

Note: Undo does not undo such operations as Save and Acquisition of data.
The Edit » Undo list is cleared after each change of plot focus.

The Edit » Undo function is applicable to the Window Menu, Regions, FlowPAGE and fonts.

Redo

Edit > Redo reverses the last Undo operation.

If a new operation is performed after a series of Edit>» Redo operations, the Edit > Redo list is
cleared and all previous Undo actions are lost.

The Edit » Redo list is cleared after each change of plot focus.

Cut

Edit > Cut deletes the highlighted items from the display, placing them within the Clipboard.
These items can be recalled either by using the Copy, Paste or Paste Special options within the
Edit menu.

Histogram plot displays can be Cut from one Overlay plot to another by using the Paste or
Paste Special options.

If you Edit » Cut another item before the first item is Pasted, this first item is overwritten.

See also:

Copy
Paste

Paste Special
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Copy

To Copy Statistics, Regions or Plot Images onto the Windows Clipboard, @ Edit > Copy.

This allows for Pasting these items into other areas of CXP software or to other Windows
Applications such as MS PowerPoint®, Word, Excel, and so on.

The exact nature of what can be pasted depends upon the target application and can be
controlled or modified using the target applications Edit» Paste Special command.

See also:

Cut

Paste

Paste Special

Paste
After copying into memory, CXP software allows the pasting of a number of different items.

The default paste result depends upon what you are trying to paste.

* If the target is a FlowPAGE, the Plot Image and Statistics are Pasted.

1 Select the Plot of interest to be copied.

2 @ the Plot and hold down the left mouse button. (The No Drop Cursor @ is
displayed.)

3 Drag the cursor onto the FlowPAGE. (The Drop Cursor %3 is now shown.)

4  Release the mouse button to paste the Regions onto the Plot or the Plot Image plus the
Statistics onto a FlowPAGE.

Note: If you use +@ to Drag and Drop, you get the Plot Image but not the
Statistics.
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* If the Paste target is a Plot, then the previously copied regions are Pasted.

1 Select the Plot with the region of interest to be copied.

2 Drag the cursor to the destination Plot.

3  Release the mouse button to paste the Regions onto the Plot.

Note: If the copied region is required as a gate, use +@ to Drag and Drop the
region.

See also:

Cut

Paste

Paste Special

Paste Special
Allows which form of a copied object is pasted. Bitmaps, Text or Region may be pasted
depending on the copy source and the paste target.

See also:
Cut

Copy

Delete

When Delete is used, any selected items are deleted. In certain circumstances, it may be
possible to reverse the Delete action by selecting the Undo option.

See also:
Undo
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Edit Font

You can modify the Font type, size and
color of selected text. The fonts available
depend upon the fonts installed in
Windows. If in doubt, try to use only True
Type fonts.

The fonts selection dialog box is the
standard Windows common dialog box for
font selection and is fully explained in the
Microsoft Windows documentation.

Fant: Fant style:
fial Bold oK. |
| |Regular
Al Black Ialic Cancel_|
B Avial Narow
T Book Antiqua Bold Italic
H Bookman Old Style
B Bookshelf Syrbal 1
" Eookshelf Symbol 2~ |
— Effects —Sample
™ Stikeout
AaBhYyZ.
™ Underline Yyzz
LColor:
I- Black - I Script:
IWestem LI

Thiz iz a TrueType font. Thiz zame font will be used on bath

wour printer and pour screen.

For True Type fonts, you can generate both horizontal and vertical fonts for the Plots.

For non-True Type fonts that do not have point sizes for both horizontal and vertical (portrait
and landscape), Windows attempts to use a horizontal font for the vertical direction. Under
these circumstances choose another font or reload the font of your choice making sure the
font sizes required are available in both portrait and landscape types.

Please see the Microsoft Windows documentation on loading new fonts.

See also:

Edit Font (FlowPAGE)
Font

Font Annotations

Edit Font (FlowPAGE)
To change the fonts in FlowPAGE:

1 Double click on a plot or text box to display the grap handles.

2  Click the right mouse button on the plot or text box to display the properties dialog box.
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3 @ the Font tab.

4 @ the desired font, font style, size and color. Underlined or strikethrough text can be

shown. @ to set your new values.

) @ once outside the plot or text box. The cursor reverts back to the Chooser cursor

% and the handles disappear.

See also:
Font
Font Annotations

B.17 VIEW MENU

Acquisition Manager

The Acquisition Manager is used to create a Worklist for the Cytometer. It may also be used to
create or modify existing panels. Sample and Test information may be entered here, this data
is stored as part of the FCS listmode file.

Panels and Protocols can be added to the Acquisition Manager Worklist by using the
Resource Explorer to Drag and Drop or by using the ACQUISITION MANAGER TOOLBAR.
Items may be reordered within groups or entire groups may be reordered using Drag and
Drop. Thick black lines define groups, and items within the groups are separated by thin
dotted lines.

By clicking the right mouse button in the column headings the following menu choice is
available.

Customize columns
Erint warklizt

Select the appropriate option to Customize the Worklist Columns allowing the addition,
removal or renaming the columns, see Customize Worklist Columns or print the Worklist
when a Print dialog box is displayed.
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See also:

ACQUISITION MANAGER TOOLBAR
Worklist Columns Available
Acquisition Manager - Panel

Acquisition Manager — Modifying Panels and Worklists

The Acquisition Manager is used to create a Worklist for the Cytometer. It may also be used to
create or modify existing Panels or Worklists.

IMPORTANT Risk of erroneous quality control statistics. Panels containing QC regions must be
constructed from individual unique protocols. Do not use a panel constructed from one protocol (with
different parameter names) for QC database purposes.

Panels

1 Open the Panel to be modified.

2 To add tests to a Panel, use the Insert Test i button on the Acquisition Manager
Toolbar. Repeat this process as necessary. You may also insert multiple tests by using the
Insert Panel button. Alternate protocols may be selected once the tests have been added

'}

=g

using the File button inside the Worklist.

3  To remove tests, delete the entire row from the Worklist.

4  To change any other panel information, such as how instrument settings are loaded, use
the appropriate columns. When the changes are complete, click the right mouse button

inside the panel and @ Save As Panel.

9 Ifyouintend to generate Panel Reports from this panel,

@ ¥ Export results of panel to Report G enerator .
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Worklists

1 Open the Worklist to be modified.

2 To add samples to the Worklist, use Drag and Drop from the Resource Explorer. This
starts a new panel or protocol that is automatically added to the end of the Worklist.

3  To remove tests, delete the entire row from the Worklist.

4  Save the Worklist using the Save Worklist wi| button on the Acquisition Manager
Toolbar.

See also:
Acquisition Manager
Customize Worklist Columns

Worklist Columns Available

The following columns are available for display within the Acquisition Manager:

Panel

Protocol

Plots

Region Source

Cytosettings

Tube ID

Carousel Number and Location
Sample ID 1 — 4

CAL Factor

LMD Filename

Stop Condition and Value
Parameter Names
Acquisition Manager
Customize Worklist Columns
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Acquisition Manager - Panel

IMPORTANT Risk of erroneous quality control statistics. Panels containing QC regions must be
constructed from individual unique protocols. Do not use a panel constructed from one protocol (with
different parameter names) for QC database purposes.

Panel
Displays the name of the currently selected panel. An

L=lx

‘ Panel

1 = |5c 1L.PHL

u

=

2z 5C 1L.PHL
3 5C 1L.PHL

alternative panel may be selected using the File
button or a New Panel created using the Panel Wizard.

See also:

Acquisition Manager

Worklist Columns Available

Acquisition Manager — Modifying Panels and Worklists
Customize Worklist Columns

Deleting a Worklist Row

Adding a Panel

Adding a single Test to the Worklist

Acquisition Manager - Protocol

Protocol
. Protocol
Displays the name of the currently selected protocol. T

ﬁ' = 5C 1L.PRO
An alternative protocol may be selected . & 5C 1LPRO

Acquisition Manager - Plots
Plots — A two-state toggle button displayed as icons. These states are:

Load the plots, and gates from the protocol, this is the default option. Plote
[

'l Carry the plots, and gates through from the previous acquisition. &
[=
[E
[2]
[

Note: This column is de-selected by default.

See also:

Worklist Columns Available
Acquisition Manager
Customize Worklist Columns
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Acquisition Manager - Region Sources

Region positions can be carried between different protocols within a panel — regions can, for
example, be set on a control sample then carried through all the tests in a panel.

Note: In order for a region position to be carried into a new protocol the source and target
region must satisfy all the following criteria:

* Regions must have the same name
* Regions must be of the same type

* Regions must be drawn on the same parameters.

All regions satisfying these criteria are carried from one protocol to another.

There are three options for the region source:

This option loads the region positions from the current
protocol

‘ Region Source

u This option carries the region positions from those of the
previous tube in a panel.

= This option loads region positions from any suitable protocol,

LTS T TR T T T
& FFEE

ly&2a FITC Contral PRCH

bt |
use the Browse button & (o select the required protocol. The
name of the selected protocol then appears.

See also:

Worklist Columns Available
Acquisition Manager
Customize Worklist Columns
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Acquisition Manager - Cytosettings
Cytosettings — three-state toggle displayed as icons or bitmaps. These states being;:

+

Loads the instrument cytosettings from the protocol,

Carries the instrument cytosettings through from the previous
acquisition.

Note: When using the Instrument Settings column of the
Aquisition Manager to carry settings between protocols within a
panel, you should ONLY carry settings between protocols where
the parameter number and order are identical.

Retrieve the instrument cytosettings from an external file. For
example, from an AutoSetup protocol, another protocol or
listmode file.

When the Retrieve instrument settings from external file option is
selected, the external file name is displayed in this field. A

'
Browse & button is provided so that a setting file can be
opened.

See also:

Worklist Columns Available
Acquisition Manager
Customize Worklist Columns

Acquisition Manager - Tube ID

Carousel

Tube ID Ho. Location | Sample ID1 | Sample D2 | Sample ID3 | Sample ID 4
89265232953 1 1 Sample 1 ‘Whole Blood Mormal
89265232954 1 2 Sample 1 ‘Whole Blood |Hormal
89265232955 1 g Sample 1 ‘Whole Blood |Hormal
9268232956 1 4 Sample 1 ‘Whole Blood |Hormal
9265232957 1 5 Sample 1 ‘Whole Blood |Hormal

‘ Cytosettings

= B e

= ¥

= ¥

= ¥

= ¥
2 =] AS4CIL
R It

1=t

Tube ID — Displays the bar-code number from the tube. Allows positive sample identification
and an error is generated if the Tube ID does not match the bar-code label on the sample tube.
If no Tube ID is entered, but a bar-code label is present on the sample tube and run on the FC
500, the bar code is read and the Tube ID field is updated with this information.

Acquisition Manager - Carousel No. and Location

Tube ID c"::“' Location | Sample ID1 | SampleID2 | Sample ID3 | Sample ID 4
89268232953 1 1 Sample 1 Whole Blood Martnsl
9268232954 1 2 Sample 1 ‘Whole Blood |Hormal
89268232955 1 3 Sample 1 ‘Whole Blood |Hormal
89265232956 1 4 Sample 1 ‘Whole Blood |Hormal
89265232957 1 3 Sample 1 ‘Whole Blood |Hormal
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Carousel No. and Location — Allows you to to specify the Carousel number and the location
of a tube in the carousel. You can run a tube at multiple points in a worklist (for example: a

set-up or cleaning tube) and random access to sample tubes.

Acquisition Manager - Sample 1D

Carousel

Tube ID Location | Sample ID1 | Sample D2 | Sample ID3 | Sample ID 4
89265232953 1 1 Sample 1 ‘Whole Blood Mormal
89265232954 1 2 Sample 1 ‘Whole Blood |Hormal
89265232955 1 g Sample 1 ‘Whole Blood |Hormal
9268232956 1 4 Sample 1 ‘Whole Blood |Hormal
9265232957 1 5 Sample 1 ‘Whole Blood |Hormal

Sample IDs — Up to four Sample ID fields may be displayed. Any required information can be
entered into these fields.

See also:

Acquisition Manager
Customize Worklist Columns

Acquisition Manager - CAL Factor

CAL Factor — Edit box containing absolute count CAL factor, designed to allow the use of
multiple Flow-Count, Leuko-Count or Stem-Count fluorospheres batches. The CAL Factor

button allows the display of the Absolute Count Calibration dialog box. See Absolute Count
Calibration for more details.

Note: If the same CAL Factor is used for multiple panels in a worklist, use + @ to
autofill the entire worklist with the CAL Factor.

See also:

Acquisition Manager
Customize Worklist Columns

Acquisition Manager - LMD File Name

LMD File Name — The File Name displayed in this column is only a provisional file name.
Some available options (for example: Run Number and Time) can only be defined at the time
of acquisition. If these elements are included in the file name and a printout of the Worklist
with the final assigned file name is required. They only print correctly once acquisition of

samples is complete. A Browse button is available to allowing file name definition

through the Workspace Preferences - LMD File Name option.

See also:

Worklist Columns Available
Acquisition Manager
Customize Worklist Columns
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Acquisition Manager - Stop Condition and Stop Value

Stop Condition — By clicking the mouse within this box, you can select the Stop Condition to
apply. This option allows you to override the stop conditions present within a protocol.

The options are:
Protocol to use the preset stop condition.
Time to Stop at a particular time.

Maximum events when the require number of event have been collected.

Stop Value — Detected from protocol and can be edited, again allowing user to override
currently defined stop value.

Note: If a stop count is used on a plot that contains an AutoGate region, the stop count is not
exact.

See also:
Acquisition Manager
Customize Worklist Columns

Acquisition Manager - Parameter Names

Parameter Names — An editable box displaying the default parameter names from the
protocol or panel. This allows free text entry of parameter names to be added as required.
Changes made here are updated in the protocol once acquisition begins. Protocol Save can
then be used to save these parameter names in the panel. See Edit FCS Header Attributes for
an alternative way of saving parameter names in a protocol prior to acquisition.

In this example, the columns are numbered P1 to
P6. The actual number present is determined by the — prmmrtmt b e
number of parameters selected in the protocol; the  [rzpeiiirs 55 cosrme T S

maximum number you can have is 16. FE BEAK PSS ICDS FTE b4 FE CO45ECD
FS FEAK F5 155 10D3 FITe DA FE D45 ECD

P1 P2(P3 P4 P43 Ph

F= PEAK iFS iS5 (HLA-DR FITC  :CD19 PE CD43 ECD
F5 PEAK iFS iS5 (CD10-FITC CD19PE CD43 ECD

See also:

Worklist Columns Available
Acquisition Manager
Customize Worklist Columns
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Customize Worklist Columns

Use the Customize Worklist Columns dialog box
to add, remove, or edit Worklist Columns
displayed. Columns can also be renamed or
reordered.

A column is included or removed by enabling or
disabling the checkbox. If the checkbox is grayed
out it cannot be altered.

The Column Name can be edited by double
clicking on the name and renaming as

appropriate. If the name has a lock & jcon, no
changes are allowed.

The Default button resets the Worklist Columns
to the standard default and consequently resets
the Workspace Preferences — LMD File Name.

USING CXP SOFTWARE

Customize Worklist Columns...

VIEW MENU

Panel

Pratacol

Plotz

Region Source

Cytozettings

Tube 1D

Carouzel Mo

Location

Sample D 1

Sample 1D 2

Sample ID 3

[el C vl T A
oK I Cancel |

s

=

o Defaults |

Help |

x|

Note: If a particular Worklist Column is not displayed, the standard default heading still
shows on the Workspace Preferences — LMD File Name tab dialog box.

If the Names are changed, this reflects in the name labels within Workspace

Preferences — LMD File Name.

Reordering Columns

The columns may be reordered by selecting a column or a group and using Drag and Drop to
move it to the desired location. To move a column within a group, use Drag and Drop. To
move a group of columns use (Ctl)+Drag and Drop. Groups are defined by thick black lines,
and items within the groups are separated by thin dotted lines.

Deleting a Worklist Row

To delete a Row within a Worklist,

highlight the appropriate Row or 7
Rows by clicking the mouse in the S
Row Number column shown by the

3

4 adminPanelé
-+

a3

Panel ‘ ‘ Protocol ‘P1‘ P2 ‘ P3 ‘ P4
adminPanelé 5P12.PRO FS |PhAT1 |PMTZ LOG | PMTS LOG
.................... adminPanelé 5P12.PRO FS |PhT1 |PMTZ LOG | PMTS LOG
SP12.PRO FS [PRT1 |PMT2 LOG |PMTS LOG
adminPanelé S5P12.PRO FS |PhT1 |PMT2 LOG |PMTS LOG

Use < or within the

Acquisition Manager Toolbar to delete
the appropriate rows.

If you inadvertently mark a row or
rows for deletion, click the mouse
within the body of the Worklist

outside of those rows highlighted.
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Carousel Overflow

An FC 500 carousel can hold a maximum of 32 x|
tubes. Creating a worklist with more than 32 tubes

in one carousel generates a carousel overflow

Tessage.

@ to jump to the point in the worklist

where a new carousel number must be added. This
is the initial tube of the next complete panel. Panels
can not be split across carousels.

@ The maximum number of kests in a panel is 32,

@ Cancel (o clear all the carousel information
(when running in manual mode, for example).

Resource Explorer

The Resource Explorer occupies a definable area within the Workspace. It allows you to
browse files, and can be used to Drag and Drop items into CXP software. Tabs for Listmode
files, Protocols and Histograms allow files to be dropped into the Workspace or Overlay Plots.
Panels and Worklist can be dragged from the Resource Explorer and dropped into an
Acquisition Manager Worklist. Information added in this way always appears at the end of the
Worklist. The order may be changed using Drag and Drop after the information has been
added.

==l
...... 1 admin File: | T_l,lpel Date/Time  «
MomalD5.LMD LMD 1993-03-21
MormalDZLMD LMD 19930321
MomalD3LMD LMD 19930321 (—
NormallD4.LMD LMD 13930321 [+
4 I I »
Blworists | 3 panele | @Y Protocols  |:={1MD R support

- Fegions
G-+ LMD Files
F-Ir Gates

Ready
The view that you see depends upon your particular access rights. User levels show only a
particular user Listmode, Histogram and Protocol directory, depending on the tab selected.

If you are a member of a particular Workgroup, all the user folders within that Workgroup are
visible. The Support tab provides a link to the Beckman Coulter and ACS web sites as well as
links to any Tutorials and ancillary Help files.

B-64 PN 1755708



PN 1755708

USING CXP SOFTWARE B
VIEW MENU

Toolbars - Customize Toolbars
This allows you to select the style and which Toolbars are displayed.

Toolbars x
Toolbar Name Toslbars | Commands |
Show ToolTips
Toolbars:

Cool Look MiFile ¥ Show Tooltips Mew... |
Large Buttons o I Lol Look et |
Ne WlAutotATOR I" Large Buttons =

W... [ &cquisition Manager Toals
Reset

T oolbar name:

|File

ak. I Cancel | Help |

If a customized Toolbar has been created and this is highlighted, ﬂl is available to
allow the deletion of that Toolbar.

See also, Toolbars - Customize Commands Tab

Toolbars
Select which Toolbars you wish to be displayed. Any customized Toolbars are listed.

Toolbar Name

Allows you to modify the name of any customized Toolbar. It is grayed out for the standard
Toolbars.

Show ToolTips

Show Fly-over help when the mouse is pointed to the Icon.

Cool Look
This changes the style to a "cool" look.

Large Buttons
Changes the Icon buttons to a Large size.

New...
Displays a dialog box to enter your customized name of your new Toolbar.

Reset
Resets the Toolbar to the default values.
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Toolbars - Customize Commands Tab
This allows you to customize the Toolbars by dragging the button to the desired position
within any Toolbar.

Categories X

Buttons
Description

Toolbars Commands |

Categories: — Buttan:

a OOy HfoiBE =

Tools

Cytarneter
Acquizition b ana
Flowpage

Batch %

Select a category. then click a button to zee its description. Drag the button
to any toolbar

— Description

] I Cancel Help

See also, Toolbars - Customize Toolbars

Categories
Displays the Toolbars that are currently available.

Buttons
Shows the buttons that may be selected for any Toolbar.

Description
Displays a description of the Icon button selected.

Zoom
The following option allows you to zoom in on a FlowPAGE, or Overlay Plot to 100%, 200%
or 400%.

Select the desired view. Selecting 100% returns to the default size.
Refresh
Selecting View » Refresh, or pressing (F5), causes CXP software to refresh the screen, all plots

and FlowPAGEs. This option is useful when Windows fails to refresh the screen correctly
leaving some graphical errors visible.

B-66 PN 1755708



USING CXP SOFTWARE B
INSERT MENU

B.18 INSERT MENU
Blank FlowPAGE

To open a new blank FlowPAGE, @ =l

Note:

* The page displayed in the FlowPAGE is the same aspect ratio and paper orientation as
used in the default Printer.

* The page scaling can be changed at any time after a FlowPAGE is created.

* Several FlowPAGEs can be created.

*  FlowPAGES in a locked protocol can not be inserted, deleted or edited.
All FlowPAGEs contain:

* Institution name

* Acquisition or playback protocol
* Acquisition date and time

e UserID

e Settings file name, date and time
* Listmode file name

* Total acquisition time and stop condition
* SampleID 1

* Protocol status

* Analysis date

* Instrument serial number

e Software version

FlowPAGE from File

When a FlowPAGE has been created, (including all the departmental logos, addresses, plots,
statistics and comment boxes), the whole FlowPAGE can be saved and retrieved.

Use the open FlowPAGE option to open a FlowPAGE template from disk. FlowPAGE uses the
default file extension *.PGE. The *.PGE extension is only a suggested extension, any
standard DOS characters can be used for the full file name.
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@ Insert » Open FlowPAGE From File to
view the Open FlowPAGE dialog box.

@ the desired drive in the Drive List
box.

Sharlene - Dpen Flowpage File HE
Lank jr | =3 Sharlene _:I = £ B
) AcquisitionPratacal (] Panel
= AnalysisProtacol CaPoF
HST I Results
HTML 1 worklist
Images @ Headeronly FGE
“1LMD
File name: I Open I
Files of type: IFluwpage Files [*pge] Li Cancel -
i

@ the desired directory in the Folders List box.

@ the type of file in the Files List box and click.

@ the name of the file to view. @ .

Or

Double click on the file name to close the dialog boxes and display the file.

FlowPAGE Statistics Tahle

This option is used to insert statistics into FlowPAGE.
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Select Plot to Use |

1 @ Insert » FlowPAGE Statistics Table. Pots _ |
% [F1] [Ungated] File001 LMD : FLT LOG/FLZ LOG

E (F1) [Ungated] File001.LMD : Legend

|8 Overlay Plat 1

L& (F1] [Ungated] File001 LMD : FL1 LOG

@iF1] [Ungated] File001. LMD - FL1 LOG/FLZ LOG §

2  From the list of plots currently open in

CXP software, @ the one containing
the statistics you wish to insert.

@ or press (Esq) to exit

the dialog box without accepting the
changes.

ak. I Cancel Help

3 The statistics for the selected plot are inserted into the FlowPAGE and can then be

moved to the desired position.
Only one plot is permitted per statistics table.

FlowPAGE Texthox

This option is used to insert text into FlowPAGE.

1 @ Insert » FlowPAGE Texthox. An insert text cursor A is displayed.

2  Move the cursor to the place for the textbox and @

PN 1755708
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3  Type the required text and x
QK Cancel Help |

4 @ outside the text box to accept the changes.

9  Click the right mouse button on the text box to edit properties, enter text, edit the font
or change the alignment.

FlowPAGE Plot

Insert Plot
To insert plots currently displayed on the desktop into FlowPAGE.
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@ x4
1 Insert » FlowPAGE Plot and Piots |
ﬁ [F1)[Ungated] F1 : 55/F5
@ & [F1)[Ungatsd] F1 : FL1 LOG/FL2 LOG
a plot in the list.
2 @ [ 1 The plot is placed in
the upper left corner of the FlowPAGE. oK | Cancel Help

Inserting Drag & Drop Plot
Insert currently displayed plots on the desktop into FlowPAGE.

1 @ inside the plot to be inserted into FlowPAGE and hold down the left mouse button.

The No Drop cursor @ is displayed.

2  Drag the cursor onto the FlowPAGE. The Drop cursor %3 is now shown. Release the
mouse button. The plot is now inserted into FlowPAGE.

Note: If you Drag and Drop the plot, the plot and the statistics are inserted. If you
(cti)+Drag and Drop the plot, the statistics are not inserted with the plot.
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Other FlowPAGE Object

Inserting a Rectangle

1 @ Insert » Other FlowPAGE Object and @ the Rectangle option.

A cross-hair cursor + is displayed.

2 @ and hold down the left mouse button while you drag to size the rectangle.

3 @ outside the rectangle to anchor it.

See also:

Inserting a Line
Inserting a Picture
Inserting a Text File

Inserting a Line
Draw straight lines using FlowPAGE » Insert > Line.

1 @ Insert » Other FlowPAGE Object and @ the Line option.

A cross-hair cursor + is displayed.

2  Drag the cursor to desired line size and release the mouse button. The line is drawn and

the cursor reverts back to the Chooser cursor % .

See also:
Inserting a Picture
Inserting a Text File
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Inserting a Picture
FlowPAGE allows the import of a Windows Bitmap file (extension *.bmp).

USING CXP SOFTWARE
INSERT MENU

1 Use MS Paint or other graphics editor to create a bitmap file to be placed on a FlowPAGE
and save it as a file.

@ Insert » Other FlowPAGE Object and @ the Picture option.

2 Select the desired bitmap file.

. C

Look

. O

type:

L

the desired directory in the
in: list box.

the type of file in the Files of
list box.

the name of the bitmap file

you want to insert.

Note: Double click on the file
name to close the dialog box and
display the file.

Open
Look jr |{SJ Sharlene _:I 4= £ EE-
= AcquizitionProtocol 1 Panel
= AnalysisProtacol CaroF
HST ] Resuls
HTML [ wiorklist
Images
LMD
File hiame: I| Open I
Files of type:  [Bitmap Files [* brnp;".dib] Bl Caricel |/
%

3 @ the FlowPage location where you want to place the picture.

See also:

Inserting a Line
Inserting a Rectangle
Inserting a Text File
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Inserting a Text File

1 @ Insert » Other FlowPAGE Object and @ the Text File option.
Note: Use MS Notepad or other text editor to create text (*.txt) files.

2  Select the desired text file.

L

Look

. O

type:

L

the desired directory in the
in: list box.

the type of file in the Files of
list box.

the name of the text file you

want to insert.

Note: Double click on the file
name to close the dialog box and
display the file.

admin - Open Textfile ﬂll
sk [ s @l @l o
Hst (oes
Htrl 1 Results
Images [Z0warklist
Lrnd
Parel
Fratacal
File name: || Open I

Files of type: | Testfiles ("4t

j Cancel |

4

3  The text box is placed in the upper left corner of the FlowPage.

a. Use ‘%’ to move the text box to the desired location.

b. @ ouside the text box to anchor it.

See also:

Inserting a Line
Inserting a Picture
Inserting a Rectangle

Other Insert Menu ltems

Annotation

Inserts text into an Overlay Plot

Overlay Annotations - Introduction

B-74
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Auto Text
AutoText inserts the FCS Header Keyword Annotation into Overlay Plots.

The options are:

¢ Stain

e Source

* Parameter
¢ File Name

e Date

To insert other keywords, see FCS Keyword Annotation Mode.

Overlay Histogram
Inserts a stored histogram into an Overlay Plot.

See also, Adding a Histogram to the Overlay Plot.

B.19 TOOLS MENU

Publish Histogram Data Now

Opens Microsoft Excel and exports data from the Overlay histogram plot, the raw channel
information is exported and additional statistics calculated. MS Excel must be present for this
tool to function.

Publish Results Now

Statistics are displayed under plots in resizable columns and can be exported to Microsoft
Excel or ASCII text (.txt) file format.

The Workspace Preferences — Publish tab option Publish Data to Text File and/or Publish Data to

MS Excel L= must be enabled. See Workspace Preferences - Publish.

To open the Statistics Pane, move the mouse over the =10l x]
Plot so that the X (Sigma Cursor) is displayed and click ~
the left mouse button. The Statistic Pane drops down g
showing ALL the Plot statistics. To hide the Statistics i
Pane, click the mouse on the Sigma cursor again. 5
5
w —
If other Regions are added or deleted while the Statistics -
Pane is open, it is automatically resized to accommodate ]
the change. QZ' T
. . c . . S5l
Plots, including the Statistics Pane, can be resized at any "
time by dragging any part of the Window Frame Region Cellsful | Number | %Ga... | %-Mean [ ¥-Mean |
. .. . ALL 6194 27072 100.00 505 605
although the helght of the Statistics Pane remains A 1238 5411 1999 106 391

unchanged.
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The Statistics Pane can only be resized by using the - Splitter Bar while holding down (ctr).
Use the mouse to drag the revealed Statistics Pane to the required position. If resizing is
achieved using the splitter bar, the automatic sizing using the X (Sigma Cursor) is
overridden.

Auto sizing is the default mode selected when the Plot is first created whereas user-defined
sizing is selected as soon as resizing occurs using the Splitter Bar. To reinstate the Auto sizing,
hold down while clicking the 2 (Sigma Cursor) with the mouse.

AutoMATOR

B-76

Welcome to AutoMATOR

Use the AutoMATOR option to sequentially read, analyze and report a set of listmode files.
AutoMATOR performs batch analysis of stored data using a multi-file protocol.

AutoMATOR allows listmode files to be read and analyzed in a sequential or a predetermined
batch order.

AutoMATOR Setup
© x
1 = to display the set of files last Analysis Eles

Filename | Madified |

o
-~

used. If these files are not required,

Cancel

highlight them and @ Remove Files.

[
[ Bl |
Add Files... |
Eemove Files |
Reordering Files Add Blank |
Add Files Panelize |
Remove Files tep |
Add Blank I Restare Analysis Files on Startup Load Queue |
Panelize [~ Show full pathname ﬂl Save Queue |
Load Queue — Dutput Options
Save Queue [ Prirt Plats [~ Print Plats to POF
Print [¥ Print Stats I Prirt FlawPAGEs ta PDF
Restore Analysis Fﬂes on Startup [¥ Prirt FlowPAGEs I Publish Fiesults

Show full pathname

Output Options

2 @ AddFiles.. | o LoadQuese | (6 select the required files.
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3  Navigate to the correct directory and locate the relevant files.

4  Select the relevant files by highlighting with the mouse. To select more than one file,
hold down (Ctl} and click the relevant files with the mouse button (to deselect, click again
while is held down).

5 @ Open.

The files are listed in the AutoMATOR Setup dialog box.

6 @ to accept changes. does not apply any of the changes made.

Note: To select all the files, press (Cti)+A).

Status Icon:

T Pause The Auto Pause function pauses the run of tests pauses and then
carries on with the rest of the panel automatically after a
15-second wait. The countdown shows on the AutoMATOR
Status Bar. When the tests are in the Auto Pause setting, you can

hold down and click the Pause | ! | button. overrides
the Auto Pause, placing the AutoMATOR into Continuous Pause.

[

To restart, click the Run button and the test resumes from
the point at which it was paused.

M Continuous Pause Pauses the tests for modifications and remains on pause until you
decide that processing continue. This function allows the test to
stop without reverting to the beginning of the panel again. To

b

resume the test, click the Run button.

4 Continue Plays back the indicated file without pausing.
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These icons allow you to insert a pause or a stop into the panel, or let the panel run straight
through from start to finish. Clicking repeatedly on the icon until it displays the desired
status modifies the status in the highlighted file.

+ . NFileO01 LMD
+ L NFileO0Z LMD
+ L NFileO03.LMD
ZE B ..\File004.LMD

In this example, the four files would run and then pause before printing. This allows you to
make any necessary alterations to the plots and regions before outputting results.

Report Icon:

Once the files have been panelized, the report icon only appears next to the last file, as
a report print out would only be produced after all files in a group have been run.
(This differs from Acquisition Manager where there is a printout after each test that
has run). This is providing that the correct Output Options have been selected.

Once the files have been panelized, you can select all or a block of the files so that they are
highlighted. If the icon on one of the highlighted files is changed, all of the other selected files
change to the same icon simultaneously. To change the status settings for one file only,
highlight the file and then click on the icon until it changes to the desired status.

Reordering Files

Once all files are listed, they can be arranged in File Name or Date and Time order by clicking
on the relevant column title. Rearrange files by Dragging and Dropping them.

1 @ on the relevant file so that it is highlighted.

2  Hold the mouse button down and drag the file to the appropriate position so that it is
between two file names.

3  Release the mouse button.

If there are a number of files in the AutoMATOR Setup dialog box, you can either use the
scroll bar, or utilize the Drag and Drop option.
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Select a file using the mouse, keep the mouse button held down and drag to either the top or
the bottom of the window. Moving the cursor outside the window scrolls the list. The further
the cursor is pushed to the top/bottom, the faster it scrolls.

Add Files

Select this option to display the Open Listmode File dialog box. You can then peruse other
Files in various drive and directories and add them to the list.

Select the name of the listmode file(s) you want to add.

Remove Files

When selected, this option removes any highlighted files within the AutoMATOR Setup
dialog box. The button performs the same function.

Add Blank

A Blank is used to fill a space when there is an incomplete panel of listmode files, so that the
results from the tests are kept in the correct order and a complete panel is maintained.

When selected, this option puts a blank at the end of the file list. This can then be Dragged
and Dropped into the required position.

Panelize

This sets all the highlighted files into groups to easily select the Run, Pause or Stop replay
options.

Load Queue
Displays a dialog box to load a queue file.

Save Queue

Displays a save dialog box to save the queue to a file. The files are saved in the LMD
subdirectory under the file extension ALQ.

Print
Print a listing of the files in the queue.

Restore Analysis Files on Startup

If the checkbox is enabled, all the files displayed in the Analysis File list appear in the list the
next time that you log in.

If the checkbox is not ticked, the list is empty the next time you log in.

Show full pathname
Shows the paths to the destination directories for the selected LMD files.

Output Options

These options consist of several checkboxes found at the bottom of the AutoMATOR Setup
dialog box. Check the required output options to print or publish data at the completion of
each sample.
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The options are:

* Print plots as displayed.
* Print statistics only.

* Prints all FlowPAGEs.
If these are not selected, the Page icon appears crossed out, and a report is not printed
from the test.

¢ Publish Plots or FlowPAGES in PDF format.

* Publish Results
Allows the automatic publishing of results to a text file or Microsoft Excel spreadsheet at
the completion of each sample.

AutoMATOR Status Bar

This shows the current file being run and the current state of that file.

AutoMATOR Status x|

I FPauzed - Auto start in 15 zecs.

The AutoMATOR Status Bar, which displays the function that the test is performing, can be
removed from the screen.

Click on the Close button featured on the Status Bar while the AutoMATOR is running.
This hides the bar from view. It automatically reappears again the next time the AutoMATOR
is run. The Status Bar cannot be brought back onto the screen once closed down without
reopening AutoMATOR.

* Processing
This is when the file is being analyzed by the software.

¢ Auto Pause
When this command is active, it informs you as to the length of time left in pause before

P | button

the analysis resumes. If this length of time is not required, selecting the Run
again can restart the analysis.

¢ Continuous Pause
This informs you that the processing is paused and can only continue if you restart the

analysis manually by selecting the Run b [button again.

Listmode Playback

B-80

The Listmode Playback option allows for listmode playback with runtime protocol/panel or
with a new protocol/panel. This option also allows listmode compensation of 20-bit data files
in a fully automated manner, replicating the procedure used during analysis. Compensation
settings may be verified and manually adjusted if required. The Options tab allows setting of
default options during listmode playback.

Note: Panel Reports generated from listmode replay must be run using the Listmode Playback
tool, replaying the listmode files through the desired export panel.
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Single File Mode

E
DA Z s (e EeE

Single File Mode I List Comp Setup I Options I

Panel Filename Compensation Filename

]

I Protocols |Rgn| LMD File I CmplStatusI Savel

Cloze I Help |

This mode allows for single file or panel based listmode file playback, similar to acquisition of
samples.

A single panel may be selected; multiple copies of this panel may be run at a time. Tubes may
be added or removed from individual panels.

Load Queue loads a listmode queue file (a list of listmode files).

Regions may be Loaded or carried within a panel, AutoGating and positives analysis can be
active on any protocol within a panel

Where the source listmode file is a 20-bit data file, comp settings can be from the run time
protocol (stored within the LMD file), from the Compensation settings file created in
ListComp Setup or any *.CMP file may be used.

During playback the title bar displays the current file being analyzed.

Optionally a new file may be saved containing newly compensated 10-bit data. The original
LMD file cannot be overwritten automatically.

Saved files have the suffix entered in the Options tab appended to each saved file.
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List Comp Setup

E
INEEETEEEEE I ET T T
Single File tode  List Comp Setup | Optians I
Panel Filename Compenzation Filename
_I [~ Auto Save
I Param I Protocols |Rgn| LMD File |Status|
Cloze I Help |

This dialog provides an Acquisition Manager style worklist for the selection of compensation
panels and associated protocols. *ppp files created from the protocols used in the

AutoSetup II applications do not need the *_STAND protocol. These *.ppp panels allow you
to replay their associated LMD files to create *.cmp files. For RXP AutoSetup I, if runtime
panels are selected, as these contain Flow-Set fluorospheres protocols which have no use in
this dialog, this protocol is removed from the displayed panel and a warning is displayed.

The dialog is resizable by dragging the corners to the required size.
The settings file name defaults to the name of the panel but with a new *cmp extension.

The Auto Save checkbox allows settings to be automatically written to the settings file that
has the name of the panel selected.

Panels can be created within this dialog, but cannot be used for acquisition. These listmode
panels are saved with a *.ppp extension.

The Parameter field indicates the Compensation parameter within the protocol.
The Status field allows a pause or stop between each file playback.

Note: Listmode Compensation must be performed using the runtime protocol or a protocol
with equivalent parameters as the runtime protocol.
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Options Tab

E
R T

Single File Mode I List Comp Setup  Options |

—Output——————————— [~ Preferences
|_ ] ™ Minimize when running
[~ Print Stats ™ Show File Paths
™ Print FlowPAGE s [~ Show Region Filename
[™ Publish Results File 5uffix
[ Publish FlowPAGE as PDF _modified

[~ Publish Plots as FDF

Cloze I Help |

This tab allows setting of default options for the Listmode Playback. Print options, publish
functions, file save naming options are set in this dialog box.

File Sorting - In the Listcomp setup or Single file mode options, listmode files may be sorted
using the LMD File Listing option. This allows files to be sorted alphabetically, or by Time /
Date modified. Files may be Dragged and Dropped. Individual files may be selected and
moved up or down the list using the arrow buttons.

The start of each panel is indicated by an arrow.

A Show File Path checkbox allows the full file path for each file.

x4
LMD Files | Modified |
== C:ACytomics\U sershadminLMD2c Meg Control LMD 01/08/02 17:40:52
C:hCytomics'U sershadmintLMD\2c CO3 CO4.LMD 01/08/02 17:42:02
C:ACytomicshU sershadmintLMD\2c CD3 CDE.LMD 01/08/02 17:43:16
C:ACytomicshU sershadmintLMD\2c CD3 CO19.LMD 01/08/02 17:44:28
C:ACytomicssU sershadminLMO\2e CO3 COSE. LMD 01/08/02 17:45:40

e L

k. I Cancel | Help | ¥ Show file path

AutoSetup Application Defintion

IMPORTANT Risk of erroneous quality control statistics. Panels containing QC regions must be
constructed from individual unique protocols. Do not use a panel constructed from one protocol (with
different parameter names) for QC database purposes.
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Use the Application Definition Wizard to define your applications and save these definitions
to be used in the Autosetup Scheduler. The application definition captures the instrument
setup, lasers, parameters, fluorochromes, target channels, verification and alignment
requirements of a particular application. See APPLICATION DEFINITION WIZARD in the
Instructions For Use manual to run the wizard.

AutoSetup Scheduler
Use the AutoSetup Scheduler to select the applications to be run on the instrument in a given
day or "shift". AutoSetup Scheduler groups the selected applications for efficient set up of
multiple applications simultaneously and provides the carousel load report to facilitate the
setup and loading of samples for daily QC. See AUTOSETUP SCHEDULER in the
Instructions For Use manual to run the scheduler.
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B.20 PLOTS MENU

Plots - Introduction

CXP software can display eight Plot types and the Legend for Color Gated Plots. When a Plot
is displayed, click the right mouse button to display further menu options.

Note: You cannot add or duplicate plots when running a locked protocol.

Color Dot Plot

Histogram Plot

Contour Plot

Density Plot

Overlay Histogram Plots (CXP Analysis software only)
Tomogram Plot (CXP Analysis software only)

Surface Plot (CXP Analysis software only)

Prism Plot

Legend

Info Plot

Duplicate Plot

This option creates an exact duplicate of the currently selected Plot.

(ctr)+{D) may be used as a keyboard shortcut for the same function.

Color Dot Plot
The Color Dot Plot option provides two-parameter displays of data and allows any
combination of the parameters to be selected. Each dot in a Color Dot Plot represents one
event (cell or particle). The dot location gives the parameter values for each event. Each
parameter can have a channel number from 0 to 255 for 256 channel data or 0 to 1023 for
1024 channel data. The colors of the dots reflect the Gate or combination of Gates used to
create the plot.

To Create a Color Dot Plot:

 Usl
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From the dialog box displayed, select x|
the required File, then select desired Labsing | Fot | StpandSave |
Gates, Parameters and Regions for Data Source Events |  Resolution
display. File Gate
Dot Plot Data Source [5C2Las veity 8133 7 -
Dot Plot Events # Parameter ' Parameter
Dot Plot Resolution | 55 Lin: 55 Lin | |F5 Lin: F5 Lin =l
Dot PlOt Labeling [~ spply gate to all plotz
Font ™ Apply % on plot to all plots

I I Shaw % on plat
Stop and Save (Acquisition only) S
Note: You cannot make any changes on
this screen when running a locked 0K | Cancel Help

protocol.

When a Plot is displayed, click the

Copy Plot Image

right mouse button within the plot to Copy Plat Data
display further menu options. Format
Copy Plot Image

Copy Plot Data

Format Plot

Copy Plot Image

Copies the current plot image into memory for pasting into other applications. See Copy for
more details.

Copy Plot Data

Copies the raw plot data into memory for pasting into other applications, such as Microsoft
Excel.

Format Plot
Displays the Plot Properties dialog box for the current plot. See Format Plot.

Dot Plot Data Source

Choose the X and Y parameters for the current plot. Gating equation and regions to be
displayed can be selected.
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File x
Gate Labeling | Font I Stop and Save
X and Y Parameter Diata Source I Ewvents I Resolution
Apply Gate to All Plots Fie
Apply % on plot to all plots [5C 2L a5 Veiiy 81332 7]
ShOW (%) on plO[ # Pararneter ¥ Parameter

|55 Lin: 55 Lin =l |FsLinFsLn |
Note: You cannot make any changes on this screen

] [ &pply gate to all plots

when running a locked protocol. I~ Apply % on plot to all plots

[T Show % on plot

] I Cancel Help

File

Select the required file from the files already in memory, displayed in the drop down box, or
click the browse button to explore your directories for the required file (Analysis only).

Browse Button

Allows you to peruse other directory options and select files as appropriate.

X and Y Parameter

Select the required parameter for display from those available in the list.

Gate

Available Gates are listed. Gates required for Advance Precedence should be selected at this

point. See Modify Color Precedence.

Apply Gate to All Plots

To select this option, enable the checkbox and apply the gate selected to all plots.

Apply % on plot to all plots

Displays the % of events in the regions on all plots.

Show % on plot
Displays the % of events in the regions on this plot only.

Dot Plot Events

Use this to specify the percentage of events to view. This option significantly increases the

speed at which dot plots refresh if large data files are being analyzed. For an event interval less
than 100%, data is displayed uniformly from within the whole of the data file, that is, if 10%
of events are selected then event numbers 1, 11, 21, 31, and so on, are displayed if they meet

the Gating criteria for the plot.

The default value for the number of events to display can be set in the File » Workspace

Preferences and selecting the Plot Display tab.
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No. of Events to Show
Apply to All Plots

Note: You cannot make any changes on this screen
when running a locked protocol.

See also:

Workspace Preferences - Plot Display
Dot Plot Data Source

Font

No. of Events to Show

Dotplot Properties
Labeling I Font | Stop and Save

Data Source Events Resolution

Total Mo. of Everts 21374
*age Total Events 100

Mo. of Events to Show 21374

|

™ &pply to all plots

o]

Cancel I Help

Place the cursor on the Slide bar and move to change the No. of Events to Show.

Apply to All Plots

Enable this checkbox to apply the No. of Events to Show to all Plots.

Dot Plot Resolution

Set the number of channels for the X and Y Axis of the Plot.

Note: You cannot make any changes on this screen when running a locked protocol.

The available options allow for 64, 128, 256 and
512 channels to be displayed on the axis.

A higher resolution gives an improved graphic
image whereas a lower resolution allows faster
redrawing of that image.

Note: If a higher resolution is selected, a sufficient
number of events is required to produce a visually
acceptable graph.

Dot Plot Labeling

The options here allow you to override the default plot display options for the current plot.

This is useful when capturing images for publication.

x
Labeling I Font I Stop and Save |
Data Source I Events Resolution
Fiesolution of plot
ak. I Cancel Help
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Show Plot Title on Output
Show Axis Tick Marks
Show Axis Labels

X and Y Axis Labels

Note: You cannot make any changes on this screen
when running a locked protocol.

Show Plot Title on Output

USING CXP SOFTWARE

PLOTS MENU
x
Data Source I Ewvents I Resolution
Labeling | Font I Stop and Save

¥ Show plat title on output
¥ Showi avis tick marks ¥ Show = axiz labels
[V Show'r avis tick marks W Show Y axiz labels

A axis label |$S TAIM Pick |
Y awiz label |$S TAlM Pick |

I

by
] I Cancel I Help

Unchecking this option prevents the plot title from appearing when the plot is printed or

exported.

Show Axis Tick Marks

Unchecking these options hides the axis scale tick marks and labels.

Show Axis Labhels

Unchecking these options allows the axis parameter name to be hidden.

X and Y Axis Labels

Allows custom naming of the parameters on the current plot, any FCS keyword or text may
be entered. Alternatively select Pick to select from File Name, Stain name ($PnS) or Parameter

name ($PnN).

Font

Note: You cannot make any changes on this screen when running a locked protocol.

Select the required Font Type, Font Style and Point
Size.

Other font attributes available are Underline,
Strike-Out and Text Color. The default color is black.

The Apply To All Plots checkbox allows the selected
font to be applied to all the currently displayed
plots. You should choose True Type fonts so that X
and Y axis displays are available.

Dotplot Properties
Data Source | Ewents I Resolution
Labeling Farit I Stop and Save

Bold 3

Italic
Bold ltalic

Fr Arial Black
T Anial CE
T Al CrR
Hr Arial Greek
T Arial TUR
Fr Comic Sans M5 ~ Sample
T Courier New LI

AaBhCoDd

Text Color. [N |~

[~ Underine [~ Stike-Out o Apply To All Plots

ak. I Cancel | Help
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Histogram Plot

B-90

To create a Histogram Plot:

Single parameter histograms show the frequency distribution of the chosen parameter. All
histograms can be customized, that is, Colors, Gate for histogram, Scaling, and so on.

U=

From the Data Source dialog box
displayed, select the required File, then
select desired Gates, Parameter and
Regions for display.

Histogram Plot Data Source

Histogram Formatting

Histogram Scaling

Histogram Labeling

Font Annotations

Stop and Save

Note: You cannot make any changes on
this screen when running a locked
protocol.

Histogram Plokt Properties k

Labeling | Stop and Save

D ata Source | Hiztogram

File:
IEC 2L AS Verify 8133+ "I

Parameter

IFL3 Log: FL3 Log 'I

[~ Apply gate to all plots
™ Apply % on plot to all plots
™ Show % on plat

Gate

Fort
Scaling

o]

Cancel

Help

When a Plot is displayed, click the
right mouse button to display further
menu options.

Copy Plot Image
Copy Plot Data
Format Plot

Histogram Plot Data Source
Choose the parameter and gate for the current plot. Gating equation and regions to be

displayed can be selected. Note: You cannot make any changes on this screen when running a
locked protocol.

Copy Plot Image
Copy Plat Data

Farmat
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File

Gate Selection

Parameter

Apply % on plot to all plots
Show % on plot

Parameter

USING CXP SOFTWARE
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Histogram Plot Properties k

Labeling | Stop and Save I Font
Drata Source I Histogram I Sealing
File:
IEC 2L A5 Verify 8193 'l
Parameter

IFL3 Log: FL3 Log 'l

™ Apply gate to all plots
[~ &pply % on plat to all plats
[T Show % on plot

] I Cancel Help

Select the required parameter for display from those available in the list.

Histogram Plot Configuration

Use Gate Color
Smooth
Freeze Frame

Note: You cannot make any changes on this screen
when running a locked protocol.

Use Gate Color

Histogram Plokt Propetrties

Labeling I Stop and Save I Font
[iata Source Hiztograrn | Sealing

—Histogram

V¥ Use Gate Color |'|

¥ Smoath

— Freeze Frame
I INone Selected

I INone Selected 'I:E

ak. I Cancel Help

If the Use Gate Color option is checked, the Histogram fill color is the same as the default color
for the Gate that the plot is gated upon, and the Color Select button is unavailable. To change
the color of the Histogram in the selected plot, clear the Use Gate Color checkbox and click the
Color Select button. The colors returned are only those which the display is capable of

rendering.

Smooth

If the Smooth box is checked, the visual representation of the Histogram is smoothed.

Freeze Frame

Check a Freeze Frame box to assign the current Histogram. The top button creates a dotted
overlay and the bottom button creates a dashed Histogram.
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The current Histogram is assigned to whichever Overlay button is selected and its name
appears in the edit box adjacent to the button. This legend may be modified if desired.

In order for Freeze Frame to work in blote

Acquisition, ensure that pass plots is set up

in the Acquisition Manager. e
+
+

Histogram Freeze Frame

CXP software allows the display of up to three Histograms on each single parameter
Histogram. The base Histogram is the one that relates to the current listmode file and the
other two can be overlays from any other compatible file. Statistics are calculated from the
base Histogram only.

The other two overlays are for comparison only and no statistical information can be obtained
from them.

See also:
Create a Histogram Freeze Frame
Delete a Histogram Freeze Frame Overlay

CXP software Multi File Analyses allows any number of overlays to be displayed in a 2D or
3D Gallery Plot using the Overlay Histogram Plot.

Create a Histogram Freeze Frame

In order for Freeze Frame to work in Prote

Acquisition, ensure that pass plots is set up

in the Acquisition Manager. g
4+
4+

1 Readin a file or acquire data to be assigned as an overlay (for example: a negative
control).
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2  Highlight the chosen single parameter Histogram to be used as an overlay plot (click on
the title bar).

3  Click the right mouse button on the plot and @ Format Flot ' then @ the

Histogram tab. See also Histogram Formatting.

4  Check a Freeze Frame box to assign the current Histogram. The top button creates a
dotted overlay and the bottom button creates a dashed Histogram.

9 The current Histogram is assigned to whichever overlay button is selected and its name
appears in the edit box adjacent to the button, this legend may be modified if desired.

6 @ Or press to accept any changes.

7 @ or press to exit the dialog box without saving the changes.

Now you can open another file or acquire a positive sample. The new data is displayed as
the base histogram and the previous sample is seen as an overlay.

Delete a Histogram Freeze Frame Overlay

1 Highlight the plot containing the unwanted overlay (click on the title bar).
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2 Click the right mouse button on the plot and @ Format Plot then @ the

Histogram tab.

3 Clear the appropriate Overlay Histogram checkbox to delete an overlay.

4 @ or press to accept any changes.

5 @ or press to exit the dialog box without saving the changes.

CXP software then updates the display.

Histogram Scaling

Clip Channels
Automatic Maximum Value
Set Maximum

Note: You cannot make any changes on this screen
when running a locked protocol.

Clip Channels

Histogram Plok Properties

I Stop and Save

Labeling
Data Source

V¥ Clip Channels

I Histogram

W Automatic Maximum Yalue

Set M aximum

—

Fant
Scaling

o]

Cancel

Help

If Automatic Maximum Value calculation is used then toggling the Clip Channels on ensures
that the bottom and top channels are excluded from the calculation of the plots full-scale

value.
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This option searches the histogram for the maximum value and then sets the value found to

be the full scale for the histogram.

Set Maximum

If the Automatic Maximum Value button is cleared, then any value entered here is the full

scale for the histogram.

Histogram Labeling

Use the options here to override the default plot display options for the current plot. This is

useful when capturing images for publication.

Show Plot Title on Output
Show Axis Tick Marks
Show Axis Labels

X and Y Axis Labels

Note: You cannot make any changes on this screen

when running a locked protocol.

Contour Plot

Histogram Plot Propetties x|
[ata Source I Histogram I Scaling
Labeling | Stop and Save I Font

W Show plat title on output
[V Show i avis tick marks W Show X axiz labels
¥ Showy axis tick marks W Show Y axiz labels

# asis label |$S TAIM Fick = |
' axis label |$S TAlIM Pick |

s

] I Cancel I Help

The Contour Plot option (CXP Analysis Software only) provides two-parameter displays of
data. Each event has a position on the plot according to its channel values for both
parameters. Contour lines on the plot provide a third dimension by indicating the channel
numbers containing the same event count or frequency count. (ISO-count contours).

To Create a Contour Plot:

1 @

2  From the Data Source tab box, select the required File, then select desired Gate,

Parameters and Regions for display.
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3  When a Plot is displayed, click the Copy Flot Image
right mouse button to display further Copy Plot Dgla

menu options. Format

Copy Plot Image
Copy Plot Data
Format Plot

See also:

Contour Plot Data Source
Contour Plot Configuration
Contour Plot Resolution
Contour Plot Labeling

Font Annotations

Format Plot

Contour Plot Data Source

Choose the X and Y parameters for the current plot. Gating equation and regions to be

displayed can be selected.

Flle Contour Plot Properties

Browse Button

Gate Selection

X and Y Parameter

Apply Gate to All Plots
Apply % on plot to all plots
Show % on plot

Note: You cannot make any changes on this screen
when running a locked protocol.

X

Data Source | Contour I Resolution I Labeling I Fant I
File Gate
[ ~ | E"“||Llngated -]
# Parameter ' Parameter
[FlilogFlites x| [FlzlogFleles 7]
[T &pply gate to all plok:
™ Apply 3 on plat to all plats
[~ Show % on plat

] I Cancel Help

PN 175570B



PN 1755708

USING CXP SOFTWARE

PLOTS MENU
Contour Plot Configuration
Use this option to specify the contour levels and other configuration preferences.
Contour Level Color x|

Contour Plot Automatic Maximum Threshold
Enter the Maximum Contour Level

Contour Plot Logarithmic Threshold Calculation Level 1
Smooth Contour Plot
Dots for Data < Level 1

Lewvel 2

Lewvel 3

Note: You cannot make any changes on this screen Level 4
when running a locked protocol. Level 5

Cantour Level Colars

| I
O~
L~
O~
| M|

Data Source  Conkour | Hesolutionl Labelingl Font I

¥ Automatic taximum T hreshald
Masimum Contour Lewvel

o
¥ Logarithmic Threshold Calculation
¥ Smoath Contour Plot
¥ Dots for data < Level 1

Uze Defaults |

] I Cancel I Help

Contour Level Color

A Contour Plot may have up to 5 different ISO-count levels, each of which is represented by a
color. Choosing the appropriate button may change the default color for each level.

1 @ the Level 1 button to view the Color dialog box.

2  Select the desired color that is to be allocated to Level 1.

3  Continue as above until all desired changes have been made. @ to accept

all changes.

Contour Plot Automatic Maximum Threshold

This option allows automatic configuration of the maximum value, which is used to calculate
the contour color levels. If this option is cleared you may manually enter the value.

If the Automatic Maximum Threshold is checked, next time the Contour Plot Attributes

dialog box is entered the Automatic Maximum value is displayed.
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Enter the Maximum Contour Level

This option allows the configuration of the Contour Plot manually. Enter the value, which is
used to calculate the Contour Color Levels. The manual value can only be active when the
Automatic Maximum Threshold checkbox is cleared.

Contour Plot Logarithmic Threshold Calculation
Contour color thresholds may be calculated in one of two ways:

* Linear threshold calculation - option cleared
The maximum value is used to determine the threshold value for each color. The actual
threshold value is calculated as follows:

Value = (Level No) x (Maximum In Plot/5) - 1

* Logarithmic threshold calculation - option checked
The maximum value is used to determine the threshold value for each color. The actual
threshold value is calculated as follows:

Value = 10(Level No) x (logl0 (Maximum In Plot/5)) - 1

Smooth Contour Plot
Check this option to smooth the Contour Plot. Clear it to display raw unsmoothed data.

Dots for Data < Level 1

Check this option to see dots placed where data is present as 1 or more events but is at a level
less than defined in level 1.

Note: This option may not appear to function unless smoothing is switched off first.

Contour Plot Resolution
Set the number of channels for the X and Y Axis of the Plot.

The available options allow for 64, 128, 256 and Contour Plat Properties
512 channels to be displayed on the axis.

A higher resolution gives an improved graphic
image whereas a lower resolution allows faster
redrawing of that image.

Note: You cannot make any changes on this screen
when running a locked protocol.

ak. I Cancel Help

Contour Plot Labeling

Use the options here to over ride the default plot display options for the current plot. This is
useful when capturing images for publication.
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Show Plot Title on Output
Show Axis Tick Marks
Show Axis Labels

X and Y Axis Labels

Note: You cannot make any changes on this screen

when running a locked protocol.

Density Plot

USING CXP SOFTWARE
PLOTS MENU

Contour Plot Properties

Data Sourcel Eontourl Resolution  Labeling | Font I

W
[V Show i avis tick marks W Show X axis labels
¥ Show axis tick marks ¥ Show Y axiz labels

% axis label |$s TAIM Fick = |
Y awiz label |$S Tald Pick = |

Ok I Cancel

Help

The Density Plot option provides two-parameter data display, any combination of parameters
can be selected. Each colored area in a Density Plot represents an ISO-count of the number of
events (cells or particles). The color shows the number of events at any X and Y parameter

value.

To create a Density Plot:

1 @

2  From the Data Source dialog box
displayed, select the required File, then
select desired Gates, Parameters and
Regions for display.

Density Plot Data Source
Density Level Configuration
Density Plot Resolution

Density Plot Labeling

Font Annotations

Stop and Save (acquisition only)

Note: You cannot make any changes on
this screen when running a locked
protocol.

Density Plot Properties

Labeling | Font I Stop and Save
Diata Source | Diemsity I Resolution
File Gate
|5c 2L A5 Verify 81932 v[ -
# Parameter ' Parameter
| F5 Lir: FS Lin | |55 Lin: §5 Lin |

[~ Apply gate to all plots
™ Apply % on plot to all plots
™ Show % on plat

ak. I Cancel Help

B-99

B



USING CXP SOFTWARE

PLOTS MENU

B-100

3  When a Plot is displayed, click the Copy Flot Image
right mouse button to display further Copy Plot Dgla
menu options. Format
Copy Plot Image
Copy Plot Data

Format Plot

Density Plot Data Source

Choose the X and Y parameters for the current plot.
displayed can be selected.

File

Gate Selection

X and Y Parameter

Apply Gate to All Plots
Apply % on plot to all plots
Show % on plot

Note: You cannot make any changes on this screen
when running a locked protocol.

Density Level Configuration

Gating equation and regions to be

Use this option to specify the Density levels and other configuration preferences.

Density Level Colors

Automatic Maximum Threshold
Maximum Density Level
Logarithmic Threshold Calculation
Smooth Density Plot

Use Gate Color

Use Single Color Range

Note: You cannot make any changes on this screen
when running a locked protocol.

x
Labeling | Font I Stop and Save
Diata Source Diensity I Resolution
File Gate
|5c 2L A5 Verify 8193 v[
# Parameter ¥ Parameter
| F5 Lir: FS Lin | |55 Lin: 55 Lin |
[~ Apply gate to all plots
[~ Apply % on plat to all plots
™ Show % on plat
ak. I Cancel Help
Denzity Plot Properties |

Labeling I Font I
Density

Stop and Save

Data Source Resolution

Density Level Colars [V Automatic Maximum Threshold

Level 1 -|' Maximum Denzity Lewvel
Level 2 -|' ID
¥ Logarithmic Threshold Calculation
Level 3 I:”' .
¥ Smoath Dengity Plot
Level 4 - [~ Use Gate Color
Level 5 -|Y " Use Single Color Range

Usze Defaults |

o1

Cancel I Help
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Density Level Colors

This Plot may have up to 5 different ISO-count levels, each of which is represented by a color.
Choosing the appropriate button may change the default color for each level.

1 @ the Level 1 button to view the Color dialog box.

2  Select the desired color that is to be allocated to Level 1.

3  Continue as above until all desired changes have been made. @ to accept

all changes.

@ or press to exit the dialog box without saving the changes.

Automatic Maximum Threshold

This option allows automatic configuration of the maximum value that is used to calculate
the Density Color Levels. If this option is not selected you may manually enter the value
which is used to calculate the Density Color Levels.

Maximum Density Level

Configure the Density Plot to manually enter the value that is used to calculate the Density
Color Levels. This option is only active when the Automatic Maximum Threshold button is
cleared.

Logarithmic Threshold Calculation
Density color thresholds may be calculated in one of two ways:

* Linear threshold calculation - option toggled off
The maximum value is used to determine the threshold value for each color. The actual
threshold value is calculated as follows: -

Value = (Level No) x (Maximum In Plot/5) - 1

* Logarithmic threshold calculation - option toggled on
The maximum value is used to determine the threshold value for each color. The actual
threshold value is calculated as follows: -

Value = 10(Level No) x (logl0 (Maximum In Plot/5)) - 1
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Smooth Density Plot
Choose this option to smooth the Density plot. Clear it to display raw unsmoothed data.

Use Gate Color
Creates a single color density range based on the currently assigned gate color.

Use Single Color Range
Creates a range of density level colors based on the selected Level 1 and Level 5 colors.

Density Plot Resolution
Set the number of channels for the X and Y Axis of the Plot.

The available options allow for 64, 128, 256 and

X
512 channels to be displayed on the axis. Lbsivg | P | SwpandSave |
Data Source I Density Rezalution
A higher resolution gives an improved graphic oot ol
image whereas a lower resolution allows faster
redrawing of that image.
Note: You cannot make any changes on this screen
when running a locked protocol.
[ ok | cancel Help
Density Plot Labeling
Use the options here to override the default plot display options for the current plot. This is
useful when capturing images for publication.
Show Plot Title on Output x|
ShOW AXlS Tle Marks Data Source I Dengity I Resolution I
Show Axis Labels Labelng | Font | StopandSave
X and Y Axis Labels ,
[V Show ¢ axis tick marks . [V Shaw % axis labels
Note: You cannot make any Changes on this screen I Shaw'y asis tick marks [V Show ¥ awis labels
when running a locked protocol. X s label  [$5TAIN Pick |

Y awis label |$S TAIM Pick = |

s

] I Cancel Help
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Overlay Histogram Plots

Open Overlay Plot

The Overlay Plot (CXP Analysis only) displays and compares multiple histograms. The
Overlay Toolbar becomes active once an Overlay Plot is created or selected.

1 @ - to open a new Overlay Plot.

2  Data can be retrieved from Listmode Files, from stored Histogram Files or dragged in
using the Drag and Drop feature from histograms open in the Workspace. To include

data from a Listmode File, @ from the overlay toolbar. To include data from a

Histogram File, @ Insert » Overlay Histogram.

See also, Adding a Histogram to the Overlay Plot

Overlay Plot Mode

The Overlay Plot has three possible views by selecting the appropriate icon from the Overlay
Toolbar as follows:

o Gallery
Lo ks

™ Overlay
- Angled

The plots are automatically shown in Gallery Style. This is the default, which may be changed
using Workspace Preferences - Plot Display and Default Overlay Mode.

The Overlay plot - Gallery Mode, allows the overlay of a control sample on all plots and
subsequently allows histogram subtraction and the calculation of Kolmogorov Smirnov
Statistics and Overton Statistics.

Adding a Histogram to the Overlay Plot

A histogram may be added to the overlay plot by either opening a stored histogram file, or
inserting a histogram derived from a listmode file or by dragging a histogram plot from the
workspace to the overlay plot.
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To Add plots from a stored listmode file:

1 Click the Insert Histogram button, or

|

Files already in use are displayed on the
left hand side, additional files can be
added to the list using the More Files & MoeFies. |

browse button. Gote R - |
ak. I Cancel | Help |

2  Highlight the required files — parameters common to all selected files are displayed in a
list on the right hand side of the dialog box.

3  Highlight the required parameters for display.

4 @ the required gate from the list of gates available.

5 @ to add these histograms to the Overlay plot. aborts the

operation.

To open a stored histogram file:
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open 21|
1 @ H and Navigate to the folder Loak i | (3 HST s emsE

: - 20 €03 (D19 Lymph FL1 Log.HST 2t €03 CDE Lymph FL1 Log.HST
where the hlstogram files are stored. [#] 2 D3 CD19 Lymph FLZ Log.HST  [3] 2c CD3 CD& Lymph FLZ Log.HST

2c D3 CD4 Lymph FL1 Log. HST 2c Meq Control Lymph FL1 Log, HST
2c D3 CD4 Lymph FLZ Log, HST 2c Meq Control Lymph FLZ Log, HST
2¢ CO3 056 Lymph FL1 Log HST
2¢ C03 056 Lymph FLZ Log HST

2  Highlight the file names to use. To Forene | =
select all, highlight the first file and esotvee [ = I_Cance| |
les ol 2 A -
press +. P istogram Files |A

3 @ . CXP software now displays all chosen files.

The plots are automatically shown in Gallery Style. This is the default, which may be changed
using Workspace Preferences - Plot Display and Default Overlay Mode.

The Plots can be Annotated with relevant notes/comments, see Annotation.

See also, Overlay Plot Mode

Rearranging Overlay Histograms - Plot Sorter
Overlay Histograms can be rearranged within the Gallery View.

Moving an Individual Histogram
To rearrange the order of the histograms:

1 Select Gallery Style using the Gallery button

2 Select the desired histogram by clicking the left mouse button, holding it down and
dragging the histogram to its new position.
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3 A gray line appears to the left-hand side of the histogram as the plot is dragged.

4  Using the gray line as a marker, Drag and Drop the highlighted histogram to its new
location.

9 Release the mouse button to complete the move.

Moving Several Histograms
To move more than one histogram at a time:

1 Select Gallery Style using the Gallery button

2 Select the desired histograms by holding down and, using the left mouse button,

@ on each histogram until all relevant histograms are highlighted.
Note: (ctl)+(A) is a quick way of selecting all the plots.

3  still holding down (ct), hold down the left mouse button and drag all the histograms to
their new positions. A gray line appears to the left-hand side of the first chosen
histogram.

4  Using the gray line as a marker, drag the highlighted histograms to the new location.

9 Release and the mouse button to complete the move.
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See also, Arrange

Deleting Overlay Histograms

1  Highlight the unwanted histogram with the left mouse button.

If more than one histogram is required, hold down and @ the required histograms
with the left mouse button.

Note: (ctl)+(A) is a quick way of selecting all the plots.

2 Press or click the right mouse button and select Cut.

Selecting a Single Overlay Histogram Plot

1 Within the Overlay plot, @ on a histogram to select it.

2 Once a single Histogram Plot within % cu
the Overlay Plot Window has been EW
Fazste

selected, click the right mouse button

and a menu containing the following et as conrol
. FRemove Control
OpthHS appears: Coartral in frant
Cut Formnat
Zoorm to fit
Co -
194 Zoom 4

Paste

Set As Control
Remove Control
Control In Front
Format

Zoom to Fit
Zoom
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Cut

The Cut option takes a copy of the selected histogram and removes the original. This too can
be pasted back into CXP software or into a spreadsheet program. This moves histograms to
another position or to the Windows clipboard. It remains on the clipboard until other text,
data or pictures are copied.

Copy
Copy places the text, data or picture onto the clipboard. The original remains in the
application.

Paste

The Paste option is context sensitive. Pasting inside the overlay plot pastes histograms from
the Windows clipboard at the end of the current histogram set.

You can paste text, data or a picture that were previously cut or copied to the clipboard using
shortcut buttons, the menu, or the keyboard.

Set As Control
This option allows the comparison of a control sample with a test.

1 @ the histogram to be assigned as the Control to highlight it.

2 Click the right mouse button and @ Set as Control.

3 This places the Control histogram onto all the other histograms featured on the overlay
plot, allowing for comparison. The Control histogram is outlined in blue.

4  Only one histogram can be selected as the Control. If a you select a different histogram as
the control, the previous Control histogram is deselected as the Control.

PN 175570B



USING CXP SOFTWARE B
PLOTS MENU

Remove Control
This option removes a previously-set control.

1 Select any histogram by clicking the left mouse button. Click the right mouse button and

@ Remove Control and the blue outline is removed.

Control In Front

If the histogram is filled with color, rather than a single line, the histogram can be set out so
that the Control plot is in front of the other test, enabling easier comparison.

1 @ any histogram, then click the right mouse button to bring the Modify Menu onto
the screen.

2 @ the Control in Front option.

3  The action can be reversed by clicking on the menu and deselecting the Control in Front
option again.

Format

To customize the appearance of histograms within the Overlay, use the Format, Scaling or
General options within the Format Histogram dialog box.

Zoom to Fit
The Zoom to Fit option maximizes the selected histogram within the plot window allowing for
easier viewing,.

1 @ the required histogram, then click the right mouse button to get the Modify Menu.
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2 @ Zoom to Fit.

3 To restore the histogram to its previous size, click the right mouse button and @ Zoom
from the menu.

4 @ the 100% option, which brings the histogram back to its original size.

Zoom

The View » Zoom option allows you to zoom in on a FlowPAGE, or Overlay Plot to 100%,
200% or 400%.

Select the desired view. Selecting 100% returns to the default size.

Selecting Multiple Overlay Histogram Plots

1 Press and @ those histograms required. Click outside to histograms area to
deselect.
Note: You can select all the Plots by pressing (Cti)+{A).
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2 When multiple histograms are selected, Cut
within the Overlay Plot Window, click Copy
the right mouse button and a menu Easte
containing the following options gﬂrmal .

oo bo ik
wppears. i
Copy
Paste
Format
Zoom to Fit
Zoom

Where NO Histogram Plots within the Overlay Plot Window have been selected, and the
Overlay Plot Window is in focus, click the right mouse button to view a menu containing the
following options:

Arrange Plots ¥ Cut

Histogram Mode Copy

Overton Mode [ Paste

Kolmogorov Smirnov Mode Arrange .
Zoom

Remove Control [+ tistogam Mode

Owerton Mode

Folmogoroy-Smimoy Mode

Zoom L4

Remaove Cantrol

Arrange Plots

Allows plots to be automatically arranged within the overlay plot. See Arrange for more
details.

Histogram Mode
This is the default mode and displays the histograms in the order in which they were read.

This is the area in which most of the modifications to histogram formatting is undertaken, for
example, adding statistics and annotations.

Overton Mode

This option subtracts a control histogram from the test histogram according to the algorithm
defined by Roy Overton.
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In order to activate the Overton Mode, you must first set a control by selecting the control
histogram on the Overlay plot, click the right mouse button and select the Set as Control
option. To activate Overton mode, verify that no histograms are selected, then click the right
mouse button in the Overlay plot and select Overton mode.

Results are displayed in the statistics pane also the Overton Percentage can be selected using
the FCS Keyword Annotation Mode or (shi)+($]. This gives the percentage of cells that are
calculated to be positive.

k=3

The Overton subtraction value can be displayed by selecting the Overlay Statistics
button.

For additional information, see Modified Histogram Subtraction Technique for Analysis of
Flow Cytometry Data; W Roy Overton; Cytometry 9:619-626 (1988).

Kolmogorov Smirnov Mode

This allows the statistical comparison of two tests to determine the probability of the two
plots being different.

In order to activate the Kolmogorov Smirnov mode, you must first set a control by selecting the
control histogram on the Overlay plot, click the right mouse button and select the Set as
Control option. To activate Kolmogorov Smirnov mode, verify that no histograms are selected,
then click the right mouse button in the Overlay plot and select Kolmogorov Smirnov mode.

The Kolmogorov Smirnov test D Value and probability value can be displayed by selecting the

Opverlay Statistics P button.

If an annotation is placed on the plot while in Kolmogorov Smirnov mode, and the FCS
Keyword Annotation Mode is entered Shift/$, the Chi Squared option can be selected giving the
Chi Squared value for the plot compared to the control.

See also:
Overlay Plot Mode
Rearranging Overlay Histograms - Plot Sorter

Overlay Histogram Plot (Format Tah)

Use the Format option to customize the line style, color, weight, background color and the fill
color of the histograms.
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Line x
Flll Farmat |Scahng| Generall
Plot Background Lin
£ Automatic Shyle: _.l
Color: NN -
Wfeight: vl
" Automatic
 Mone
& Custom Fill Color gl
r— Plat background
£ Automatic
= Mone
 Custom Eackaround Color |v|

0k, I Cancel | Lipply | Help |

Line

Automatic Automatically assigns a color to the line.

None Makes the line around the histogram data points transparent.
Custom Selects the line style, color and weight.

Style Changes the line from a solid to a broken line.

Color Selects a line color or define a new line color.

Weight Changes the width of the line.
Fill

Automatic Automatically assigns a color to fill the histogram.

None Makes the area under the histogram line transparent.
Custom Selects a fill color or define a new fill color.
Plot Background

Automatic Automatically assigns a color to the background.
None Makes the background transparent.
Custom Allows a user selectable background color for each histogram.
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Overlay Histogram Plot (Scaling Tah)

When a control is overlaid on a test, select one of x
the options to change the scaling. Fomat Scaling | Genersl|

 Scaling
Make the Number Of EVentS.... ' Make the number of events an both histograms equal then

scale to the greatest value on the plots

Scale Each Histogram....

Absolute Counts

" Ahsolute counts - the contral ahd sample histograms are
CUStom scaled to the peak value of both histograms

' Hcale each histogram to 100% of the peak value

© Custam Max ¥ Walue  [451

The Sample graph gives a preview of the effect a
particular scale mode has on the plots. - Sample

Change the zcaling mode to get a
preview of the effect it will have on
your averlay plots,

u]: I Cancel Spply Help

Make the Number of Events....

This option normalizes the total number of events on both histograms and then scales both to
the greatest value on the plots. Use this option for control and test files that have different
numbers of events.

Note: If the control histogram has more events than the test histogram the control histogram
is not normalized.

Scale Each Histogram....
This option scales each histogram to 100% of its peak value.

Absolute Counts

This option scales both test and overlaid control histograms to the greatest value found on
either histogram.

Custom

Use this option to enter the Max Y Value required. This scales both the test and the overlaid
control to the same value.
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Overlay Histogram Plot (General Tah)

Plot Options 11
Axis And Tick Mark Labels -
. Farmat I Scaling  General |
X Axis Labels :
r— Plot option
Slide here to adjust the
smaoothing of the histagram
¥ Show ads tick marks ¥ Show X axis labels
¥ Show' axis tick marks ¥ ShowY axis labels
R awds label  [$STAIN Pick =
— Sampl
Change the smaathing level to get a
preview of the effect it will have an
your overlay plots.
akK I Cancel | Apply Help
Plot Options

The slider bar allows adjustment of the smoothing level. Selecting <0> shows the data at full
resolution. Levels of smoothing can be applied by sliding the bar to the right up to a
maximum of <3>.

Axis And Tick Mark Labels

Checkboxes enable you to hide or show X/Y axis tick marks and X/Y axis labels. Select the
desired options for display.

X Axis Labels

FCS Keywords can be selected using either the Pick drop down list option, which gives
Parameter, Stain and File Name, or a user definable keyword may be used. Alternatively, free
text may be entered.

To apply the changes made on the Format, Scaling, and General tabs, click the Apply button
featured on the bottom of each tab.

Clicking applies the changes, and removes the Format Histograms box.

removes the box without applying the changes onto the required histograms.

All changes made in this option can be undone by selecting the Edit» Undo menu.
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Arrange

This allows the Overlay Histograms to be arranged By fie no

in a particular order and displays four alternative By sitian
ways of arranging histograms. By stain
By parameter

Call up the Context Menu by clicking the right
mouse button anywhere on the plot No histogram
selected.

Select the Arrange option, which gives the choice of the following:

By File Number Arranges the histograms in order of file number.

By Deviation This orders histograms according to the difference between the test and the
control on a mean channel basis, one histogram must first be “set as a Control”
for this option to have an effect.

By Stain Arranges the histograms according to the user-defined stain parameter name.
By Parameter This arranges the histograms according to the original parameter name.

Annotations - Introduction
This section describes how to place an annotation onto an overlay plot.

1 @ A on the Overlay toolbar.

2  Click the part of the histogram where the annotation is to be placed so that it is
highlighted.

3  Type in the text.

4  Click outside the annotation area to fix the annotation into position.

Once an annotation is in place, it can be modified as required.
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Format Annotations
See also the Font Annotations Tab.

1 @ first on the annotation to select it, click the right mouse button once on the
selected annotation to display the following menu.

2 Use Cut, Copy and Paste to % Cu
move/remove/copy annotations. Copy
2 Easte

Format Annotations. .

3  Use Format Annotation to select a Fill x|
Color and the Style, Color and Weight of Fomat | Fort |
the line around the the annotation. o’
o ClY O m—
£ Custom =
coor: - |
weight: I v|
— Fill
&N ’
~ EE:;m FilCoor [ ||

0K I Cancel Lpply Help

Font Annotations
The Font dialog box allows you to alter the style, size and color of the font.
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1 @ the font style and size required.

2 A preview of how the new font looks is
shown in the Sample box contained
within the Font dialog box.

3  There is a checkbox to enable you to
underline the text. This can be undone
by unchecking the box. This also
applies to the Strike-Out box. The text
color can also be changed by clicking
on the Text Color box, which reveals a
drop down box. Select the color
required.

Annotation

Format ~ Fant |

T Arial

T Arial Marrow
Hr Book Antigua

T Bockman 01d Style
T Bookshelf Symbol 1
T Bookshelf Symbol 2
T Bockshelf Symbol 3
T Certury Gothic

T Comic Sans MS LI

™ Underine I Skike-Out

Bold
Italic:
Bold Italic

—Sample

AaBhCcDd

Text Color: | -

oK I Cancel

Apply

Help

4  Once modifications are complete, @ and the changes are transferred onto

the histogram.

9 These changes can be undone through Edit» Undo on the toolbar, and the changes are

undone in reverse order.

FCS Keyword Annotation Mode

The FCS Keyword Annotation Mode allows FCS Keywords contained in the file header to be

placed within a histogram.

1 @ one histogram within the Overlay Plot.
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2

|

3 @ the histogram in the required area.

4

Press (Shi)+($) to display the FCS
Keywords.

Comment
Cytarneter
DATATYPE
Date
DFC2TON
Filename
FLOWRATE
G1B

G1E

o L

i)

Double click on the desired field.

6 @ the plot to set the annotation on to the histogram.

Copying an Annotation onto the Other Plots

1 @ an annotation that is already on one of the histograms.

2

Press (Ctl)+(C] to copy.
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3 Press (ci)+(A) to select all or (Cti)+ click each required plot.

4  Press [ct])+V) to paste onto all the other histograms (or use the right mouse button and

@ the Paste option.)

9  Click outside the annotation to fix the annotations into position.
Note: When copying the annotations onto all plots, it is best to Cut from the original
annotation rather than Copy it, so that another annotation does not display over the
original one.

The annotations can be moved within the histogram by clicking on them once and then
Dragging and Dropping to a new position.

Pasting Data from Overlay Plots into a Spreadsheet

Selecting Paste in a spreadsheet program pastes the plot data into a column within the
worksheet. The parameter name is pasted in the first cell.

To transfer data from the CXP software to a spreadsheet:

1 Select the required plot.

2 Click the right mouse button and @ the Cut or Copy option.

3  Go into the spreadsheet program and @ Edit » Paste from the toolbar.

PN 175570B



USING CXP SOFTWARE B
PLOTS MENU

4  This transfers the data from the plot.

9  Multiple plots can be copied in that manner by selecting the required plots (hold down

and @ lots).
p

An alternative option is to @ Tools » Publish Histogram Data Now when the Overlay plot
is in focus. This directly exports all plot data to an Excel spreadsheet and performs
statistical analysis of the selected files.

See also:

Publish Histogram Data Now

Tomogram Plot

The Tomogram Plot option (CXP Analysis Software only) provides three-parameter data
display and any combination of parameters can be selected. Each colored area in a Tomogram
Plot represents an ISO-count of the number of events (cells or particles). The color shows the
number of events at any X and Y parameter value and the third parameter being Z.

Tomogram Plots use colors to show the relative frequency count of events on the display at
any position by using the Density Style View.

Alternatively, a Gate Precedence View can be chosen. Both these views are set, by clicking the
right mouse button and selecting either the Density Style View or the Gate Precedence View from
the menu box displayed.

See the Note at the end of the INSTALLING CXP SOFTWARE procedure about graphic card
drivers for the correct display of Tomogram Plots.

To create a Tomogram Plot:

1 @
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2  From the Data Source dialog box Copy Plot Imags
@ Copy Flot Data
displayed, the required File, then Farmat Al+Enter
select desired Gates, and Parameters for AutoRotate
display. IT Gate precedence vigw
AutoRotate Dengity style view
Gate Precedence View/Density Style
View

3 When a Plot is displayed, click the right mouse button to display further menu options
for which context sensitive Help topics are available.

AutoRotate

Allows the Plot image to automatically rotate and is only available for Tomogram and Surface
Plots.

Gate Precedence View/Density Style View

This option is used to set the Density Style View or the Gate Precedence View, which are mutually
exclusive. See Modify Color Precedence for further information.

See also:

Tomogram Plot Data Source
Tomogram Plot Density
Tomogram Events
Tomogram Resolution
Format Plot

Tomogram Plot Data Source

Choose the X, Y and Z parameters for the current plot. Gating equation and regions to be
displayed can be selected.
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Browse Button

Gate Selection

Select X Parameter
Select Y Parameter
Select Z Parameters
Apply Gate to All Plots

File
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Tomogram Properties

Data Source | Densityl Eventsl Hesolutionl

File Gate

= | [inchde &1 Data |
# Parameter ' Parameter
[Fs:Fs i . E =]
Z Parameter

IFITE: PMT2 LOG 'I ™ Apply gate to all plots

ak, I Cancel Help

Select the required file from the files already in memory, displayed in the drop down box or

- |
click the Browse & button to explore your directories for the required file.

Browse Button

Allows you to peruse other directory options and select files as appropriate.

Select X Parameter

Select the X Parameter from the choice displayed in the drop down box and click the mouse on

the Parameter required.

Select Y Parameter

Select the Y Parameter from the choice displayed in the drop down box and click the mouse on

the Parameter required.

Select Z Parameters

Select the Z Parameter from the choice displayed in the drop down box and click the mouse on

the Parameter required.

Gate

Available Gates are listed in Precedence order, highest precedence being at the top. To
rearrange the precedence order — click to highlight the Gate name ONLY then drag the Gate

to the required position.

Gates required for Advance Precedence should be selected at this point.

Apply Gate to All Plots

To select this option, enable the checkbox and apply the gate selected to all plots.

Tomogram Plot Density

Use this option to specify the Density levels and other configuration preferences.
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Density Level Colors

Automatic Maximum Threshold
Maximum Density Level
Logarithmic Threshold Calculation
Smooth Density Plot

Tomogram Events

Tomogram Properties

Data Source  Density I Eventsl Hesolutionl

Denzity Level Colars

Lewel 1

Lewvel 2

Lewvel 3

Level 4

Level 5

v iutomatic Wasimom T hreshold

-|'| Marimurm Density Lewvel

[T R —

™ Logarithmic Threshold Calculation
E” [~ Smooth Density Plot

Usze Defaults |

[ |

Cancel I Help

Use this to specify the percentage of events to view. This option significantly increases the
speed at which plots refresh if large data files are being analyzed. For an event interval less
than 100%, data is displayed uniformly from within the whole of the data file, that is, if 10%
of events are selected then event numbers 1, 11, 21, 31, and so on, are displayed if they meet

the Gating criteria for the plot.

No. of Events to Show
Apply to All Plots

Tomogram Resolution

Resolution of Plot
Tomogram Slices

Tomogram Properties

Data Sourcel Denzity  Everts | Hesolutionl

Total Mo, of Everts 20037

#age Tatal Events 100

Mo. of Events to Show 20037

i

™ Apply to all plots

o ]

Cancel I Help

Tomogram Properties

Data Source | Density | Events  Resolutian |

R ezolution of plot

Tomagram slices a2

Use Default Position to restore the Default Position |

plot to itz original position

[ ox ]

Cancel | Help
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Resolution of Plot

Set the number of channels for the X and Y Axis of the Plot. The available options allow for
64, 128, 256 and 512 channels to be displayed on the axis.

A higher resolution gives an improved graphic image whereas a lower resolution allows faster
redrawing of that image.

Click on the drop down box and select the required resolution.

Tomogram Slices

The Z Axis resolution is the number of Tomogram slices that are chosen for the third
parameter.

A higher resolution gives an improved graphic image whereas a lower resolution allows faster
redrawing of that image.

Click on the drop down box and select the resolution factor required.

Surface Plot

The Surface Plot option (CXP Analysis only) provides two-parameter isometric display and
any combination of parameters can be selected. Each colored area in a Surface Plot represents
an ISO-count of the number of events (cells or particles). The color shows the number of
events at any X and Y parameter value.

Alternatively, a Gate Precedence View can be chosen. The view is selected using the click the
right mouse button and selecting either the Density Style View or the Gate Precedence View
from the menu displayed.

To create a Surface Plot:

1 @

2  From the Data Source dialog box displayed, select the required File, then select desired
Gates and Parameters for display.
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3 Whena Plotis displayed, click the Capy Plot Image
right mouse button to display further Copy Plot Data
menu op[ions, Format Al+Enter
AutcRotate
IT Gate precedence view
Density style view
See also:

Surface Plot Data Source
Surface Plot Density
Surface Plot Events
Surface Plot Resolution
Format Plot

Surface Plot Data Source
Choose the X and Y parameters and the gating equation for the current plot.

Flle Surface Plot Properties x|

Browse Button

Gate Selection

X and Y Parameter
Apply Gate to All Plots

Data Source | Densit_l,ll Eventsl Flesolutionl

File: Gate

= | IUngated 'I

# Parameter ' Parameter

i i [Fs:Fs ElF o |ss:ss =l
Note: The Region button is grayed out for the

[~ Apply gate to all plots
Surface PlOt. Feaions... |
ak. I Cancel | Help |

Surface Plot Density
Use this option to specify the Density levels and other configuration preferences.

Density Level Colors £

Automatic Maximum Threshold
Maximum Density Level

Data Source  Density | Eventsl Hesolutionl

) ) ) Denisity Lewvel Colors [+ iButomatic Masimom T hreshold
Logarlthmlc Threshold Calculatlon Level 1 -l'l Mawinnum D ensity Level
Smooth Density Plot Levei2 | [oo

™ Logarithmic: Threshold Calculation

T I W Smooth Densty Flot

Lewvel 4 - |'|
Usze Defaults |
Level & - |'|

] I Cancel | Help
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Surface Plot Events

Use this to specify the percentage of events to view. This option significantly increases the
speed at which surface plots refresh if large data files are being analyzed. For an event interval
less than 100%, data is displayed uniformly from within the whole of the data file, that is, if
10% of events are selected then event numbers 1, 11, 21, 31, and so on, are displayed if they
meet the Gating criteria for the plot.

No. of Events to Show x
Apply to AH PIOtS Data Sourcel Density  Events | Hesolutionl

Total Mo, of Everts 20037
%age Total Events 100

Mo. of Events to Show 20037

™ Apply to all plots

] I Cancel I Help |

Surface Plot Resolution
Set the number of channels for the X and Y Axis of the Plot.

The available options allow for 64, 128, 256 and |
512 channels to be displayed on the axis.

Data Sourcel Densit_l,ll Events Resolution |

A higher resolution gives an improved graphic Resalution cf pot
image whereas a lower resolution allows faster
redrawing of that image.

Uze Default Position ta restors the Lefault Position |

plot ko itz original position

ak. I Cancel | Help |

Prism Plot

A Prism Plot is a way of displaying all the subpopulations or phenotype percentages of a
multi-color immunocytometry analysis protocol.

The Plot represents the relative percentages of each subpopulation (phenotype) and the
number of phenotypes depends on the number of color parameters being simultaneously
analyzed. Prism Plots can be customized, for example: Gate for Prism, Scaling, and so on.

To create a Prism plot:
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1 @@.

2  An empty Prism plot window is displayed with the Data Source dialog box overlaying it.

3  Make the desired changes.
Data Source (Prism)
Format Plot

The plot type with the current Gate is displayed in the plot window. Ungated is the
default.

Data Source (Prism)
Choose the File and Gate to be used for the Prism plot.

File CrrrE—
Browse Button Data Source | Fant |

Gate Selection
Apply Gate to All Plots

File Gate

= | IUngated 'l

™ Apply gate to all plots

QK I Cancel Help
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What is Prism?

The Prism parameter is a method of summarizing P [1.PRISMAD.LMD PRISM A =Y
multi-parameter surface marker data as a

one-dimensional Prism plot representing all
possible subpopulations or phenotypes.

4030

36.0%

The Prism plot is a simple bar graph. The height of i 2 5
each bar represents the count of each phenotype. - .
The count as a percentage of all events or gated i
events is written adjacent or above each bar. The :
prism plot can be gated, in which case the % values -
represent the percentage of gated prism events and | 61.6%
the gate is indicated in the title bar.

How is Prism Created?

In single parameter analysis of surface marker data, one or two regions are normally set to
measure both Negative and Positive cells. We can then look at a second parameter and
calculate the 2 phenotypes from parameter-1 positive populations and the two phenotypes
from parameter-1 negative populations (four phenotypes in total).

We can repeat this with 3, 4 or more parameters.

The Prism Divider can be used instead to mark the dividing line between the Negative and
Positive cells.

Divider 1 +
-~
W& COMpOon z(-+)
Divider 2 + *
. .

Phen e components:(/(-+}(+.}(+
- + I + l + I ¥ I
Divider 3
. - - .

Phenotype components: (---] (-——+ {-+-J-++ (-l pl++4)

Phenotype components are written from left to right as (Divider 1, Divider 2, Divider 3.}

Prism Dividers

A Prism is created by setting one or more prism dividers. There are three ways of setting
prism dividers, two of them involve graphical positioning (single and dual prism dividers).

The third uses Analysis » View/Modify Prism that can set the divider numerically on any divider.

Any changes to the divider on one plot is replicated on any other plot using that parameter.

Each new parameter that has a prism divider set on it multiplies the total number of
phenotypes by 2.

Only one divider can be set per parameter.
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Setting a Single-Parameter Prism Divider

Single parameter prism dividers are set by placing a
Single-parameter histogram in focus and selecting

=* _The divider can then be set by clicking on the
selected plot, positioning the divider, and then
clicking once more to fix the divider position.

Dual Parameter Prism

" [1):PRISM40.LMD FL1 LOG &

=1ol %]

FE

10 10

Dual parameter prism dividers are set by
placing a Dual-parameter plot in focus and
L]

selecting =37 . This simultaneously creates
two prism dividers.

|T[1]:PHISM4I].LMD PHMT2 LOG/ =] 3]

109
107]

1]

PE

FITC

T1g T ThaTTT o203

The combinations of dividers are combined
to produce 2P regions

Where p is the number of prism dividers set.

2 regions

This table shows the number of phenotypes
created for up to six Prism dividers set.

Number of Prism Number of
Dividers set phenotypes created
1 2
2 4
3 g
4 16
5 32
] 54
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This Plot shows a 3 color Prism Plot (3
dividers set, 8 phenotypes created).

The percentages printed on the prism plot
from left to right match one-to-one with the
phenotype nomenclature indicated on the
axes.

Example:

Triple Positive phenotype (+ + +) is
0.7%.
Triple Negative phenotype (- - -) is
25.1%

The phenotype percentages are
staggered to prevent excessive
obscuration of the numerical values
when a high density of prism
information is presented.

Editing Prism Dividers

[El2 PRISH

2676

=lolx|

[25.

1.6%

4.3%

49

Fit%

CoSFTC .

codFD

colECcD .

1 Mouse over the divider to get the ++ cursor.

2 @ and drag the divider to the new position.

Removing Prism Dividers

1 @ the Prism divider you want to delete.

2 Press ;
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CXP Software - Prism Compatibility

The CXP software Prism plot can interpret the Prism parameter derived from:

* RXP/CXP data acquisition

*  EXPO™ data acquisition

e EXPO 32 data acquisition

* Elite or ALTRA data acquisition or

* COULTER Elite version 4.x DOS software acquisition.

CXP software cannot display Prism using listmode files saved from COULTER XL
SYSTEM II™ software however, CXP software can generate Prism plots from XL SYSTEM II
files.

Note: Reanalysis of listmode files overrides the analysis protocol's Prism dividers. You have to
adjust the dividers when this occurs.

Third party software may not display Prism data correctly since a special Prism data display
algorithm is involved to display Prism in CXP software.

Legend

Use this option to view the population colors and population names,

1 @ Plots » Legend Plot to create a legend plot.
When a Plot is displayed, click the right mouse button within the plot to display further
menu options.

2  Every time the population names or (o]
colors are edited CXP software updates Color[Name[% Gated]% Total|Number
the Legend Window. FL2 | 3335 | 33.35 | 3434
If CXP software is in Dot Plot
Mode-Color Blend mode, Legend FL1 | 6180 | 6160 | B343
displays the names, colors and
associated statistics of the color Gate A 1422 422 | 1464
combinations.
CAL| 1712 | 17.12 | 1763
4 I -l
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3  If CXP software is in Dot Plot Mode-Color Precedence mode, Legend displays the names,
colors and associated statistics of the Gates with the highest precedence at the top.
Note: When analyzing multiple files using Color Precedence, the Legend plot shows all
gates from all plots, regardless of precedence and file. To change this so that the Legend
shows only those gates and plots associated with a given file, use the Advanced
Precedence tab on the Color Precedence edit dialog.

See also:

Data Source (Legend)

Legend - Options Tab

Color Blend Mode - Introduction
Modify Color Precedence
Advanced Precedence

Data Source (Legend)
Choose the File and Gate to be used for the Legend plot.

File x

Browse Button
Gate

Data Source | Options | Font |

File:

IEC 2L AS Verify 8153 'l

Note: You cannot make any changes on this screen
when running a locked protocol

ak. I Cancel Help

See also:

Legend

Data Source (Legend)
Legend - Options Tab
Format Plot

Legend - Options Tab
The Options tab displays various checkboxes that may be enabled as appropriate.

PN 1755708 B-133



USING CXP SOFTWARE

PLOTS MENU

Show "Phenotype Logic" Columns x
[0)
/O Gated Data Source  Dptions | Font I
[0)
/O TOtal I~ Show 'Phenctype Logic! columns
Number
Absolute Count Include Statistic;
{ W % Gated W % Total

. V' Murnber IV Absolute Count

Note: You cannot make any changes on this screen

when running a locked protocol.

QK I Cancel Help

See also:

Legend

Data Source (Legend)
Format Plot

Show "Phenotype Logic" Columns

Displays the logical combination of Color Gates for each population. Available in Color Blend
Mode only.

% Gated

Total number of events in region, as a percentage of events in a gated display.

% Total

Total number of events in region as a percentage of total events in the file.

Number
Total number of events in a Region.

Absolute Count

This displays the absolute count of a population based on the calibration factor (CAL Factor)
and the number of particles within a defined CAL region.

Info Plot

B-134

Set up the Info plot to include instrument serial number and User ID information on
statistical printouts. Use the Info Plot FCS tab to select the FCS Keywords for the
information you want on your statistical printouts.
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@ Plots » FCS Information to create an Info plot.

Info Plot Data Source

Displays the name of the file that is the data source
for the Info Plot.

Info Plot - FCS Tab

Show FCS Keyword — Enable this checkbox to display
the FCS Keyword as well as the associated keyword
value.

Multiple Keywords can be selected from the scroll
box.

Select Clear All Selected to deselect the items.

USING CXP SOFTWARE
PLOTS MENU

i)
[$ETIM] 14:458:23
[§DATE] 09-Jul-03

[$CYT] Cytomics FC 500
[FIMNST]

[E@SAMPLEIDT] FCMNormalDanor
[E@SAMPLEIDZ]

[@SAMPLEID3]
[@SAMPLEID4]
[$FIL] tetraCxP FC 45-56-19-3.L =
[« | v

Info Plot Properties
[rata Source | FC5 | Faont |

Filez

IAS 5C 1L Yerity CD 3-4- 'l

()3 I Cancel

Help

Legend Plot Properties

Data Source  FCS |F0nt I

™ Show FC5 Keyword Clear All Selected |

@PEL =5
@PEC] GEOMETRIC =l o |
@PEZ] ON
@PED] FL4 Log Up |
$MODE] L
$TOT] 3323 M
$PAR]E
$SYSE EEtomicséTI:‘;l [P 1.0 for Win32 | Bottam |
SNEXTDATA] 486579
SDATATYPE]|
$ERP]
SPRON] =

Ok I Cancel | Help
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Acquisition Stop and Save

B-136

Use Acquisition Stop and Save to terminate the acquisition of a sample at a preset stop value.
If there is more than one stop value set, then the first stop counter reached terminates the
current acquisition.

Note: The values set in the Cytometer Control Acquisition Limits (duration and Max events)
overrides the stop values set here in the event of an acquisition limit being reached before the
Acquisition Stop value has been achieved.

Single Parameter Histograms can be selected for automatic saving in FCS Format.

Note: An acquisition from lysed whole blood is to be stopped on 5,000 lymphocytes to allow
the collection and storage of all event data.

In normal blood, where lymphocytes account for about 30% of the white cell count, we have
no problem with the above setup. We can predict with a normal sample that the total count
from a 5,000 cell lymphocyte count is around 5,000 x 100/30 or 16,666 events total.

If the sample is from a lymphopenic patient, this could be a problem. A 5,000 lymphocyte
count may not be achieved before the sample tube is empty or RAM memory is full.

It is normal under these circumstances to set two counters, one for the stop count and one for
the maximum permissible count, that is, the maximum total event count. If a stop count is
used, it is recommended that the stop count be set to a large number, for example, 100,000
events. Thus, with a lymphopenic patient, if the lymphocytes are less than 5% of the white
cell count, an acquisition would terminate on the total event count of 100,000 before a 5,000
cell lymphocyte count could be achieved.

Setting a Stop Counter

Note: If a stop count is used on a plot that contains an AutoGate region, the stop count is not
exact.

1 Highlight the plot on which you wish to set a stop counter.
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Histogram Plot Properties
2 Plots » Acquis"ion Save and stops Data Source | Histogiam | Scaling  Stop and Save | Font |
command to view the Acquisition Plot Acquisition Stop Candiion
Set-up dlalog bOX_ ¥ Usze Stop Condition
Use Stop Condition Maimum Everts |3000
Maximum Events
Save HiStOgram Data il’l FCS Format [~ Save Histogram D atain FCS Format

Note: You cannot make any changes on
this screen when running a locked
protocol.

ak. I Cancel Help

3 @ ¥ Use Stop Condition and enter Maximum Events.

4  To enable an FCS Histogram to be saved from this plot, check the Save Histogram Data in
FCS Format checkbox.
Note: The actual histogram save action is only performed if the Save Histogram
checkbox is checked in Workspace Preferences - Acquisition Options.

See also:

Color Dot Plot

Histogram Plot

Density Plot

Format Plot

Acquisition Stop and Save

Use Stop Condition
Check this checkbox if the stop counter is to be activated.

Maximum Events
Set the maximum number of events you wish to be recorded.

Save Histogram Data in FCS Format
Check this checkbox to save the Histogram Data in FCS Format.
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Format Plot
To display the Plot Properties dialog box, click the right mouse button on the plot and

@ Farmat Plok

Format options differ depending on the Plot type. Select a formatting option from the table
below to view detailed information about the format options available for the different types

of plots.

Plot Type Plot Name Available Formatting Options
Single Parameter | Histogram Plot Data Source Histogram Scaling Labeling  Font Stop & Save*
Dual Parameter | Dot Plot Data Source Events Resolution Labeling Font Stop & Save*

Contour Plot** | Data Source Contour  Resolution Labeling  Font

Density Plot Data Source Density Resolution Labeling  Font Stop & Save*
Three Parameter | Tomogram Plot** | Data Source Density Events Resolution Font

Surface Plot** Data Source Density Events Resolution Font
Special Types Overlay Plot** Format Scaling General

Legend Plot Data Source Options Font

Prism Plot Data Source Font

Info Plot Data Source FCS Font

*=CXP Cytometer only
**=CXP Analysis only

B-138
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Create / Modify Gates

Use the Gating function to define populations of interest either for plot display or for sorting.

zl
ﬁ fiate Status Logic E diing
1 . Color | Hame ] Logic Espression ] Fiegions ]
vy B Lymph AHD B a1

Al b2

Note: You cannot make any changes on
this screen when running a locked

AL
protocol. "
- Operand
Ungated events color ::;M of | woR
- New Delete
NoT | ]
oK. | Cancel | Help | M

» U

Gate and Logical Expression
Gate Color

New

Delete

Operands

3  New Gate 4 is highlighted so you can modify the name if desired.

4  Create new logical expressions.

Note: Gate names are case sensitive so

it is possible to have 2 gates with the Gate Status
same name. When editing gate names, =
ensure that you do not use duplicate =
names.

See also:

Gate Selection

Gate Color

Boolean Gating
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Gate and Logical Expression
Shows the Gate name and the logical combination of Gates.

New
Allows you to create a new Gate with a new combination of Regions.

Delete

The Delete button erases any selected gates highlighted in the Create/Modify Gates dialog
box.

Operands

The Operands function allows you to insert a combination of regions into the gating equation
using the Operands buttons. Once a Region has been entered next to the new file name, the
Operands have to be utilized to enable a new combination of cells to be viewed. The
Operands work according to Boolean Gating.

Gate Selection

The Gate option can be used once Gates have been created.

To apply a Gate to a plot:

1 Click the right mouse button on the plot and @ FoiiEEra:

2 @ the Gate you wish to apply from the Gate drop down list box.

3 @ or press to accept the changes.
@ Or press to exit the dialog box without saving the changes.

Gate Color

When a region is drawn on a plot, the first region is automatically shown as red, meaning
events inside this gate are colored red when viewed on a color dot plot. The second is in
green, and the third in blue.
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These colors can be altered through the Color function if more or different colors are
required.

1 @ the down arrow next to the Color Well for the selected Gate or select the Ungated
events color down arrow to change the color for Ungated events.

2 @ the required color.

This automatically changes the events
within the gate to this color.

[T .
HETEn
SIS T
1 1ETTE

Other... I

3  If further colors are required,

@ Other to reveal a larger color B ErEEE

| il § Il 8|
. HT NN NN
palette. a defined color or drag the EEEEEEEN
cursor around on the color board to il
select the color of choice. et el g
Frrrrrrrr-
Hug: ID_ Bed: l?
I_I_I_I_I_I_I_I_ ﬁat:lm ﬁreen:lﬂ_
Define Custom Calars >3 | ColrlS glid Lurr: IS_ Blue: ID_
Cancel | Add ta Custom Colors |

4  When the appropriate color has been found, you can click the Add to Custom Colors buton

for easy use at a later date or you can @ to add to a plot.

The same principles can also be applied to the Ungated Events Color option.

Boolean Gating

CXP software implements Boolean gating. Up to eight regions can be combined to form a
gate. A gate is used to select a specific subpopulation of data.
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CXP software uses a combination of regions and operators to achieve the Boolean gating
process. The Operands are utilized in order to create a combination of regions.

Gate Logic
The shaded areas show the following logical combinations of regions.

AND

Events which are in both regions A AND A
region B. This is written as A AND B.

OR

Events that are in region A OR in region B.
This is written as A OR B.

XOR

Events, that are EXCLUSIVELY in region A
OR in region B, but NOT in both. This is
written as A XOR B.
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NOT

Events that are NOT in region A. This is
written as NOT (A).

NOT

Events which are NOT in region A AND in
region B. This is written as NOT (A AND B).

NOT

Events, which are NOT in region A OR in
region B. This is written as NOT (A OR B).

PARENTHESES (]

These are used to define a precise logical
statement. An open parentheses must be
placed after a NOT operator even if the
operand is only a single value.

Example: Lymphs AND NOT (CD8).

Color Blend Mode - Introduction

CXP software allows the use of combinations of Gates to determine the color of dots in a dot
plot. The key concept behind this process is similar to color printing and depends upon the
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use of colored combinations of Gates to define a unique subpopulation. Each Gate (up to
three) is given a color and the logical gate combinations give rise to populations with blended
colors.

Consider three gates: Gate A, set on FL1 positive cells; Gate B, set on FL2 positive cells; Gate
C, set on FL3 positive cells. Any event may be in either none, one, two or all three of these
Gates and therefore, combinations of the gates may be used to define eight different
subpopulations (phenotypes) of events as follows:

Each of these subpopulations may be represented by  pefautt Name PrimaryA  Secondary B Tertiary C
a different color. Thus up to eight differently Sroup 0 (FLY (FL2) (FL3)
colored subpopulations may be visualized on a giﬁﬂﬁé N x )
Color Gated Dot Plot, and each group can be given w3 + + -
. roup - - +
a user defined name. Group 5 . . .
Group B - + +
Group 7 + + +

YWhere: +ve data is inside a Gate, and -ve data is outside a Gate

When in color blend mode ONLY color statistics from the blended colors are displayed in the
Legend plot. Use to view Region statistics.

See also:
Modify Color Blend

Modify Color Blend

To use Modify Color Blend:

1 @ Analysis » Modify Color Blend to view the Modify Color Blend dialog box.

2 @ the Gate you wish to modify.
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Make the desired changes.
Gate Names

Blend Color

Enable

Name

Logic

Color

Create Gate

Note: You cannot make any changes on
this screen when running a locked
protocol.

Muodify Color Blend x|

—Blend Gate 1

Gate Names

@ BlendColor ¥ Enable

— Select Population

—Blend Gate 2

Gate Names

— Selected Population

Mew Gate 2 <
I J Mame LColor
@ BlendColor ¥ Enable [Growp 7 -
- Logic
. [C1J AND [C2] AND [C3)
Gate Names
MNew Gate 3 =
I J Create Gate.. |
@ BlendColar ¥ Enable
,TI Cancel | Help |

B

4 @ or press to accept the changes.

@ or press to exit the dialog box without saving the changes.

See also:
Create / Modify Gates
Workspace Preferences - Gating

Gate Names
Allows the selection of a Gate that defines a population of interest.

Enable

Enables the selection of one, two or all three blend Gates.

Blend Color
Displays the color to be associated with the selected Gate logic.

Name
Allows a user-defined name for the selected combination.

Color
Allows you to modify the predefined colors.
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Logic
Displays the full coloring Gate logic for the selected population.

Create Gate

Creates a logical Gate based on the coloring logic. A Create Gate screen is displayed showing
the Gate Logic to be applied. Press Yes to Create the Gate or No to cancel.

Modify Color Precedence

When a subpopulation is very small and a larger blended color would swamp a smaller

population, Color Precedence can be used instead of Color Blending. In Color Precedence
Mode, the subpopulation (or color) given the highest precedence overrules any color with
lower precedence when the same event satisfies more than one color gate, or, when two or
more events are to be displayed at the same location.

1 @ Analysis » Modify Color Precedence to view the Color Precedence — Gates tab dialog

box.

@ the required gate so as to

highlight the gate name ONLY.

Note: You cannot make any changes on
this screen when running a locked
protocol.

Use Up | and Down | to move

Gates into the required order of
precedence. Those with the highest
precedence are at the top of the list.

See also:
Workspace Preferences - Gating
Advanced Precedence

Advanced Precedence
Note: You cannot make any changes on this screen when running a locked protocol.
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Gates | Advanced I

Gate Aftributes

Color | Mame | |

o~

| =

LIk

LI

|~

LIk

M~

h —|D°W”

IIL
[x
Lymphsz
Ungated

Cancel

o1

Apply Help
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Advanced Precedence allows you to assign xl
particular Gate colors to specific plots. R

Elats Precedence Gates

Parameters Gate o0
FLT [0G COAEFILE v. FLe LG CDARDT ok il AR
FL2[0G CO4FDT v. 55 55 Ewclud=t g g

This is of particular interest if different plots are
gated on completely different criteria and the color
from one gate, therefore, has no relevance to
another plot or file.

Advanced Precedence is useful when performing
multifile analysis and you do not want a gate from
one file to be represented as a color in another file.

4 |
0K || Cancel | iol Help

Regions Introduction
A Region identifies a specific population of cells.

Up to 256 regions (total) can be set on any combination of Parameters, 32 of these are usable
as Gates.

Regions are drawn on a Single Parameter Histogram by setting the position of an upper and
lower boundary (Region markers).

Regions are drawn on a 2-Dimensional Dot Plot by enclosing a subpopulation of events with
rectangles, polygons (nonrectangular Regions) or using quadrant markers (four rectangular
Regions, set with only one point).

To speed up the analysis of data, when a Single Parameter Histogram Region or a Rectangular
or Polygonal Region is created, it is also assigned to a Gate. This assignment can be accepted
or edited later. The automatic assignment of Regions to Gate can be switched on or off if
desired, using Gates » Automatic Gate Creation.

Region Properties

@ on a region to make it active and then click the right mouse button on it to display the

Reqion Propetties

Region Properties dialog box. Re-Calculate Autogate

The Re-Calculate AutoGate option allows a return to AutoGating after manual manipulation of
an Auto region.

Polygonal Region

The Polygonal Region allows you to draw a free-form Region with up to 100 points and can
include horizontal acute angles on a dual parameter plot. To draw a Polygonal Region in a
dual parameter display see, Create Polygonal Regions. in the Instructions For Use manual.
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Polygonal Region Propetrties

Region Name
Prime
Reqion Mame

Automatic Region Name Positioning
. L Lowerlimt 467 Upperimt |55
Region statistics exported for QC suerimt pperint

QC Pro dUCt ™ Prime [~ Target region for automatic setup

™ Automatic region name positioring

None &
. v Region statistics exported for Quality Control
Elliptical
Contour GCFroduct (01 FlowCheckTHM] =]
Sensitivity — Positives Analysi
Travel I active Percent Positive |2
Minimum Count r— Mirimum Count
Linked Region ™ active Count ID
Note: You cannot make any changes on this screen [ Linked Region
’ ; y & ™ Linked Region linkedto | -]
when running a locked protocol other than
selecting a QC product or choosing to export QC 0k | Cocel | Hep |
statistics.
Region Name

Displays the name of the region. If the name is not grayed, you can rename it.

Prime

When checked, this option allows the system to determine if the peak of the events on the
plot is within this region. If the peak is outside this region (due to an air bubble or partial
clog), the system performs a Prime cycle. A maximum of three sequential Prime cycles are
allowed; if the peak of the plot is still not within this region, the MCL aborts.

Automatic Region Name Positioning
Region labels default to an automatic position. You may move a region label to any desired

position within a plot, this user modification automatically unchecks this option. To revert to

the automatic position recheck this option.

Region Statistics exported for Quality Control

The region's results are exported to the Quality Control feature of the Report Generator (CXP

Acquisition software only).

QC Product

Select the QC product from the drop down list (CXP Acquisition software only). See also,
Setting Up QC Products in the Instructions For Use manual.

AutoGating

None
This is the default when the AutoGate option is not selected.
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Elliptical
Toggle the AutoGate to an elliptical region.

Contour
Toggle the AutoGate region to a contour region.

Sensitivity
Eliptical AutoGate settings are 0.11, 0.33 and 1.1 (% of processed peak). Contour AutoGate
settings are 1, 2, 3, 4, and 5.

* Level 1 =0.11% processed peak at a resolution of 64x64.
e Ievels2,3and4=0.11, 0.33 and 1.1% at a resolution of 128x128.
* Level 5=1.1 % processed peak at a resolution of 256x256.

Selecting 0.11 creates a larger region, whereas selecting 1.1 creates a smaller radius region
around the target population.

Travel

Input a maximum value the contour AutoGate region travels from the mean. The Minimum
value is 25; Maximum is 250 channels. Use this option to slightly adjust the AutoGate from
tube to tube if slight changes in lysis cause the target population to move slightly. This option
is not available for elliptical AutoGates.

Minimum Count

Check this option and enter a number in the Count field to enable the minimum count
function. This overrides an existing stop count to ensure a minimum number of events within
a particular region are collected. The actual stop count in this case is approximate (but is
always in excess of the minimum count value). This is limited by the Duration and Total
Events.

Linked Region

Select a region to be linked to another region and the region tracks the selected region. A
region may only link to a region of the same type and parameters. For dual parameter regions,
the parameters may be transposed. A rectangular region may link to a quadrant region, but a
quadrant region may not link to a rectangular region.

When a region is linked to another, changes to either region's coordinates (by dragging the
region) are propagated to both regions. The exception is when the region is an auto analysis
region (positives analysis, Elliptical and Contour AutoGate). Then the regions track the auto
analysis region and the link is unidirectional.

If a region is linked to another, positives analysis and autogating are disabled for that region.
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Polygonal Region Format Tab

Specity the Color and line Weight for the Polygonal
Region boundary.

Note: You cannot make any changes on this screen
when running a locked protocol.

Interactive Polygonal Region Editing

Regiun Properties
Fiegion Propertiss  Format |
Line
' Automatic Color; I -
" Customn weight: lﬂ

Ok I Cancel Help

When a Region's position is changed, any Gates and statistics that use the Region are
automatically updated and each plot is redrawn to reflect the changes in that Region. When
the Region is deleted, any Gate or statistics that used the Region are also automatically

deleted. When a Gate has been deleted, any plot that used the deleted gate is reset to Ungated.

CXP software allows you to resize an already created Region.

Rectangular Region

This option draws a Rectangular Region on a dual parameter plot. See also: Create
Rectangular Regions in the Instructions For Use manual.

Rectangular Region Properties

Region Name

Prime

Automatic Region Name Positioning
Region statistics exported for QC
QC Product

X and Y Coordinate

Minimum Count

Linked Region

Note: You cannot make any changes on this screen
when running a locked protocol other than
selecting a QC product or choosing to export QC
statistics.

Interactive Rectangular Region Editing

Region Properties E]
Region Name |A

[~ Frime [V futornatic region name postioning

[ Begon stabstics esported for Quality Control

QC Froduct
Lowser left
# Coordinate |41 *f Coodinate | 212

Upper right

X Conrdinate [727 ' Coordinate |13

Miniimwem Court

™ Adlive Court
Linked Region

r Region linked o

0OF, Carcel | Help |

When a Region's position is changed, any Gates and statistics that use the Region are
automatically updated and each plot is redrawn to reflect the changes in the Gate. When the
Region is deleted, any Gate or statistics that used the Region are also automatically deleted.
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When a Gate has been deleted, any plot, which used the deleted Gate, is reset to Ungated.
CXP software allows resizing of previously created Regions.

Quadrant Region

Insert a Quadrant Region into a dual parameter plot. All quadrants comprise four sets of
Rectangular Regions on a dual parameter plot. The Quadrants are automatically assigned an
alphabetical region name and a number for each quadrant. See also: Create Quadrant Regions
and Repositioning a Quadrant Region in the Instructions For Use manual.

Quadrant Region Properties

Region Name : : i
. Region Properties @
X and Y Coordinate

. . . . ,07
Region statistics exported for QC e st
QC PrOdUCt % Coordinate  |535 Y Coordinate |838
Positives Analysis [¥ Reqion stahistics exported for Quality Controf
Linked Region GC Product [F5]0C Test product 1 «
. Positives Analyzi

Note: You cannot make any changes on this screen ‘ petlves Ansbss ) ‘

. [ Active Percent Positive I
when running a locked protocol other than
selecting a QC product or choosing to export QC Linked Region
statistics - Region inked to

oK Cacel | Heb |

X and Y Coordinate
Set the region to defined position by entering X and lower Y coordinates for the region.

Interactive Quadrant Region Editing

When a Region's position is changed any Gates and statistics derived from the Region are
automatically updated and each plot is redrawn to reflect the changes in the Gate. When a
Region is deleted any Gate or statistics that used the Region are also automatically deleted.
When a Gate has been deleted, any plot, which used the deleted Gate, is reset to Ungated.
CXP software allows you to reposition an already created Region.

Elliptical AutoGate

Create an Elliptical AutoGate around the selected population on a plot.

See also: Create AutoGate in the Instructions For Use manual.

Contour AutoGate

Create a Contour AutoGate around the selected population on a plot.

See also: Create AutoGate in the Instructions For Use manual.
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Linear Region

Insert a Linear Region. See also: Create Linear Regions in the Instructions For Use manual.

Linear Region Properties

Lomer Limit
. . . . gion Properties
Lower Limit and Upper Limit

Prime Region Mame  |B

Target Region for Automatic Setup Lowerimit |31 Upper imé  |575

Automatic Region Name Positioning I Pime | Teugetegion for suftomalic setup

Region statistics exported for QC o regt '

QC Product --

Positives Analysis GEProd. S FSI AT Testpracict 1 ]

Minimum Count Pesitives Anabsis

Linked Region [ Aclive Peicent Posilive
Mo Caurnt

Note: You cannot make any changes on this screen I Aclive Count

when running a locked protocol other than Likad Fegion

selecting a QC product or choosing to export QC r Regioninkedlo | E

statistics.

ok | Cencel | Hep |

Lower Limit and Upper Limit

Set the region to defined limits by entering upper and lower limits for the region. These limits
can be viewed in the statistics box for each plot by selecting Analysis » Select Results and
select Min/Max.

Target Region for Automatic Setup

Specify the region as the Flow-Set fluorospheres target region for AutoSetup when multiple
regions are present on a FS plot.

Positives Analysis

This option moves the region to the selected percent result. Specify a positive percentage
value from 0.1 to 99.9. If the positive analysis option is not selected, the percentile is
unavailable. Use this option to automatically set the region position for a negative control
sample.

Interactive Linear Region Editing

When a Region's position is changed, any Gates that use the Region are automatically
updated and each plot is redrawn to reflect the changes in the Gate. When the Region is
deleted any Gate which used the Region is also automatically deleted. When a Gate has been
deleted, any plot that used the deleted Gate is reset to Ungated. CXP software allows you to
resize an already created Region.

Status Bar (Linear)
The status bar normally gives a brief description of selected menu items.
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When drawing or modifying Regions the status bar divides into three areas of information.
These update as a region is modified:

* The status bar shows Channel for X parameter
* The total integral count of the region

* The percentage of events currently within the region.

X Coordinate

The X Axis channel value is the coordinate of the cursor position given by a scaling factor.
This scaling factor depends on whether the Histogram parameter is using linear or
logarithmic amplification and whether you have calibrated that parameter or not.

If the parameter is linear and uncalibrated, the X channel varies between 0 - 255 or 0 - 1024
depending on the data source. If the parameter is logarithmic and uncalibrated, the value
varies between 0.1024 - 1024 and span four decades. For most other manufacturers, the data
varies between 1 - 10,000, spanning four decades also.

Integral

When you create a Region the status bar reflects the integral values given along the scale for
that parameter at the cursor position. That is, before the first marker is set.

If the cursor is on channel 10, the integral shows the count value of the populations at
channel 10.

After first marker is set and as you move the mouse to either the left or right of this point, the
integral value continuously updates to reflect the summation of each channel between the
Region starting position and the current mouse position.

Multiple Linear Regions

This option sets multiple consecutive linear Regions on one display. See: Create Multiple
Linear Regions in the Instructions For Use manual.

Interactive Multi-Linear Region Editing

When a Region's position is changed, any Gates that use the Region are automatically
updated and each plot is redrawn to reflect the changes in the Gate. When the Region is
deleted any Gate which used the Region is also automatically deleted. When a Gate has been
deleted, any plot that used the deleted Gate is reset to Ungated. Allows you to resize an
already created Region.

Linked Marker

Use the Linked Marker (Overlay Plot only) to set a Region on all histograms. This shows the
percentage of events inside that Region compared to the total number of events on the plot as
a whole. This Region can be increased or decreased in size by clicking on either end of the
line with the left mouse button, holding it down and dragging it across to the desired point.

To delete the Region, highlight the line (there is a box at each end) and @ ﬂl.
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New Non-Linked Marker

Use the New Non-Linked Marker (Overlay Plot only) to add on an independent Region,
showing the percentage of a particular plot. Any number of these can be added to
all/some/one of the plots. This Region can be increased or decreased in size by clicking on
either end of the line with the left mouse button, holding it down and dragging it across to
the desired point.

To delete the Region, highlight the line (there is a box at each end) and @ ﬂl.
View / Modify Regions

Use this option to view/edit a Region's properties, Region points or to delete a Region that is
no longer required. Allows you to copy and paste Regions between protocols.

1 @

2  Make the desired changes. x|
See also:
Region Name
Region Points

Region Mame

CD45 Lymphs LCancel

Delete

s

Help
Region Points
Tv]: 74, 313 i’
[<v]: 16, 359
[<¥]: 26, 469
Bv]: 112, 596 =l
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3 @ or press to accept the changes.
@ or press to exit the dialog box without saving the changes.

See also:

Deleting Regions

Editing and Moving a Region Name
Moving a Region

Resizing a Region

Region Name
Select the Region to view, edit, or delete from the Regions list box. Highlight the Region Name

and @ ﬂl to delete the region(s). Double click the Region Name to rename the
region.

Region Points

This list box gives details of the Region bounds. This is Upper/Lower channel for single
parameter histograms. For rectangles the lower left and upper right vertices are specified and
for polygons the X/Y coordinates of all the vertices. To display a Region's points (or bounds),
click on the desired Region in the Regions list box.

Resizing a Region
If you want to enlarge or shrink a Region:

1 @ the Region.

The Region is now active and handles appear. Vertices also appear for Contour AutoGate
and Polygon Regions

2  Hold the left mouse button down while moving the handle (or moving a vertex as in
Contour AutoGate and Plygon Regions).
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Moving a Region
To move a Region to another position:

1 Mouse over the Region to get the I%' Cursor.

2  Hold the left mouse button down while moving the Region anywhere in the current
window. If the Region has been moved, the statistics automatically recalculate.
The Region name moves to the same relative position alongside the Region's new
position.
See also:
View / Modify Regions

Editing and Moving a Region Name
To edit or move the Region name:

1 Double click on or near the first letter of the Region name to activate the Region Name
dialog box.

2 To edit the Region name, type in the

desired changes, if any, click

|

Edit Begion Hame

E =]

3  To move the Region Name, mouse over the region to get the I%' cursor. If the region

name has multiple characters, mouse over the first character to get the I%' Cursor.
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4 @ + hold and drag ‘%’ to move the region name.

9 @ to fix the location of the region name.

Deleting Regions

There are two methods used to delete degions, From Within a Plot and Using the Delete

Button in the View / Modify Regions Dialog Box.

Note: If a plot is deleted, its regions are still retained.

From Within a Plot

1 @ the Region.

The Region is now active and handles appear.

2 Press (Deeete]. The Region is now deleted. Any Gates and statistics that were associated

with this Region are also deleted.

Using the Delete Button in the View / Modify Regions Dialog Box

d

2|
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2 @ the Region to delete and @ _ Dok |,

Use +@ to select multiple regions to delete.
Use (c)+A)] to select all of the regions.

3 @ or press to delete the Regions.
@ or press to exit the dialog box without deleting any selected

Regions.

When you exit the View / Modify Regions dialog box, CXP software updates all the
Windows. If a deleted Region was also specified in any statistics or Gates, then CXP
software updates to reflect these changes.

Re-Calculate All AutoGates

Use this function to re-calculate multiple autogates in a protocol, rather than re-calculating
them individually.

Create Prism Divider

Dual Prism Divider

The Analysis > Create Prism Divider » Dual Prism Divider menu option allows you simultaneously
set two Prism dividers in a “quadrant fashion" on a dual parameter plot. Any displayed Prism
Plot is automatically updated with the new Prism statistics. If the number of Prism dividers is
changed during the divider creation, the corresponding Prism plot also reflects this by
changing its format according to the number of active Prism dividers.

Note: CXP Cytometer software only allows one Prism divider per parameter and the dividers
are GLOBAL across the application. As a consequence, modifying the Prism divider of any
parameter on any plot automatically updates the divider of that parameter if it is displayed on
any other plot. This includes both dual and single parameter plots.

See also:
Setting a New Dual Prism Divider
Editing a Dual Prism Divider
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Setting a New Dual Prism Divider

1 Highlight the chosen dual parameter plot (current window).

2 @ Analysis » Create Prism Divider » Dual Prism Divider.

[
3 A Dual Prism cursor is displayed in the current window.

4  Position the cursor anywhere on the window, click to show the prism divider lines. If
is pressed at this point the operation is abandoned.

9 Move cursor to position crosshair then click to set position.

Editing a Dual Prism Divider

Editing an existing Dual Parameter plot with a set of dual Prism dividers displayed essentially
consists of creating a new set of dual Prism dividers. When the second set of dual Prism
dividers is defined the first set is deleted.

1  Highlight the required dual parameter plot.

2 Mouse over the Prism divider to get the ++, Tor ‘$' Cursor.
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3 @ + hold to set the new Dual Prism crosshair. When the new dividers are set they
replace the previously set dividers. Any associated Prism plot is updated with the new
Prism statistics.

Any associated Prism plot changes its format and has its statistics updated to reflect a
smaller number of Prism dividers and a smaller number of displayed phenotypes.

4  To delete Prism divider, @ on the divider to make it active and press (Delete]. The Prism
divider for the associated parameter is deleted altogether from this plot and from any
other plot that has this divider set. Any associated Prism plot changes its format and has
its statistics updated to reflect a smaller number of Prism divider(s).

Single Prism Divider

The Analysis » Create Prism Divider » Single Prism Divider menu option allows a single Prism
divider to be set on a single parameter plot. Any displayed Prism plots is automatically
updated with the current Prism statistics. If the number of Prism dividers is changed during
the divider creation, the corresponding Prism plot also reflects this by changing its format
according to the number of active Prism dividers. Please refer to your Cytometer system
manuals for further explanation on Prism parameter.

Note: CXP software Cytometer software only allows one Prism divider per parameter. As a
consequence modifying the Prism divider of any parameter on any plot automatically updates
the divider of that parameter if it is displayed on any other plot. This includes both single and
single parameter plots.

See also:
Setting a New Single Prism Divider
Editing a Single Prism Divider

Setting a New Single Prism Divider

1 Highlight the required single parameter plot.
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2 @ Analysis » Create Prism Divider » Single Prism Divider.

3 A Single Prism cursor is displayed in the current window.

4  Position the cursor anywhere on the window, click to show the prism divider lines. If
is pressed at this point the operation is abandoned.

9 Move cursor to position crosshair then click to set position.

Editing a Single Prism Divider

Editing an existing Single Parameter plot with a set of single Prism dividers displayed
essentially consists of creating a new single Prism dividers. When the second single Prism
dividers are defined, the original is deleted.

1  Highlight the chosen single parameter plot (click on the title bar).

2  Mouse over the Prism divider to get the ++, Tor <$' cursor.

3 @ + hold to set the new divider. The old divider is deleted and the display is once
again updated to show only one single Prism divider. Any associated Prism plot is
updated with the new Prism statistics.
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4  To delete Prism divider, @ on the divider to make it active and press (Delete]. The Prism
divider for the associated parameter is deleted altogether from this plot and from any
other plot that has this divider set. Any associated Prism plot changse its format and
have its statistics updated to reflect a smaller number of Prism dividers.

View/Modify Prism
Under most circumstances, Prism is modified graphically by using Dual or Single Prism
Divider cursor operations. Occasionally, it is necessary to modify the Prism dividers
numerically to reproduce exactly the setup of another experiment. View/Modify Prism allows
you to do this.

1 @ Analysis » View Modify Prism. The Prism Setup dialog box is displayed.

@ x
2 the parameter whose divider you Vaue | List Mode Parameter |
wish to edit. [¥]308  CD3ECD

32 CD4-RO1
26 COA-FITC
[Jof FS
[ o 55

ak. I Cancel Help

3  Place a check in the box next to the Listmode Parameter value you wish to enable.

Note: If no check is in the checkbox, the particular value is automatically set to OFE
This switches off the prism divider and deletes it from any displays that were using it. If
a prism divider is switched off, any active prism plots and plots with prism divider
displays also update them to reflect the modified number of prism parameters in use.
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4 @ the value that you wish to change and enter the required value within the range 0
to 1023.

) @ to accept all changes.
@ to abandon all changes.

Select Results

CXP software gives the flexibility of generating many different statistics and these are
produced using combinations of Regions and Gates.

A Gate is used to select events that may potentially be counted while Regions mark
subpopulations and determine whether an event is actually counted.

All Regions and Gates can be named according to your preference, allowing easy recognition
of your results.

The statistics calculated and displayed depend upon those selected in the current protocol. If
no statistics have been selected then the default statistics are displayed. FCS options are either
generated automatically by CXP software or obtained from sample information entered by the
User. Desired items can be selected and exported during the publishing of an Excel
Spreadsheet. The selected FCS information is only published and does not print with the
plots within CXP software.

When in Color Blend Mode, only the color blend color statistics from the blended colors are

displayed in the Legend plot. Use to view Region statistics.
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Statistic: Type — Report Dptiohs
ﬁ/’lll;lhelf Eilll.igl';\[_ ¥ Current Filename:
o ata ¥ Mean Calculation Methad
% Gﬂt&d Comment
Percentile
Mean e
cv s REVTERD 12 B
i Y hlean $CELLS
Median R [SET] s P 500
| FDATATYPE] |
HP-CV Y tedian RDATE) 22or 0
M d Y [4NFr1TA2114 70 |
oae
c ” / L Select Numeric Frecizion + Decimal places
Iwe' s Il;M |1 € Sianifizant figues
In an ax
QK I Cancel | Advanced... | Help
Current File Name
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Mean Calculation Method

FCS Information

Select Numeric Precision

Enter Numeric Value

Advanced Statistics Configuration

For more information concerning the Publication of
Results, see Publish Results Now.

Statistic Type
There are the different types of statistics that can be utilized. Any number of these can be
selected and the relevant statistic appears in the box beneath the plot.

Current File Name
This option allows you to include the data file name when the results are published to an
Excel Spreadsheet. This information is not displayed within the Statistics Window.

Mean Calculation Method
This exports the method of calculating the mean as part of a Published Excel spreadsheet.

FCS Information

These options are either generated automatically by CXP software or obtained from sample
information entered by you. Desired items can be selected and exported during the
publishing of an Excel Spreadsheet. The selected FCS information is only published and does
not print with the plots within CXP software.

Number
Total number of events in a Region.

% Total

Total number of events in region as a percentage of total events in the file.
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% Gated

Total number of events in region, as a percentage of events in a gated display.

Percentile

This is the channel, which divides the events in a region by the percentile value. The default
percentile is 50 (the median) but this can be set to request any desired value.

Mean

The Mean channel is the arithmetic mean channel defined as the sum of the region channel
numbers, times counts, divided by the integral of the region.

The Mean (or the average) is found when all selected events are added together and then
divide by the total number of events.

The Advanced button allows for the calculation of a Geometric mean.

Cv
The CV is Standard Deviation divided by the mean of the data between the markers.

Note: Standard Deviation calculations are only valid between markers that have a Normal or
Gaussian distribution. CV is not strictly valid for any other shape distribution. The derivation
of CV can be found in any standard statistic text.

Median

Median is used to indicate the point on the scale of measures where the population is
centered. The median of a population is the point that divides the distribution of scores in
half. Numerically, half of the scores in a population have values that are equal to or larger
than the median, and half have values that are equal to or smaller than the median.

HP-CV
(HP X-CV and HP Y-CV) The Half Peak Coefficient of Variation (HP-CV) is derived by the
fixed mathematical relationship between the Standard Deviation (SD) and the Full Width

Half Max (FWHM) value of a Normal or Gaussian peak. The relationship between them is
defined as SD=FWHM/2.354.

This is an approximation to the real value of CV. The advantage of calculation HP-CV is that
the value remains fairly independent of the position of a pair of region markers, provided that
the markers are set either side of a peak and the marker channel counts are less than half the
value of the peak channel count. In general, the HP-CV approximation is usually smaller than
the CV calculation. See standard statistics texts for further explanation of HP-CV and CV
differences.

Mode

The mode channel is the channel with the largest number of counts between region markers.

Gate colors can be customized using the drop down color box and selecting the required
color.
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Cells / pL

This displays the absolute count of a population based on the calibration factor (CAL Factor)
and the number of particles within a user defined CAL region.

Min and Max

Displays linear region boundaries.

Select Numeric Precision
Choose the precision you want to specify for, Percent, Mean or CV.

Enter Numeric Value

Maximum 3 decimal places for CV, 4 decimal places for Percent and maximum 5 digits for
Mean.

Advanced Statistics Configuration

Selecting the Advanced button offers further ]

options to select the way that the mean is

Calculated . — Calculation Preference oK I
5, Elite, Lysys Lancel
LOg-LOg _l
. Help |
LOg—Lll’l —Automatic Statistic Percentiles
Automatic Statistic Percentiles i s ¥ Asis
50.0 50.0

Differences Between Log-Log and Log-Lin Statistical Calculations

For most practical applications users may never notice the difference between the two. In
general, Log-Log mean appears to have its value skewed further to the right than a Log-Lin
mean calculation on the same data. This skew is more pronounced when the distribution of
data extends greater than +half a decade from the mean value, however calculated.

Log-Log
Selecting Log-Log calculates the mean values of Log data using geometric conversion of each
individual channel before a mean value is calculated.

Log-Lin
Selecting the Log-Lin mode calculates the mean values by determining the arithmetic mean of
the raw ADC channels and then converting this to its relative linear channel equivalent.

Automatic Statistic Percentiles

This is the channel, which divides the events in a region by the percentile value. The default
percentile is 50 (the median) but can be set to request any desired value. Different values may
be set for both the X and Y axis.
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Absolute Count Calibration

Use absolute count calibration particles for the calculation of absolute numbers of cells
present in a sample.
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As a sample is analyzed, the numbers of a particular cell type in a region, and the numbers of
absolute count calibration particles present in a CAL region are compared, and the absolute
concentration of the cell type is then calculated automatically.

A listmode files replays with its runtime Cal Factor. Use this screen to enter a different Cal

Factor to calculate individual lismode absolute counts.

Note:

A CAL region MUST be set for the system to be able to calculate an absolute count.

See Setting a CAL Region.

Listmode replay uses the runtime protocol Cal Factor unless you select a different

Cal Factor before replaying the file.

To display the absolute count, @ Cells/pL from the Analysis/Select Results menu option.

Setting a

From the list of Available Absolute Count Calibrators,

CAL Factor for Absolute Counts

select the Lot Number currently in use.

Enter a Manual Absolute Count Calibration Value if the
required Lot is not present in the list. A manual
calibration value is only used for the current
session, it cannot be saved. A listmode file replays

with its runtime Cal Factor.

Note: The number of events in the CAL region must
be greater than 1000, otherwise absolute counts are

not determined.

Override runtime CAL Factor...
Check this option if you want to replay a batch of listmode files using a different Cal Factor.

Advanced

Available Absoute Count Calbrators

/10 [ Count [ Expiy Date |

Number
2

1122 18Mov 2003
0318 Ry 200

™ Overiide runtime CAL Fastor when teplaying Batch listmode data

Manual Absalute Count Calibration Yale

[ 100 ™ Enable

o | Cancel

1| Heb |

Advancad.. |

- bsolute Count C:
Product Name

Lot NurberAD

Cal Factor

If your Administrator has assigned you access rights, the Advanced button is active and you
can enter and modify batch and count information. Enter the Product name, Expiry Date, Lot
Number/ID and CAL Factor.See Add Absolute Calibration Batches in the User Administration

section.

ADD

Use the ADD button to enter new lot information (only available on the Advanced screen).
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Replace
Use the Replace button to replace the selected information with updated values (only
available on the Advanced screen).

Delete
Use the Delete button to remove a selected lot from the list (only available on the Advanced
screen).

Setting a CAL Region

Create a Region around the absolute count calibration particles, the region MUST be named
CAL. Set or select the calibration factor for the batch of beads in use from the Analysis »
Absolute Count Calibration menu item.

Note: If the Cal Factor is set to 0 or there is no CAL Region present in the protocol, “Error”
appears in the Cells/uL field. If the number of events in the CAL region equal to or less than
1000, "Invalid" appears in the Cells/uL field.

Calculate Results

This option calculates the statistics for all files selected on the screen.

LMD QuickCOMP

Note: If you adjust the compensation of a Listmode file using the LMD Quick COMP tool, the
Amplifier Gain field of the FCS Header is no longer available, from either the File / View FCS
Header menu item or Legend Plot. The original stored file remains unchanged and contains
the Amplifier Gain information.

Enabling LMD QuickCOMP displays orange ||:|| x|

slider bars on all dual fluorescence plots.

EE
These sliders are used to intuitively adjust L z

the compensation coefficients and update 107
the compensation values applied to the :
listmode file.

FLS Log
k.

Clicking the arrows adjusts the settings by
+0.1%, clicking either side of the slider
adjusts by +1.0% or drag the slider to place
the cells in the required position. You can
view the new settings in the LMD
QuickCOMP Matrix

Show LMD QuickCOMP Matrix

When you use the LMD QuickCOMP slider bars to change compensation settings, the new
settings are displayed in the LMD QuickCOMP Matrix dialog box. You cannot use the LMD
QuickCOMP Matrix to change a protocol’s compensation settings .

Note: To view compensation adjustments of Listmode data, always view the LMD
QuickCOMP Matrix. The compensation matrix in the Cytometer Control dialog represents
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the compensation settings last used in that protocol and may not necessarily be the
compensation settings used for any given Listmode file.

zl
Compensation M atrix
FL1 FL2 FL3 FL4 FL5
IFL1 1.1 2.4 21 0.0
|FL2 149 148 1.7 106
|FL3 449 358 249 49
|FL4 049 4.3 234 2.2
|FL5 0.3 oy 28 5.9

Show Analysis Algorithm Results

Only available when running protocols from optional applications, such as tetraCXP.

B.22 FLOWPAGE MENU

FlowPAGE - Introduction

FlowPAGE is the reporting area for Data, Plots, Statistics, micrographs and user created text.
FlowPAGE enables custom formatting of multiple pages of flow cytometer information
without the need to swap between other third party applications.

Once a FlowPAGE is created, the contents of its plots and statistics windows are
automatically updated to reflect new listmode data or configurations made in the CXP
software analysis.

All FlowPAGE:s are saved with a Protocol, this retains the link between the Plots you display
and how you want to format the output to the Printer.

FlowPAGEs contain fixed header and footer information generated from FCS Keywords. The
automatic header information as displayed on the FlowPage reports always displays xxxxxx
on the CXP Workspace. Upon printing, all automatic header fields are populated with the
listmode file Keyword information on the printout ONLY.

FlowPAGEs are not updated during Data Acquisition in live time. FlowPAGEs are updated at
the conclusion of acquisition, or after reading a new data file from disk, or editing Regions,
Gates or Statistics or resizing FlowPAGEs.

Note: Occasionally, when using a FlowPAGE, one or more items cannot be deleted from a
page. If this occurs, the items can be cleared from the FlowPAGE by selecting Files » Save
As... to save the protocol with a new name. If you reload this new protocol, the items are now
cleared from the FlowPAGE..

Editing FlowPAGEs

You cannot make any changes to a FlowPAGE when running a locked protocol. See Creating
FlowPAGES in the System Overview chapter in the Instructions For Use manual.
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Note: Due to the flexibility of listmode file naming options, listmode filenames can become
very long. When such listmode files are open in the Analysis Only software, the software
assigns a file designator (that is, F1) and displays that designator, with the filename in all
statistic boxes on a FlowPage. Due to the long file name, this may result in overlapping
statistic boxes, requiring reformatting of the FlowPage to view all results.

Select a Single ltem Within FlowPAGE

1 Mouse over the item until you see the H:_' cursor.

2 @ the item and handles appear around the item.

Move a Selected Item Within FlowPAGE

1 Mouse over the item until you see the H:_' cursor and @ +hold and drag the selected

item to its new position.

Select a Group of ltems Within FlowPAGE

1 Click and hold the mouse button, selecting just outside the group of items required.

2 Drag the cursor until the marquee (dotted outline) completely encompasses the items
you want to select.

3 Release the mouse button. Each item has handles around it.
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4  Mouse over the selected items til you see the ‘%’ cursor and @ +hold and drag the
selected items to move them.

9  Click the right mouse button on the selected items to edit them.

Deleting Objects in FlowPAGE

1 @ the object that is to be deleted. Handles appear around the object.

2 Press .

Resizing Objects in FlowPAGE

1 @ the object that is to be resized. Handles appear around the object.

2  Drag a handle to the size required and release the mouse button.
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Additional FlowPAGE Formatting Options

Click the right mouse button on any object
on the FlowPAGE to select additional
formatting options.

You can Cut, Copy and Paste items that are
selected.

dh cut
Copy

E Paste

Qrder L4
Grouping 4
Propetties. ..

Align Plot [ Stats

You can change the order of items that are
selected.

dh o

Copy

E Paste
Crder Bring to Fronk
Grauping 4 Send to Back.
Properties. .. Bring Forward

_ Send Backward
align Plot [ Stats

You can group and ungroup items that are
selected.

& cur
Copy

E Paste

Crder 4

Grauping Graup

Properties. .. Ungraup
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You can edit and change the alignment of x|

text. Tet |Line | Fil | Font |

Text

[ Multiple Lines ™| wiord Break

Horizontal Alignment
© Left

& Center

" Right

Wertical Alignment
" Top
% Center
" Bottom

Ok I Cancel Apply

You can change how lines are displayed. x|

Tew Line |Fil | Font |

Colar: MI“ [ Transparent
Style: ‘width:
—— O Point (1 Pixel] &
— — Dashed —— 1 Paint
________ Clotted —— 2 Paint
— - — - Dash-Dat — 3 Foint
—— Dazh-Daot-Daot 4 Point
a5 Point
. £ Point LI

ak. I Cancel | Apply |

You can change the fill properties of items x|

that are selected. Tew |Lie Al |Font |

Foreground Calor: ~""""[[4| ¥ Transparent Fil

Background Calor: |'| ¥ Transparent Background

Hatch:

|:| Dovrward Diagonal

I:‘ Crosshatch

|:| Diaganal Crozshatch

|:| Upward Diagonal LI

ak. I Cancel | Apply |
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You can change the font properties of items x|
that are selected. Tew |Lie |Fi Font |
T Georgia ;I 14 :l
T Impact 18
. Italic 18
Fr Lucida Console Bold Itsiic i
Hr Lucida Sanz Unicade 77
T Marlett 24 LI
T Microzoft Sans Serif 28
T Palatine Linotype Sample
T Symbol
. AaBbCeD
[~ Underine ™ Shike-Out Text Color: NI -

Ok I Cancel | Apply I

Edit Text

1 @ Textbox in the FlowPAGE that you wish to edit. The edit handles appear.

2 Right mouse click on the textbox and $ cut
Copy
@ E Paste
Properties. . ,
Grouping 4

3 Type in the new text. x
Text |Line I Fill I Fant I Puasition and Sizal

¥ Multiple Lines I~ wioid Break

Harizontal Alignment
 Left

% Center

" Right

Yertical Alignment
! Top
& Certer
= Bottarn

4 @ . See Edit Font

(FlowPAGE).

ak I Cancel Aoply
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Change Plot
Use Change Plot to change which Plot is displayed from those available on the CXP desktop.

On the FlowPAGE, @ the Plot you want to replace. The edit handles appear.

1
@ x
2 FlowPAGE » Change Plot. Plos =

- [Lymiphs] FL3 Log/FLS Log

& [Lymphs] FL2 Log/FL3 Lag

- [Lymiphs] FL1 Log/FLS Log

% [Ungated] 55 Lin/FS Lin

i [Ungated] Legend

g [Lymiphs] FL4 Log/FLS Log

& [Lymphs] FL3 Log/FL4 Log

o [Lymiphs] FLS Log/FL4 Log

& [Lymphs] FL2 Log/FL4 Lag

- [Lymiphs] FL1 Log/FL4 Log

@ [Lymphs] FL1 Lag/FL3 Log

4§ {5000) [Lymphs] FL1 Log/FLZ Log
|4 1 oronks1FL2 1A =l

0K I Cancel Help |

3 Select the plot you want to use.

4 @

Grow to Largest

1 Select the items to be changed. See Select a Group of Items Within FlowPAGE.

2 @ . All items in the group grows to the size of the item which has the largest area.

Shrink to Smallest

1 Select the items to be changed. See Select a Group of Items Within FlowPAGE.
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2 @ the button. All items in the group shrink to the size of the item which has the
smallest area.

Align Left

1 Select the items to be aligned. See Select a Group of Items Within FlowPAGE.

o+
2 @ . All items are now aligned to the item that was the furthest left in the objects
selected.

Align Right

1 Select the items you wish to align. See Select a Group of Items Within FlowPAGE.

2 @ . All items are now aligned to the item that was the furthest right of the objects
selected.

Align Top

1 Select the items to be changed. See Select a Group of Items Within FlowPAGE.
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o=
2 @ . All items are now aligned to the item that was the topmost in the section that
was selected.

Align Bottom

1 Select the items to be changed. See Select a Group of Items Within FlowPAGE.

+ 4
2 @ . All items are now aligned to the item that was nearest the bottom of the
objects that were selected.

Space Evenly Across

1 Select the items to be changed. See Select a Group of ltems Within FlowPAGE.

2 @ lad . All items are now horizontally spaced equally.

Space Evenly Down

1 Select the items you wish to change. See Select a Group of Items Within FlowPAGE.

2 @ 3 . All items are now vertically spaced equally.
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Save FlowPAGE As
To save an existing FlowPAGE as a FlowPAGE template:

1 @ FlowPAGE » Save FIowPAGE As to view the Save FlowPAGE dialog box.

2  Specify the desired drive and folder by 20x]
selecting them in the list boxes or by Save it [ adrmin = =1
typing the path in the File text box. st %Gcs

Heml Results
Images C'worklist
Lrnd

Panel

Praotocal

3 In the File name text box, type the Flepane | s |
deSired Flle Name. Save as ype: IFInwpage Files [* pge) ﬂ Cancel |

4

4  FlowPAGE gives the default file extension * PGE. The *.PGE extension is only a
suggestion, any standard DOS characters can be used for the full file name.

Note: Keep the extension consistent for easy file searches.

B.23 CYTOMETER MENU

The Cytometer menu is concerned with online connection and control of the flow cytometer.
The Cytometer Control menu option allows the Cytometer Control screens to be activated.
Until this is done the other Cytometer menu items are grayed out.

The Status Page displays current instrument settings, which can be printed out for future
reference.

The Cytometer Log displays a log of errors generated by the system.

The Get Cytosettings from Protocol option allows Cytometer Instrument Settings to be
obtained from a Protocol other than the current Protocol in memory:.

The Get Cytosettings from LMD file option allows Cytometer Instrument Settings to be
obtained from a listmode file.

The Controls for Acquisition are also found within the Cytometer menu.
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See also:
Flow Rate
Status Bar

Cytometer Control

The Cytometer Control button

USING CXP SOFTWARE
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opens the Cytometer Control screen. This screen is a

show/hide dialog box. The type of Cytometer you have installed determines the screens

displayed and the functions that are available.

See also:

Cytometer Control Acquisition Setup Tab
Cytometer Control Detector Tab
Cytometer Control Compensation Tab
Flow Rate

Cytometer Control Acquisition Setup Tab

This screen is used to set the Acquisition Mode and Acquisition Limits. Additionally, the
Discriminator values for the selected Parameters can be set.

Duration (s)

Max Events
Drive Space (MB)
Live Gate

Setup Mode
Quick COMP Mode
QuickSET Mode
Baseline Offset
Dots
Discriminators
Parameter Button
Red Laser Shutter

Note: You cannot make any changes on this
screen when running a locked protocol.

See also:

Cytometer Control

Cytometer Control Detector Tab
Cytometer Control Compensation Tab
Cytometer Control Parameter Setup
Flow Rate

Status Page

Cytometer Control K|

Az Sebup I Detectorsl Compensationl

—Acquisition limits
Duration (g]

Dizcriminatar | | J

EDD

Max everts
100000

Drive Space(MB]:  1603.4

— Acquizsition mode

Live Gate

—

¥ Setup Mode

FS
55
FL1
FL2
FL3
FL4
FL3
ALK

— Red Laser Shutter

" Laser Disabled
* | azer Enabled

5
OFF
OFF
OFF
OFF
OFF
OFF
OFF

T

Parameters... |

B-179

B



USING CXP SOFTWARE
CYTOMETER MENU

Duration (s)

Sets the maximum Duration of the Acquisition in seconds for each sample. When this time
limit has been reached acquisition stops. However, if the maximum number of events is
reached before the duration limit, acquisition ceases at this point.

Max Events

This is the maximum number of events, which may be acquired on the next Acquisition. To
change this, enter the new number required in the input field. However, if the Duration is
reached before the maximum number of events acquisition ceases at this point.

Drive Space (MB)
Shows how much free data storage space is available on the currently selected storage device,
in megabytes (MB).

Live Gate

This displays all Gates that are available for the Live Gating of data during acquisition. Data
outside the selected gate is not displayed and is NOT STORED to disk to reduce the size of
the listmode files by gating out all unnecessary events.

Setup Mode

Enable this checkbox to allow the continuous acquisition of data from the Cytometer. In this
mode, Stops are disabled, Printing is disabled and listmode files are not stored.

Setup Mode allows continuous acquisition of data from the Cytometer giving continuous
real-time feedback of instrument performance on the displayed plots. Any Stop & Save values
set are ignored in this mode.

Display of data continues until Abort is selected, to end data acquisition, or the Setup Mode box
is unchecked, to begin normal data acquisition.

In Setup Mode the plots are updated live time with only the most recently acquired events
displayed. The incoming data is not saved. During Setup Mode, older events are cleared from
the screen and from memory allowing the Cytometer settings to be adjusted in real-time
without reaching a set stop condition.

Data is displayed on a “first in; first out” basis. The number of events to be displayed can be
changed by entering the required value into the Dots input box.

Once you have finished using Setup Mode click Abort, or uncheck the Setup Mode checkbox
and then perform the acquisition.
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QuickCOMP Mode

Enabling QuickCOMP on the Cytometer :

Control Acquisition Setup Tab dialog box W[Lvmphs] FL3 Log/FL =101 x|
displays red slider bars on all dual = :
fluorescence plots. 103 §||1 2

These sliders are used to intuitively adjust 0%+
the compensation coefficients and update the :
compensation values in the Cytometer

0
Control Compensation Tab. HIE

FLS Log
4

Clicking the arrows adjusts the settings by 1Du‘§

+0.1%, clicking either side of the slider T

adjusts by £1.0% or drag the slider to place e e
1

. . .- 3
the cells in the required position. o

When QuickCOMP is enabled QuickSET mode is
not available.

Note: Listmode Compensation must be
performed using the runtime protocol or a
protocol with equivalent parameters as the
runtime protocol.

QuickSET Mode

Enabling QuickSET on the Cytometer _(olx R |
Control Acquisition Setup Tab dialog box ' =—=3 == =

displays slider bars on all plots.

0 B1 B2
024

1023

q_

107,

FS Lin
FLZ Lo

These sliders are used to adjust voltages
at the data plots and update the high -
voltages in the Cytometer Control S

0 1023
Detector Tab. S5 Lin FL1Log

u”-f

Clicking the arrows adjusts the voltage by
+0.1 volt, clicking either side of the slider
adjusts by 1.0 volts or drag the slider to
place the cells in the required position.

When QuickCOMP is enabled QuickSET
mode is not available.

Baseline Offset

Enable this checkbox to switch on Baseline Offset. Further information concerning the
setting of this option can be found under Workspace Preferences - Plot Display.

Dots
This sets the maximum events to be displayed during Setup Mode. The default size is 1,000
events. The Setup Mode rolling displays are updated up to three times per second. To change
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the size, edit the Dots field to the number of Dots required. If a zero is entered, an error
message displays showing range of 10 - 9999. The Dots value is stored in the Protocol

Discriminators

Lists the currently selected parameter and allows the setting and modification of
discriminator values. To change a value, select the discriminator you wish to alter and use the
Slide Control on the right hand part of the display to change the value as appropriate.

Parameter Button
Selecting this displays the Setup Parameter Screen.

Red Laser Shutter

Use to enable or disable the red laser. The shutter setting is passed as part of the instrument
settings part of the protocol.

Cytometer Control Parameter Setup

This screen is used to select the Signals required in the Parameter Setup.
The signals that are available are selectable by checking the options you require.

Note: If you add a parameter to an existing protocol, the Detector Names revert to the default
names shown below.

IMPORTANT Risk of erroneous results if you assign the same parameter name to more than one detector.
Use a different parameter name for each detector.

Parameter Selection ﬂ
— Detectar — Ratio Selected Signals

S Lin Leg Mumeratar lm 5 Lin
Mo Dienominator ISS Lin vl EE‘ILIi_n
og

FS

I
35 ISS
d = — Derived Parameters————— FLZ Log
L IFI“I r ~ Timne: -
R atia -
FL2 FL2 r
FL3 |r rr
FL4 FL4 rr
FLS rr

—Ailiary P.

[rs = [aox r r

RN

H

K Cancel | Help |

You can arrange the order within the Selected Signals list box by highlighting the appropriate
item(s) and Drag and Drop into your chosen order within the Selected Signals list box.
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To remove a previously selected item from the Selected Signals box, uncheck the parameter no
longer required.

Ratio and Time cannot be reordered and always appear at the bottom of the list.

Ratio — Choose from the drop down box the appropriate option for the Numerator and
Denominator if required.

A detector name may be entered, this is displayed in all Cytometer Control screens but does not
appear on plots.

Note: You cannot make any changes on this screen when running a locked protocol.

Cytometer Control Detector Tah

This shows the detectors with editable =
names and detector settings. Changes made Acq Setup Detectors | Compensation |

here are only reflected in the Cytometer
Control dialog box and are used to identify

Standard Detectars

Hame Volts Gain
the various fluorochromes in use. Reagent Fs F= 08 54
re s . 55 S5 7 20.0
or sample specific information should not = o %92 10
: : H FL2 FLZ 356 1.0
be entered in this menu. See View » s o o 0
Acquisition Manager » Parameter Names or AL FLd 12 18
FL5 FLS 435 1.0

File » Edit FCS Header Attributes.

Auziliary Parameters

Name Hame Volts Gain

Volts AUX AL 0 10
Gain
AUX

Note: You cannot make any changes on this
screen when running a locked protocol. o |
Close

Help

See also:

Cytometer Control

Cytometer Control Acquisition Setup Tab
Cytometer Control Compensation Tab
Cytometer Control Parameter Setup

Name

These input fields allow the editing of the Names assigned to the default manufacturer’s
detectors. Changes are ONLY reflected in the names shown within the Discriminator box in
the Acquisition Setup tab and the Compensation tab. This allows the various fluorochromes
to be easily recognized when adjusting instrument settings.

Volts

Select the appropriate Voltage for the particular Detector. This is done by using the Slide Bar
on the right side of the screen and adjusting it to the required value. For fine adjustment, the
Up and Down arrows at the ends of the Slide Bar can be used.
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Gain
Adjusts the Gain amplifier. Set the Gain to the appropriate setting you require for that
Detector. This is chosen from the drop down box, which appears when you click in the box.

AUX

Displays the signal source for the Auxiliary Parameter channel.

Cytometer Control Compensation Tab

Compensation allows for the subtraction of i
a percentage of the signal of one Acn Setup | Detectors  Compensation |
fluorescence detector from the signal of 5 — .
ompenzation b atris J
another fluorescence detector to correct for
, A FL1 | FL2 | FL3 | FL4 | FLS
the overlap of one dye’s emission into
N FL1 1.4 3.0 2.4 24
another dye’s detector.
FL2 147 152 19 94
Compensation Matrix s 19 | B 30 | 48
Clear All Button FL4 1.0 45 255 24
FLS 0.0 o7 0o 95

Note: You cannot make any changes on this
. Select the column which containg the
screen when running a locked prOtOCO].. Flusrachrome creating spectral overap in the PMT

[raw). Clear &l | j

Clogze I Help

See also:

Cytometer Control

Cytometer Control Acquisition Setup Tab
Cytometer Control Detector Tab

Compensation Matrix

Click in the box and type a value or use the Slide Bar to set the desired value. Use the Up and
Down arrows to make any fine adjustments to the value.

Clear All Button
Selecting the Clear All button resets ALL the values within the Compensation Matrix to zero.

Status Page

To view the cytosettings of an application, display or print the Cytometer Status screen for
the verification tube of the application.
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The Status Page displays the Cytometer
settings currently in use and allows you to
print these if required.

Selecting the Print button displays the
standard Windows Print dialog box.

Printed status pages also contain the
protocol filename, date, time and
cytometer serial number.

Cytometer Log

USING CXP SOFTWARE

: Status Page ﬂ
Frint |
FS 55| FL1| FL2| FL3| FL4| FL5| AUX
Voltage 266| 217| 392| 365| 445| 412| 4499 o
Gain 20| s00f 10| 10 10| 10| 10 10
FS 55| FL1| FL2| FL3| FL4] FL5] AUX
| Discriminat 25| OFF| OFF| OFF| OFF| OFF| OFF| OFF
FL1| FL2| FL3| FL4] FL5
FL1 1.1 3 24| 289
FL2 147 192 18| 499
FL3 49| 354 3| 48
FL4 1 45| 298 24
FL5 o o7 0 495
Laser Power (mW)| 20,00

Use this menu item to view the log of errors generated by the system. It also allows you to

clear this log as needed.
Get Cytosettings from Protocol

The Get Cytosettings From Protocol
option allows Cytometer Instrument

Sharlene - Open Protocol

21|

Look ik I =3 AcquisitionProtocol

] e ®Bcr B

Settings to be obtained from a
Protocol other than the current
Protocol in memory.

Choose and Open the required
Protocol.

| A5 2 [Settings].PRO
] 45 2C Flow-Set PRO

=] &5 2C Neg Control. PRO
] 5 2C Verify.PRO

] A5 4C 1L verify. PRO
] 45 4C 1L Flow-Set.PRO
] 45 4C 1L [Settings] PRO
] A5 4C 2L [Settings] PRO
(3] 45 4C 2L Flow-Set PRO

4]

A5 FL3 Comp.PRO

A5 FL4 Comp,PRO

A5 FLS Comp.PRO

Cleanse - Bleach,PRO

[#] Cleanse - Water,PRO

QC 1L Flow-Check.PRO
L Fi An]

=] A3 4C 2L verfFy FRO

8] 45 5C 1L [Settings].PRO
=] A5 5C 1L Flow-Set PR
] 45 5C 1L Verify PRO

8] A5 5C 2L [Settings].PRO
] 5 5C 2L Flow-Set PRO
=] A5 5C 2L Verify PRO

=] A5 FLL Comp.PRO

] 45 FL2 Comp.PRO

| i

File name:

[T 2L Flow-Check.PRO

Open I

Filez of twpe: IProtocoI Files [* pra]

ﬂ Cancel |

4

Get Cytosettings from LMD file

The Get Cytosettings From LMD File
option allows Cytometer Instrument

new user - Open LMD File

21|

Laok jr: | ) LMD

x| = ®ckE-

Settings to be obtained from a
listmode file.

Choose and Open the required
listmode file.

2 CD3 CD4.LMD
= 2c €03 CDE.LMD
&= 2c coa co19.LmD
) 2 o3 cose.LMD
2c Meq Control LMD

(&) 2c verify LMD

4]

4c 1l Yerify LMD Irrmuno2 Flow G
Comp FL1 LMD
Comp FLZ.LMD
Comp FLE.LMD
Comp FL4 LMD

Immunol Flow Count. LMD

| o

File name: |

Open I

Files of type: ILMD Files [*.Imd *fcz)

[ Open Rurtime Protocol

j Cancel |

4
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Start
2 .
The Start button initiates acquisition of the current sample.
Stop
|
The Stop button ends data acquisition. Any Output options such as saving data,

calculating statistics, printing reports, and so on, are then performed.

Pause

The Pause button pauses data acquisition as does clicking. To continue Acquisition,

b l

select . To restart acquisition from zero events select

Abort

Selecting the Abort button displays the Abort screen. This function is only available if
Acquisition is running.

Note: No Files are saved if a tube is Aborted.

Select the option required and @ .

Abort the Tube? T x
Abort the Panel?

Abort the MCL? Doy:ou want to

Repeat the Tube? e

Repeat the Panel? € Abett the MCL?
" Repeat the lube?
" Repeat the panel?

0k I Help
Abort the Tube?
Stops acquisition, marks the current tube as aborted and the instrument proceeds to the next
tube.

Abort the Panel?

Stops acquisition, marks the remainder of the current panel as aborted and the instrument
proceeds to the first tube of the next panel.

Abort the MCL?

Ejects the current carousel and leaves the remainder of the Worklist unread allowing
resumption from the current tube.
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Repeat the Tube?

Allows the current tube to be resampled.

Repeat the Panel?

Allows the current panel to be resampled. The MCL returns to the first tube of the current
panel.

Restart

d

If a sample is already being acquired, the Restart button
zero events.

restarts the Acquisition from

Pause and Rotate
The Pause and Rotate button allows you to pause processing of a single sample and

rotate the MCL to a fixed position on the carousel so that additional reagent, for example, can
be added to the sample. SHOW ME an example of Pause and Rotate sample processing

Note: To prevent excessive air from entering the flowcell, do not leave the Cytometer paused
for extended periods of time.

Idle Mode

The Idle Mode button IE‘ places the Cytometer in Idle mode so that various cleaning and
replacing procedures can be performed.

Prime

The Prime button @ allows you to declog or remove bubbles or blockages from the sample
line with sheath solution.

Cleanse

The Cleanse button allows you to initiate a cycle to flush the instrument sample lines

with Clenz solution. The Cytometer must be in Idle mode, IEI, to perform this function.
AutoCleanse

The AutoCleanse button IE allows you to initiate an automatic cleanse cycle to clean the

MCL vacuum and sample lines. The Cytometer must be in Idle mode, IE‘ to perform this
function.
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Status Bar

The Status Bar which is shown at the bottom of the screen displays the following information
when in Acquisition.

Lunaiting S ample | =)= |2.9s 10000 events | [MLIM | 4
i
||§<B§%ﬁ::®ﬁ & 3
Cytometer Status “Aowaiting Sample” Elapsed Acquistion Total Events
Indication or Events/Sec Time (Secs) Acquired
See also:
Total Events
Elapsed Time
Data Rate

Total Events
The current total number of events acquired is displayed here.

When acquiring, this value increments to the maximum events set or until one of the Stop
conditions has been met. See Acquisition Stop and Save.

When acquiring data in Setup Mode, this item cycles in the range from 0 to 10 times the
number of Events shown in the Dots Displayed. The value appears to wraparound, that is, if
you have requested 5,000 dots to be displayed, this item increments to 4,999. On the 5,000th
event the total events counter resets to 0.

This ensures that you can continue to display data without reaching a set stop condition.

Elapsed Time
This item shows how many seconds have elapsed since the start of data acquisition.

When in Pause mode, the timer on the status bar does not continue to increment. The total
elapsed time can be viewed from the FCS Keywords associated with the beginning time and
end time of acquisition.

Data Rate
This item shows the speed of data acquisition.

This refers to the Processed Data Rate, that is, the number of events which have exceeded the
discriminator, subsequently processed and saved in memory.
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Flow Rate

This item shows the relative flow rate _

of the Cytometer during acquisition. .
Click on the drop down box and Lytometer Window Help

choose the required rate. | [ =] 1 |

The Flow Rate can only be displayed + I & | b ||Medium |
as Low, Medium or High. The Flow

Rates are approximately: 10, 30 and

60 pL/min respectively.

B

Cytometer Status

Displays the current status of the Cytometer and the most recent error message. Double click
on this field to display the Cytometer Status Message dialog box.

Windows Status Bar

The Windows Status Bar normally gives a brief description of selected menu items.

When drawing or editing Regions, the Status Bar shows Channel for X and Y parameters
respectively as they are drawn.

X and Y Coordinates

The X and Y channel values are the coordinates of the cursor position given by a scaling
factor. This scaling factor depends upon whether the respective parameters are linear or
logarithmic amplification and whether you have calibrated the parameters or not.

* If the parameters are linear and uncalibrated, the X and Y channels vary between 0 - 255
or 0 - 1024 depending on the data source.

If the parameters are logarithmic and uncalibrated, the values vary between 0.1024 - 1024,
and span four decades. for most other manufacturers, the data varies between 1 - 10,000,
spanning four decades.

B.24 WINDOW MENU

Cascade
Use Cascade to display the window so that the plots overlay.

@ Window » Cascade.

Tile
Arranges each plot so every window display is visible. The pattern depends on the number of
open Windows.

@ Window » Tile.
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Tile Special

Tile Special overrides the normal Windows Tile command, this allows plots within the

workspace to be arranged in a logical manor.

The plot size in Tile Special resizes plots currently displayed in the workspace.

New plots are sized equally according to the default size setting in File » Workspace
Preferences » Plot Display.

Plots may be ordered by File, Gate, or Parameter or any combination of these.

At the start of each row, the Plot Type Icon is displayed.

1 @ Window > Tile Special to display the Tile Special dialog box.

By clicking the mouse on the File, Gate
or Parameter column heading, the plots
are displayed across the screen in
alphabetical order. Clicking the
appropriate column heading again
displays the plots in reverse order.

B-190

The order is shown in the Tile Special

dialog box. @ to apply

the change.

You can also Drag and Drop the plots
into any order.

Tile Special =

File | Gate

| Farameters | =

u @ 50 21 as verify 819-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd
o 5 21 &z verify 8-19-3-45-4.Imd
FLOWPAGEZ 3
FLOWPAGEZ 4

u @ 50 21 as verify 819-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd

u @ 50 21 as verify 819-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd
Whcllas werify 8-159-3-45-4.Imd

- Whcllas werify 8-159-3-45-4.Imd

Flat Size

" Smal
& Medium
' Large

o]

[180x180)
[225x225)
[300x300)

Lymphsz
Ungated
Ungated

Lymphsz
Lymphsz
Lymphsz
Lymphsz
Lymphsz
Lymphsz
Lymphsz
Lymphsz
Lymphsz

Cancel

FL1 Logw. FLZ Log
55 Linv. F5 Lin

FL1 Logw. FL3Log
FL1 Logw. FL4 Log
FL1 Logw. FLA Log
FLZ Logw. FL3 Log
FLZ Logw. FL4Log
FL5 Log w. FL4 Log
FL3 Logw. FL4 Log
FL3 Logw. FLS Log
FL4 Logw. FLS Log LI

Help
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B

The - icon is activated by clicking to the
left side of a plot listed in the File column.
This forces that plot to be displayed on the

[ [

following row. If an existing d is clicked,
the icon marker is removed and New Row is
not forced.

1§ o, SR FE
s 3

In addition, if (Ct1) is depressed while the
File, Gate or Parameters selection is made,
plots can be sorted by Gates within File, and
Parameters within Gates/Files.

cRsERr _
cRsERr _

CRsERr

When is selected in the example
Tile Special screen shown above, the s
resulting plot display is shown to the right.

Arrange Icons
This option is used to arrange minimized plot windows. Plot windows can be minimized and

placed anywhere on screen. @ Window > Arrange Icons to place all icons along the bottom of
the screen.

Note: This option is very useful when minimized plots have been "lost" on the desktop.
Choosing Window » Arrange Icons places all the icons along the bottom of the CXP software
Window.

Force Square

Each window is squared so that horizontal and vertical sides are the same length. That is,
aspect ration is forced to 1:1. This is used mainly for dual parameter plots.

Close All

Choosing this option closes all CXP software windows.
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B.25 QUALITY CONTROL REPORT

The Quality Control Report consists of Levey Jennings plots based on information selected in
the QC Template and data stored in the QC tables in a report database. The information
selected in the QC Template may be results (that is, %, cells/pL, mean, mode) or cytosettings
(that is, voltages, gains). The data is plotted against time in the Levey Jennings Plots and can
be saved to spreadsheet format.

Note: A QC protocol must be run prior to viewing data associated with your instrument
(serial number).

QC Levey Jennings Screen

[ac Levey Jennings - Clinical Panel (ver 0.0.2:9) =)
Fle Teplste Help

1 @ BL! Report Generatm{}Karen...l to display = | v 2000 =

Torite | o =r

the Report Generator toolbar. N

1: FS Mode - g1l flow-check lot 2088.PRO. Flow-Check(TM), 2088, Flow-Check, X, Mode }

51967 Means25D)
507.07 (Mean)

494,47 (Mean25D)

2 FS770 Mods - o1l lowcheck lot 2086 PRO, Flow Check{TM) 770, 763303, FC770, X, Mods

4 MearTOMEN)
324 Mean(MAN)
T4 e TOMAN)
—
=
2 =

3 LT Mode - oe1l fovecheck lot 2098 PRO, FlovCheck(TH), 2088, 4, %, Mode

522 Means37MAN)

on the Report Generator
toolbar to display the QC Levey
Jennings screen. O Rt ot S, o 055,

485 Mean{aN)

48 Mean37MAN)

511 Means42IMAN) =

St 760 tmi2iaters e teien N2 sma mEnl 234
tadzonk

Al E|

Instrument
Choose the instrument that you want to view QC data from.

Application

@ W and choose an AutoSetup 11 application that is associated with a template.

Note: To view QC results that were run without being associated with an application (for
example, Flow-Check QC results), leave this option unchecked.

Data Table

Displays the information from the Levey Jennings plots in tabular format.
See also, QC Data Table.
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Remove Points
To remove a data point from a plot, |
Sl e R
@ @ zc?::,FcEéz[u,kHPch" R
on a data point and Remove. e [T

To restore the data point, ) e

@ Valie ,55— U-Limit | B7

¥ Remove to clear the checkbox. Ve [
. . Loth | 20w

Deleted data points are displayed green e

and are excluded when calculating the et [Cicl Pne
mean and SD on the Levey Jennings Connens |

plO t. Save Comment I Reference

¥ Removed

To remove a range of data points,

1 @ Remove Points | and @ on the first data point to remove.

2  Right mouse click on the last data point to remove and @ .
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B-194

Reference Points

To assign a data point as a Reference,

@ on a data point and @

Reference.

To restore the data point,

@ ¥ Reference to clear the
checkbox.

Reference points are displayed blue and
when assigned, the Mean and SD of the
Levey Jennings plot can be calculated
from the Reference points.

[#¥Data Point Information
Label |1 FS HPCY - OC 4C 1L FITC-PE-ECD-PCS
Flow-Check(Th|_ALIGN.pr. Flow-Check[TH].
20k, FC@2.0, %, HPCY
Date  [5/19/2004 1:42:08 PM
Appleation | sjipmenty
U-Limit |67
Value |68
Mean |66
Lot | 20w
Llimt |65

User 1D Clnical Panel

Comment [

Save Comment I Reference

™ Removed

To assign a range of data points as reference,

1 @ Peteenceponts | 41 @ on the first data point.

2 Right mouse click on the last data point and

M ==
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Delete Plot

1 @ s (to the right of the plot title). Multiple data plots can be selected.

2 @and@.

New Plot
Add a new plot.

File Menu

Print
Print the displayed QC data.

Print Preview
Preview the QC data printout.

Page Setup

Set page orientation and margins.

Close
Close the QC Levey Jennings screen.

Template Menu
The dataplot definitions of the Levey Jennings screen can be saved as a QC template.

Clear Template
Clear the current template

Select Template
Select a saved template.

Save Template
Save the current template

Save Template As
Save a template as a different name.
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Associate Default Template Files To Your Instrument

Default QC templates are installed with the software. You need to save the default template
files with your instrument serial number for the database to populate them correctly.

1 OntheQC Levey Jennings screen Inshument | Defaul =]

@ A
Default in the Instrument field. ez ion I -# -]

Select QC Template

OC Template [ UseriD_[_Instument |_Appisation | Date [2]
A5 5C2L_STAND default 8/19/2003 12:31:00 PM
2 Template » Select Template. A atenr i Banna 112t
A4S LSA 45-4-83 _STAND default 8/19/2003 2:16:00 PM
A5 LSA 4548 3FC_STAND default 8/19/20031:01:00 PM
A5 LSA TBNE _STAND default 8/19/2003 2:01:00 PM
A5 LA TBMK FC_STAND default 8/19/2003 1:55.00 PM

A5 telralHP 45-4-83_STAND defaul 8/19/2003 2:36.00 PM
A5 tetracup 45-4-8-3 FC_STAND default 8/19/2003 2:32.00 PM
A5 telraC¥P TBNK._STAND defaul 8/19/2003 212,00 PM
A5 tetraC{P TBNK FC_STAND defauit 8/13/2003 2:07:00 PM
10AP Immuno Low tetra default 8/18/2003 5:51:00 P
1GAP Immune Low tetra FC default 8/18/2003 4:40:00 PM
10AP ImmunoTrol tehia default 8/18/2003 5:13.00 P
1GAP ImmunaTrol tehiaF C default 8/13/2003 12.22:00 PM

o

defaul

3  Highlight the desired template and

O

defaul

Open Delete Cancel

@
4 Template » Save Template As,

enter the template name and [AC 2L Flow-Check[TH] ALIGH
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Modifying Template Files

You can modify a default template to collect QC data from different protocols and parameters.

USING CXP SOFTWARE
QUALITY CONTROL REPORT

Note: Do not modify or edit IQAP templates. Use the IQAP templates to submit control data
to the IQAP Program. Refer to the IQAP manual, PN 4206384, or www.beckmancoulter.com
for additional information.

Select Parameter

1 @ on the title bar of a plot.

g1l flove-check lot 2DBB.PHD%FIGW-Eheck[TM] 770, 763303,

2 Use = to choose the appropriate,

b.
C.
d

User Label
Protocol
Product
Lot #.

3 @ one of the choices,

a.

Parameter & and choose the

parameter or compensation setting

or,
Region & and choose,
¢ the Region
e XorY
* the Statistic.

(K1

Protocal IQE 4C 1L FITC-PE-ECD-PCS Flow-Cheek(TH]_ALIGN pr

Ll

Ll

Product  [Flow-CheckiTH)

(K1

Lot 20

Parameter |

Ll
&

Fegon  |FC@20 s

(O (ol

Statistic |HF‘EV j

ok Cancel

4 @
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Select Mean

[Mea
1 @ (Mean). E\%

@
2 one of the choices, TV
e CGomputed Mean. | BEEEE

¢ Manual Mean and enter value.

" Manual Mean

% Computed Mean

3 @ | o | =]

Select Limits

@ @ [Mean+§[ﬁl]
1 (Mean+) or (Mean-).

@
2 one of the choices,
¢ Mean+/-nSD and enter a number. & MeansinSD w50 |2

* Mean+/-%Mmean and enter percent.

= Mean+/-%Mmean Percent [%] |5
" Mear+/alue Walug I1

¢ Mean+/-Value and enter value.

oK | Cancel |

3 @
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QC Data Table
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The QC Data Table displays the information from the Levey Jennings plots in tabular format.
Each column of the table displays the data from one Levey Jennings plot. The statistics for
each column are displayed at the bottom of the table.

@ E and El or @ in the scroll

box to scroll both data tables together.

E-E and drag a scroll bar to scroll a
data table individually.

File Menu

Create Spreadsheet File

EE [oserate | 4 display the Data Table.

Fle 108° Heb

Facily |

nstument[ags0004

Tenelste (138 InmnoT ol erafE

Applcaon

=
CurentDste 571972004

DB FistDate  [5/1972008
DB LastDate  [5/13/2004

W oo
W e

W osonee |7

Date. [ Flag [ 175 Mode | 2F5770Mode | 3FL1Mode | 4FL2Mode | SFL3]
TSR En 2 20 501 e
2772003 1156 30 AM
82003 121121 PAd
771072003 351,38 4M
27 M

773072003 11:403

iode | BFLeMode | TFLSMode | BFS HP o]
07 I ]

s a8 7
ol a1 7
= e 7
= e )
.
51

a
@
i
bt
o1 ED £ el E = a9 ®
s a7 B P} bt @ e o
01 i 5 s = a8
siz -3 52 50 20 a0 &
sz £ 52 i bt e} a7 0
En 2 5 a1 a3 50 i
£ 2 En 153 a3 F a0 109
Er ) ) bz} s pr an ®
S0 E) £l a7 a7 a5 ane i
En 27 si7 157 a7 = a9
s g2} st i a3 = a0 i
05 E22 £ 3 e = a5 T
s En) Ei m a0 & 76 §
512 E Em b} po ey a7 i)
En 3 £y s51 50 i 50 ]
= 2

= STr0Mo | 3

e
e

=0

24N
38
118

AN
3Nan)

2
sasan)
53
118

aan)

aagen)
785

15
St
Qnen)

7N
55

i
StapaN)
)

L1 Mode | 4FL2Mode | 5FL3Mode | BFLAMode | 7FLEMode | GFSHPCY
g g e ) = e

SEMAN) dBSMAN) | LIMAN)
6as 761 17

131 158 1931

SIGMAN)  SOSMAN) | LEMAN)

SMAN)  IMAN) BN
o

Creates a text file (*.txt) that contains the data table information. You can import the file into

a spreadsheet program for analysis.

Print

Print the QC data table. When you use an IQAP template for control results, print the data
table and fax or mail the results to the IQAP Program.

Print Preview
Preview the QC data table printout.

Page Setup

Set page orientation and margins.

Close
Close the QC Data Table screen.
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IQAP Menu
The IQAP information entered here is saved to the printout and spreadsheet file.
Edit IQAP
@ -nix
1 I0AP » Edit IQAP to display the Patiopant D [
IQAP information. teons [————

B.26

B-200

Instiument IDAF Code

oK | Cancel |

2 Enter your IQAP information and

U

4

PANEL REPORT TEMPLATE

IMPORTANT Risk of panel report not generating if you have not saved the template before running the
assay for the first time. Edit the limits and save the template before first-time use.

Risk of misleading results if you do not specify the correct cell population. Specify the correct cell
population even if you do not want to print the line since other lines may refer to this line.

Overview

Results are exported to the database when they are generated from panels that are “export”
panels. tetraCXP panels and LSA panels are examples of export panels. This means that when
you run a sample in a tetraCXP panel, LSA panel, or replay a listmode in a tetraCXP panel or
LSA panel, the results are automatically exported to the database. There is a one-to-one match
between tetraCXP panels and their corresponding templates and a one-to-one match between
the LSA panels and their corresponding templates.

Any panel can be saved as an export panel. See Creating a New Panel Report Template or
Creating Panels in the Instructions for Use manual.

When you open the desired panel report template, it is important to understand how the
template affects the printed report.

Each line in the template represents information to be used in the final printed report. Certain
lines of information, such as those used for calculating other results, are not printed on the
report.

Each template has three tabs: Global, Local and Data Plots.
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B.27 CREATING A NEW PANEL REPORT TEMPLATE

In order to print patient panel reports, you need to create a panel report template that you use
to define what to print on the report.

Create A CPF File

A CPF file contains the settings for a panel report template.

1 'I'f“ 1 h 1 Look in: | (3 Parel R = e =z
, select the panel you want to B e
[Ei]4cL - 2tube panel.PrL
use to create a panel report template T

5C2L-Beads, PRL
FHRCSA Assary. PHL

m LS4 45-4-5-3 Assay For 6.PNL
and .

File name: |4E1 L - 2tube panel PML Open I
Fies of type: [ Panel Files [~pri) =l Cancel |/
A
2 Right click on the panel in Acquisistion 2]
Save jn I@ Panel j - ok B~

2C1L - Stube panel PHL

4C1L - Ztube panel PNL

SCIL - 1tube panel.PIL
5C2L-Beads, PHL

PHPCSA Assay.PHL

LS4 45-4-8-3 Assay for 6.PNL

Manager and @ Panel vizard &

File name: |4E1 L - 2tube paneld PHL Save I
3  Type a name for the panel, Saveasype: [FansiFies o0 ol g |

¥ Export results of panel to Report Generator

@ ¥ Export Results of panel to Report

Generator and @ .

PN 1755708 B-201



USING CXP SOFTWARE
CREATING A NEW PANEL REPORT TEMPLATE

Create the Panel Report Template

open 2=

Look in: [ =3 Panel - & ek E-
4 @ B Report Generator and @ l@| to ! _

display the Patient Template screen.

Fil name: [4c1L - 20ube panelz.cof =l pen

[ o |
S Files of type [Panel Filez [~.cpf = Cancel
P

5 @ File » Open, select the CPF file
you want to use for patient reports and

U

6  Use the Global, Local and Data Plots tabs to enter the information you want on the
patient report.

7 @ File » Save to save the template.
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Global Tab Settings
JITeTEY
e e Template: LSA45-4-8-3Assay
j"éTBE'éT’| Local | Data Plats |
(G Bl E Caloa Hem = r SI Units ™ Auto Prirt Report //o
r Print Ranges T AutoSavePdf |
Report Comment: T AutoSaveXLS =
= 0
\ 4
é 6 55700068
@ Allows you to choose whether or not to print ranges on the report.
@ Allows you to select the reporting unit format: SI Units or US format (which is the default if SI Units is
not selected)
© Allows you to enable auto-printing so that the panel reports automatically print at the end of
acquisition.
@ Allows you to enable auto-save to .PDF.
© Allows you to enable auto-save to an XLS file.
O Allows you to define a global report comment that prints on every panel report generated from this

template
Note: You can edit the comment on individual reports if necessary. See Editing Report Comments.

)

Allows you to choose Cells/ul CAL, Cells/ul Hem or Number. Cells/ul CAL adjusts absolute counts
based on the CAL factor. Cells/ul Hem calculates absolute counts based on the Cell Population
selected from the hematology patient information and the number of events in the result region.
Number displays the unadjusted count in the region.
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Local Tab Settings
[PHrane rempiate \ i1
File Help
Template: /| 4C1L

j High /@

Region: l_ v Opt Stats: (1] l_ 'l 0 |\ D//
- @ - o \ u///m

" Equation l__;l = | Update | Ugcelfgian& |

Description F/Eq Region Cel Opt Stat 1 | Opt Stat 2

Poy &
| | | o | | | | \
1 1.000 1{.000 1.000 0.000 3| #

)

%Low #%High Hlow #High |%
\

1
\

el

© © © 000000

(1) The equation result is selected from a drop-down list that includes:

%&# (Both) = Percent result is calculated from percents and is placed in the Result column
and Count result is calculated from counts and is placed in the Count column.

Percent = Result of the equation is placed in the Result column with a % sign.
Count = Result of the equation is placed in the Count column.
Result = Result of the equation is placed in the Result column, no % sign.

55700078

See explanation for © for additional equation options.

IMPORTANT Risk of misleading results if you do not specify the correct cell population. Specify the
correct cell population even if you do not want to print the line since other lines may refer to this line.

(2] Select a cell population (LY, MO, NE, EO, BA, Other, WBC, RBC, PLT, or blank) based on the gating
that was used. The available selections correspond to the hematology information in the database.
A selection must be made when the calculation method is Cells/uL HEM; otherwise, Cell Pop is
grayed but retains its value. Cell Pop is blank when Equation is selected.

(3] Text description of the current template line
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(4] When selected, lists all the protocols in the panel. From the drop down list select the protocol to
extract results from.
(5 Use one of the following methods to define a custom equation.

« Type an equation using the (), *, /, +, -, @, & operators. Result Rows are designated in the
equation as R001 to R999.

» The Row number can be preceded by,
"% = Use the value in the Result column of the row
"# = Use the value in the Count column of the row
'@ = Use the value in the Opt Stat 1 column of the row
'& = Use the value in the Opt Stat 2 column of the row

« Define an equation by clicking on a cell in the Results Section to add it to the equation. For
example, clicking on the Count column of Row 5 adds #R005 to the equation.

Right clicking on this field displays the following options,
+ Add
Subtract
* Multiply
/ Divide
DF = Dilution Factor
HV = Harvest Volume
BW = Body Weight
0 Displays the optional statistics for the result that was selected in the Region field in the Protocol
area of the Local tab. Select up to two of the following for each Results Row: X-Mean, Y-Mean,
X-Mode, Y-Mode, X-Median, Y-Median, X-CV, Y-GV, X-HPCV, Y-HPCV. Only statistics that were

selected in the protocol during acquisition are available as options. Optional statistics cannot be
selected when Equation is selected.

(7] Adds a row using the information entered and blanks all of the fields.

(3] Indicates if item prints on the report:
N = not printed; used for calculations; do not enter ranges for these items
Y = printed
B = blank

(9] Adds a row using the information entered and retains the information in all of the fields.

(10) Fields where you enter the low and high percentage range limits that appear in ®and O,
respectively. Low range is -1000 to 1000 with 3 decimal places. High range is -1000 to 1000 with
3 decimal places.

(1) Fields where you enter the low and high absolute count range limits that appear in ®and O,

respectively. Low range is -999999.999 to 999999.999. High range is -999999.999 to
999999.999.

(1) Indicates if item prints on the report:
N = not printed; used for calculations; do not enter ranges for these items
Y = printed
B = blank
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Displays the optional statistics for the result that was selected in the Region field in the Protocol
area of the Local tab.

Indicates that result of the equation is calculated from counts and placed in the Count column.

Indicates that result of the equation is calculated from percents and placed in the Result column.

Displays the high count range limit entered in (11
Displays the low count range limit entered in (11}
Displays the high percentage range limit entered in (10}

Displays the low percentage range limit entered in (10}

Represents the cell population used for gating absolute counts from a hematology instrument on
non-Flow-Gount panels.

Displays the region from where data was extracted.

®Se 6066 66068668 6

Displays the protocol name (P) or an equation (Eq) used for arriving at the results.

®

Text description of the current template line.

Data Plots Tab Settings

rotient Temppre

File  Help

TR \ mom [ Data Ptz i|
- D e I Mg
#so#e W #a 1 <1 AAFT S5 FS =l
, z | :J 105453733 CDASFITE v, 55 =
102757575 COI-PCS v, COSGRD1
49 om0 w1 w2 3 = 7 g 5
: 2 -
3 4 ms ;31 5 ﬂ ﬂ
E 7 |
[ ' =]
Clear All ~ — ! :J
: 1o

55700088

@ Allows you to select up to 16 data plots to include in the report.

@ Displays the protocol name and index number. The index number represents the protocol order in the
panel.

© Displays the data plot name and index number. The index number is a unique number for plot
identification.

B.28 EDITING PANEL REPORT TEMPLATES

B-206

Before Running an Export Panel for the First Time

Before you run an export panel for the first time, update the template and save the limits. If
you do not save the updated template, the following message appears:
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Panel validation error x|

& Panel Report will nat be generated because there is no Report Template Far the panel.

Save the template in the Report Generator Report Template to mark the data for export,

Procedure for Editing/Saving Panel Report Templates
Do this procedure to edit and save a any export panel report template to:

select/deselect SI units

enable/disable the auto-print feature (when enabled, the report prints automatically at
the end of acquisition) Note: The panel report auto-print feature is in addition to
FlowPAGEs, plots and/or statistics that auto-print per the Workspace Preferences setup
(see Workspace Preferences, Acq Options tab)

add a global report comment (which is printed on every report generated from the
affected template)

edit flagging limit ranges
add or delete plots

@ | IQ Report Generakor

@ @l to open the Patient Template screen.

PN 1755708

View the templates (with .cpf ooen
extension): Loskcin: [5 Pore

(] 2c1L.cof
a. @ File » Open.

[#]4C1L cpf
b. Navigate to the desired panel
folder.

4

File name:
B Files of type: Panel Files [*.cpl)
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4  To view the contents of a pre-defined template, select the desired .cpf and @ Open.

Note: Any export panel created by a user must have the corresponding Panel Report
Template created by that user.

5  To select/deselect SI units,

Template:  L8A45-4-8-3Assay

enable/disable auto-print, or to 55 s
Coun Dipay Core e — r SUms T AdoPitepen
r Print Ranges. I AuoSavePd
add/enter a report comment, 5
Global. ’

Note: If editing a global report
comment, only future reports will be

#High %] 4| OptStatt | optsta2 [ p[ A

LSA45483PR0 coaical | i
printed with the updated text; reports < R ﬂ ;
generated prior to the change will not
contain the updated comment.

i
o -
e e  LSA45-4-8-3Assay
6  To edit flagging limits, Local. s o
N e o — -
@ Pooed [sassesarR0 ] Low Hi
P T a— (R e | Pacet [ IL:
care [ = e = o e (e

CD3+/C08+ (Suppressor Toelk) LS4 454:8:3PR0 COB(E2) 4 0000 0000 000 0000 ks
Co4.CD8 Ralio >%=RO0ZAO03/100 E) 0000 0000 000 0000 v
CO3+ Reabiity Check. S%-RODTAICZAAO0S  eq 0o 00w 00 0000w v
000 000 000 0000
s

71  Enter/edit the information as needed.
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8  To select data plots for the report,

Template:  PH2_LSA_2ube.

Gicbal| Local | DalaPlois
Data Plots. B = — 8

o I |
3 TUSE AT HIPRO | ST S5y S j
Bl e LY - T—— T O T
2] zusmssisaem =] 10T cosees comRD1 %
ESI T i = i|
i Ee WS e I By b
= 7 il

o e - i<

et i G|

2% e g
o omgy
w oway

9 @ File » Save to save the template with your changes.

10 @ File » Print to print a copy of the template for your records.

11 @ File » Close to close the template screen.
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B.29 PANEL REPORT

ATTENTION: The panel must be selected for export so results go to the database.

Below is an example of a patient panel report with data only. Each area is defined for the
purpose of helping you better understand the origin of the report

information.

*_°

4]
\ \

P

CXP Panel Repor / Your Facility Name
Runtime Results 25 Harvard Street, Boston, MA 02110
|23€ep2003  3:45pm /o
SampialD1: | ID13579tetraT1l Name: Jon Doe
Panel Nams:_ | tetraCXP TBNK FC Assay| Patient ID: 13579 D.0.B.: 17Apr1976
Camplete™ Y Match.ﬂ FC 500 SN: 12345
@D | LD Name(s): CXP v1.0 tetraCXP v2.0 ' 5 ]
1D13579tetraT101Jan2003
1) ID1357S%atraT201Jan2003 I— |
T —aotach > User ID: BCI
01Jan2003 _10:04am Tube ID: 67892345 \_@
Sex: M ID#:  111-22-3333 Hematology Date / Time: 01Jan03  10:04am
G\\ Physician: Jane Smith, MD Hematology Instrument: LH 750
Sample Type: EDTA WBC: 7.33x1073/uL LY %: 35.04
Dilution Factor: 15.00 RBC: 4.835x 1076/ uL MO %: 9.37
D)—1 | orvest vorume: 100.00 mL PLT: 2635x10°3/ul  NE%: 4892 ————@J)
Body Weight: 407.23 kg Other: EO %: 6.00
BA %: 0.67
Cell
®\ | | Description Region Pop Result Cells/pL Opt Stat 1 Opt Stat 2 /@
Avg Total CD3+ (T celisy 70.33 1112 o
Expected Range 53.0-90.0 1050-1600
CD3+/CD4+ (Helper T cells) 2430 L 300 L
Expected Range 53.0-90.0 1050-1600 /@
CD3+/CD8+ (Suppressor T cells) 53.79 H 1376 H T
®_\ | Expected Range 9.8-48.6 45-1350
CD3-/CD56+ (NK Cells) 7.62 118
Expected Range 2.32-8.35 75-150 X /@
CD19+ (B cells) 14.93 231
Expected Range 8.95-25.46 178-267
CD4:CD8 Ratio eq 0.22
Expected Range 1.00-2.00
% Total Lymphocytes (T+B+NK) | eq 93.06
Expected Range 90.0-100.0
CD3+ Reliability Check e 2.45
Expected Range 0.0-10.0
CD3+ Intrapanel Check eq 1.80
Expected Range 0.0%£2.0
17
Comments:‘
- /_
Page 1 of 1 Signature:
55700098
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PANEL REPORT

Date and time report was printed
Sample identification (obtained from CXP listmode file)
Indicates the name of the panel used (obtained from CXP listmode file)

CXP software version and application plug in software version, if installed (obtained from system
registry)

Institution’s name and address where report was produced

Patient information (entered on Database Information screen; see Entering/Editing Database
Information)

Instrument’s serial number (obtained from CXP listmode file)
tetraCXP software version (obtained from CXP listmode file)
User who logged on to CXP and generated the report

Tube ID (barcode)

Hematology information (entered on Database Information screen; see Entering/Editing Database
Information)

Cell count results (may come from CXP listmode file or can be calculated by the Report Generator
depending on the template selected) and expected range of cell count (entered at Global Tab in
report template; see EDITING PANEL REPORT TEMPLATES). If a non-Flow-Count template is used
and hematology information is added, Cells/pL are reflected as Cells/pL HEM.

Optional statistics

Percent positive results (obtained from CXP listmode file) and expected range of percent (entered
at Global Tab in report template; see EDITING PANEL REPORT TEMPLATES)

Signature blank for your lab’s use

Comments (entered by user at the template or at individual report)

Indicates that an equation was used and that results were generated by Report Generator
Reported results (measured or calculated)

Cell population used for gating absolute counts from a hematology instrument when a Cells/pL
HEM panel/template is used; field is blank when a template from a Gells/pL CAL panel is used

Specimen information (entered on Database Information screen; see Entering/Editing Database
Information)

Date and time of sample analysis (obtained from CXP listmode file)
Date and time sample was collected

Listmode filenames (obtained from CXP listmode file)

B-211
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(24) Indicates if the complete panel (for example, all tubes) was processed (obtained from CXP
listmode file)

Y =vyes
N = no (Rerun entire panel if N appears.) Incomplete Report prints on the report.

(25) Indicates if protocols or regions in the file match the template definition (obtained from CXP
listmode file)
Y =vyes
N = no (Indicates that the protocol used different regions than the template. Rerun data/sample
through original protocol.)
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Below is an example of a panel report with data and plots.

USING CXP SOFTWARE
PANEL REPORT

CXP Panel Report

Listmode Playback

Your Facility Name
25 Harvard Street, Boston, MA 02110

22Feb2003 3:45pm
Sample ID1:  ID13579tetraT1 Name: Jon Doe
Panel Name:  tetraCXP TBNK FC Assay Patient ID: 13579 D.O.B.: 17Apr1976
Complete: Y Match: Y FC 500 SN: 12345
LMD File Name(s): CXP v1.0 tetraCXP v2.0
ID13579tetraT101Jan2003
ID13579tetraT201Jan2003
Collection Date: User ID: BCI
Analysis Date / Time:  01Jan2003  10:04am Tube ID: 67892345
Sex: M ID#: 111-22-3333 Hematology Date / Time: 01Jan03  10:04am
Physician: Jane Smith, MD Hematology Instrument: LH 750
Sample Type: EDTA WBC: 7.33x 1073/ uL LY %: 35.04
Dilution Factor: 15.00 RBC: 4.835x 1076/ uL MO %: 9.37
Harvest Volume: 100.00 mL PLT: 263.5x1073/uL NE %: 48.92
Body Weight: 407.23 kg Other: EO %: 6.00
BA %: 0.67
Cell
Description Region Pop Result Cells/uL Opt Stat 1 Opt Stat 2
Avg Total CD3+ (T cells) 70.33 1112
Expected Range
CD3+/CD4+ (Helper T cells) 2430 L 300 L
Expected Range
CD3+/CD8+ (Suppressor T cells) 53.79 H 1376 H
Expected Range
CD4:CD8 Ratio eq 0.22
Expected Range
CD3+ Reliability Check eq 245
Expected Range
Comments:
Page 1 of 1 Signature:

55700108
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Below is an example of a panel report with plots only.

CXP Panel Report Your Facility Name
Runtime Results 25 Harvard Street, Boston, MA 02110
22Feb2003 3:45pm
Sample ID1:  ID13579tetraT1 Name: Jon Doe
Panel Name: tetraCXP TBNK FC Assay Patient ID: 13579 D.O.B.: 17Apr1976
Complete: Y Match: Y FC 500 SN: 12345
LMD File Name(s): CXP v1.0 tetraCXP v2.0
ID13579tetraT101Jan2003
ID13579tetraT201Jan2003
Collection Date: User ID: BCI
Analysis Date / Time:  01Jan2003  10:04am Tube ID: 67892345
Sex: M ID#: 111-22-3333 Hematology Date / Time: 01Jan03  10:04am
Physician: Jane Smith, MD Hematology Instrument: LH 750
Sample Type: EDTA WBC: 7.33x 1073 /uL LY %: 35.04
Dilution Factor: 15.00 RBC: 4.835x 1076/ uL MO %: 9.37
Harvest Volume: 100.00 mL PLT: 263.5x 1073 /uL NE %: 48.92
Body Weight: 407.23 kg Other: EO %: 6.00
BA %: 0.67
Comments:
Page 1 of 1 Signature:

55700118

Printing Patient Panel Reports

Auto-Printing

If auto-print was selected in the template, the panel report prints automatically after
acquisition ends.

Manually Printing Panel Reports
Do this procedure to manually print a panel report (if auto-print is disabled).
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@ IQ Report Generabar

@ J. to open the Reports

Selection screen.

Tube ID:

Stating Dale: [~ [ddmrormyyy) Clear

Sample (D1 | Patient (D | Last Mame | Tube D | Report#t |[UserID | Date & Time | Comment:
[ _[FENoma NoFead 34 Cirical Pa_ 5/13/2004 217 PM
I[ES] m Chinners  NOREAD 33 Jorge  6/18/2004 620 PM
EE 7102 Sith [LEIRECT ] Joige  6/18/2004 616 PM
E 34343 Willams 00311285 31 Jorge  5/18/2004 B:16 PM
IEES E0E01 Watkins 00311265 30 Joge  5/1/2004E16 PM
s 50505 Kelly 00311264 23 Joige  5/18/2004 616 PM
EY 40404 Bel [EIRE= R Jorge  6/18/2004 E16PM
E: 30303 Jones 0032 37 Joge  6/18/2004 618 FM
IEE 20702 Kerp 00311261 26 Jorge  5/18/2004 B:16 PM
I 10101 Wight 00311260 25 Joge  5/18/20046:16 PM
S naz Srith 2] Joige  5/18/2004 614 PM
Y 34343 Willams 2 Jorge  6/18/2004 613 PM
I E0E01 Walkins 2 Joge  EN1B2004ET3PM
I 50505 Kelly Edl Joige  5/18/2004 612 PM
i) |
Select Select All Exit Comments

Search for the desired report(s) using the following search criteria: patient ID, last name,
sample ID1, or analysis date.

a. Enter the search criteria information.

b. @ Search.

The last sample run appears at the top of the list by default. You can sort the list by
Sample ID, Patient ID, Last Name, etc. by simply clicking the desired column title.

Note: To do a global search and locate every sample report in the database, leave all

search criteria fields empty and @ Search.

Select the desired report(s). For details on selecting, see Tips for Selecting Reports.
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B-216

9  Once you have selected the desired £
. . Specimen | Patient|
report(s), the Reports View & Print Sl [T o
screen appears et I
pp . Panel Nama
Sample Type: I WEC:
H Date / Ti Rec
s, Dt/ Tine: [ R T T—
Hema. Instrument:
[Nt <« | < > | >
Dilution Factor I MO %
NE Pint Print Al
Harvest Volume: I =
ED %
=
Body elght [ BA % | 3 | Bt
Results
Description | Region | Result | Cells/ul CAL | Res Ranges | Cells/ul CAL
[ |Avg Total CD3+ (T cells) &a 74.275% 63801 53.000-80.000 1050.000-16
| |CD3+/CD4+ [Helper T cells] CD3+CD4+  49765% 4530 25.000-63.000 350000180
| |CD3+/CD8+ [Suppressor T cells) CD3+C08+  23161% 2110 9.000-48.000 45.000-1350
| |cD19+ B Cele) D13 14500 1450 400035000 15.000-750.C
| |CD3-/CD56+ [NK Cels] CD3CDB6+  10.960% 106.0 2.000-26.000 15.000-425.0
| |CD4CD8Ratio CD4/CD8 2143% o
[ |% Total Lymphocytes (T+B+MK] T+B+MK 99523% o 90.000-100.000
|__|CD3+ Reliabilty Check. e 1.345% 010,000
CD 3+ Intrapansl Chack &q 1.345% 0-2.000

6 @ Patient tab.

= Reports view & Print

Patient |
S ample D1 N Report i
Tube ID: I
Panel Name
Sample Type: [ WEL:
Hema. Date / T - e
ema. Diate / Time: BLT T
Hema. Instument:
L% « | <| > | >3
Diluton Factor MO %
B [ Pt Frint Al
Harvest Volume: |— b | |
- =] =]

Body Weight | BA % 2] =]
Results

Desciption [Region  |Fesuk  [Cel/l CAL | Fles langes | Cells/ul CAL
[ | g Total CD3+ [T cels) eq 7a0BEx  TOROL 53.000-30.000 1050.000-16
|__|CD34/CD4+ [Helper T cells) CD3CD4s  48147% 4580 2500063 000 350.000180
|__|cD34/CD8+ Buppressor T cels) CD3:CDB: 237825 2260 5.000-48.000 450001350
|_|coiss (8 Cals) D13+ 14ESE 1420 4.000:35.000 15.000-750.C
|| CD3/C086s K Cells) CD3CDSG6e 12193 1160 2.000:26.000 150004251
|_|coacoeRatio CD4/CDE  20%5% 0
|2 Total Lumphocytes (T8 4tiK) ToENK M0L440%H 0 50,000-100.000
|__|CD3+ Reiiabiity Check. eq 2159% 010000

CD3+ Inirapane! Check. cq 0570% L 0-2.000
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7 USil’lg L % | > | > |
<< displays first report
< . .
displays previous report
> .
displays next report
i displays last report

, review the reports as needed.

8  Print the desired reports:

e To print all reports as a batch, @

e To print the report currently displayed, @

Print All

Frint

9  Print (save) the desired reports as a PDF or an XLS file:

Print

Print Al

O saves the selected report to XLS file.

@ saves the selected report as a PDF file.

© saves all reports in this set as XLS files.

O saves all reports in this set as PDF files.

For a better understanding of the printed report, see PANEL REPORT

10 @ Exit when finished.

PN 1755708
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Tips for Selecting Reports

* To select only one report, highlight the desired row and @ Select.

[ S —
e
Semplelpt [
L —
StatngDale [ () | o
SampleID1 | PatentlD | Last [TubelD | Reparth [UserlD [Date Time, T Comment -
571572004 217 Pi
> 11111 [
212 5/18/2004 616 PM
3303 5/18/2004 616 PM
o601 a 5/18/2004 616 PM
50505 = 5/18/2004 616 PM
a1t ol 5/18/2004 616 PM
WG dones 5/18/2004 616 PM
202 = 5/18/2004 616 PM
0 wih o % 5/18/2004 616 PM
22z smin S/18/2004 614 P
33 wilms % S/18/2004 613PM
OB watkins 2 571812004 613PM
S0 Kely 2 571812004 612PM g
1 | l‘l

Edit Comments

sorattt |

* To select all reports, @ Select All.
* To select multiple reports in sequence:

a. Highlight the first report you want to select.

Press while you @ the far left column of the last file to be selected.

c. Release and the mouse button.
The selected rows are highlighted.

e. @ Select.

[E=Reports selection =
L e —
e —
Sanpliys [
T
SaingDae [ (@) [ e | e

[Patend_[Lat

[ziz |

[TubeID [Datet Time

2 6/19/2004 217 P

5/18/2004 5:16 PM
5/18/2004 6:16 PM
5/18/2004 6:16 PM
5/18/2004 6:14 PM
5/18/2004 6:13PM
5/18/2004 6:13PM
5/18/2004 6:12PM

0311262
0311281
s 2%

st | i Comors |

* To select multiple reports out of sequence:

a. Pressand hold while you @ the far left column of each file.
b.
c. Release after all desired files are highlighted.

d. @ Select.

* To deselect a report, press and hold while you @ the far left column of the
highlighted file. The deselected file is no longer highlighted.

The selected rows are highlighted.

PN 175570B
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USING CXP SOFTWARE
PANEL REPORT

If a comment was added to a template, all reports generated from that template will print that
comment. However, you can add or delete comments from individual sample reports via the

Edit Comments feature.

Do this procedure to edit comments for a specific report.

1 @ BL! Report Generakar

5
[
& Specimen | Patient|
2 to open the Reports et e —
Tube D: I
S 1 5 Panel Name
election screen. Sample Type | — WEC,
RBC
Hema, Date /Tine: [ Fi T T—
Hema. Instrument:
Lrx «| <[> ]»
Diluion Factor I MO %
B Print Frint Al
Harvest Volume: &
£0 3
= =
Body Weiaht ——  omx [e]l=]a
Results
Description | Region | Result | Cells/ul CAL | Res Ranges | Cells/ul CAL
[ [Ava Total CD3+ (T celkl ea e BBl 53.00090.000 105000016
| |CD3+/CD4+ IHelper T ceolk) CD3CD4+  49769% 4530 2500063000 350000180
| |CD3+/C08+ (Suppressor T cels) COCDB+  23161% 2110 9.000-48.000 450001350
| [cD19+ (B Cell) D19+ 14%0% 1450 400035000 15.000-750.C
| |CD3/CD8B+ (MK Cals) CD3CDSB+  10.360% 1060 200026000 15.000-425.C
| |cD4CD8 Ratio CO4/CDE  213% 0
|| Total Lumphacytes (T+BNK) TeBaMK  99E23% 0 90.000-100.000
|__|CD3+ Refiabity Check. eq 1.345% 010,000
D3+ Intrapane! Check eq 1.345% 02,000
< v

3 Search for the desired report using the following search criteria: patient ID, last name,

sample ID1, or analysis date:

a. Enter the search criteria information.

b. @ Search.

Note: To do a global search and locate every sample report in the database, leave all

search criteria fields empty and @ Search. The last sample run appears at the top of the

list.
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4 Toselecta report, highlight the desired
Patient 10 |
TOW.
Last Mame: |
Sample 1D1; |
Tube ID: |
Swatgbate [ iddnmnu) _m Clear
Sample D1 | Patiert D [LastMame | TubelD | Repot#t |UserlD | Date kTime | Commert 5
MNoRead 3
[11711[Chinners __[NOREAD _[33 | |
2212 Smith 00311267 32 5/18/2004 6:16 PM
34343 Williars 00311266 3 5/18/2004 B:16 PM
BOB01 ‘Watkiing 00311265 30 5/18/2004 6:16 PM
50505 Kelly 00311264 29 5/18/2004 6:16 PM
40404 Bell 00311263 28 6/1842004 B:16 PM
30303 Jones 00311262 27 5/18/2004 5:16 PM
20202 Kemp 00311261 26 5/18/2004 B:16 PM
10101 ‘wight 00311260 25 5/18/2004 6:16 PM
21212 Smith 24 5/18/2004 6:14 PM
34343 Williams 23 6/1842004 B:13 PM
BOG01 ‘watkiing 22 Jorge 5/18/2004 5:13 PM
50505 Kelly 2 Jorge 5/18/2004 6:12 PM .
|
Select Gelectall Edit Comments |
5 Enter/edit the comment information
. Comments
(750 characters maximum).
Lipemic Sample =]
i i Cancel
a. @ Edit Comments and enter/edit _ teeel | y
the text.
b. @ 0K when finished.
6 The comments appear on the Repor[s |
3 Patiertt 10
Selection screen. '
Last Mame: |
Sample 1D1; |
Tube ID: |
Starting Date: T [ddmmmypyy) Cearch Clear
Sarple D1 | Patient|D | LastMame | TubeID. | Report#t | UserID | Date & Time. | Cornmert s
35 Cliriesl Pa 5/19/2004 2:40 PM
NoRead linical P 5/13/2004 2:17 PM
00311267 32 Jorge 5/18/2004 6:16 PM
00311266 an Jorge 5/18/2004 6:16 PM
00311265 30 Jorge 5/18/2004 B:16 PM
00311264 23 Jorge 5/18/2004 6:16 PM
00311263 28 Jorge 5/18/2004 6:16 PM
00311262 27 Jorge 6/1842004 B:16 PM
00311261 6 Jorge 5/18/2004 5:16 PM
00311260 25 Jorge 5/18/2004 B:16 PM
24 Jorge 5/18/2004 6:14 PM
23 Jorge 5/18/2004 6:13 PM
738 EOEO01 Watkiing 22 Jorge 6/1842004 B:13 PM
« |

Select Selectal | Edt Comments |
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B.30 DATABASE ENTRY

The Database Information screen is where you enter/edit information for:

* patient demographics,
* specimen information, and

* hematology information.

The database information prints on the patient panel report.

Entering/Editing Database Information

Keep in mind that you should enter/edit information prior to acquisition or listmode replay.
The database links the information to CXP by Sample ID1.

1 @ BL! Report Generakar

=]
2 @ to open the Database Information screen.

ATTENTION: Regarding hematology information, if Flow-Count was not used for a single-platform absolute
count, the WBGC and differential parameters may be entered prior to saving or replacing the listmode data
files through a non-Flow-Count panel. Absolute counts will then be determined as a dual-platform with the
manually entered hematology information and printed on the panel report by replaying the listmode files
through a non-Flow-Count export panel.

3  To edit information or to add specimen S — |
information for an existing patient: R —r T —
) ) BithDate EE— FistName: —
a. Enter the search criteria Co— v e e —
information (Such as patient #) Specimen Information Hematology Information
o e —
@ N ]| Hendcbw e 7=
Callection Date: Coumir (A3 [35.04
b. Search. N e o —
Jane Srith, MO % 937
TubelD B —— wee [iEE oot
NxE o
............ =N —— o m
Body Weight — wE b
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B-222

4  Highlight the desired information to ]
edlt. Patient ID: I m
Last Name: I
9  Verify that the correct information Sanvke ;| -
Tube ID: I
appears.
Patient I [ Last Name | Sample 1D |Tueld =
[ (11111 Chinners 123
Edit Add Spec Info |10 wright 133
6 or IEEEEE] Fiyan FeT)
| |20202 Kemp 235
| |21212 Smith 298
| [22222 Charie 345
| [30303 Jones 356
| |33333 Mariano 456
| |50505 Kelly 465
| [44444 Foster 567 -
<| - nl
Edit Add Spec nfo Help | Close |
Edit . . . Add Spec Info
Note: allows you to edit all information except Sample ID. | " allows you to

enter new specimen information for this patient, as well as edit existing information,
including Sample ID; all demographic information is retained.

Edit the information as needed and

@ Save to save the changes.

ESpatabase Inf

Patient D

BithDate:

Sex

Sanple D1

Sample Type:

Colecton Date:

Physicisr
Tube D:

Diiton Factr:

Harvest Volme:

Body Weight

Cear

Patient Demographics

ES
[T7Rp1576
e |

Specimen Information

Hidde it [ o [mzes

Hematology Information

o

O12r2003 10,04 AN

[whde Booa =1 R ——
| I — Counts
o7 dan 200 o
aaaaa wac: 0L
ine S D = —
| — feC 5w X06hL

NE % @5
1500 PLT: x10°3AL.

o —

| —

BA%  [057
CZ—

EdtRecard
Save Seach
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DATABASE MANAGEMENT

To enter information for a new patient:

a. [!9 Clear.

b. Enter the information.

c. @ Save to save the input.

DATABASE MANAGEMENT

Use the Database Management screen to,

* Connect To Archive Database
* Archive QC Records
* Restore QC Records

Database Management Screen

1 @ IE Report Generatnr{}Karen...l to display

the Report Generator toolbar.

2 @ E on the Report Generator

toolbar to display the Database
Management screen.

x|
phics
PatientID: IW— Last Name: '—
Bith Date: —— FistName: —
Sex: ’ﬁ Midde Init: '— ID#: ’—
Specimen Information Hematology Information
Sample ID1 [
Sanple Type: I = I
e B —
Jcn Dt Counts v ——
s weC [

o I I s s
TubelD: [ R

0 —
Dition Factor: ’— BLT. ’—x e,

T
Harvest Volume: ’— L

Bz [
B Weight —

New Record
Clex Sove Seach
[® Database Management - Clinical Panel (¥er 0.0.2.9) x|

Help

Achive/Restore Database Table Entriss

Records E
Start Date:
End Date

Archive OC Records |

Archive Patient Becords. |

= Auchive Database

Sorver IS
Database [Prchive FCS25
UserD [opuser
Fezae |

Fiestore OC Fecords |

Restore Patient Records. |

LConnect to Archive DB

B-223
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Archive Database Records

Connect To Archive Datahase

1  Display the Database Management Screen.

2 Enter cxppass in the Password field.  Archive Database

Server |llocallMSDE

Database |4rchive_FC525

UzerID ICRDUWT
3 Connect bo Archive DB N

Connect to &rchive DB N

Archive QC Records

Use Remove QC Records to move records from the system database to the archive database.

1  Connect To Archive Database.

Records

@ Start Date
Between Dates.

End Date |5.-"1 9/2004

@ @ Archive/Restore Database Table Entries
2 =] and Before Dates or otuzen Dated
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3 @ in Start Date field and

Sun Mon Tue Wed Thu Fri Sat

29 30 @ 2 3 4 5

a. select the date. e ol A
13 14 185 168 17 18 19

20 0N 2 023 M4 B X

208 029 ;AN 1z

T Today: 8/22/2003

If using Between Dates, repeat this step Carce o
for the End Date field. -

. O

QC Tables will be archived ... Continue?

Cancel |

Restore QC Records

1 Connect To Archive Database.

@ @ Archive/Restore Database Table Entries
2 =] and Before Dates or

Records

Start Date 37 2004
Between Dates.

End Date |5.-"1 9/2004

PN 1755708
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| USING CXP SOFTWARE

B-226

3 @ in Start Date field and

a. select the date.

. W=

If using Between Dates, repeat this step
for the End Date field.

[ < | July. 2003
Sun Mon Tue wed Thu

Sat

23 30 @ 2 3
E 7 &8 3 10
13 14 16 16 17
0 21 2 23 XM
028 23 0 AN
3 4 5 6 7
T Today: 8/22/2003

Cancel

5
12
19
26
2
k|

DK[\J

. O

QC Tables will be restored ... Continue?

o

PN 175570B
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B.32 USING RXP AUTOSETUP PANELS

You cannot use AutoSetup I panels with AutoSetup Scheduler. Follow this procedure to use
AutoSetup I panels with CXP AutoSetup II.

@ to clear the Acquisition Manager.

=

Wil
2 @ | and select the AutoSetup I panel.

Note: You can only run 1 AutoSetup I panel at a time. If you open 2 AutoSetup I panels
in Acquisition Manager, the software stops after the verify tube in the first panel and does
not continue.

3  Enter the carousel ID number in the

. Carousel _
Acquisition Manager. Ho. Location
56 T
4 Assign a CAL Factor if necessary. CAL
Factor

PN 1755708 B-227
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@

) m to begin processing samples. ‘ Protonal Type: Voltage setup
The AutoSetup 11 Wizard processes the
AUtosetup I panel' See Before Running Calculating compensation coefficients
the AutoSetup II Wizard in the Verlying instrument settings
Instructions for Use manual.

» Setup voltages and gains

Adjusting Yolts and Gains.
These p ters are still adjusting:

Note: Automatically approve steps where
appropriate is enabled by default.

v Automatically approve steps where appropriate

[~ Auto Adjust Disabled

Abort I < Hemun Acquire Help

6  Check the verification tube results to ensure instrument settings are correct and

U
Note: When you run AutoSetup I panels with AutoSetup II, cytosettings are
automatically saved to the associated settings file. AutoSetup II does not allow you to

reject the updated cytosettings, therefore any unacceptable AutoSetup I panel results
should be repeated.

B.33 USING NEGATIVE CONTROLS WITH AUTOSETUP

You can use a negative control sample in place of the calibration fluorospheres to set voltages
and gain values in the AutoSetup process for research applications. If you wish to use a
negative control sample, first an Application must be defined using the Application Definition
Wizard. The Calibration protocol (*_stand.pro) of the Application's AutoSetup panel can
then be modified to accommodate the use of the Negative Control.

To use a negative control with AutoSetup II you need to,

* Modify a standardization protocol to use as a negative control.
* Schedule the negative control protocol using the AutoSetup Scheduler.
* Run the negative control protocol using the AutoSetup II Wizard.

*  When scheduling multiple Negative Control setups together, ensure that the same
negative control sample is used for those applications.
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Modify A Standardization Protocol

1 Open the standardization protocol. 21x|
Loak in I 3 AcquisitionProtocol ﬂ = £ '
AS 2C_FL1.pro as 3c 1l neg contral.pro
a File » Open Protocol ASZC_FLZ‘prn as 3 1l werify.pra
. 525 2C_sTamD.pro [#] 45 3C1L settings.pro
[#] a5 2C_vERIFY.pris [#]as 3ciLpro
as 3c 1l [settings].pro AS 3CIL_FLi.pro
. . as 3c 1l Flow-set.pro AS FCIL_FLZ.pro
b the standardization protocol.
L] i
File name: IAS 2C_STAND.pro Open I
C. i Files of type: IF‘rolocoI Files [*.pro] ﬂ Cancel |/
%

2 Delete the FS and SS histograms. =

@ in the upper right corner of

: FS 55

the FS and SS histograms. To 0% “ho%
1] 1023 a 1023

F5Lin S5 Lin
3 CreateaFS vs. SS dotplot. Y
Labeling I Font I Stop and Save I
' Data Source | Events I Resalution
_| and ensure that SS and FS e e

are the X and Y parameters. [Eoame vy 57557 2] =
* Parameter ' Parameter
|55 Lin: 55 Lin =l |FstinFsiin =l

[ Apply gate to all plots
[T Apply % on plak o all plats
[~ Show % on plat

Ok I Cancel Help
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B-230

Create an AutoGate region on the
dotplot.

. Um

b. @ inside the FS vs SS dotplot.

[#][Ungated] 55 Lin/F

=10l x|

FS Lin
1023
I N N N T O B |

S5 Lin

1023

Assign the AutoGate to the x
ﬂuorescence hlStOgramS' Labeling I Stop and Save Font I
Data Source | Hiztogram I Sealing
@ . File Gate
a. on a histogram and press E ERE =
+ . Parameter E&gatEd
IFL2 Log: FLZ Log 'I FL1
@ £
Fs
[ Apply gate to all plots
-
b. j under Gate [ Apply % on plot to &l plots
¥ Show % on plot
C. @ the gate created in step 4.
Ok I Cancel Help
Adjust the linear regions in the ¥ (10000) [B]FL1 Lo _|o)
fluorescence histograms so that they
encompass the first decade.
FL1
00
Tpo o Tz "9
FL1 Log
PN 1755708
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7  Delete the invalid plots on the o]
FlowPAGE.

8 Insert the new plot on the FlowPAGE. =l

&1 nnuo[e]u

|& [B]FLZ Log

Ok I Cancel Help

9 @ to save the Protocol.
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Accuracy - The ability of an instrument to agree with a predetermined reference value at any
point within the operating range. Contrast with precision.

APC - Abbreviation for allophycocyanin dye.

ASCII - Abbreviation for American Standard Code for Information Interchange. An ASCII file
is a type of text file.

Assay values - Values for a control established by extensive repeat testing of that control.

AutoGate - A gate that automatically sizes to the population contained within the boundaries
of the region. There are two types: Elliptical and Contour.

AutoSetup Wizard - A software feature that guides you through the processing of quality
control materials to automatically establish your application settings.

AUX Signal - Auxiliary acquisition pathway that allows either control of simultaneous Lin
and Log signals or acquisition of a Peak signal.

Background count - Measure of the amount of electrical or particle interference.
Bar - A strip (or element) that is usually black and has minimum reflectance.

Bar-code symbol - A group of parallel bars and spaces with encoded characters. A bar-code
symbol generally contains a leading quiet zone, a start character, data characters, a check
character, a stop character, and a trailing quiet zone.

BP filter - A band-pass optical filter that passes a band of wavelengths and blocks others.

Button - The Workstation screens have pictures/icons (for example, | El]) that you select
with the mouse to tell the software what to do. They are arranged on Toolbars for related
functions.

CAL Factor - A number used in conjunction with a known number of particles identified by
a CAL region, that adjusts the region counts obtained.

Channel - In an analog-to-digital converter, the number of equally spaced divisions of the
amplified input signal voltage. All FC 500 flow cytometer signals are resolved into 1024
channels. For dual-parameter histograms, the number of channels is reduced to 64, 128, or
256.

Character - The smallest group of elements that makes a number, letter, or punctuation mark.

Check character (digit, check digit, checksum) - A character used to mathematically check
that the bar-code symbol was read correctly.

Cleaning agent - A detergent used to flush sample from tubing and minimize protein buildup.
Click - To press and release a mouse button.

Coefficient of variation (CV%) - A measure of the variability in signal intensity that is
generated as particles pass repeatedly through the laser beam. This variability is expressed as
a percentage of the average signal intensity.
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Collimate - To make parallel (for example, collimate rays of light).
Color compensation - The subtraction of:

e apercentage of the signal from one fluorescence light sensor
from
* the signal from another fluorescence light sensor

to correct for the overlap of one dye's emission into another dye's emission measurement.

Continuous code - Each character in the bar-code symbol starts with a black bar and ends
with a white space. Characters follow after each other to form a continuous flow of code.

Control - A substance used to routinely monitor the performance of an analytical process that
does not have the characteristic being measured (for example, Immuno-Trol cells or
CYTO-TROL control cells).

Controls and indicators - Instrument controls are the mechanisms you use to communicate
with the instrument. Indicators are the mechanisms the instrument uses to communicate
with you.

Cross-cylindrical lenses - Used in the Cytometer to focus the laser beam and form an
elliptical beam spot.

Cytometer - The system component that analyzes the sample and contains the sheath fluid
and cleaning agent bottles.

Cytosettings - Cytometer hardware settings. Consists of acquisition duration, acquisition
maximum events, gating settings, disciminators, voltages, gains, baseline offset and
compensation settings. Same as Instrument Settings in Acquisition Manager.

db - Abbreviation for decibels.
dc - Abbreviation for direct current.

Defaults - Original settings for the instrument. You can change them to customize the
settings for your laboratory.

Digit - See checksum.
DiOC5(3) - Abbreviation for oxacarbocyanine dye.

Discrete code - Each character in the bar-code symbol starts with a black bar and ends with a
black bar. A white space gap (intercharacter gap) is between each character in the bar-code
symbol.

Discriminator - A channel setting for a parameter that lets you ignore events below the
setting. This lets you eliminate signals caused by debris.

DL filter - A dichroic, long-pass optical filter that directs light in different spectral regions to
different detectors.

Element - A bar or space in a bar-code symbol. There are narrow elements and wide elements.

GLOSSARY-2 PN 1755708



GLOSSARY

Event - A particle passing through the laser beam.

Export file (*.XLS or *.TXT) - File containing selectable statistics and other sample
information from each sample run.

FDA - Abbreviation for fluorescein diacetate dye.
FITC - Abbreviation for fluorescein isothiocyanate dye.

Fixed code length - A specific length of sample ID code, (usually enabled when all sample
IDs are the same length) to make sure that only one length sample ID is accepted.

Flow cell - A device through which particles pass, in a stream of fluid, one at a time, through
a laser beam.

Flow cytometry - A process for measuring the characteristics of cells or other biological
particles as they pass through a measuring apparatus in a fluid stream.

Flow Cytometry Standard (FCS) - The flow cytometry data file standard that provides the
specifications needed to completely describe flow cytometry data sets within the confines of
the file containing the data.

FlowPAGE - A template for creating a report. It can include: data plots, statistics, and user
attached text and/or graphics.

Fluorescent light - The emission of electromagnetic radiation that occurs when the emitting
body absorbs radiation from some other source. For example, when a fluorescent dye is
excited (absorbs radiation), it emits fluorescent light at a wavelength that is different from the
wavelength of the light that excited it.

Fluorescent light (FL1, FL2, FL3, FL4 and FL5) sensors (PMTs) - Collect the fluorescent
light and generate voltage pulse signals. The 1 refers to the first fluorescence sensor; 2 the
second; and so forth.

Forward scatter (FS) - The laser light scattered at narrow angles to the axis of the laser beam.
The amount of forward scatter is proportional to the size of the cell that scattered the laser
light.

Forward scatter (FS) sensor - Collects the forward scatter and generates voltage pulse
signals.

Gain - The amount of amplification applied to a signal. In linear amplification, all of a
sensor's signals are increased by the same amount. Contrast with logarithmic amplification.

Gating - The use of criteria that must be met before an event is included in a histogram.
GB - The abbreviation for gigabyte.

High voltage - Can be adjusted to change the sensitivity of a fluorescent light sensor.
Histogram - A graph showing the relative number and distribution of events.

HPCV - Half peak coefficient of variation
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Hydrodynamic focusing - A process that focuses the sample stream through the flow cell. It
ensures that cells move through the laser beam one at a time, along the same path.

Indicators - See Controls and Indicators.

Integral signal - A voltage pulse with height and area proportional to the total amount of
fluorescent material in a cell.

Intercharacter gap - The space between two characters in a bar-code symbol. Refer to discrete
code. Not in all bar-code types.

IQAP - Abbreviation for Beckman Coulter's Interlaboratory Quality Assurance Program. A
service for all worldwide users of Immuno-Trol cells and CYTO-TROL control cells, the IQAP
statistically compares your control data with that of other laboratories.

Laser - Abbreviation for light amplification by stimulated emission of radiation. Two standard
lasers are in the instrument: one in the MCL for reading bar codes and one in the flow cell for
analyzing cells.

Linear amplification - See gain.
Listmode data - A list of measurements from each cell.

Listmode playback tool - A tool used: 1) to replay 20-bit linear listmode data though new
compensation settings, 2) for panel playback of listmode files, and 3) to replay AutoSetup
listmode files to generate a new compensation file.

LiveGate - Listmode Gate used as a live gate in acquisition and for listmode archival.

Logarithmic amplification - A method of increasing the gain and dynamic range of a signal. A
larger gain is applied to a sensor's smaller signals than to the sensor's larger signals. See also
gain.

MB - Abbreviation for megabyte.

Mean - Arithmetic average of a group of data. See also standard deviation and coefficient of
variation.

Menu - On a Workstation screen, a list of items from which you can choose.

Minimum Event Counter - The count that must minimally be achieved in order to stop
acquisition. Used to ensure collection of rare events.

Mouse - A pointing device. The cursor on the Workstation screen moves as you slide the
mouse on your desk or other flat surface.

Multi-tube CarouselLoader (MCL) - An automated sample loader for the instrument.

Neutral density (ND1) filter - An optical filter that can be used with the forward scatter
sensor to reduce the intensity of the forward scatter, thus enabling the instrument to analyze
large particles without saturating the sensor.

Optical filters - Mediums, such as glass, that separate fluorescent light by wavelength, which
is measured in nanometers (nm). See also BK, BP, and DL filters.
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Panel - In general, a group of protocols for analyzing a series of samples corresponding to one
specimen. The Cytometer settings and regions can be passed on through the panel with
identification of the primary samples.

Panel Wizard - A software feature that guides you through creating or editing a panel.
Panel Report - Patient data reports that are generated by the optional tetraCXP application.
PC7 - Abbreviation for phycoerythrin-cyanine tandem dye.

Photo-multiplier tube (PMT) - A light-sensitive sensor that converts light energy into
electrical current and generates a voltage pulse signal.

Pickup lens/spatial filter assembly - Collects side scatter and fluorescent light from only the
sensing area of the flow cell, and collimates it.

Pop-up window - A rectangular area that appears on top of the current screen displayed on
the Workstation. You must close the window before you can use the current screen again.

Positives analysis - Analysis performed on the negative control to set regions automatically to
exclude the negative population from the positives statistics.

Power Supply - The system component that provides direct current power, pressure, and
vacuum to the Cytometer, and collects waste from the Cytometer.

Precision - Ability of an instrument to reproduce similar results when a sample is run
repeatedly. Precision shows the closeness of test results when repeated analyses of the same
material are performed. Also known as reproducibility. Contrast with accuracy.

PRIME region - When a histogram Peak is not within a PRIME Region the system performs
an AutoPrime.

Printer - An optional system component that provides a printout of sample results and other
information.

Prism - Phenotype plot for multicolor analysis.
Prism histogram - Histogram that displays the phenotype of an identified population.

Protocol - A set of instructions that tells the Cytometer what and how to acquire data and
relay listmode data.

Quality control (QC) - A comprehensive set of procedures a laboratory sets up to ensure that
an instrument is working accurately and precisely.

QuickCOMP - Direct histogram manipulation to adjust Cytometer color compensation.
QuickSET - Direct histogram manipulation to adjust Cytometer voltages and gain.

Quiet zone - An area at each end of the bar-code symbol, which must be clear of marks,
including readable text.

RD1 - Abbreviation for phycoerythrin dye..
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Runtime Protocol - The Protocol stored with the listmode file at acquisition. Listmode
replays identical to the acquisition protocol.

Scroll bar - The area on the left of a pop-up window. The bar's arrows let you move (scroll)
the window's content up or down so that you can see other parts of it. For example, the scroll
bar in the Resource Explorer lets you scroll through the entire list of protocol names.

Select - To position the mouse cursor on an item, and then press and release a mouse button
to choose that item.

Self-checking - A bar code that uses a checking algorithm to make sure the bar-code symbol
was read correctly.

Sensitivity - The ability of the instrument to distinguish very low levels of light scatter and
fluorescence from background light or electronic noise.

Sheath fluid - A balanced electrolyte solution.

Side scatter - The amount of laser light scattered at about a 90° angle to the axis of the laser
beam. The amount of side scatter is proportional to the granularity of the cell that scattered
the laser light.

Side scatter (SS) sensor - Collects the side scatter and generates voltage pulse signals.

Slider bars - They appear on dual fluorescence plots when you enable QuickCOMP mode on
the Cytometer Control dialog box. These sliders are used to intuitively adjust the
compensation coefficients and update the compensation values in the Cytometer Control
Compensation Tab.

Space - A strip (or element) that is usually white and has maximum reflectance.

Specimen ID - ID assigned to a Specimen draw as opposed to a tube.

SQL - Standard query language.

Standard deviation (SD) - A measure of difference from the mean. A measure of precision.

Start and Stop characters - The characters that start and end the bar-code symbol and show
the scan direction.

Symbology - A set of rules for encoding and decoding information contained in a bar-code
symbol. Examples of symbologies include Code 39, Code 128, Interleaved 2-of-5, and
Codabar.

Tube ID - The Bar code ID on individual reaction sample tubes.

Voltage pulse signals - The signals that the forward scatter, side scatter, and fluorescence
sensors generate. They are proportional to the intensity of light the sensor received.

Workstation - The system component that runs the software that lets you control the
instrument. It displays sample results and other information.
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Symbols

$BTIM

key value, 3-10
$BYTEORD

key value, 3-10
$CELLS

key value, 3-10
$CYT

key value, 3-10
$DATATYPE

key value, 3-10
$DATE

key value, 3-10
$DFCiToj

key value, 3-11
$ETIM

key value, 3-10
$EXP

key value, 3-10
$FIL

key value, 3-10
$INST

key value, 3-10
$MODE

key value, 3-10
$NEXTDATA

key value, 3-10
$OP

key value, 3-10
$PAR

key value, 3-10
$PnB

key value, 3-10
$PnE

key value, 3-10
$PnN

key value, 3-10
$PnR

key value, 3-10
$PnS

key value, 3-10
$PnV

key value, 3-10
$PROJ

key value, 3-10
$RUNNUMBER

key value, 3-11
$SMNO

key value, 3-10

PN 1755708

$SRC

key value, 3-10
$SYS

key value, 3-10
$TOT

key value, 3-10
@ABSCALFACTOR

key value, 3-12
@ACQUISITIONPROTOCOLOFFSET

key value, 3-12
@BARCODE

key value, 3-11
@BASELINEOFFSET

key value, 3-11
@CAROUSEL

key value, 3-11
@COMPENSATIONMODE

key value, 3-11
@CYTOMETERID

key value, 3-11
@Discriminator

key value, 3-11
@FILEGUID

key value, 3-11
@HENELASER

key value, 3-11
@LOCATION

key value, 3-11
@PANEL

key value, 3-12
@PnADDRESS

key value, 3-11
@pPnC

key value, 3-11
@PnDIVIDER

key value, 3-11
@PnGAIN

key value, 3-10
@PnQ

key value, 3-11
@PnU

key value, 3-11
@PnX

key value, 3-11
@PnZ

key value, 3-11
@RATIODENOMINATORMUX

key value, 3-12
@RATIONUMERATORMUX

INDEX-1
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key value, 3-11
@RESAVEDFILE

key value, 3-11
@SAMPLEID1

key value, 3-11
@SAMPLEID2

key value, 3-11
@SAMPLEID3

key value, 3-11
@SAMPLEID4

key value, 3-11
@TARGETLASERPOWER

key value, 3-11
@TUBENO

key value, 3-11
@Y2KDATE

key value, 3-11

A

abort
abort the MCL, B-186
abort the panel, B-186
abort the tube, B-186
on error
autogating failure, B-49
repeat the panel, B-187
repeat the tube, B-187
about this manual, xxiii
absolute counts
calibration, B-167
advanced button, B-167
setting a CAL factor, B-167
fluorospheres used to determine, 1-5
access other files?
add user/modify user, B-12
accessibility, instrument
installation requirements, 2-1
accuracy
definition, GLOSSARY-1
acquisition
stop and save, B-136
stop counter, B-136
maximum events, B-137
minimum count, B-149

save histogram data in FCS format, B-137

use stop condition, B-137
acquisition manager
acquisition options, B-42
CAL Factor, B-61

INDEX-2

carousel number, B-60
carousel overflow, B-64
customize worklist columns, B-63
cytosettings, B-60
delete worklist row, B-63
introduction, B-55
LMD filename, B-61
modifying panels, B-56
modifying worklists, B-57
panel, B-58
parameter names, B-62
plots, B-58
protocol, B-58
region sources, B-59
reorder worklist columns, B-63
sample info, B-61
stop condition, B-62
stop value, B-62
toolbar, B-17
tube info, B-60
worklist columns available, B-57
acquisition options
acquisition manager, B-42
cytometer control translucency, B-43
default log scaling, B-42
output options, B-42
workspace preferences, B-42
acquisition setup
Cytometer Control, B-179
baseline offset, B-181
discriminator, B-182
dots, B-181
drive space, B-180
duration, B-180
live gate, B-180
max events, B-180
red laser button, B-182
setup mode, B-180
Action log sheet, A-1
Add, B-6
add user/modify user
access other files?, B-12
delete user, B-4
overwrite acquired data files, B-12
overwrite other data files, B-12
password, B-12

remember last accessed LMD directory, B-12

sign-on administration, B-11
user ID, B-12



user privileges, B-12
ADF
application definition extension, 3-7
admin button
signing on to CXP software, B-2
administration
add user/modify user, B-11
create export logs, B-4
create user profiles, B-4
create user workgroups, B-4, B-5
export billing information, B-7
remote user database, B-8
tools, how to access, B-2
user access control paths, B-13
user ID available at installation, B-1
user ID, description, B-2
work with sign on passwords, B-4
workgroups, users, B-5
working with user profiles, B-4
air conditioning
special requirements, 2-2
allophycocyanin
See APC
ALQ
file extension, 3-7
ambient temperature
instrument, 2-2
amplification
fine, specifications, 3-3
high voltages, specifications, 3-3
linear specifications, 3-3
analysis
analysis only software option, 1-4
menu, B-139

multi user analysis software option, 1-4
network user analysis software option, 1-4

protocol, B-24
software options, 1-4
annotations
annotations on overlay plots
FCS keyword annotation, B-118

copy annotations onto other plots, B-119
font annotations on overlay plots, B-117
format annotations on overlay plots, B-117

introduction, B-116

APC
(675/633) Setup Kit, 1-5
definition, GLOSSARY-1
fluorospheres to check, 1-5
QC materials, 1-5
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See also controls

append PDF file name

INDEX

PDF file name extension, LMD file name, B-41

Application Definition

Wizard, B-83

application definition

extension, 3-7

apply to all plots

color dot plot events, B-88

archive

archive QC records, B-224
connect to archive database, B-224
restore QC records, B-225

archive directory

path, B-13

Archive Now, B-13
arrange

arrange overlay plots, B-116

arrange icons

Windows, B-191

ASCII

definition, GLOSSARY-1, GLOSSARY-5

assay values

definition, GLOSSARY-1

autocleanse

Cytometer, B-187

AutoGate

definition, GLOSSARY-1

autogating

failure, B-49
abort on error, B-49
ignore errors, B-49
pause on error, B-49
region
creating, B-151
sensitivity, B-49
contour sensitivity, B-49
contour travel, B-49
elliptical sensitivity, B-49

automatic

color precedence, B-48
gate creation, B-48
gate maintenance, B-48
maximum value

scaling histogram plot, B-95
region name positioning, B-148
setup target region, B-152

Automator

add blank, B-79
add files, B-79
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introduction, B-76
output options, B-79
panelize, B-79

path details, B-79
remove files, B-79
re-ordering files, B-78

restore analysis files on startup, B-79

setup, B-76
status bar, B-80
toolbar, B-18
autorotate, B-122
tomogram plot, B-122
Autorun
does not occur at installation, 2-11
software installation, 2-7, 2-8
AutoScheduler, B-84
AutoSetup

Application Definition Wizard, B-83
default panels and protocols, 3-8, 3-9

initial protocol, 3-8

panels, 3-8, 3-9

protocols, 3-8, 3-9

Scheduler, B-84

target region, B-152

Wizard,definition, GLOSSARY-1
AUX parameter

signal, definition, GLOSSARY-1

source

Cytometer, B-184

background count

definition, GLOSSARY-1
backup directory

assign path, B-13

display path, B-13
bar

definition, GLOSSARY-1
bar-code labels

carousel and tube, illustration, 1-2

types read by the MCL, 1-2
bar-code reader

description, 1-3
bar-code symbol

definition, GLOSSARY-1
baseline offset, B-46

auto, B-47

off, B-47

on, B-47

INDEX-4

beam shaping

optics, 3-2

billing information

export, B-7
how to set up, B-7

boolean gating, B-141

gate logic, B-142

bottle, waste

See waste container

BP filters

definition, GLOSSARY-1

browsing buttons, B-13
Btus

required for operating system, 2-2

buttons

definition, GLOSSARY-1
See also toolbar

CA Factor

batch ID in acquisition manager, B-61

cable connections

location, 2-3
power, 2-3
signal, 2-3

CAL factor, B-167

definition, GLOSSARY-1

CAL region, B-168
calculate results, B-168
calibrating

absolute counts, B-167

carousel number

display in acquisition manager, B-60

carousel, sample

overflow display in acquisition manager, B-64

carry

cytosettings, B-60

gates, B-58

plots, B-58

regions from previous tube, B-59
regions from protocol, B-59

carryover

performance specifications, 3-12

cascade

Windows, B-189

category

installation, 3-1

cell type, user info, B-44
channel
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definition, GLOSSARY-1
character

definition, GLOSSARY-1
check character

definition, GLOSSARY-1
check digit

definition, GLOSSARY-1
checksum

definition, GLOSSARY-1
cleaning agent

definition, GLOSSARY-1

description, 1-4
cleanse

Cytometer, B-187
Cleanse Mode

use of cleaning agent, 1-4
click

definition, GLOSSARY-1
clip channels

scaling histogram plot, B-94
close all

Windows, B-191
CMP

compensation file extension, 3-6
CMP file

import settings, B-35
coefficient of variation (CV)

See CV
collimate

definition, GLOSSARY-2
color

precedence, automatic, B-48
color blend mode, B-143

modify color blend, B-144
color compensation

definition, GLOSSARY-2

QC material used to adjust settings, 1-5

specifications, 3-3
See also compensation
color dot plot
coloring mode, B-49
copy plot data, B-86
copy plot image, B-86
creating, B-85
data source, B-86
events, B-87
apply to all plots, B-88
no. of events to show, B-88
font, B-89
format plot, B-86

PN 1755708

labeling, B-88
show axis labels, B-89
show axis tick marks, B-89
show plot title on output, B-89
x and y axis labels, B-89
resolution, B-88

compensation

clear all

Cytometer Control, B-184
Cytometer Control, B-184
file extension, 3-6
listmode, B-82
matrix

Cytometer Control, B-184

compensation protocols, 3-8
components

See system components

computer

electrical input requirements, 2-2
specifications, 3-4

configuration

contour plot, B-97

automatic maximum threshold, B-97

contour level color, B-97
dots for data, B-98

INDEX

logarithmic threshold calculation, B-98

maximum contour level, B-98
smooth, B-98
density plot, B-100

automatic maximum threshold, B-101

density level color, B-101

logarithmic threshold calculation, B-101

maximum density level, B-101

smooth, B-102

use gate color, B-102

use single color range, B-102
histogram plot, B-91

freeze frame, B-91

smooth, B-91

use gate color, B-91

connections, cables

location, 2-3
power, 2-3
signal, 2-3

connections, tubing

location, 2-5
pneumatic, 2-5
pressure, 2-5
vacuum, 2-5

waste container, 2-5
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container
waste, capacity, 2-2
waste, connections, 2-5
continuous code
definition, GLOSSARY-2
contour plot
automatic maximum threshold, B-97
configuration, B-97
contour level color, B-97
creating, B-95
data source, B-96
dots for data, B-98
labeling, B-98

logarithmic threshold calculation, B-98

maximum contour level, B-98
resolution, B-98
smooth, B-98

control histogram

remove histogram as control on overlay

plot, B-109

set histogram as control on overlay plot, B-108
set histogram in front on overlay plot, B-109

controls

and indicators, definition, GLOSSARY-2

APC (675/633) Setup Kit, 1-5
CYTO-COMP cells, 1-5
CYTO-TROL control cells, 1-5
definition, GLOSSARY-2
Flow-Check fluorospheres, 1-5
Flow-Count fluorospheres, 1-5
Flow-Set fluorospheres, 1-5
fluorospheres, 1-5
Immuno-Brite fluorospheres, 1-5
IMMUNO-TROL cells, 1-5
IMMUNO-TROL Low cells, 1-5
Leuko-Count fluorospheres, 1-5
list, 1-5
PC7 (770/488) Setup Kit, 1-5
QuickCOMP 2 kit, 1-5
QuickCOMP 4 kit, 1-5
Stem-Count fluorospheres, 1-5
Stem-Trol control cells, 1-5
conventions
used in the manual, xxiv

copy

copy annotations onto other plots, B-119

edit menu, B-52

paste CXP data into spreadsheet, B-120

plot data, color dot plot, B-86

INDEX-6

plot image, color dot plot, B-86
COULTER CLENZ
See cleaning agent
creating
analysis protocol, B-24
autogating regions, B-151
color dot plot, B-85
contour plot, B-95
density plot, B-99
gates, B-139
advanced precedence, B-146
blend color, B-144
boolean gating, B-141
color blend mode, B-143
gate and logical expression, B-140
gate color, B-140
gate logic, B-142
gate name, B-144
modify color blend, B-144
modify color precedence, B-146
operands, B-140
histogram freeze frame, B-92
histogram plot, B-90
legend plot, B-132
linear regions, B-152
linked marker, B-153
multi-file protocol, B-25
multiple linear regions, B-153
new acquisition protocol, B-23
non-linked marker, B-154
polygonal regions, B-147
prism plot, B-127
dividers, B-129

dual parameter prism dividers, B-130, B-158

phenotypes, B-129

single parameter prism divider, B-130, B-160

quadrant regions, B-151
rectangular regions, B-150
surface plot, B-125
tomogram plot, B-121
cross-cylindrical lenses
definition, GLOSSARY-2
customize
toolbars command tab, B-66
toolbars tab, B-65
cut, edit menu, B-51
CvV
definition, GLOSSARY-1
CXP software
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defined keywords, 3-10
file extensions, 3-6
files written in ASCII, 3-6
installation, 2-7
path details, B-13
sign-on administration, B-4
uninstalling, 2-9
See also software
CcY7
See PC7
CYTO-COMP cells
description, 1-5
See controls
Cytometer
abort
abort the MCL, B-186
abort the panel, B-186
abort the tube, B-186
repeat the panel, B-187
repeat the tube, B-187
autocleanse, B-187
cleanse, B-187

control translucency, acquisition options, B-43

cytosettings

get cytosettings from LMD file, B-185
get cytosettings from protocol, B-185

definition, GLOSSARY-2
description, 1-1

idle mode, B-187

menu, B-178

pause, B-186

pause and rotate, B-187
prime, B-187

prime if idle too long, B-187
restart, B-187

serial number, user info, B-44

settings
status page, B-184

specifications, 3-1

start, B-186

stop, B-186

toolbar, B-20

Cytometer Control

acquisition setup, B-179
baseline offset, B-181
discriminator, B-182
dots, B-181
drive space, B-180
duration, B-180
live gate, B-180
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max events, B-180

red laser button, B-182

setup mode, B-180
button, B-179
compensation, B-184

clear all, B-184

matrix, B-184
detectors, B-183

AUX parameter source, B-184

gain, B-184
names, B-183
volts, B-183
parameter setup, B-182
QuickCOMP, B-181
QuickSET, B-181
cytometry
See flow cytometry
Cytosettings
definition, GLOSSARY-2
cytosettings
carry, B-60

INDEX

display state in acquisition manager, B-60

get cytosettings from LMD file, B-185
get cytosettings from protocol, B-185

load, B-60
CYTO-TROL control cells

description, 1-5

See controls

D

daily log

for instrument standardization, A-1

for instrument verification of alignment and

fluidics, A-1
data acquisition throughput

performance specifications, 3-12

data files
overwrite, acquired, B-12
overwrite, other, B-12

data rate
status bar, B-188

data sheets, material safety
how to order, 1-6

data source
apply gate to all plots, B-87
color dot plot, B-86
contour plot, B-96
density plot, B-100
file, B-87
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gate, B-87
histogram plot, B-90
info plot, B-135
legend plot, B-133
parameter, B-91
prism plot, B-128
surface plot, B-126
tomogram plot, B-122
x and y parameter, B-87
data storage
drives, 3-4
specifications, 3-4
database
archive QC records, B-224
connect to archive database, B-224
restore QC records, B-225
Database Management, B-223
database, remote user
sign-on administration, B-8
date
LMD file name, B-40
db
definition, GLOSSARY-2
dc
definition, GLOSSARY-2
default
% of events on dot plot, B-46
3d plot mode, B-47
AutoSetup protocols and panels, 3-8, 3-9
definition, GLOSSARY-2
log scaling, acquisition options, B-42
overlay mode, B-47
overlay plot background color, B-46
plot size, B-47
definitions, GLOSSARY-1
delete
deleting overlay histograms, B-107
edit menu, B-53
FlowPAGE objects, B-171
histogram freeze frame overlay, B-93
prism plot dividers, B-131
regions, B-157
user, add user/modify user, B-4
workgroup, B-6
worklist row, B-63
delivery inspection
instrument, 2-1
density
density plot automatic maximum

INDEX-8

threshold, B-101
density plot level color, B-101
density plot logarithmic threshold
calculation, B-101
density plot maximum density level, B-1
plot resolution, B-102
surface plot, B-126
tomogram plot, B-123
density plot
automatic maximum threshold, B-101
configuration, B-100
creating, B-99
data source, B-100
density level color, B-101
labeling, B-102
log scale, B-46
logarithmic threshold calculation, B-101
maximum density level, B-101
resolution, B-102
smooth, B-102
use gate color, B-102
use single color range, B-102
density style view
tomogram plot, B-122
detectors
Cytometer Control, B-183
AUX parameter source, B-184
detector gain, B-184
detector names, B-183
detector volts, B-183
digit
definition, GLOSSARY-1
dimensions
computer, 3-1
Cytometer, 3-1
instrument, 3-1
Power Supply, 3-1
Workstation, 3-1
DiOC5(3)
definition, GLOSSARY-2
disable
HeNe laser, B-182
discrete code
definition, GLOSSARY-2
discriminator
definition, GLOSSARY-2
specifications, 3-4
dissipation, heat
special requirements, 2-2

01
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dividers, prism plot, B-129
deleting, B-131

dual parameter, B-130, B-158, B-159

editing, B-131

editing single parameter, B-161

removing, B-131

single parameter, B-130, B-160
DL filters

definition, GLOSSARY-2
documentation for your instrument

about your reference manual, xxiii

conventions used, xxiv

introduction to your manuals, xxiii

using the manuals, xxiii
dot plot
coloring mode, B-49
copy plot data, B-86
copy plot image, B-86
creating, B-85
data source, B-86
events, B-87
apply to all plots, B-88
no. of events to show, B-88
font, B-89
labeling, B-88
show axis labels, B-89
show axis tick marks, B-89

show plot title on output, B-89

x and y axis labels, B-89
drainage requirements, 2-2
Duplicate Plot, B-85

E
edit
copy, B-52
cut, B-51
delete, B-53
FCS header attributes, B-34
FlowPAGE
align bottom, B-177
align left, B-176
align right, B-176
align top, B-176
change plot, B-175
copy, B-172
cut, B-172
grow to largest, B-175
paste, B-172
reorder, B-172
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resize objects, B-171
save as, B-178
shrink to smallest, B-175
space evenly across, B-177
space evenly down, B-177
text, B-174
FlowPAGE fill, B-172
FlowPAGE font, B-172
FlowPAGE line, B-172
font, B-54
font, FlowPAGE, B-54
IQAP information, B-200
menu, B-51
paste, B-52

paste CXP data into spreadsheet, B-120

paste special, B-53
prism plot

dual parameter prism dividers, B-159

INDEX

single parameter prism divider, B-161

prism plot dividers, B-131
redo, B-51
regions, B-154
delete region, B-157
move region, B-156
region name, B-156
region points, B-155
resize, B-155
select region, B-155
status bar, B-152, B-153
undo, B-51
elapsed time
status bar, B-188
electrical input
special requirements, 2-2
element
definition, GLOSSARY-2
enable
HeNe laser, B-182

establishing fluorescence and/or light scatter target

ranges log, A-1

establishing HV/total gain ranges log, A-1

establishing peak position and HPCV target ranges

log, A-1
events
color dot plot, B-87
definition, GLOSSARY-3
surface plot, B-127
tomogram plot, B-124
EWL
external worklist extension, 3-6
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Exit, B-51
experiment, user info, B-44
export billing information
user administration, B-7
export file
bitmap size, B-51
data format, B-50
definition, GLOSSARY-3
export logs
billing, how to create, B-7
how to create, B-4
extension cord
Caution, 2-2

F

FC 500
components description, 1-1
installation, 2-1
manuals, hard-copy, xxiii
monitor linearity, 1-5
specifications, 3-1
view of instrument, 1-1
FCS
definition, GLOSSARY-3
extension for histogram file, 3-6
extension for Listmode data file, 3-6
file format, 3-4
format files, save all, B-30
header
edit attributes, B-34
info plot, B-134
keywords, 3-10
view information, B-34
information
info plot, B-134
select results, B-164

keyword annotations on overlay plots, B-118

keyword list, 3-10

save histogram data in FCS format, B-137

standard keywords, 3-10
FDA
definition, GLOSSARY-3
file
export, definition, GLOSSARY-3
histogram file, save as, B-31
menu, B-22
open histogram, B-30
open listmode, B-27
open protocol, B-32

INDEX-10

options toolbar, B-14
plot data source, B-87
protocol, save as, B-33
references in data, B-50
save all FCS format files, B-30
save protocol, B-33
file name
extension, LMD file name, B-40
file references in data, B-50
filename
specifications, 3-7
unavailable characters, 3-7
filter block, dual laser
options, 1-4
filter block, single laser
options, 1-4
filter kit
options, 1-4
filter kit, single laser
options, 1-4
filters
BP, definition, GLOSSARY-1
contained in optional filter block, 1-4
contained in optional kit, 1-4
DL, definition, GLOSSARY-2
dual laser filter block, optional, 1-4
filter kit, optional, 1-4
ND1, definition, GLOSSARY-4
optical, definition, GLOSSARY-4
optical, list of, 3-2
optical, specifications, 3-2
single laser filter block, optional, 1-4
single laser filter kit, optional, 1-4
finish button
signing on to CXP software, B-3
FITC
definition, GLOSSARY-3
fixed code length
definition, GLOSSARY-3
flow cell
definition, GLOSSARY-3
sensing area, 3-1
specifications, 3-1
flow cytometry
definition, GLOSSARY-3
flow cytometry standard
definition, GLOSSARY-3
flow rate
related to pressure, 3-1
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specifications, 3-1
status bar, B-189
Flow-Check 675 fluorospheres
description, 1-5
Flow-Check fluorospheres
description, 1-5
log sheets, A-1
See also controls
Flow-Count fluorospheres
description, 1-5
setting a CAL factor, B-167
advanced button, B-167
setting a CAL region, B-168
See also controls
FlowPAGE
copy objects, B-172
cut objects, B-172
data printouts, 3-5
definition, GLOSSARY-3
deleting objects, B-171
edit
align bottom, B-177
align left, B-176
align right, B-176
align top, B-176
change plot, B-175
fill, B-172
font, B-54, B-172
grow to largest, B-175
line, B-172
save as, B-178
shrink to smallest, B-175

space evenly across, B-177

space evenly down, B-177
text, B-174
example, B-169
insert
blank, B-67
drag & drop plot, B-71
from file, B-67
line, B-72
picture, B-73
plot, B-70
rectangle, B-72
statistics table, B-68
text file, B-74
textbox, B-69
introduction, B-169
menu, B-169
move selected item, B-170
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paste objects, B-172

print, B-36

reorder objects, B-172

resize objects, B-171

select a group of items, B-170
select single item, B-170
toolbar, B-16

Flow-Set 675 fluorospheres

protocols, 3-8

Flow-Set 770 fluorospheres

protocols, 3-8

Flow-Set fluorospheres

description, 1-5
log sheets, A-1
protocols, 3-8
See also controls

fluidics systems

check stability, 1-5

fluorescence
color compensation, specifications, 3-3

HPCV specification, 3-12

INDEX

resolution, performance specifications, 3-12
sensitivity, performance specifications, 3-13

standardize intensity, 1-5

fluorescent light (FL)

definition, GLOSSARY-3
sensor, definition, GLOSSARY-3

fluorospheres

protocols, 3-8

font

annotations on overlay plots, B-116, B-117

color dot plot, B-89
edit, B-54
edit FlowPAGE font, B-54

force square

Windows, B-191

format

FCS, 3-4

font annotations on overlay plots, B-117
format annotations on overlay plots, B-117

overlay plots

axis and tick mark labels, B-115

fill, B-112
line, B-112
plot background, B-112
plot options, B-115
x axis labels, B-115
zoom to fit, B-109

PDE 3-5

plot, B-138
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forward scatter (FS)
definition, GLOSSARY-3
HPCV specification, 3-12

resolution, performance specifications, 3-12

sensor, definition, GLOSSARY-3
freeze frame

creating, B-92

deleting overlay, B-93

histogram plot configuration, B-91

introduction, B-92

G
gain
definition, GLOSSARY-3
settings
Cytometer Control, B-184
gate
automatic creation, B-48
carry, B-58
color options toolbar, B-15
create, B-139
advanced precedence, B-146
automatic, B-48
blend color, B-144
boolean gating, B-141
color blend mode, B-143
gate and logical expression, B-140
gate color, B-140
gate logic, B-142
gate name, B-144
modify color blend, B-144
modify color precedence, B-146
operands, B-140
data source, apply to all plots, B-87
load, B-58
maintenance, automatic, B-48
maximum per protocol, 3-5
options toolbar, B-15
plot data source, B-87
precedence view
tomogram plots, B-122
selection
tomogram plot data source, B-122
gating
definition, GLOSSARY-3
workspace preferences, B-48
GB
definition, GLOSSARY-3
graphic card drivers

INDEX-12

needed for tomogram plot display, 2-8
ground path requirement, 2-2
group

See workgroups
guidelines

for setting region widths for Flow-Set, 3-9

H

handheld scanner
See bar-code reader
hardware
options, 1-3
heat dissipation, 2-2
help
toolbar, B-15
help toolbar, B-15
HEMA
displayed with Cells/uL, B-211
hematopoietic progenitor cells (HPC)
Stem-Trol cells, 1-5
high voltages
amplification, 3-3
definition, GLOSSARY-3
histogram
add histogram to overlay plot, B-103
definition, GLOSSARY-3
delete histogram from overlay plot, B-107
file, open, B-30
file, save as, B-31
mode
overlay plot histogram mode, B-111
overlay plot Kolmogorov Smirnov
mode, B-112
overlay plot Overton mode, B-111
moving individual histogram on overlay
plot, B-105
moving several histograms on overlay
plot, B-106
PRISM, definition, GLOSSARY-5

re-arrange histograms on overlay plot, B-105

remove histogram as control on overlay
plot, B-109
resolution, 3-5

selecting a single overlay histogram plot, B-107

selecting multiple overlay histogram
plots, B-110

set control histogram in front on overlay
plot, B-109

set histogram as control on overlay plot, B-108
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histogram plot blank page, B-67
configuration, B-91 drag & drop plot, B-71
creating, B-90 from file, B-67
data source, B-90 line, B-72
freeze frame, B-91 picture, B-73

creating, B-92 plot, B-70

deleting overlay, B-93 rectangle, B-72

introduction, B-92 statistics table, B-68
labeling, B-95 text file, B-74
scaling, B-94 textbox, B-69

automatic maximum value, B-95 menu, B-67

clip channels, B-94 overlay histogram, B-75

set maximum, B-95 overlay plot annotation, B-74
smooth, B-91 overlay plot auto text, B-75
use gate color, B-91 installation

HPCV Autorun, 2-7, 2-8
definition, GLOSSARY-3 category, 3-1
specification for fluorescence, 3-12 CXP software, 2-7
specification for forward scatter, 3-12 laser power requirements, 2-2

humidity, allowance, 2-2 system power requirements, 2-2

hydrodynamic focusing institute
definition, GLOSSARY-4 address, B-44

user info, B-44
| instrument
accessibility, 2-1

icons delivery inspection, 2-1
See buttons, toolbars dimensions, 3-1

idle mode electrical input requirements, 2-2
Cytometer, B-187 installation special requirements, 2-1

ignore errors, autogating failure, B-49 layout, 2-1

Immuno-Brite fluorospheres location, 2-1
description, 1-5 monitor linearity, 1-5
See also controls performance specifications, 3-12

IMMUNO-TROL cells software specifications, 3-4
description, 1-5 space needed, 2-1
See controls unpacking, 2-1

IMMUNO-TROL Low cells view, 1-1
description, 1-5 instrument settings
See controls definition, GLOSSARY-2

import integral signal
settings from CMP file, B-35 definition, GLOSSARY-4

indicators See also signals
definition, GLOSSARY-4 intensity calibration particles

info plot used in fluorescence performance
data source, B-135 specifications, 3-13
FCS tab, B-134 intercharacter gap

input, electrical definition, GLOSSARY-4
special requirements, 2-2 introduction to your manuals, xxiii

insert IQAP
FlowPAGE definition, GLOSSARY-4
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enter IQAP information, B-200 display plots, B-22
IsoFlow sheath fluid light scatter
See sheath fluid standardize intensity, 1-5
linear amplification
See gain
K i .
inear region
keyboard . creating, B-152
cable connection, 2-3 interactive information, B-152
Kolmogorov Smirnov mode properties, B-152
overlay plot histogram mode, B-112 automatic name positioning, B-148
lower and upper limit, B-152
minimum count, B-149
L
, positives analysis, B-152
labeling prime, B-152

color dot plot, B-88
show axis labels, B-89
show axis tick marks, B-89
show plot title on output, B-89
x and y axis labels, B-89
contour plot, B-98
density plot, B-102
histogram plot, B-95
laser
beam spot size, Argon, 3-2
beam spot size, HeNe, 3-2
beam spot size, solid state, 3-2
definition, GLOSSARY-4
disable HeNe, B-182
operating wavelengths, 3-2
second laser option, 1-3
specifications, 3-2

region name, B-152
target region for automatic setup, B-152
linearity
monitor instrument, 1-5
linked marker
creating, B-153
listmode
batch replay, B-76
compensation, B-82
compensation panel extension, 3-6
data, definition, GLOSSARY-4
FCS file
save as, B-29
file, open, B-27
maximum file size, 3-5
maximum parameters, 3-5
options, B-83

lasetzllzz,rr?_szpot size Parameter Mismatch, B-28

z

Argon, 3-2 playback, B-80
HeN ’3 5 list comp setup, B-82

?i'de’t ; 35 options, B-83

| Sotl state, o2 QuickCOMP, B-168

ayout QuickCOMP matrix, B-168
of the instrument, 1-1 single file mode. B-S1

legend plot & ’

single file mode, B-81
specifications, 3-5
Listmode playback tool
definition, GLOSSARY-4
LiveGate
definition, GLOSSARY-4
LMD file name
date, B-40
display in acquisition manager, B-61
file name extension, B-40
PDF file name extension, B-41

creating, B-132
data source, B-133
options, B-133
% gated, B-134
% total, B-134
number, B-134
show phenotype logic, B-134
Leuko-Count fluorospheres
description, 1-5
See also controls
Levey-Jennings
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append PDF file name, B-41
run number, B-40
sample ID 1, 2, 3, 4, B-39
tag number, B-40
time, B-40
user 1D, B-40
workspace preferences, B-38
LMD QuickCOMP, B-168
matrix, B-168
load
cytosettings, B-60
gates, B-58
plots, B-58
regions from current protocol, B-59
log out, B-51
log scale density plots, B-46
log sheets
action log, A-1
daily log for instrument standardization, A-1
daily log for instrument verification of alignment
and fluidics, A-1
establishing fluorescence and/or light scatter
target ranges, A-1
establishing HV/total gain ranges, A-1
reagent log, A-1
logarithmic amplification
definition, GLOSSARY-4
logged in
signing on to CXP software, B-2

manuals for your instrument
about your reference manual, xxiii
conventions used, xxiv
how to use, xxiii
introduction to your manuals, xxiii
using the manuals, xxiii

material safety data sheets (MSDS)
how to order, 1-6

MB
definition, GLOSSARY-4

MCL (Multi-Tube Carousel Loader)
definition, GLOSSARY-4
description, 1-2

mean
definition, GLOSSARY-4

menu
analysis, B-139
Cytometer, B-178
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definition, GLOSSARY-4
edit, B-51
file, B-22
FlowPAGE, B-169
insert, B-67
plots, B-85
tools, B-75
view, B-55
window, B-189
minimum count, B-149
minimum event counter
definition, GLOSSARY-4
mode
cleanse, use of cleaning agent, 1-4
overlay plot mode, B-103
modify
advanced precedence, B-146
color blend, B-144
color precedence, B-146
panels in acquisition manager, B-56
prism plot, B-162
regions, B-154
user ID, B-12
worklists in acquisition manager, B-57
modify color blend
blend color, B-144
gate name, B-144
monitor
specifications, 3-4
monoclonal antibody
QC material used to verify performance, 1-5
QC material used to verify staining, lysing and
analysis, 1-5
mouse
definition, GLOSSARY-4
MSDS (material safety data sheets)
how to order, 1-6
multi-file protocol, B-25
multiple linear regions
creating, B-153
interactive information, B-153
Multi-Tube Carousel Loader (MCL)
See MCL
Multi-User Sign-On
Page 1, B-1
Screen 2, B-3

negative control
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protocol to use in AutoSetup, 3-8
network

connection, user must validate, B-8

server option, description, 1-3

use to locate the remote user database, B-9

user analysis software option, 1-4
validate connection, B-8
Windows configuration, B-8
neutral density (ND1) filter
See filters
new
acquisition protocol, B-23
panel, B-27
protocol, B-22
worklist, B-27
new panel, B-27
next button
signing on to CXP software, B-2
non-linked marker
creating, B-154

0

opaque region labels, B-45
open
drain, 2-2
histogram, B-30
listmode file, B-27
overlay plot, B-103
protocol, B-32
optical
beam shaping, 3-2
systems, check stability, 1-5
options
analysis only software, 1-4
bar-code reader, 1-3
dual laser filter block, 1-4
filter kit, 1-4
hardware, 1-3
legend plot, B-133
% gated, B-134
% total, B-134
number, B-134
show phenotype logic, B-134
listmode playback, B-83
multi user analysis software, 1-4
network user analysis software, 1-4
Printer, 1-3
second laser, 1-3
single laser filter block, 1-4

INDEX-16

single laser filter kit, 1-4
software, 1-4
Workstation/network server, 1-3

output options

acquisition options, B-42
Automator, B-79

overlay

toolbar, B-19

overlay plot

add histogram, B-103
annotations, B-116
FCS keyword annotations, B-118
font, B-117
format, B-117
arrange plots, B-116
background color, B-46
delete histogram, B-107
font annotations, B-117
format
fill, B-112
line, B-112
plot background, B-112
general
axis and tick mark labels, B-115
plot options, B-115
x axis labels, B-115
histogram mode, B-111
Kolmogorov Smirnov mode, B-112
Overton mode, B-111
insert auto text, B-75
insert histogram, B-75
insert plot annotation, B-74
linked marker, B-153
moving individual histogram, B-105
moving several histograms, B-106
non-linked marker, B-154
open overlay plot, B-103
overlay plot mode, B-103
re-arrange histogram, B-105
remove histogram as control, B-109
scaling, B-114

selecting a single overlay histogram plot, B-107

selecting multiple overlay histogram
plots, B-110

set control histogram in front, B-109

set histogram as control, B-108

views available, 3-6

zoom to fit, B-109

Overton mode
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overlay plot histogram mode, B-111
overwrite acquired data files

add user/modify user, B-12
overwrite other data files

add user/modify user, B-12

P

Panel Report
definition, GLOSSARY-5
panel report
preserve data, 2-9
Panel Template, B-200
Panel Wizard
definition, GLOSSARY-5
panels
AutoSetup, defaults, 3-8, 3-9
definition, GLOSSARY-5
display in acquisition manager, B-58
file extension, 3-6
listmode compensation extension, 3-6
modifying in acquisition manager, B-56
new, B-27
Parameter Mismatch
when loading listmode files, B-28
parameters
Cytometer Control setup, B-182
data source, B-91
names in acquisition manager, B-62
names revert to default, B-182
tomogram plot data source, B-122
x and y data source, B-87
passwords
add user/modify user, B-12
how to create for sign on, B-4
signing on to CXP software, B-2
paste
edit menu, B-52
paste CXP data into spreadsheet, B-120
paste special, edit menu, B-53
path details
description, B-13
paths
archive directory, B-13
backup directory, B-13
display details, B-13
home directory, B-13
user access control paths, B-13
pause
Cytometer, B-186
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pause and rotate
Cytometer, B-187
pause on error, autogating failure, B-49
PC7
(770/488) Setup Kit, 1-5
fluorospheres to check, 1-5
QC materials, 1-5
See also controls
PDF
file extension, 3-6

INDEX

file name extension, LMD file name, B-41

format, 3-5
performance specifications
carryover, 3-12
precision for surface markers, 3-12
resolution, 3-12
sensitivity, 3-12
stability, 3-13
throughput, 3-12
See also specifications
photodiodes
FS and SS sensors, 3-2
photo-multiplier tube
See PMT
physical specifications, instrument, 3-1
pickup lens/spacial filter assembly
definition, GLOSSARY-5
plot backgrounds, changing to black, B-45
plot display
baseline offset, B-46
auto, B-47
off, B-47
on, B-47
default % of events on dot plot, B-46
default 3d plot mode, B-47
default overlay mode, B-47

default overlay plot background color, B-46

default plot size, B-47
opaque region labels, B-45
print dots black, B-46
print plot frames, B-45
show % in region, B-45
show overlay legend pane, B-46
show overlay statistics pane, B-46
smooth histograms, B-46
workspace preferences, B-45
plot options toolbar, B-14
plots
carry, B-58
contour plot configuration, B-91, B-97
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creating

contour plots, B-95

density plots, B-99

dot plots, B-85

dual parameter prism dividers, B-130, B-158

histogram plots, B-90

legend plots, B-132

prism plot dividers, B-129

prism plot phenotypes, B-129

prism plots, B-127

single parameter prism

dividers, B-130, B-160

surface plots, B-125

tomogram plots, B-121
data source

color dot plot, B-86

contour plot, B-96

density plot, B-100

histogram plot, B-90

info plot, B-135

legend plot, B-133

prism plot, B-128

surface plot, B-126

tomogram plot, B-122
deleting

prism plot dividers, B-131
density

surface plot, B-126

tomogram plot, B-123
density plot configuration, B-100
display in acquisition manager, B-58
editing

dual parameter prism dividers, B-159

prism plot dividers, B-131

single parameter prism dividers, B-161
format options, B-138
info plot

FCS information, B-134
labeling

color dot plot, B-88

contour plot, B-98

density plot, B-102

histogram plot, B-95
legend plot options, B-133

% gated, B-134

% total, B-134

number, B-134

show phenotype logic, B-134
load, B-58
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menu, B-85
overlay plot
linked marker, B-153
non-linked marker, B-154
overlay, views available, 3-6
print, B-36
prism
view/modify, B-162
prism plot
compatibility, B-132
explained, B-129
properties, B-138
resolution
color dot plot, B-88
contour plot, B-98
density plot, B-102
surface plot, B-127
tomogram plot, B-124
scaling
histogram plot, B-94
overlay plot, B-114
tomogram plots density style view, B-122
tomogram plots gate precedence view, B-122
PMT
definition, GLOSSARY-5
FL sensors, 3-2
specifications, 3-2
pneumatic power supply
description, 1-2
location, 2-5
pneumatic tubing connections
location, 2-5
PNL
extension for panel file, 3-6
polygonal region
creating, B-147
interactive information, B-150
properties, B-148
format tab, B-150
pop-up window
definition, GLOSSARY-5
positives analysis, B-152
definition, GLOSSARY-5
power
cable connections, 2-3
electrical input, 2-2
power cables
connection, 2-3
Power Supply
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definition, GLOSSARY-5
description, 1-2
dimensions, 3-1
electrical input requirements, 2-2
PPP
listmode compensation panel extension, 3-6
precision (reproducibility)
definition, GLOSSARY-5
surface markers, performance
specifications, 3-12
prime
Cytometer, B-187
region, B-152
Prime region
definition, GLOSSARY-5
print, B-35
dots black, plot display, B-46
FlowPAGE, B-36
plot frames, plot display, B-45
plots, B-36
serial number, B-134
statistics, B-36
to PDE, B-37
User ID, B-134
Printer
definition, GLOSSARY-5
option, 1-3
PRISM histogram
See histogram
PRISM parameter
definition, GLOSSARY-5
prism plot
compatibility, B-132
creating, B-127
dividers, B-129
dual parameter prism dividers, B-130, B-158
single parameter prism divider, B-130, B-160
data source, B-128
deleting dividers, B-131
editing
dual parameter prism dividers, B-159
single parameter prism divider, B-161
editing dividers, B-131
explained, B-129
phenotypes, B-129
removing dividers, B-131
view/modify, B-162
privileges, user
add user/modify user, B-12
PRO
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extension for protocol file, 3-6

Profiles located!, B-10
project, user info, B-44
protocol preview pane
signing on to CXP software, B-3
protocols
AutoSetup, defaults, 3-8, 3-9

compensation, 3-8
creating analysis, B-24
creating multi-file, B-25

INDEX

creating new acquisition protocol, B-23

definition, GLOSSARY-5

display in acquisition manager, B-58

file extension, 3-6

Flow-Set, 3-8

how to access, B-3

how to access other users’, B-3
new, B-22

open, B-32

preview pane, B-3

runtime, definition, GLOSSARY-6
save, B-33

save as, B-33

settings, 3-8

verification, 3-8

publish

Q

histogram data, B-75

publish data to MS Excel, B-50
publish data to text file, B-50
results, B-75

switch to MS Excel on publish, B-51

workspace preferences, B-50

QC Data Table, B-199
QC Levey Jennings, B-192
QC materials

listing, 1-5

quadrant region

creating, B-151
interactive information, B-151
properties, B-151

quality control (QC)

archive QC records, B-224
connect to archive database, B-224
definition, GLOSSARY-5
materials, 1-5

materials, use and function, 1-5
restore QC records, B-225
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Quality Control Report, B-192 carry previous tube, B-59
QuickCOMP creating
definition, GLOSSARY-5 autogating region, B-151
enabling for analysis, B-181 linear region, B-152
listmode playback, B-168 multiple linear regions, B-153
LMD, B-168 polygonal region, B-147
QuickCOMP 2 kit quadrant region, B-151
description, 1-5 rectangular region, B-150
See controls display sources in acquisition manager, B-59
QuickCOMP 4 kit editing, B-154
description, 1-5 delete region, B-157
See controls move region, B-156
QuickSET region name, B-156
definition, GLOSSARY-5 region points, B-155
enabling, B-181 resize region, B-155
quiet zone select region, B-155
definition, GLOSSARY-5 introduction, B-147
linear region, B-152
R interactive information, B-152
properties, B-152
RD1 load, B-59
definition, GLOSSARY-5 maximum per protocol, 3-5
reagent log, A-1 multiple linear regions, B-153
reagents interactive information, B-153
connections, 2-5 polygonal region, B-147
description, 1-4 interactive information, B-150
sheath fluid, definition, GLOSSARY-6 properties, B-148
types used, 1-4 properties, format tab, B-150
See also cleaning agent prime, B-152
See also sheath fluid properties, B-147
rectangular region linear region properties, B-152
creating, B-150 polygonal region properties, B-148
interactive information, B-150 quadrant region properties, B-151
properties, B-150 rectangular region properties, B-150
red laser quadrant region, B-151
disable, B-182 interactive information, B-151
enable, B-182 properties, B-151
redo, edit menu, B-51 rectangular region, B-150
reference manual interactive information, B-150
conventions used, xxiv properties, B-150
introduction to your manuals, xxiii setting a CAL region, B-168
using the manuals, xxiii specifications, 3-5
refresh, B-66 toolbar, B-15
regions types available for gating and analysis, 3-5
autogating, B-151 view/modify, B-154
contour, sensitivity, B-49 delete region, B-157
contour, travel, B-49 move region, B-156
elliptical sensitivity, B-49 region name, B-156
autosetup target region, B-152 region points, B-155

carry from protocol, B-59
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resize region, B-155 See protocols
select region, B-155
remember last accessed LMD directory S
add user/modify user, B-12
remote user database sample
how to connect each user computer, B-10 ID 1, 2,3, 4, LMD file name, B-39
how to implement, B-9 info display in acquisition manager, B-61
sign-on administration, B-8 measurable cell sizes, 3-1
user access rights, B-9 optimum concentration, 3-1
reporting units preparation, 3-1
for absolute count, 3-5 requirements, 3-1
reproducibility (precision) source, user info, B-44
definition, GLOSSARY-5 sample tube
surface markers, performance See test tube
specifications, 3-12 save
requirements, installation all FCS format files, B-30
instrument accessibility, 2-1 histogram file as, B-31
space needed, 2-1 listmode FCS file as, B-29
requirements, sample, 3-1 protocol, B-33
resolution protocol as, B-33
color dot plot, B-88 scaling
contour plot, B-98 histogram plot, B-94
density plot, B-102 automatic maximum value, B-95
performance specifications, 3-12 clip channels, B-94
surface plot, B-127 set maximum, B-95
tomogram plot, B-124 overlay plots, B-114
resource explorer, B-64 scatter
restart sensitivity, performance specifications, 3-12
Cytometer, B-187 scroll bar
restore definition, GLOSSARY-6
restore QC records, B-225 SD (standard deviation)
results definition, GLOSSARY-6
select

advanced statistics configuration

automatic statistic percentiles, B-166 definition, GLOSSARY-6

differences between log-log and log-lin select results, B-163
statistical calculations, B-166 advanced statistics configuration, B-166
log-lin, B-166 automatic statistic percentiles, B-166
log-log, B-166 differences between log-log and log-lin
select, B-163 statistical calculations, B-166
advanced statistics configuration, B-166 log-lin, B-166
current file name, B-164 log-log, B-166
FCS information, B-164 current file name, B-164
statistic type, B-164 FCS information, B-164
room temperature statistic type, B-164
ambient operating, 2-2 self-checking
special requirements, 2-2 definition, GLOSSARY-6
specifications, 2-2 sensitivity, 3-12
run number definition, GLOSSARY-6
LMD file name, B-40 performance specifications, 3-12

runtime protocol Sensors
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fluorescent light, definition, GLOSSARY-3
forward scatter (FS), definition, GLOSSARY-3

specifications, 3-2
types, 3-2
serial number
include on printout, B-134
set maximum
scaling histogram plot, B-95
setting a CAL factor, B-167
advanced button, B-167
settings
get cytosettings from LMD file, B-185
get cytosettings from protocol, B-185
import CMP file settings, B-35
protocols, 3-8
setup mode Cytometer Control, B-180
show
% in region, B-45
dot plot axis labels, B-89
dot plot axis tick marks, B-89
dot plot title on output, B-89
dot plot x and y axis labels, B-89
FCS header
info plot, B-134
legend plot
phenotype logic columns, B-134
overlay legend pane, B-46
overlay statistics pane, B-46
side scatter (SS)
definition, GLOSSARY-6
sensor, definition, GLOSSARY-6
signal cables
connections, 2-3
signals
processing of, specifications, 3-3
signing on to CXP software
sign-on administration, B-4
user name, B-2
sign-on administration
add user/modify user, B-11
remote user database, B-8
signing on to CXP software, B-4
user administration, B-4
single file mode
listmode playback, B-81
Slider bars
definition, GLOSSARY-6
smooth
contour

INDEX-22

plot configuration, B-98
density
plot configuration, B-102
histograms
plot configuration, B-91
plot display, B-46
software
options, 1-4
specifications, 3-4
See also CXP software
space
definition, GLOSSARY-6
space needed, instrument, 2-1
special requirements
installation, 2-1
specifications
instrument, 3-1
Listmode, 3-5
performance, 3-12
physical, 3-1
regions, 3-5
software, 3-4
See also performance specifications
specimen ID
definition, GLOSSARY-6
SQL
definition, GLOSSARY-6
stability
check fluidics systems, 1-5
check optical systems, 1-5
day-to-day, 3-13
performance specifications, 3-13
within day, 3-13
standard deviation (SD)
See SD (standard deviation)
start
Cytometer, B-186
start and stop characters
definition, GLOSSARY-6
statistics
print, B-36
toolbar, B-15
status bar
Automator, B-80
region editing, B-152
integral, B-153
x coordinate, B-153
system status, B-188
data rate, B-188
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elapsed time, B-188
flow rate, B-189
total events, B-188
status page
Cytometer settings, B-184
Stem-Count fluorospheres
description, 1-5
See also controls
Stem-Trol control cells
description, 1-5
See controls
stop
acquisition, B-136

condition display in acquisition manager, B-62

counter
maximum events, B-137
minimum count, B-149

save histogram data in FCS format, B-137

use stop condition, B-137
counter, setup, B-136
Cytometer, B-186

value display in acquisition manager, B-62

surface markers
precision, 3-12
throughput, 3-12
surface plot
creating, B-125
data source, B-126
density, B-126
events, B-127
introduction, B-125
resolution, B-127
symbology
definition, GLOSSARY-6
system
components, 1-1
connections, 2-3
system components description
Cytometer, 1-1
Power Supply, 1-2
Workstation, 1-2
system status
status bar, B-188
data rate, B-188
elapsed time, B-188
flow rate, B-189
total events, B-188
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T

tabbed protocol pane

signing on to CXP software, B-3

tag number

LMD file name, B-40

temperature, ambient operating, 2-2
test tube

size, 3-1

TESTFILE

key value, 3-11

TESTNAME

key value, 3-11

throughput

tile

performance specifications, 3-12

Windows, B-189

tile special

Windows, B-190

time

LMD file name, B-40

tomogram plot, B-122

creating, B-121
data source, B-122
apply to all gates, B-122
file, B-122
gate selection, B-122
select parameter, B-122
density, B-123
density style view, B-122
events, B-124
gate precedence view, B-122
graphic card drivers needed, 2-8
introduction, B-121
resolution, B-124
tomogram slices, B-124

toolbar

acquisition manager, B-17
Automator, B-18

customize command tab, B-66
customize toolbars tab, B-65
Cytometer, B-20

file options, B-14
FlowPAGE, B-16

gate color options, B-15
gate options, B-15

help, B-15

overlay, B-19

plot options, B-14

region options, B-15

INDEX

INDEX-23



INDEX

statistic options, B-15
tools

listmode playback, B-80

menu, B-75

menu, Automator, B-76

publish histogram data now, B-75

publish results, B-75
total events

status bar, B-188
Tube ID

definition, GLOSSARY-6
tube info

display in acquisition manager, B-60

tube, sample
See test tube
tubing

Power Supply pressure connection, 2-5
Power Supply vacuum connection, 2-5

waste container connection, 2-5

u

undo, edit menu, B-51
unpacking of instrument, 2-1
user
add, B-11
modify, B-11
view all, B-5
user access control paths, B-13
backup directory, B-13
home, B-13
path details, B-13
user administration
create export logs, B-4
create user profiles, B-4
export billing information, B-7
sign-on administration, B-4
user access control paths, B-13
workgroups, description, B-5
workgroups, edit, B-6
workgroups, users, B-5
User ID
include on printout, B-134
user ID
add user/modify user, B-12
admin, B-1
LMD file name, B-40
user info
cell type, B-44
experiment, B-44

INDEX-24

institute, B-44
institute address, B-44
project, B-44

sample source, B-44

workspace preferences, B-43

user name

at software installation, B-1
signing on to CXP software, B-2

view all users, B-5

user privileges

add user/modify user, B-12

user profiles

create, B-4

using

v

CXP software, B-1

ventilation requirements, 2-1
verification protocols, 3-8
Vernier gain

specifications, 3-3

view

FCS header information, B-34
menu, B-55

menu, customize toolbars command tab, B-66

menu, customize toolbars tab, B-65
menu, refresh, B-66

menu, resource explorer, B-64
menu, zoom, B-66

view/modify, regions, B-154

delete region, B-157
move region, B-156
region name, B-156
region points, B-155
resize, B-155

select region, B-155

voltage pulse signals

definition, GLOSSARY-6

voltages

W

settings
Cytometer Control, B-183

waste

disposal, 2-2
requirements, 2-2

waste container

capacity, 2-2
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connections, 2-5 description, 1-2
waste line server option, 1-3
connection, 2-5 specifications, 3-4
welcome to CXP software, B-1
window 7

See pop-up window
window menu, B-189
Windows
arrange icons, B-191
cascade, B-189
close all, B-191
Explorer, use to browse, B-13
force square, B-191
network configuration, B-8
tile, B-189
tile special, B-190
WLQ
file extension, 3-7
WLS
worklist extension, 3-6
Workgroup Selection, B-5
workgroups
add/remove user, B-5, B-6
delete, B-6
description, B-5
edit, B-6
edit the name, B-6
how to create, B-4, B-5
how to display and select, B-5
view users, B-5
worklist
columns available in acquisition manager, B-57
columns, customize in acquisition
manager, B-63
columns, reorder in acquisition manager, B-63
extension, 3-6
extension, external, 3-6
modifying in acquisition manager, B-57
new, B-27
row, deleting in acquisition manager, B-63
workspace preferences
acquisition options, B-42
gating, B-48
introduction, B-37
LMD file name, B-38
plot display, B-45
publish, B-50
user info, B-43
Workstation
definition, GLOSSARY-6

zoom, B-66

PN 1755708

INDEX

INDEX-25



INDEX

INDEX-26 PN 1755708



BECKMAN COULTER, INC. CUSTOMER END USER LICENSE AGREEMENT

This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by
United States and international copyright laws and international trade provisions. You must treat the
software contained in this Product like any other copyrighted material. This license and your right to use
the Product terminate automatically if you violate any part of this agreement.

This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software
to you under the following terms and conditions:

You May:

1. Use this software in the computer supplied to you by Beckman Coulter;

2. Maintain one copy of this software for backup purposes (the backup copy shall be supplied by
Beckman Coulter);

3. After written notification to Beckman Coulter, transfer the entire Product to another person or entity,
provided you retain no copies of the Product software and the transferee agrees to the terms of this
license agreement.

You May Not:

1. Use, copy or transfer copies of this Software except as provided in this license agreement;
2. Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;

3. Loan, rent, lease, or sublicense this Software or any copy.

Limited Warranty

Beckman Coulter warrants that the software will substantially conform to the published specifications for
the Product in which it is contained, provided that it is used on the computer hardware and in the
operating system environment for which it was designed. Should the media on which your software
arrives prove defective, Beckman Coulter will replace said media free of charge within 90 days of delivery
of the Product. This is your sole remedy for any breech of warranty for this software.

Except as specifically noted above, Beckman Coulter makes no warranty or representation, either
expressed or implied, with respect to this software or its documentation including quality, performance,
merchantability, or fitness for a particular purpose.

No Liability for Consequential Damages

In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including,
without limitation, damages for loss of profits, business interruption, loss of information, or other
pecuniary loss) arising out of the use of or inability to use the Beckman Coulter Product software. Because
some states do not allow the exclusion or limitation of liability for consequential damages, the above
limitation might not apply to you.

General

This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any
prior agreement concerning this Product software. It shall not be modified except by written agreement
dated subsequent to the date of this agreement signed by an authorized Beckman Coulter representative.
Beckman Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation,
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This
agreement is governed by the laws of the State of Florida.

ST~
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TRADEMARKS

ALTRA, BECKMAN COULTER logo, COULTER, COULTER CLENZ, CYTO-COMP,
CYTO-TROL, Elite, EPICS, EXPO, FlowCentre, Flow-Check, Flow-Count, Flow-Set,
Immuno-Brite, ImmunoPrep, Immuno-Trol, IsoFlow, Multi-Q-Prep, Q-Prep, Stem-Count,
Stem-Trol, SYSTEM II, TQ-Prep, XL, and XL-MCL are trademarks of Beckman Coulter, Inc.

All other trademarks, service marks, products, or services are trademarks or registered
trademarks of their respective holders.
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